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Third-party owners from whom Bay Networks has acquired license rights to software that is incorporated
into Bay Networks products shall have the right to enforce the provisions of this license against licensee.

Licensee shall not remove or obscure any copyright, patent, trademark, trade secret, or similar intellectual
property or restricted rights notice within or affixed to any Software and shall reproduce and affix such
notice on any backup copy of Software or copies of software resulting from modification or combination
performed by licensee as permitted by this license.

Licensee shall not reverse assemble, reverse compile, or in any way reverse engineer the Software. [Note:
For licensees in the European Community, the Software Directive dated 14 May 1991 (as may be
amended from time to time) shall apply for interoperability purposes. Licensee must notify Bay Networks
in writing of any such intended examination of the Software and Bay Networks may provide review and
assistance.]

Notwithstanding any foregoing terms to the contrary, if licensee licenses the Bay Networks product “Site
Manager,” licensee may duplicate and install the Site Manager product as specified in the Documentation.
This right is granted solely as necessary for use of Site Manager on hardware installed with licensee’s
network.

This license will automatically terminate upon improper handling of Software, such as by disclosure, or
Bay Networks may terminate this license by written notice to licensee if licensee fails to comply with any
of the material provisions of this license and fails to cure such failure within thirty (30) days after the
receipt of written notice from Bay Networks. Upon termination of this license, licensee shall discontinue

all use of the Software and return the Software and Documentation, including all copies, to Bay Networks.

Licensee’s obligations under this license shall survive expiration or termination of this license.
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About This Guide

If you are responsible for configuring and managing Wellfleet® routers,
you need to read this guide. This guide describes how to configure your
Wellfleet router so that it runs a default configuration of each protocol
that you enable. Refer to this guide for

0

a

An overview of the Configuration Manager

Instructions on configuring network interfaces using Site Manager
defaults

An overview of, and instructions on, configuring Multiline

Instructions on configuring the router’s connection to the
Technician Interface console

Instructions on specifying BN administrative information

Overview of Ethernet, Token Ring, and FDDI and SMT
physical-layer protocols

Instructions on customizing line services

Instructions on implementing configurations created in local or
remote mode, and saving dynamically made changes to a
configuration file

A list of Wellfleet defaults
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How to Get Help

Before You Begin

Before using this guide, you must complete the following procedures.
For a new router:

o Install the router (refer to Installing and Maintaining BN Routers,
Installing and Maintaining ASN Routers, Installing and Starting
8-Port AN Hubs, or Installing and Starting AN Routers)

o Connect the router to the network and create a pilot configuration
file (refer to Quick-Starting Wellfleet Routers or Installing and
Starting AN Routers)

Make sure you are running the latest version of Wellfleet Site Manager
and router software. For instructions, refer to Upgrading Wellfleet
Routers from Version 5 to Version 8.10, or Upgrading Wellfleet Routers
from Version 8.00 to Version 8.10.

How to Get Help

For additional information or advice, contact the Bay Networks Help
Desk in your area:

United States 1-800-2LAN-WAN
* Valbonne, France (33) 92-966-968

Sydney, Australia (61) 2-903-5800

Tokyo, Japan (81) 3-328-0052

Conventions

angle brackets (< >) Indicate that you choose the text to enter based on
the description inside the brackets. Do not type the
brackets when entering the command. Example: if
command syntax is ping <ip_address>, you enter
ping 192.32.10.12

arrow character (=) Separates menu and option names in instructions.
Example: Protocols->AppleTalk identifies the
AppleTalk option in the Protocols menu.
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brackets ([ 1)

user entry text

command text

italic text

screen text
ellipsis points
quotation marks (“”)

vertical line (])

Acronyms

AARP
ANSI
APPN
ARP
AS
AT
ATM
BDR
BGP

Indicate optional elements. You can choose none,
one, or all of the options.

Denotes text that you need to enter. Example: Start
up the Windows environment by entering the
following after the prompt: win

Denotes command names in text. Example: Use the
xmodem command.

Indicates variable values in command syntax
descriptions, new terms, file and directory names,
and book titles.

Indicates data that appears on the screen. Example:
Set Trap Monitor Filters

Horizontal (. . .) and vertical ( : ) ellipsis points
indicate omitted information.

Indicate the title of a chapter or section within a
book.

Indicates that you enter only one of the parts of the
command. The vertical line separates choices. Do not
type the vertical line when entering the command.

Example: If the command syntax is
show at routes | nets, you enter either
show at routes or show at nets, but not both.

AppleTalk Address Resolution Protocol
American National Standards Institute
Advanced Peer-to-Peer Networking
Address Resolution Protocol
Autonomous System

AppleTalk Protocol

Asynchronous Transfer Mode

Backup Designated Router

Border Gateway Protocol
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Acronyms

BOFL
BOOTP
CLNP
CMIP
CSMA/CD

DDP
DLCMI
DLS
DXI
EGP
FDDI
FR
HDLC
HSSI
IEEE
ILI

IP
IPX
IS-IS
LB
LLC
LSAP
MAC
MIB
MOP
MTU
NCP
NLPID
NSAP

Breath of Life message

Bootstrap Protocol

ConnectionLess Network Protocol

Common Management Information Protocol

Carrier Sense Multiple Access with Collision
Detection

Datagram Delivery Protocol

data link control management interface
Data Link Switching

Data Exchange Interface

Exterior Gateway Protocol

Fiber Distributed Data Interface
Frame Relay protocol

High-level Data Link Control protocol
High Speed Serial Interface

Institute of Electrical and Electronic Engineers
intelligent link interface

Internet Protocol

Internet Packet Exchange (Novell)
Intermediate System to Intermediate System
Learning Bridge

Logical Link Control

Layer Service Access Point

Media Access Control

Management Information Base
Maintenance Operations Protocol
maximum transfer size

Network Control Protocol

network layer protocol identifier

Network Service Access Point




OSI
OSPF
PCM
PDU
PHY
PID
PPP
PVCs

RIF
RIP
RMT
QENET
SAP
SIP
SMDS
SMT
SNAP
SNMP
SR
SRM
STE
SVCs
TCP/IP

TTRT
vC
VINES
WCP

Open Systems Interconnection

Open Shortest Path First

Physical Connection Management (FDDI)
Protocol Data Unit

Physical Layer Protocol (FDDI)
protocol identifier

Point-to-Point Protocol

permanent virtual circuits

Reverse Address Resolution Protocol
Routing Information Field (SR)
Routing Information Protocol

Ring Management (FDDI)

Quad Ethernet Link Module

Service Access Point

SNMP Interface Protocol

Switched Multimegabit Data Services
Station Management (FDDI)
Subnetwork Access Protocol

Simple Network Management Protocol
Source Routing protocol

system resource modules

Spanning Tree Explorer packet (SR)
switched virtual circuits

Transmission Control Protocol/Internet Protocol
Trivial File Transfer Protocol

target token rotation time

virtual connection

Virtual Networking System (Banyan)
Wellfleet Compression Protocol
Translation Bridge
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Chapter 1
Configuration Manager Overview

This chapter provides an overview of the Configuration Manager tool.
It also describes the router configuration functions you can perform
using this tool, explains the three operating modes (local, remote, and
dynamic), and how to start and operate the Configuration Manager in
each mode.

Note: If you are configuring an Access Node (AN)™ or an Access Stack

Node (ASN)™ for the first time, you must read Administering
Networks for AN and ASN Routers before you continue. This
manual explains the special considerations for configuring and
booting the Access Node and the Access Stack Node.

Router Configuration Functions

The Configuration Manager provides remote router configuration
functions. Specifically, it allows you to

a

o o o a

Add network interfaces based on defaults to the router.
Customize network interfaces for your network environment.
Reconfigure the router’s connection to the Technician Interface.
Specify a router’s hardware configuration.

Specify administrative information about the router.
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Router Configuration Functions

Adding Network Interfaces

The Configuration Manager simplifies the router configuration process
by providing default values for the majority of parameters required to
configure an interface. Chapter 2 provides detailed instructions on
adding network interfaces. Appendix A lists the Wellfleet router
configuration defaults.

Customizing Network Interfaces

The Configuration Manager allows you to customize an interface after
you add it to the router by providing management access to all
parameters associated with an interface.

These parameters consist of the physical-layer (line) parameters,
datalink-layer (circuit) parameters, and network-layer (bridging/
routing) parameters. Basically, you can perform the following
functions:

o Edit the physical-layer, or line, parameters associated with the
interface.

Chapter 3, “Customizing Line Services,” describes how to edit
physical-layer parameters.

g Delete and rename circuits, as well as move a circuit to another
interface.

Chapter 2, “Adding Network Interfaces,” describes how to delete,
rename, and move circuits.

o Add protocols to and delete them from the circuit associated with
the interface.

Chapter 2, “Adding Network Interfaces,’; describes how to add
protocols to and delete them from the circuit associated with an
interface.

o Edit bridging and routing protocol parameters.
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You can access these parameters on a system-wide or interface-
specific basis. Refer to the appropriate protocol-specific guide for
instructions on editing bridging and routing protocol parameters.

0 Add multiple Internet Protocol (IP) addresses to a single circuit
that supports IP.

Customizing IP Services describes how to add multiple IP
addresses to a single IP circuit.

Configuring the Router Connection to the Technician Interface

The router’s console port connects the router to the Technician
Interface. Site Manager provides default settings for the console
configuration; however, you can use the Configuration Manager to
access and reconfigure all console parameters.

Chapter 2, “Adding Network Interfaces,” describes how to configure
the router’s connection to the Technician Interface.

Specifying Router Hardware Configuration

In dynamic and remote modes the Configuration Manager does not
require you to specify router hardware. In local mode, however, the
Configuration Manager requires you to specify the hardware
configuration whenever you create a new configuration file.

Chapter 2, “Adding Network Interfaces,” describes how to specify
router hardware.

Specifying Administrative Information

The Configuration Manager allows you to specify a system name, a
system contact, and a system location for the router. When you use Site
Manager to access the router, Site Manager retrieves the
administrative information and displays it in the Wellfleet Site
Manager window (Figure 1-1), which appears at Site Manager
start-up.




Operating Modes

Chapter 2, “Adding Network Interfaces,” describes how to specify
administrative information.

@ Wellfleet Site Manager
File View Options Tools Administration Help
fConnectionl {Statisticsl i Traps | § Events | Z

192, 32, 14,59
192.32,37.117  Down
192,32,37.114  Down

System Name/IP Address: 192,32,6, 166
SNMP ID (Community) : public
System Name: ”

Contact: ”

ny

Location:
Description: "Image: int/8.10/36 Created on Fri Dec 16 14:21:03
EST 1994,”

MIB Version: %8, 10

Model: Backbone Link Node (BLN)

Power Supply 1: Not Applicable Fan: Not &pplicable
Power Supply 2: Not Applicable Temperature: Not &pplicable
Power Supply 3: Not Applicable

Power Supply 4: Not Applicable

Figure 1-1. Wellfleet Site Manager Window

Operating Modes
The Configuration Manager allows you to perform all configuration
functions in one of three modes:
o Local
o Remote

o Dynamic
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You specify the operating mode from the Wellfleet Site Manager
window (Figure 1-1) by selecting Tools=»Configuration Manager and
the appropriate operating mode option. When you operate the
Configuration Manager in remote or dynamic mode, you configure
SNMP options that allow the Configuration Manager to access and
control the router.

For each function you can perform, the Configuration Manager
displays the same windows in the same sequence regardless of the
operating mode. For example, the Configuration Manager displays the
same sequence of windows when you configure the Bridge global
parameters in local mode as it displays when you configure them in
dynamic mode.

The Configuration Mode field in the upper-left corner of each window
identifies the Configuration Manager’s current operating mode. For
example, Figure 1-2 shows the Edit Bridge Global Parameters window
when the Configuration Manager tool is running in local mode.

[® Edit Bridge Global Parameters
Configuration Mode: local
SNYP Agent: LOCAL FILE
Enable [ @uaBLE ]
Bridge Table Size |1024 §
Enable Forwarding DB | ENABLE |

Figure 1-2. Edit Bridge Global Parameters Window in Local Mode

The following sections describe each operating mode, as well as how to
run and use the Configuration Manager in each mode.
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Local Mode

Use local mode to create or edit a configuration file locally on the Site
Manager workstation for later implementation on the router.

Perform the following steps for local configuration:
Open a configuration file.

Specify the hardware.

o Complete the configuration.

Q

o Save and implement changes.

Opening a Configuration File

To begin configuring in local mode, open a new or existing
configuration file from the File Selection window (Figure 1-3).

From the Wellfleet Site Manager window, select Tools-»Configuration
Manager->Local File to display the File Selection window.
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[f®] File Selection
Path:|/extra/smgr/configs | UPeE o |
[ Delete
Directory: |configs [File: [router] | L_Fi
Delete
Path List: Directories List: Files List bﬁﬁﬂDﬂLJ
/ (XTSI} [router1 A | el |
extra test router2 E:I
smgr bldl router3
conflgs bld2
bld3
¥ ] [+ |+
o [

Figure 1-3. File Selection Window

Opening an Existing Configuration File
To open an existing file, select it and click on the Open File button.

You can select a file and the directory path to it by clicking on the Path
List, Directories List, and File List. The Path List shows the path from
the root directory to the current directory. Select from the Path List to
move up a directory level. The Directories List shows the directories
available from the current directory. Select from the Directories List to
move down a directory level. The Files List shows files available from
the current directory.

Your current selections appear in the Path, Directory, and File boxes at
the top of the window. You can edit this information directly by clicking
on the appropriate box and entering a path, directory, or file.

Once you select or specify a directory and file, use the buttons on the
File Selection window to open or delete a file or to delete a directory.
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Opening a New Configuration File

To open a new file, enter the name in the File box and click on the Open
File button.

You can also create a file by entering its name in the Path box at the
top of the window and pressing Enter to create it. You can enter a new
directory by entering its name in the Path or Directory box and
pressing the Enter button.

You must have write-access privileges to the directory where you want
to create a configuration file.

Specify the Hardware

Unlike remote and dynamic modes, local mode does not access a router
or automatically display the router’s hardware configuration. You
enter the router’s hardware configuration when you create a new
configuration file or edit a file with hardware changes.

After you open a new file, the Select Router Model window (Figure 1-4)
displays the Wellfleet router models.

Select the appropriate router model and then click on the Confirm
button.
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[®) Select Router Model SR
Select Desired Model, then

Router Models

{© Feeder Node (FN) |
O Link Node (LN)

< Concentrator Node (CN)

< Access Feeder Node (AFN)

< Integrated Node (IN)

@ Backbone Link Node (BLN)

< Backbone Concentrator Node (BCN)
< Backbone Link Node 2 (BLN-2)

< Becess Node (AN)

Figure 1-4. Select Router Model Window

After you select a router model, or open an existing file, the Wellfleet
Configuration Manager window (Figure 2-1) displays a logical image of
the rear panel associated with the router you selected.

At this point, you must specify the router’s hardware configuration.
For instructions, refer to Chapter 2, “Adding Network Interfaces.”

Completing the Configuration

After specifying the hardware in local mode, use the Configuration
Manager to perform all desired router configuration functions (adding
and configuring interfaces, and so forth) as documented in subsequent
chapters.

Saving and Implementing Changes

When you are finished creating or modifying the configuration file,
save the file to the Site Manager workstation. To implement your
configuration:




Operating Modes

1. Use the Router File Manager to select TFTP to transfer the
configuration file to the router.

2. Use Site Manager to reboot the router with the configuration file.

See Chapter 6, “Implementing Configuration Changes,” for more
information.

Remote Mode

Use remote mode if you can access the router over the network, but
want to implement the configuration at a later date. In order to run the
Configuration Manager in remote mode, you must first configure the
router connection options that identify the router you want to
configure and that provide Site Manager with an SNMP community
that has read/write access to the router.

After you have specified the router connection options and selected the
remote operating mode, the Configuration Manager uses SNMP GETs
to retrieve and display the router’s hardware configuration in the
Wellfleet Configuration Manager window. Optionally, if you specify a
configuration file stored in the router’s file system, the Configuration
Manager uses TFTP to automatically retrieve that file for local editing.
In Figure 1-5, the router administrator has retrieved a configuration
file which contains configuration information for the connectors in
Slots 2, 3, and 5.

When you save an updated configuration file in remote mode, the
Configuration Manager automatically uses TFTPs to send the file to
the router. You must then use Site Manager to reboot the router with
that configuration file in order to implement the configuration.

The next section, “Performing Remote Configuration,” lists the
configuration steps you must follow when operating the Configuration
Manager in remote mode.
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[@ Configuration Manager 2]
File Options Platform Circuits Protocols Dialup Window Help

Configuration Mode: local
NP Agent: LOCAL FILE
File Name: /extra/smgr/srb/appnd6
Model: Backbone Link Node (BLN)
MIB Version: 8.10

Color Key: Used Unused

Slot Description Connectors

5 ["B450 Guad Bthernet | [ ¥CuRd | [HCVRE ] [ECVR: | IEEEEENY
4 § 5280 Quad Sync | FComt ] {comz | [ coms | [ comd |
3 15945 Dual Port Multi Channel|| MCT1-2 |{ NONE || CLOCK || MCTI-1 |
2 { Enpty Slot | FWoNE ] [ NONE | [T WONE | [ NONE ]
1 | System Resource Module | JeijEa#d

Figure 1-5. Router Hardware Configuration in Wellfleet Configuration
Manager Window

Performing Remote Configuration

To perform remote configuration, complete the following steps:

1. Specify the router you want to configure. Refer to “Specifying the
Router in Dynamic and Remote Modes” later in this chapter.

2. When the Configuration Manager returns to the Wellfleet Site
Manager window, select Tools-»Configuration Manager->Remote
File to display the Edit Remote Configuration File window
(Figure 1-6).
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[® Edit Remote Configuration File

O

Edit Configuration File
Open Cancel

Enter file name: Volume:
lcfg_NYI i {b: o

Directory:

B

AL, AL
LN, CFG
CONFIG
BUG, CFG
NI, CFG

Figure 1-6. Edit Remote Configuration File Window

3. To retrieve a file from the router for local editing, complete these
steps:

a. Select the number of the volume (or slot) containing the
configuration file.

b. Click on the Volume box to display the available volumes.
The directory of the chosen volume appears in the directory box.

c. Either type the filename in the Enter file name box or click on
the filename in the Directory scroll box.
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d. Click on the Open button.

The Configuration Manager uses TFTP to retrieve and display
the specified file in the Wellfleet Configuration Manager
window; the filename you specified is displayed in the upper-left
corner of the window. If the specified file does not exist, the
Wellfleet Configuration Manager window displays the
hardware configuration and no circuits.

At this point, you can

o Use the Configuration Manager to perform all desired router
configuration functions (adding interfaces, configuring interfaces,
and so forth).

o Use the Configuration Manager to save the configuration file to the
Site Manager workstation.

o Use the Router File Manager to select TF'TP to transfer the
configuration file to the router.

0 Use Site Manager to reboot the router with the configuration file.

Dynamic Mode

You use dynamic mode if you can access the router over the network
and want to configure the system in real time. In order to run the
Configuration Manager in dynamic mode, you must first configure
SNMP options that identify the router you want to configure and that
provide Site Manager with an SNMP community that has read-write
access to the router.

Performing Dynamic Configuration

To perform dynamic configuration, complete the following steps:

1. Specify the router you want to configure. Refer to “Specifying the
Router in Dynamic and Remote Modes” later in this chapter.

2. Specify the dynamic operating mode by selecting
Tools=>»Configuration Manager->Dynamic in the Wellfleet Site
Manager window.

1-13



Operating Modes

Note: If you used the Technician Interface to set the router to secure

mode during the Quick-Start procedure, you will now be
prompted for a password. Enter the encryption key that you
used when you set this router to secure mode.

The Wellfleet Configuration Manager window appears, displaying
the real-time router hardware and software configuration.

Perform all desired router configuration functions (for example,
adding network interfaces). Refer to later chapters of this book and
any of the customizing network protocol books (for example,
Customizing DECnet Services).

Save the configuration file to the router’s file system if you wish to
maintain a record of the changes you made. Refer to Chapter 6,
“Implementing Configuration Changes,” later in this book.

Specifying the Router in Dynamic and Remote Modes

In order to run the Configuration Manager in dynamic or remote mode,
you must first specify the router you wish to configure. You can connect
to the router three ways:

a

Use the well-known connections feature documented in the next
section. :

Select the Connector box from the Wellfleet Site Manager window
to display the Router Connection Options window (Figure 1-7).

Select Options>Router Connection to display the Router
Connection Options window. ‘

Connect to the router using the Router Connection Options window,
setting all parameters in the window, and clicking on the OK button.
Use the Delete button to delete the currently displayed connection.
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[@® Router Connection Options ET]
Node Name/IP Address 92, 168, 130, 164
Identity (Community) public

Timeout (seconds) .

Retries (per request)

Figure 1-7. Router Connection Options Window

Edit the parameters in the Router Connection Options window as
follows:
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Parameter: Node Name/IP Address
Default: None
Options:  Valid host name or valid IP address

Function:  Specifies the host name or IP address of the
Wellfleet router with which you wish to establish
a management session.

Instructions:  Enter the Wellfleet router’s IP address or host
name. You may only use the host name to
establish a management session if the host name
is included in the workstation’s host file.

MIB Object ID:  Not Applicable

Note: The Configuration Manager’s Router Connection Options
window does not display the Node Name/IP Address parameter.
Each instance of the Configuration Manager tool allows you
access to one Wellfleet router only. To configure two Wellfleet
routers simultaneously, you must display the Router
Connection Options window from the Wellfleet Site Manager
window, specify the new Wellfleet router, and then run another
instance of the Configuration Manager tool, which
automatically communicates with the Wellfleet router.

1-16



Configuration Manager Overview

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Range:

Function:

Instructions:
MIB Object ID:

Identity (Community)
Public
Any valid SNMP community name

Specifies the SNMP community name you want
Site Manager to use when communicating with
the Wellfleet router.

Enter the SNMP community name. The
community must have read-write access to the
specified Wellfleet router, if you wish to use the
Configuration Manager to reconfigure the
Wellfleet router.

Not Applicable

Timeout (seconds)
10 seconds
1 to 300 seconds

Specifies the number of seconds Site Manager
waits for a response from the Wellfleet router
after it issues an SNMP SET or GET before
reissuing the command.

Enter the number of seconds.
Not Applicable
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Parameter:
Default:
Range:

Function:

Instructions:
MIB Object ID:

Well-Known Connections Feature

Retries (per request)
2 attempts
1to 32 attempts

Specifies the number of times Site Manager will
reissue a command when the Wellfleet router does
not respond.

Enter the number of times.
Not Applicable

The main Wellfleet Site Manager window displays a scroll box entitled
Well-Known Connections (Figure 1-8). This scroll box lists the IP
addresses of routers you have connected to with this version of Site
Manager. Click on the IP address in the box to connect to the router.
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Wellfleet Site Manager
File View Options Jools Administration Help

192.32.6. 166 Up
192, 32, 14,53 Up
192,32,37,117  Down
192,32,37,114 Down

System Name/IP Address: 192.188, 130, 164
SNMP 1D (Commumty) public

System Name:

Contact: "John McNaughton”

Location: "SQ4 System Test Lab”

Description: Ig%g%gg%.njg/&i 10/46 Created on Fri Jan 20 (09:18:52
MIB Version: x8. 10

Model: Backbone Concentrator Node (BCN)

Power Supply 1: Not Present Fan: On Line

Power Supply 2: On Line Temperature:  Normal

Power Supply 3: On LJ.ne
Power Supply 4: On Line

Figure 1-8. Well-Known Connections Box

Site Manager lists the IP connections in order of the most recent
connection. Every time you make a new connection using the
Connection button on the Wellfleet Site Manager window (Figure 1-1)
or use the Options=>»Connection menu, Site Manager automatically
adds a new IP address to the list.

The status of the accessibility of the connection to the router is polled
at a sample rate you can define. The Well-Known Connections box lists
the results of the poll next to the IP address as Up, Down, or Ignore.

If you click on an IP address with a Down status, the Connection List
Management window (Figure 1-9) appears.
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[®] Connection List Management

L]

192,32, 14, 39 is marked as not available,

Try |Try to connect now.

Ignore | Do NOT poll this entry

Delete |Remove this entry,

Cancel | Do NOT do anything,

Figure 1-9. Connection List Management Window

The window offers four options:

o Try

Poll again and try to connect now.

o Ignore
Do not poll this address.

o Delete
Remove this address from the list in the Well-Known Connections
box.

o Cancel

Return to the prior window without changing anything.

Click on the option you want for this connection. The Site Manager
window appears.

Choose Options-»Connections List from the Site Manager window to
display the Connections List Options window (Figure 1-10). Set the
options you want in the Well-Known Connections box.
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[®] Connections List Options

Polling &0 O 0ff IS

Test Sample @ One Connection /Poll I Cancel |
< 411 Connections /Poll

Test Rate (secs)

Max, Connections

List Label
Up Label Up
Down Label [Down
Ignore Label Ignore
Sound < None
@ I Down
< Poll & Down
& Change
duto Scroll @ No Butomatic Scroll
< Scroll to Down Connection

Figure 1-10. Connections List Options Window

This window includes the following options:

o Polling
Set this option to Off to disable the testing of the accessibility of the
IP addresses. If you set this option to On, Site Manager polls the IP
addresses in the Well-Known Connections box to test whether the
connections are still accessible.

o Test Sample
Tests one connection or all connections per poll. If you select the
One option, each poll tests one connection on the list in sequential
order.
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o Test Rate (seconds)
Enter in seconds how often to poll the IP addresses to test the
validity of the connections. The default is 300 seconds.

0 Maximum Connections
Enter the maximum number of IP connections to display in the
Well-Known Connections box. Valid entries are 1 to 100. If the
entry is less than the number of connections currently in the box,
Site Manager will truncate the list from the bottom.

o Connections List Label
Edit this if you want to change the label (or name) of the Well-
Known Connections box.

o Up Label
Edit this if you want to change the label indicating the status of an
accessible IP address in the Well-Known Connections box.

o Down Label
Edit this if you want to change the label indicating the status of an
inaccessible IP address in the Well-Known Connections box.

o Ignore Label
Edit this if you want to change the label indicating the status of
connections to be ignored in the Well-Known Connections box. Site
Manager does not poll Ignored connections.

o Sound
Edit this if you want the Well-Known Connections box to generate
no sound, or to sound when

— A connection is down (the default)

— Polling occurs (one beep) and polling shows a connection is
down (one beep per down connection)

— There is a change in status

o Auto Scroll
Edit this if you want an automatic scroll to a down connection in
the Well-Known Connections box.

When you have completed your edits in the Connections List Option
window, click on OK to implement them.
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SNMP SET Error

On occasion you may receive a set error when you try to sign on to a
router in dynamic mode. Set errors lock you out of the router for a
period of time. A common cause might be another person using a router
you are attempting to configure. The system displays the message sSNMP
General Set Error! Machine is currently locked by Manager
(IP Address) or the more general message SNMP set error.

When a set error occurs, wait several minutes and try again. There is a
default lock-out time of 2 minutes when a set error occurs.

Router Connection Messages

Site Manager supports three error messages that
o Explain why a router connection attempt failed.

o Provide information on any adjustments you may need to make in
the router connection parameters.

Any of these messages can appear in a pop-up message box in response
to a failed connection attempt.

Table 1-1 describes the failure condition that corresponds to each
message:
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Table 1-1.  Router Connection Error Messages

Error Message

Failure Condition

Connection failed, SNMP agent
not responding. Check IP
address and Community. Time-
out and Retries may also need to
be increased.

The router at the specified IP address
did not respond to the connection
attempt from your Site Manager work-
station.

WARNING: Site Manager no
longer supports the version of
software that the router is run-
ning. Proceed with caution.

The MIB version of the router at the
specified IP address is older than the
MIB versions supported by your Site
Manager workstation. (There is a back-
ward compatibility problem.)

WARNING: Site Manager has
discovered a forward compatibil-
ity situation with the router
software. It is recommended
that Site Manager be upgraded
in order to manage this router

properly. Proceed with caution.

The MIB version used by the router at
the specified IP address is newer than
the MIB versions supported by your Site
Manager workstation. (There is a for-
ward compatibility problem.)
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Chapter 2
Adding Network Interfaces

This chapter describes how to use the Configuration Manager to
perform the following procedures:

o Specify a router’s hardware configuration.
0 Add network interfaces based on router defaults.

Defaults are suitable for most networks; however, the
Configuration Manager allows you to change (or customize) these
settings after you have added the interface. Bay Networks offers
protocol-specific guides that provide instructions for customizing
network interfaces; refer to these guides as necessary.

Edit a router’s circuits.
o Configure the router’s connection to the Technician Interface.

Specify router administrative information.

This chapter assumes that you are familiar with the Configuration
Manager’s three operating modes and that the Configuration Manager
tool is running on your workstation. Refer to Chapter 1, “Configuration
Manager Overview,” for information on the three operating modes and
for instructions on starting the Configuration Manager tool.

Note: Ifyou are configuring an Access Node (AN) for the first time,
you must read Administering Networks for AN and ASN
Routers before you continue. This manual explains the special
considerations for configuring and booting the AN.




Adding a Network Interface Overview

Adding a Network Interface Overview

Depending on the type of network interface you want to add, the
Configuration Manager tool requires you to specify only a few WAN
and bridging/routing protocol parameters. The tool then provides
default settings for the remaining parameters required to configure the
interface.

Note: You must specify the router’s hardware configuration before
adding a network interface when you create a new
configuration file in local mode. Refer to the “Specifying
Hardware” section later in this chapter for instructions.

Adding a network interface consists of the following two steps:
1. Configuring the circuit
2. Enabling bridging/routing protocols on the circuit

To configure the circuit, you specify the router’s physical network
connection by clicking on a graphic of the appropriate connector. The
Configuration Manager automatically sets all physical-layer (or line)
parameters with default values for that type of connector. Additionally,
for all local-area-network (LAN) connectors, the Configuration
Manager automatically configures the datalink-layer connection,
called a LAN circuit.

If the connector requires a wide area network connection, called a
WAN circuit, the Configuration Manager automatically displays a pop-
up menu from which you select the appropriate WAN protocol. If you
select the ATM DXI, X.25, or Switched Multimegabit Data Service
(SMDS) protocol, the Configuration Manager also requires you to set
some WAN-protocol-specific parameters.

To enable bridging/routing protocols on the circuit, you select the
desired protocols from a pop-up menu that the Configuration Manager
displays automatically once the circuit is configured. Based on the
protocols you select, the application then displays protocol-specific pop-
up windows that prompt you to specify certain parameter values.
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The Configuration Manager provides default values for the remaining
parameters needed to enable the selected bridging/routing protocols on
that circuit. Once you have enabled bridging/routing protocols on a
circuit, you have configured a network interface.

Specifying Hardware

You specify hardware only in local mode. When running in remote or
dynamic mode, the Configuration Manager automatically retrieves the
router’s hardware configuration and displays it in the Wellfleet
Configuration Manager window. When running the application in local
mode, you can add hardware to empty slots and change the hardware
in occupied slots. The procedure for both is the same.

Note: When you change hardware in a slot containing configured
circuits, the Configuration Manager automatically deletes the
circuits.

You specify hardware from the Wellfleet Configuration Manager
window (Figure 2-1), as follows:

[® Configuration Manager
File Options Platform {ivuuiis brodoools

alny  Window Help

Configuration Mode: local

Slot Description Connectors

5 | Enpty Slot T NONE |{ NONE |{ NONE || NONE |
4 [ Eapty Slot ]I NONE || NONE ][ NONE || NONE |
3 I Enpty Slot J NONE [[ NONE || NONE || NONE |
2 [ Enpty Slot | [NoNE | [ NONE_ | [ NONE | [ NONE |
1 | System Resource Module | JENREN8

: loc
SNMP Agent: LOCAL FILE
File Name: /extra/smgr/test6
lodel: Backbone Link Node (BLN)
MIB Version: x8.00

(]
o

Color Key: Used Unused

Figure 2-1. Wellfleet Configuration Manager Window
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1. Under Description, click on the slot for which you want to specify
hardware.

2. The Configuration Manager displays the Module List window
(Figure 2-2), which lists link modules and their corresponding
model numbers.

[®] Module List

L}

=

5200 Dual Port T1

5201 Dual Port T1 (56K)

5220 Single Port T1

5221 Single Port T1 (56K)

5250 Dual Port El

5280 Quad Sync

5280 Quad Sync (ASYNC)

5295 Single Port High Speed Serial Interface (HSSI)
5300 Quad Sync

5300 Quad Sync (BSYNC)

5405 Dual Ethernet

5410 Single Sync, Single Ethernet

5410 Single Sync (ASYNC), Single Ethernet

5420 Dual Sync, Single Ethernet

5420 Dual S e (ASYNC),_Single Ethernet

».4‘1[ [HHJ ST [zl bil hernet _
5430 Dual Sync “(ASYNC), Dual Ethernet
5431 Ethernet Sync Advanced Filters
5450 Quad Ethernet

5505 Dual Ethernet, H/W Filters

Cancel

Figure 2-2. Module List Window

3. Click on the Link Module you want to insert in the slot.

If the Link Module is hidden, drag the scroll bar to display it in the
window.

4. Click on the OK button.

The Wellfleet Configuration Manager window reappears,
displaying the Link Module you just selected in the slot.
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Configuring the Circuit

Note: Refer to Chapter 4 for instructions on adding MCT1 circuits,
and refer to Chapter 5 for information on adding MCE1 circuits.

To configure a circuit, begin at the Wellfleet Configuration Manager
window (Figure 2-1), and complete the following steps:

1. Click on the Link Module connector you want to connect to the
network to display the Add Circuit window (Figure 2-3).

[®] Add Circuit
Configuration Mode: local
SNMP Agent: LOCAL FILE
Circuit Name: (821 Color Key:
. ) fvailable

Select lines from available comnectors: Selected
Slot Connectors

5 £ NONE {1 NONE {1 NONE {1 NONE

4 {J NONE {1 NONE {1 NONE {1 NONE

3 {1 %CVR4 {1 XCVR3 {1 XCVR2 £ XCVR1

2 2 Coml {1 comM2 {1 XCVR2 {1 XCVR1

1 {1 CONSOLE
Cancel

Figure 2-3. Add Circuit Window

The Add Circuit window displays a default circuit name in the
Circuit Name box. The default circuit name consists of a circuit
type designator (Table 2-1) followed by two sets of numbers that
identify the circuit location (the first number is between 1 and 14
and identifies the router slot; the second number is between 1 and 4
and identifies the specific connector in that slot). For example, the
circuit name S21 in Figure 2-3 identifies a synchronous circuit in
Slot 2 on Communications Port 1.
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Table 2-1.  Circuit-type Designators in Default Circuit Names

Letter Designator | Connector Type
E Ethernet

El E1l

F FDDI

H HSSI

MCE1 MCE1

MCT1 MCT1

(0] Token Ring

S Synchronous
T1 T1

Note: We recommend that you follow the default circuit-naming
convention so that circuit types and locations are represented
consistently. However, you can assign any circuit name
containing up to 15 characters (alphabetical, numerical,
underline, or slash) without spaces. Circuit names are case
sensitive.

2. Click on the OK button.

If the connector supports hardware filters, a pop-up window
prompts: Do you want to enable Hardware Filters on this
circuit? Click on the OK button to enable hardware filters.
Otherwise, click on the Cancel button to exit the window.

— If the selected connector requires a LAN circuit, the
Configuration Manager automatically displays the Select
Protocols window. Go to the “Enabling Bridging/Routing

Services” section for instructions.
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— Ifthe selected connector is an ISDN connector (such as ISDN1),
a dialog box appears, telling you that you can only configure
ISDN from the Dialup pull down menu. For information on
configuring ISDN services, refer to Upgrading AN Routers for
ISDN Support, or Upgrading ASN Routers for ISDN Support.

— If the selected connector requires a WAN circuit, the
Configuration Manager displays the WAN Protocols window
(Figure 2-4).

[@ WAN Protocols

Standard
PassThru
PPP

SMDS

Frame Relay
x2b

&M DEI
SDLC

C O OO O SO S

I 0K | iCancel|

Figure 2-4. WAN Protocols Window

3. Select the WAN protocol you want to enable on that circuit and
click on the OK button.

Note: When you select a WAN protocol, note the following:

If you select Frame Relay, PPP, or SMDS on the circuit, protocol
prioritization is enabled automatically. For detailed information
on protocol prioritization, refer to Configuring Filter Options on

Wellfleet Routers.
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If you select Standard, you cannot change the WAN protocol on
this circuit to any of the other protocols later. If you want to
enable any other protocol later on this circuit, you must delete
the circuit and start over. For instructions on deleting a circuit
from the router, refer to the section “Deleting a Circuit from the
Router,” later in this chapter.

If you enable a specific WAN protocol on the circuit, the
synchronous line parameters are automatically set as follows:

Parameter Setting

BOLF Disable

Promiscuous Enable

Service Transparent

WAN Protocol Chosen WAN protocol

See “Editing Synchronous Line Details” in Chapter 3 for more

information.

If you are configuring a Wellfleet AN or ASN router, the ASYNC
option appears in the WAN Protocols window (Figure 2-4). See
“Editing Asynchronous Line Details” in Chapter 3 for more
information on editing the ASYNC parameters.

If you selected the Standard, PassThru, PPP, or Frame Relay WAN
protocol, the Configuration Manager displays the Select Protocols
window. Go directly to the “Enabling Bridging/Routing Services”
section for instructions.

Otherwise, you must specify a few additional parameters before
proceeding to the “Enabling Bridging/Routing Services” section.
Depending on the WAN protocol (ATM DXI, ATM FRE2, SMDS, SDLC,
or X.25) you selected, you must complete the instructions in one of the
following sections before going to the instructions in the “Enabling
Bridging/Routing Services” section:
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o Ifyou selected the ATM DXI protocol, go to the “Enabling ATM DXI
Services” section.

o If you selected the ATM FRE2 protocol, go to the “Enabling ATM
FRE2 Services” section.

o If you selected the SMDS protocol, go to the “Enabling SMDS
Services” section.

o Ifyou selected the SDLC protocol, go to the “Enabling SDLC
Services” section.

o Ifyou selected the X.25 protocol, go to the “Enabling X.25 Services”
section.

Enabling ATM DXI Services

If you enabled ATM DXI on the circuit, the Configuration Manager
displays the Select Protocols window.

To enable ATM DXI service on an interface, you

o Enable group protocols
0 Add permanent virtual circuits (PVCs)

The following sections describe these tasks.

Enabling Protocols on an ATM DXI Circuit

Enable bridging/routing protocols on the ATM DXT circuit using the
following procedure:

1.

Select the protocol or protocols you want to enable on this ATM DXI
circuit.

Click on the OK button when you finish enabling protocols on the
ATM DXT circuit.
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3. The Configuration Manager displays a protocol-specific window
that prompts for additional information (if required). If you need
assistance in responding to any queries, refer to the “Enabling
Bridging/Routing Services” section of this chapter. When you finish
configuring protocols, Site Manager returns to the Configuration

Manager window.

Adding PVCs

To add a PVC, complete the following steps:

1. From the Configuration Manager window, select Protocols=>ATM
DXI->Interfaces to display the ATM DXI Interface List window

(Figure 2-5).

[®] ATM DXI Interface List
T —
ATM DKL, Slot 4, COM

Help...

"

R T —
Enable { ENeBLE il
Interface Description [ |
DAI Mode oDE 14 1
Max # VCs [512 |
Multi Protocol Encapsulation [REC 1483 STYLE WPE |
€S PDU Encapsulation [4AL5 ENCAPSULATION | IN

Figure 2-5. ATM DXI Interface List Window
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2. Select the ATM DXI interface to which you want to add PVCs and
click on the PVCS button. The system displays the ATM DXI PVC

List window (Figure 2-6).

Enable

Mode

Multi Protocol Encapsulation
(8 PDU Encapsulation
Multicast

[® &TM DXL PVC List
|
Copy
Delete
Apply
Yalues. ..
Help.

SO § SV | W | S | — :
L]

Figure 2-6. ATM DXI PVC List Window

3. Click on the Add button. The system displays the ATM DXIT Virtual

Circuit window (Figure 2-7).
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(8 AT DRI VIRTUAL CIRCULT
Configuration Mode: local
SNMP Agent: LOCAL FILE
VPT Number 15 | '
VCT Number [45 N 1

Figure 2-7. ATM DXI Virtual Circuit Window

4.

Enter the virtual path identifier (VPI) and virtual channel
identifier (VCI) numbers that you want to use for the PVC. These
parameters are affected by the value of the DXI Mode parameter on
the ATM DXI Interface List Window (Figure 2-5). Refer to
Customizing ATM Services for guidelines.

Click on the OK button. The system returns you to the ATM DXI
PVC List window (Figure 2-6). The default mode of the PVC you
just added is GROUP ACCESS. If you want to change any of the
parameters on the ATM DXI PVC List window, refer to
Customizing ATM Services for instructions.

To add another PVC with the default configuration, repeat Steps 3,
4, and 5. When you are finished adding PVCs, go to Step 7.

Click on the Done button on the ATM DXI PVC List window to
return to the ATM DXI Interface List window.

Click on the Done button on the ATM DXI Interface List window to
return to the Configuration Manager window.
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Parameter:
Default:
Range:
Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Range:
Function:

Instructions:

MIB Object ID:

VPI Number

None

0 to 255

Identifies the virtual path of the PVC.

The value of this parameter is affected by the DXI
Mode parameter on the ATM DXI Interface List
Window (Figure 2-5). If you have selected Mode 1a
or 1b for the DXI Mode value, enter a value
between 0 and 15. If you chose Mode 2 or 2
Proprietary, enter a value between 0 and 255.
Refer to Customizing ATM Services for more
information.

1.3.6.1.4.1.18.3.5.9.5.14.1.3

VCI Number

None

32 to 65535

Identifies the virtual channel of the PVC.

The value of this parameter is affected by the DXI
Mode parameter on the ATM DXI Interface List
Window (Figure 2-5). If you have selected Mode 1a
or 1b for the DXI Mode value, enter a value
between 32 and 63. If you chose Mode 2 or 2
Proprietary, enter a value between 32 and 65535.
Refer to Customizing ATM Services for more
information.

1.3.6.1.4.1.18.3.5.9.5.14.1.4
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Enabling ATM FRE2 Services

If you enabled ATM FRE2 on the circuit, the Configuration Manager
displays the Select Protocols window.

To enable ATM FRE2 service on an interface, you
o Enable group protocols
o Add virtual channel links (VCLs)

The following sections describe these tasks.

Enabling Protocols on an ATM FRE2 Circuit

Enable bridging/routing protocols on the ATM FRE2 circuit using the
following procedure:

1. Select the protocol or protocols you want to enable on this ATM
FREZ2 circuit.

2. Click on the OK button when you finish enabling protocols on the
ATM FRE2 circuit.

3. The Configuration Manager displays a protocol-specific window
that prompts for additional information (if required). If you need
assistance in responding to any queries, refer to the “Enabling
Bridging/Routing Services” section of this chapter.

When you finish configuring protocols, Site Manager returns to the
Configuration Manager window.

Adding VCLs

To add a VCL, complete the following steps:

1. From the Configuration Manager window, select Protocols>ATM
FRE2-Interfaces to display the ATM Interface List window
(Figure 2-8).
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@ ATM Interface List

1ot o, BTHL 4 T

aTH, Slot 4, ATM1 ;

ATM, Slot 5, ATM1 | Apply
VCL. ‘e

- Values...

. Help‘ LX)

AT,

il

Administrative State Up i

Figure 2-8. ATM Interface List Window

2. Select the ATM FRE2 interface to which you want to add VCLs and
click on the VCL button. The system displays the ATM Virtual
Channel Link window (Figure 2-9).
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[® ATM Virtual Chamnel Link
ITN, Glof 3, &ML WPL 0. WCL 92, GROUE
i St 3 e o et on || =EE

[ Valves... |

VCL Mode GROUP ACCESS
Admininstrative State 0%

Xmit Peak Cell Rate (Cells/Sec) | 4716
Xmit Sustainable Cell Rate(Cells/Sec)|4716
fmit Burst Size (Cells) 40
8AL Type | AALS ENCAPSULATION

Figure 2-9. ATM Virtual Channel Link Window

8. Click on the Add button. The system displays the ATM FRE2
Virtual Channel Link Parameters window (Figure 2-10).
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[@ ATM Virtual Chamnel Link Parameters 2
Configuration Mode: local
SNMP Agent: LOCAL FILE

VPT Number J,
VCL Number 328

. Help...

Figure 2-10. ATM FRE2 Virtual Channel Link Parameters Window

4.

Enter the virtual path identifier (VPI) and virtual channel
identifier (VCI) numbers that you want to use for the VCL. Refer to
Customizing ATM Services for guidelines.

Click on the OK button. The system returns you to the ATM FRE2
Virtual Channel Link window (Figure 2-9). The default mode of the
VCL you just added is GROUP ACCESS. If you want to change any
of the parameters on the ATM FRE2 Virtual Channel Link window,
refer to Customizing ATM Services for instructions.

To add another VCL with the default configuration, repeat Steps 3,
4, and 5. When you are finished adding VCLs, go to Step 7.

Click on the Done button on the ATM FRE2 Virtual Channel Link
window to return to the ATM FRE2 Interface List window.

Click on the Done button on the ATM FRE2 Interface List window
to return to the Configuration Manager window.
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Parameter:
Default:
Range:
Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Range:
Function:

Instructions:

MIB Object ID:

VPI Number

None

0 to 255

Identifies the virtual path of the VCL.

Enter a VPI value between 0 and 255. The VPI
(virtual path identifier) is part of the cell header.
The header can contain a maximum of 8 VPI bits
for a UNI (User to Network Interface) connection.
This bit range allows for path identifiers between
0 and 255.

1.3.6.1.4.1.18.3.4.23.1.5.1.3

VCI Number

None

32 to 65535

Identifies the virtual channel of the VCL.

Enter a VCI value between 32 and 65535. The VCI
(virtual channel identifier) is part of the cell
header. The header can contain a maximum of 16
VCI bits. This bit range allows for path identifiers
between 0 and 65535.

1.3.6.1.4.1.18.3.4.23.1.5.1.4

Note: Following the recommendation of the ATM Forum, the first five
(5) VCI bits of the VCL (that is, identifiers between 0 and 31)
are reserved for added functionality.
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Enabling SMDS Services

If you specified the SMDS (Switched Multimegabit Data Service)
protocol to run on the circuit, the Configuration Manager displays the
SMDS Configuration window (Figure 2-11). Refer to the parameter
descriptions in this section to specify the required SMDS parameters
(Individual Address, Group Address, and ARP Address) and click on
the OK button to enable default SMDS service. You can then proceed
directly to the “Enabling Bridging/Routing Services” section of this

chapter.
(@] SMDS CONFIGURATION 2l
Configuration Mode: local
SNP Agent: LOCAL FILE
Individual Address | (16175054433FFFF
Group Address E161765066 77FEEF
Arp Address E1617055667TFEFF }

Figure 2-11. SMDS Configuration Window
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Individual Address
None

A complete SMDS E.164 address specified by the
SMDS subscription agreement that you have with
your SMDS provider

Provides a MAC-layer address.

Enter the complete SMDS E.164 address, for
example, C15082348734FFFF.

To configure this parameter for a multigroup
configuration, enter this same address in the IP
interface parameter MAC Address. If you want to
pair your IP interfaces with another MAC
address, enter the new address in the IP interface
parameter, not in this parameter. The IP
parameter value overrides the SMDS parameter.

To configure this parameter for a multinet
configuration, enter this same address in the IP
interface parameter MAC Address for every IP
interface that you want associated with this one
address.

For information about IP, refer to Customizing IP
Services.

1.3.6.1.4.1.18.3.5.9.3.1.5
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Group Address
None

A complete SMDS E.164 address specified by the
SMDS subscription agreement that you have with
your SMDS provider

Provides a MAC-layer multicast address for this
SMDS interface.

Enter the complete SMDS E.164 group address,
for example, E16175552876FFFF.

To configure this parameter for a multigroup
configuration, enter this same address in the IP
interface parameter SMDS Group Address. If you
want to pair your IP interfaces with another
SMDS group address, enter the new group
address in the IP interface parameter, not in this
parameter. The IP parameter value overrides the
SMDS parameter value.

To configure this parameter for a multinet
configuration, enter this same address in the IP
interface parameter SMDS Group Address for
every IP interface that you want associated with
this one group address.

For information about IP, refer to Customizing IP
Services.

1.3.6.1.4.1.18.3.5.9.3.1.6
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

ARP Address
None

A complete SMDS E.164 address specified by the
SMDS subscription agreement that you have with
your SMDS provider.

Provides an address resolution multicast address.

Enter the complete SMDS E.164 address, for
example, E16175552876FFFF.

To configure this parameter for a multigroup
configuration, enter this same address in the IP
interface parameter SMDS ARP Req Address. If
you want to pair your IP interfaces with another
ARP address, enter the new address in the IP
interface parameter, not in this parameter. The IP
parameter value overrides the SMDS parameter
value.

To configure this parameter for a multinet
configuration, enter this same address in the IP
interface parameter SMDS ARP Req Address for
every IP interface that you want associated with
this one address.

For information about IP, refer to Customizing IP
Services.

1.3.6.1.4.1.18.3.5.9.3.1.7
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Enabling SDLC Services

If you selected the SDLC option on the WAN Protocols window (Figure
2-4), the Configuration Manager displays the SDLC Line Parameters
window (Figure 2-13).

@ SDLC Line Parameters

Configuration Mode: local f:::(m
SNMP Agent: LOCAL FILE

Clock Source LE‘EERNAL
Internal Clock Speed 19200
Sync Line Coding NRZ
Cable Type R&232

Figure 2-12. SDLC Line Parameters Window

1. Specify the synchronous line parameters in the SDLC Line
Parameters window, as follows:
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Clock Source
External
External | Internal

Specifies the origin of the synchronous timing
signals. If you set this parameter to Internal, this
router supplies the required timing signals. If you
set this parameter to External, an external
network device supplies the required timing
signals. In most cases, this parameter should be
set to External.

Set this parameter to either Internal or External,
as appropriate for your network.

1.3.6.1.4.1.18.3.4.5.1.13
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Internal Clock Speed
64 KB

1200 B | 2400 B|4800 B| 7200 B|9600 B|
19200 B| 32000 B|38400 B |56 KB |64 KB|
125 KB| 230 KB | 420 KB | 625 KB |833 KB|
1.25 MB|2.5 MB|5 MB

Sets the clock speed of an internally supplied clock
when the Clock Source parameter is set to
Internal.

Click on Values and set the clock speed for the
internal clock to the desired data transmission
rate across the synchronous line. Depending on
the protocols configured on this interface, this
value may control internal decision making
within the router. In some cases, the router uses
this value for route selection. If protocol
prioritization is configured, the router uses this
parameter to calculate line delay (refer to
Configuring Filter Options on Wellfleet Routers for
information about protocol prioritization, latency,
and queue depth).

The Internal Clock Speed parameter is
unavailable when the Clock Source parameter is
set to External.

1.3.6.1.4.1.18.3.4.5.1.14
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Sync Line Coding
NRZ
NRZ |NRZI|NRZI Mark

This parameter specifies the line coding of the
physical synchronous line. You can change the
value of this parameter to match the line coding of
a device at the other end of the line.

This parameter is relevant only for the AN and
the ASN.

NRZ
Indicates Non-Return to Zero coding

NRZI
Indicates Non-Return to Zero Inverted coding

NRZI Mark
Indicates Non-Return to Zero Inverted Mark
coding.
Select the appropriate value for synchronous line
coding.

1.3.6.1.4.1.18.3.4.5.1.88

Cable Type
Null
Null |RS232 | RS422|V35|X21

This parameter is used only for switched-service
lines. If the sync port is connected to a dialup
device for switch services, use this parameter to
specify the cable interface type of the device.

Set to reflect the cable interface type being used to
connect the dial unit if you are using one.

1.3.6.1.4.1.18.3.4.5.1.83
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2. Click on the OK button to display the Select Protocols window
(Figure 2-13).

Select either DLSw or APPN as the client protocol to run on the SDLC
circuit.

[@ Select Protocols ET]

Protocols

1 DLSw
W APPN

Figure 2-13. Select Protocols Window

If you select either the DLSw or the APPN option, go to the “Enabling
Bridging/Routing Services” section in this chapter for information on
enabling DLSw and APPN.

For detailed information on customizing SDLC, APPN, and DLSw
services on your router, refer to the following manuals:

o Customizing SDLC Services
o Customizing APPN Services

o Customizing DLSw Services
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Enabling X.25 Services

Enabling X.25 service on a circuit consists of the following three steps:
o Specifying packet-level parameters
o Adding X.25 service records

o Enabling bridging/routing protocols

The following sections describe how to perform each step.

Specifying Packet-Level Parameters

If you specified that the X.25 protocol run on the circuit, the
Configuration Manager displays the X.25 Packet Config window
(Figure 2-14). Refer to the parameter descriptions in this section to
specify the packet-level parameters. When you are done, click on the
Save button to display the X.25 Service Configuration window (Figure
2-15). You add X.25 service records from this window. Refer to the
“Adding New X.25 Network Service Records” section for instructions.

2-28



Adding Network Interfaces

@ X25 Packet Config
Configuration Mode: local
SNMP Agent: LOCAL FILE
Link Address Type |WSE n
Network Address Type [ PDN_NETWORK

PDN X, 121 Address |
DDN IP Address |
Incoming Logical Channel Count IO
Incoming LON Start |
Bidirectional Logical Channel Count |0
Bidirectional LN Start |
Outgoing Logical Channel Count [0

PRI | TRUVISU | WSS | SUSSNR § SNV § SYURE b SRV [k SV SOV SO

Outgoing LCN Start I

Figure 2-14. X.25 Packet Config Window

Caution:  After you enable X.25 service on the router, you can edit the
default settings for the rest of the X.25 parameters.
However, remember that line speed, packet size, and
window size all affect packet throughput across the X.25
network. Setting any of these variables too low could cause
the router to drop packets. Therefore, use caution when
changing the default settings for the following X.25
parameters:

0 Max Window Size
o Max Packet Length

0 Window Size
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g Packet Size

See Customizing X.25 Services for instructions on editing X.25

parameters.

Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

Link Address Type
None
DCE |DTE

Specifies whether this interface provides DCE or
DTE services.

Specify the service type as DCE or DTE.
99999.31.2
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

Network Address Type
None
PDN_Network | DDN_Network | BFE_Network

Specifies the type of X.25 network to which this
interface connects, which dictates the format of
the local X.121 address.

Specify the appropriate format. Then note the
following conditions:

— If you specify PDN_Network, then you must
enter the local address in X.121 address
format, using the PDN X.121 Address
parameter.

— If you specify DDN_Network or
BFE_Network, then you must enter the local
address in IP address format, using the DDN
IP Address parameter. The router then
translates the address into X.121 format.

1.3.6.1.4.1.18.3.5.9.4.5.1.50

PDN X.121 Address
None
Any valid X.121 address

Specifies the X.121 address assigned to this
interface. The X.121 address is supplied by the
X.25 network service provider.

Note that you need to set this parameter only if
you set the Network Address Type to
PDN_Network.

Enter the appropriate X.121 address.
1.3.6.1.4.1.18.3.5.9.4.5.1.52
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Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

Parameter:
Default:
Range:

Function:

Instructions:

MIB Object ID:

DDN IP Address
None
Any valid IP address

Specifies the IP address assigned to this interface.
The router then translates the address into X.121
format and uses it as the local address.

Note that you need to set this parameter only if
you set the Network Address Type to
DDN_Network or BFE_Network.

Enter the appropriate IP address.
1.3.6.1.4.1.18.3.5.9.4.5.1.51

Incoming Logical Channel Count
None
1to512

Specifies the number of logical channels that will
accept incoming call requests received on this
interface.

Enter the number of logical channels that will
accept incoming call requests received on this
interface.

1.3.6.1.4.1.18.3.5.9.4.5.1.36
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Parameter:
Default:
Range:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Range:

Function:

Instructions:

MIB Object ID:

Incoming LCN Start
None
1 to 4096

Specifies the low end of the range of logical
channel numbers that the router can assign to
logical channels that accept incoming call
requests only.

Enter the low end of the range of logical channel
numbers designated for channels that accept
incoming call requests only.

1.3.6.1.4.1.18.3.5.9.4.5.1.37

Bidirectional Logical Channel Count
None
1to 512

Specifies the number of logical channels that will
both accept incoming call request packets and
transmit outgoing call request packets on this
interface.

Enter the number of logical channels that will
both accept and transmit call request packets on
this interface.

1.3.6.1.4.1.18.3.56.9.4.5.1.38
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Parameter:
Default:
Range:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Range:
Function:

Instructions:

MIB Object ID:

Bidirectional LCN Start
None
1 to 4096

Specifies the low end of the range of logical
channel numbers that the router can assign to
bidirectional logical channels.

Enter the low end of the range of logical channel
numbers designated for bidirectional channels.

1.3.6.1.4.1.18.3.56.9.4.5.1.39

Outgoing Logical Channel Count
None
1to 512

Specifies the number of logical channels that will
transmit outgoing call request packets on this
interface.

Enter the number of logical channels that will
transmit call request packets on this interface.

1.3.6.1.4.1.18.3.5.9.4.5.1.40
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Parameter:
Default:
Range:

Function:

Instructions:

MIB Object ID:

Outgoing LCN Start
None
1 to 4096

Specifies the low end of the range of logical
channel numbers that the router can assign to
logical channels that transmit outgoing call
requests only.

Enter the low end of the range of logical channel
numbers designated for those channels that
transmit outgoing calls only.

1.3.6.1.4.1.18.3.5.9.4.5.1.41

Adding New X.25 Network Service Records

You add network service records from the X.25 Service Configuration
window (Figure 2-15). Click on the Add button to display the X.25
Service window (Figure 2-16).

[® %25 Service Configuration
Protocols
1
| e—
Enable { |
Type l i
Connection ID I ;
Remote IP Address [ |
Remote X121 Address ( |
Broadcast [ f

Figure 2-15. X.25 Service Configuration Window
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[®] X25 SERVICE

Configuration Mode: local
SNMP Agent: LOCAL FILE

Type
Remote IP Address
Remote X, 121 Address

Connection ID

l

Figure 2-16. X.25 Service Window

Refer to the parameter descriptions in this section to specify the type of
X.25 network service you want to add and the parameters associated
with that service. When you are done, click on the OK button to return
to the X.25 Service window, which now displays the record you just
added. At this point you can add another network service record by
repeating the instructions in this section, or you can enable bridging/
routing services on the X.25 circuit by following the instructions in the
next section, “Enabling Bridging/Routing Services on an X.25 Circuit.”

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Type
None
PDN | DDN | PTOPT

Specifies the type of X.25 service that this
interface supplies: PDN, DDN, or point-to-point.

Select PDN for Public Data Network service,
DDN for Department of Defense Network service,
or PTOPT for point-to-point network service.

1.3.6.1.4.1.18.3.5.9.4.2.1.9
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Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Remote X121 Address
None
Any valid X.121 address

Specifies a destination X.121 address reachable
over this X.25 interface. You must specify a
destination X.121 address if you are configuring
PDN or point-to-point services.

Enter a destination X.121 address.
1.3.6.1.4.1.18.3.5.9.4.2.1.12

Remote IP Address
0.0.0.0
Any valid IP address

Specifies a destination IP address reachable over
this X.25 interface.

You must specify a remote IP address if you are
configuring DDN services. The router translates
the remote IP address you specify into an X.121
address so that it can route IP traffic over the
network.

Enter a 32-bit destination IP address in dotted
decimal notation format.

1.3.6.1.4.1.18.3.5.9.4.2.1.13
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Parameter:
Default:
Range:

Function:

Instructions:

MIB Object ID:

Connection ID
1
1 to 255

When there are multiple point-to-point circuits
configured to the same X.121 destination, the
connection ID identifies each circuit to the
destination.

Assign a unique connection ID for each X.121
connection.

1.3.6.1.4.1.18.3.5.9.4.2.1.11

Enabling Bridging/Routing Services on an X.25 Circuit

After you have added at least one network service record, you can
enable bridging/routing protocols on the X.25 circuit.

Note: Ifyou configured multiple DDN or PDN network service records
on the X.25 circuit, you only have to enable bridging/routing
protocols on that circuit once. However, if you configured
multiple PTOP network service records on the X.25 circuit, you
have to enable bridging/routing protocols for each PTOP
network service record. This is because the router uses a
different internal circuit for each PTOP record configured on

the circuit.

To begin, select a network service record in the X.25 Service
Configuration window and then select Protocols-»Add/Delete. The
Configuration Manager displays the Select Protocols window, from
which you select the bridging/routing protocols you want to enable on
that circuit. Click on those protocols, then click on the OK button.
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Based on the protocols you select, the application then displays
protocol-specific pop-up windows that prompt you to specify certain
parameter values. Refer to the “Enabling Bridging/Routing Services”
section of this chapter for instructions on setting these parameters.
When you have specified the protocol-specific parameters in all pop-up
windows, the Configuration Manager returns to the X.25 Service
Configuration window.

At this point, you can enable additional bridging/routing protocols on
the circuit by repeating the instructions in this section, or you can click
on the Done button to exit the window.

Configuring Multiple IP Interfaces Over X.25 Circuits

The Wellfleet Configuration Manager allows you to configure multiple
IP interfaces on single X.25 PDN circuits. This means that a single
X.25 circuit can respond to multiple IP addresses, each on a different
subnet, at the same time. This section leads you through the different
Configuration Manager screens that display when you configure
multiple IP interfaces on a single X.25 circuit. To configure multiple IP
address over X.25, perform the following steps:

1. From the X.25 Service Configuration Window (Figure 2-15), select
the Protocols»Add/Delete menu, as illustrated in Figure 2-17.
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[® X25 Service Configuration

Protocols
Add/Delete

T PO, Slot o, GOL Cotd o o 1 B | Done |

Enable | ENABLE |
Type [ DN |
Connection ID I t
Remote IP Address [ 192.32.4. 121 |
Remote X, 121 Address [ 1234 ;
Broadcast IOFF }

Figure 2-17. Selecting the Protocols Add/Delete Function on the X.25 Service
Configuration Window

When you select the Add/Delete function, the Select Protocols window
appears (Figure 2-18).
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Select Protocols

Protocols

mIp

O RIP
EGP

BGP
OSPF
BOOTP
IGMP

DVMRP

OCoocococoo

0sI

Cancel

|+

Figure 2-18. Select Protocols Window

2. On the Select Protocols Window, select the IP option and click OK.
The IP Configuration Window appears (Figure 2-19).

IP CONFIGURATION

L]

Configuration Mode: local
SNMP Agent: LOCAL FILE

IP Address
Subnet Mask

Transmit Bcast Addr

Details...
[192.32.4. 1310 }
[0.0.0.0 |
[0.0.0.0 |

Figure 2-19. IP Configuration Window
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3. Specify the local IP Address, Subnet Mask, and Transmit Bcast
Addr parameters, as follows:

Parameter: IP Address
Default: None
Options:  Any valid IP address
Function: Assigns a 32-bit IP address to the interface.

Instructions:  Enter the IP address of the interface in dotted
decimal notation.

MIB Object ID:  1.3.6.1.4.1.18.3.5.3.2.1.4.1.4

Parameter: Subnet Mask
Default: None

Options:  The Configuration Manager automatically
calculates an appropriate subnet mask,
depending on the class of the network to which the
interface connects. However, you can change the
subnet mask with this parameter.

Function:  Specifies the network and subnetwork portion of
the 32-bit IP address.

Instructions:  Either accept the assigned subnet mask, or enter
another subnet mask in dotted decimal notation.

MIB Object ID:  1.3.6.1.4.1.18.3.5.3.2.1.4.1.6
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Parameter: Transmit Bcast Addr
Default: 0.0.0.0
Options:  0.0.0.0 or any valid IP broadcast address

Function: Specifies the broadcast address that this IP
subnet uses to broadcast packets.

Accepting 0.0.0.0 for this parameter specifies that
the IP router will use a broadcast address with a
host portion of all 1s. Accepting 0.0.0.0 does not
configure the router to use the address 0.0.0.0 to
broadcast packets. For example, if you have IP
address 123.1.1.1 and a subnet mask of
255.255.255.0, accepting the default value 0.0.0.0
configures the IP router to use the address
123.1.1.255 to broadcast packets.

To set the explicit broadcast address of all 1s,
enter 255.255.255.255 for this parameter.

Instructions:  Accept the default, 0.0.0.0, unless the calculated
broadcast address (host portion) of all 1s is not
adequate. If this is the case, then enter the
appropriate IP broadcast address in dotted
decimal notation.

MIB Object ID:  1.3.6.1.4.1.18.3.5.3.2.1.4.1.8

4. When you are finished specifying the parameters on this screen,
click OK to display the Enter Adjacent Host window (Figure 2-20).

5. Specify the IP address of the adjacent host.
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ENTER ADJACENT HOST
Configuration Mode: local
SNYP Agent: LOCAL FILE
IP Address [152.32.4. 1210 i[a

Figure 2-20. Enter Adjacent Host Window

Parameter: IP Address
Default: None

Options:  The remote IP address displayed on the X.25
Service Configuration window (Figure 2-17).

Function:  Assigns a 32-bit IP address to the interface.

Instructions:  Enter the IP address of the interface in dotted
decimal notation.

MIB Object ID:  1.3.6.1.4.1.18.3.5.3.2.1.4.1.4

6. Click OK to return to the X.25 Service Configuration window
(Figure 2-21).

7. Select the Protocols->Edit IP->Interfaces menu to display the IP
Interfaces window (Fiigure 2-22).
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8] K75 Service Configuration i

Erotocolsl

Add/Delete |

Biit P b|Global... — A
Interfaces.
Static Routes.
= _Update
Adjacent Hosts...
NetBIOS. . b
Traffic Filters... v

Enable | ENaBLE |

Type B |

Connection ID I }

Remote IP Address [192.52.4. 121 |

Renote X, 121 Address 1234 |

Broadcast IDE'F I

Figure 2-21. Selecting the Protocols->Edit IP->Interfaces Menu
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[® IP Interfaces

IIIIIHE

M 1 M

:

L]

Delete
fpply
Values, .,
v Help
 S— >
Enble | ENABLE |
Subnet Mask [ 255, 255. 255, 0 H
Broadcast Address IO. 0.0.0 |
Interface Cost [1 ;
MIU Discovery |0FF %
fddr Mask Reply [orF |

Figure 2-22. IP Interfaces Window

8. From the IP Interfaces window, click on the Add button to configure
additional IP interfaces on the X.25 circuit. The IP Configuration

window appears (Figure 2-23).

Note: For information on the parameters appearing in the IP
Interfaces window, refer to Customizing IP Services.
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[® 1P CONFIGURATION
Configuration Mode: local
SNMP Agent: LOCAL FILE
TP Address [192.32.5. 131 2
Configure RIP [ VES J |
Configure OSPF s 1 il

Figure 2-23. IP Configuration Window When Adding an IP Interface to an X.25
Circuit

9. Specify information for the local IP Address, Configure RIP, and
Configure OSPF parameters, as follows:

Parameter: IP Address
Default: None
Options:  Any valid IP address
Function:  Assigns a 32-bit IP address to the interface.

Instructions:  Enter the IP address of the interface in dotted
decimal notation.

MIB Object ID:  1.3.6.1.4.1.18.3.5.3.2.1.4.1.4
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Parameter: Configure RIP
Default: None
Options:  Yes | No

Function: Specifies whether the Routing Information
Protocol is to be configured on this interface.

Instructions:  Click on Values and specify Yes or No.
MIB Object ID:  None

Parameter: Configure OSPF
Default: None
Options:  Yes | No

Function:  Specifies whether the Open Shortest Path First
(OSPF) protocol is to be configured on this
interface.

Instructions:  Click on Values and specify Yes or No.
MIB Object ID: None

For detailed information on RIP and OSPF, refer to the section in this
chapter “Enabling Bridging/Routing Services.”

10. When you have specified the parameters in the IP Configuration
window, click on OK. The Enter Adjacent Host window appears
(Figure 2-20). Specify the IP address for the remote host, as
previously described. If you need to specify additional IP interfaces
on the X.25 circuit, click on the Add button in the IP Interfaces
window (Figure 2-22) and continue adding IP interfaces until you
are finished.
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Enabling Bridging/Routing Services

Once a circuit is configured, the Configuration Manager displays the
Select Protocols window (Figure 2-24) from which you select the
bridging/routing protocols you want to run over that circuit. The
window differs slightly according to circuit type, displaying only those
protocols that the circuit type supports. In addition, for certain circuit
types, the window allows you to select the protocol priority feature
(refer to Configuring Filter Options on Wellfleet Routers for instructions
for configuring protocol prioritization).

[® Select Protocols

Protocols

(JBridge

0  Spanning Tree
arp

RIP

EGP

BGP

OSPF

Reverse ARP
BOOTP

Router Disc.

Cancel

Figure 2-24. Select Protocols Window

ooooooaad

To enable bridging/routing services, complete the following steps:

1. Select all bridging/routing protocols that you want to enable on the
circuit.

2. Click on the OK button.
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If you select Spanning Tree, the Configuration Manager automatically
enables the Bridge protocol because Spanning Tree is a Bridging
service. (Note that Spanning Tree is indented beneath the line
containing Bridge.) Similarly, if you select RIP, EGP, OSPF, BGP,
RARP, or BOOTP, the Configuration Manager automatically enables
IP because these are all IP services. If you select RIP (IPX) or RIP
(XNS), IPX or XNS is enabled automatically.

Note: When you choose protocols for a Frame Relay circuit, the
protocols you select only apply to PVCs configured for group
access mode, the default access mode for Frame Relay PVCs. If
you want to select protocols for Frame Relay PVCs in direct or
hybrid access mode, Site Manager prompts you for these
protocols when you add PVCs to your Frame Relay interface. Do
not configure protocols for these access modes when you
initially configure a Frame Relay circuit.

For each protocol you select, the Configuration Manager generally
displays a protocol-specific configuration window prompting for
additional required information. Some protocols (for example, the
Bridge, VINES, and NetBIOS) require no additional information to
provide default service. In such cases, no pop-up window is displayed.

For each protocol-specific pop-up window that the Configuration
Manager displays, you must specify the required configuration
information. You then have the option of accepting default values for
the remaining parameters needed to enable that protocol on the
circuit, or editing these default settings. This guide only provides
instructions for accepting default values. If you want to edit the
defaults, refer to the appropriate protocol-specific guide for
instructions.

To accept default values, click on the OK button in each pop-up window
after specifying the required information. The Configuration Manager
then displays the pop-up window for the next protocol enabled on the
circuit.
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The following sections describe how to define all routing and bridging
protocols for a circuit. Refer to them as necessary to specify the
protocol-specific parameters displayed in each pop-up window. Once
you have defined all protocols enabled on the circuit, the Configuration
Manager returns to the Wellfleet Configuration Manager window and
highlights the connector box to indicate that the interface has been
added.

Enabling Bridging Service

If you enabled the Bridge on the circuit, but did not enable the
Spanning Tree algorithm, you need not specify any configuration
information. Either the protocol pop-up window for the next enabled
protocol appears, or, if only the Bridge is enabled on this circuit, the
Wellfleet Configuration Manager window appears.

If you want to edit Bridge parameter defaults, refer to Customizing
Bridging Services for instructions.

Enabling Spanning Tree Service

You enable Spanning Tree service from the Spanning Tree
Autoconfiguration window (Figure 2-25). Refer to the parameter
descriptions in this section to specify the parameters and then click on
the OK button. At this point, a pop-up window will prompt Do you
want to edit the Spanning Tree Interface Details? Either click
on the Cancel button to enable default Spanning Tree service and to
display the next protocol-specific pop-up window, or click on the OK
button to edit the default values. (Refer to Customizing Bridging
Services for instructions.)

Note: Because the Spanning Tree is global (that is, it runs across all
Bridge circuits), the Configuration Manager only displays the
Spanning Tree Autoconfiguration window the first time you
specify Spanning Tree for the Bridge. After that, you never
again specify global Spanning Tree configuration information.
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[® Spanning Tree Autoconflguration

Configuration Mode: local

SNYP Agent: LOCAL FILE
Help. ..

Enable | ENaBLE |

Bridge Priority I 16 }

Bridge MAC Address [ 0000420000018 |

Max Age @00 f

Hello Time [ 200 |

Forward Delay [ 1500 |

Figure 2-25. Spanning Tree Autoconfiguration Window

Parameter: Bridge Priority
Default: None
Range: 0 to 65535

Function: In conjunction with the Bridge MAC Address
parameter, assigns a 64-bit bridge ID to the
router. This parameter supplies the most
significant 16 bits of the bridge ID, while Bridge
MAC Address supplies the remaining (least
significant) 48 bits.

The bridge ID is used by the Spanning Tree in the
selection of the root bridge. In selecting the root
bridge, the Spanning Tree chooses the bridge with
the lowest-number bridge ID. Thus, the lower the
value you set for this parameter, the more likely
that the router will be selected as the root bridge.

Instructions: Enter a decimal value from 0 to 65535.
MIB Object ID: 1.3.6.1.4.1.18.3.5.1.2.1.5
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Parameter: Bridge MAC Address
Default: None
Options:  Any valid 48-bit MAC-level address

Function: In conjunction with the Bridge Priority
parameter, assigns a 64-bit bridge ID to the
router. Bridge Priority supplies the most
significant 16 bits of the bridge ID, while this
parameter supplies the remaining (least
significant) 48 bits.

The bridge ID is used by the Spanning Tree in the
selection of the root bridge. In selecting the root
bridge, the Spanning Tree chooses the bridge with
the lowest number bridge ID. Thus, the lower the
setting of Bridge Priority, the more likely that the
router will be selected as the root bridge. In the
event of equal Bridge Priority values, the value of
this parameter determines the bridge’s priority.

Instructions:  Enter a 48-bit MAC address expressed as a
12-digit hexadecimal value. We recommend that
you set this parameter to the MAC address of one
of the router’s Spanning Tree ports, preferably the
one with the lowest priority.

MIB Object ID:  1.3.6.1.4.1.18.3.5.1.2.1.5

Enabling Internet Protocol Services

You enable Internet Protocol services from the IP Configuration
window (Figure 2-26). Refer to the parameter descriptions in this
section to specify the parameters. When you have specified all
parameters in the window, you can either click on the OK button to
enable default IP services and to display the next protocol-specific pop-
up window, or click on the Details button to edit the default values.
(Refer to Customizing IP Services for instructions.)
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[@] TP CONFIGURATION
Configuration Mode: local
SNMP Agent: LOCAL FILE

IP Address [192.32.4,44 |

Subnet Mask IO. 0.0.0 {
Transmit Bcast ddr IW. 0.0.0 E

Figure 2-26. IP Configuration Window

Parameter: IP Address
Default: None
Options:  Any valid IP address
Function: Assigns a 32-bit IP address to the interface.

Instructions:  Enter the IP address of the interface in dotted
decimal notation.

MIB Object ID:  1.3.6.1.4.1.18.3.5.3.2.1.4.1.4
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Parameter:
Default:
Options:

Function:
Instructions:

MIB Object ID:

Subnet Mask
None

The Configuration Manager automatically
calculates an appropriate subnet mask,
depending on the class of the network to which the
interface connects. However, you can change the
subnet mask with this parameter.

Specifies the network and subnetwork portion of
the 32-bit IP address.

Either accept the assigned subnet mask, or enter
another subnet mask in dotted decimal notation.

1.3.6.1.4.1.18.3.5.3.2.1.4.1.6
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Transmit Bcast Addr
0.0.0.0
0.0.0.0 or any valid IP broadcast address

Specifies the broadcast address that this IP
subnet uses to broadcast packets.

Accepting 0.0.0.0 for this parameter specifies that
the IP router will use a broadcast address with a
host portion of all 1s. Accepting 0.0.0.0 does not
configure the router to use the address 0.0.0.0 to
broadcast packets. For example, if you have IP
address 123.1.1.1 and a subnet mask of
255.255.255.0, accepting the default value 0.0.0.0
configures the IP router to use the address
123.1.1.255 to broadcast packets.

To set the explicit broadcast address of all 1s,
enter 255.255.255.255 for this parameter.

-Accept the default, 0.0.0.0, unless the calculated

broadcast address (host portion) of all 1s is not
adequate. If this is the case, then enter the
appropriate IP broadcast address in dotted
decimal notation.

1.3.6.1.4.1.18.3.5.3.2.1.4.1.8

Note: If you chose RIP, EGP, BGP, OSPF, RARP, or BOOTP at the
Select Protocols window, the Wellfleet Configuration Manager
enables the selected protocol.
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Enabling Open Shortest Path First Service

If you enabled OPSF on the interface, the Configuration Manager
displays the Initial OSPF Global Configuration window (Figure 2-27)
when you exit the IP Configuration window.

Refer to the parameter descriptions in this section to specify the
parameters for this window. When you have specified the parameters,
click on the OK button to enable default OSPF services and to display
the OSPF Area Address for Interface window (Figure 2-30). If you want
to edit the default values, refer to Customizing IP Services for

instructions.

[® Initial OSPF Global Configuration

Configuration Mode: local
SNMP Agent: LOCAL FILE

Enable

Router Id

A4S Boundary Router
Hold Down Timer
OSPF Slot

8se Metric Support
Backup Enable
Primary Log Mask
Backup Log Mask

[BuBLE ey
[192.32.44.3 |
[0 |
[ |
[ o001 1
[ DISaBLE 1
[ EneBLE |
| 0x00000FF }
[ 0x00000000 | b

Figure 2-27. Initial OSPF Global Configuration Window
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Parameter:
Default:

Options:

Function:

Instructions:

MIB Object ID:

Router ID

The IP address of the first OSPF circuit
configured on this router

Any IP address, preferably one of the router’s IP
interface addresses

This IP address uniquely identifies this router in
the OSPF domain. By convention, and to ensure
uniqueness, one of the router’s IP interface
addresses should be used as the router ID.

The router ID will determine the designated
router on a broadcast link if the priority values of
the routers being considered are equal. The higher
the router ID, the greater its priority.

Enter the appropriate IP address in dotted
decimal notation. See note below.

1.3.6.1.4.1.18.3.5.3.2.3.1.4

Note: If both OSPF and BGP are running on the router, then the
setting of the OSPF Router ID must be identical to the setting

of the BGP Identifier.
Parameter: AS Boundary Router
Default: No
Options:  Yes|No
Function: Indicates whether or not this router functions as

Instructions:

an AS boundary router. The router can be an AS
boundary router if one or more of its interfaces is
connected to a non-OSPF network (for example,
RIP or EGP).

Set this parameter to Yes if this router functions
as an AS boundary router. Otherwise, accept the
default value, No.
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Note:

MIB Object ID:

Parameter:
Default:
Range:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

1.3.6.1.4.1.18.3.5.3.2.3.1.7

Hold Down Timer
1
0 to 10 seconds

Prevents the algorithm from running more than
once per the value of Hold Down Timer. Its
purpose is to free up the CPU. Note that a value of
0 means there is no hold-down time.

Either accept the default value of 1 second, or
enter a new value.

1.3.6.1.4.1.18.3.5.3.2.3.1.9

OSPF Slot
All slots
Any slot on the Wellfleet router

Indicates which slot(s) OSPF is eligible to run on.
If the slot on which OSPF is running goes down,
the Wellfleet router will attempt to run OSPF on
another slot you specify with this parameter.

Select all of the appropriate slots.
1.3.6.1.4.1.18.3.5.3.2.3.1.10

Use caution when selecting the slot(s) on which OSPF may run.

If you choose an empty slot, and it is the only slot you choose,
OSPF will not run; if you choose a slot that becomes disabled,
and it is the only slot you choose, OSPF will not restart.

2-59



Enabling Bridging/Routing Services

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Ase Metric Support
Disabled
Enabled | Disabled

Specifies whether the new ASE metric support is
enabled. The new metric is not compatible with
the pre-Version 8.00 ASE metrics. Set this
parameter to Disabled if the router is to
interoperate with routers running a pre-8.00
OSPF version.

Select Enabled if the router is to use the new
metric support.

Select Disabled if the router is not to use the new
metric support.

1.3.6.1.4.1.18.3.5.3.2.3.1.11

Backup Enable
Enabled
Enabled | Disabled

Enables or disables the backup OSPF soloist’s
backup link state database. When you set this
parameter to Disabled, the OSPF backup soloist
does not maintain a copy of the OSPF link state
database.

Select Enabled to maintain a copy of the OSPF
link state database.

Select Disabled if you do not wish to maintain a
copy of the OSPF link state database.

1.3.6.1.4.1.18.3.56.3.2.3.1.12
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Primary Log Mask
All options enabled

Trace messages

INFO level messages

Debug level messages

OSPF interface state change messages

Nbr state changes

Self-origination of LSAs

Receipt of new LSAs

Changes to OSPF’s routing table

Bad LS requests, Acks, or updates

Receipt of less recent LSAs

Receipt of more recent self-originated LSAs
Receipt of MaxAge LSAs (i.e., LSAs being flushed)

Specifies which OSPF log messages should be
logged in the primary log.

Highlight the line entry for Primary Log Mask in
the Initial OSPF Global Configuration window
and click on the Values button. The Primary Log
Mask window will appear (Figure 2-28). Choose
the log messages that you wish to enter into the
primary log by clicking on their buttons. Then
click on OK to return to the Initial OSPF Global
Configuration window.

1.3.6.1.4.1.18.3.5.3.2.3.1.13
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[®] Values

Primary Log Mask

M TRACE B
& INFO

W DEBUG

W STATE

W ER STATE

W LS4 SELF-ORTGIN
W LS4 RECEIPT

I ROUTE CHANGE

M BAD LS
W LESS RECENT LSA

POk | iCancel]

Figure 2-28. OSPF Primary Log Mask Window
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Backup Log Mask
All options disabled

Trace messages

INFO level messages

Debug level messages

OSPF interface state change messages

Nbr state changes

Self-origination of LSAs

Receipt of new LSAs

Changes to OSPF’s routing table

Bad LS requests, Acks, or updates

Receipt of less recent LSAs

Receipt of more recent self-originated LSAs
Receipt of MaxAge LSAs (i.e., LSAs being flushed)

Specifies which OSPF log messages the router
logs in the backup log.

Highlight the line entry for Backup Log Mask in
the Initial OSPF Global Configuration window
and click on the Values button. The Backup Log
Mask window will appear (Figure 2-29). Choose
the log messages that you want to enter into the
backup log by clicking on their buttons. Then click
on OK to return to the Initial OSPF Global
Configuration window.

1.3.6.1.4.1.18.3.,5.3.2.3.1.14
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[®] Values
Backup Log Mask

{1 TRACE R
0 INFO

{1 DEBUG

{1 STATE

CINER STATE

{1184 SELF-ORIGIN
{1184 RECEIPT

£ ROUTE CHANGE

0Bab LS
{1 LESS RECENT LSA | 1%

Figure 2-29. OSPF Backup Log Mask Window

When you click on the OK button on the Initial OSPF Global
Configuration window (Figure 2-27), the Area Address for Interface
window (Figure 2-30) appears. Refer to the parameter descriptions in
this section to specify the parameters for this window. When you have
specified the parameters in each window, click on the OK button to
display the next protocol-specific pop-up window.

[® Area Address for Interface 192,32, 140, 22

Configuration Mode: local
SNMP Agent: LOCAL FILE Values. ..
Help...

gg
—

1> ]

firea Address [80.0.0 §

Figure 2-30. Area Address for Interface Window
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Parameter: Area Address
Default: None
Options:  Any 4-octet number in dotted decimal notation

Function: Identifies the OSPF area to which this interface
belongs.

Instructions:  Enter the appropriate area ID in dotted decimal
notation.

MIB Object ID:  1.3.6.1.4.1.18.3.5.3.2.3.2.14
Note: The backbone area ID is always 0.0.0.0.

Enabling Exterior Gateway Protocol Service

If you enabled EGP on the interface, the Configuration Manager
displays the EGP Configuration window (Figure 2-31) when you exit
the IP Configuration window. Refer to the parameter descriptions in
this section to specify the parameters.

When you have specified all parameters in the window, click on the OK
button to enable default EGP services and to display the next protocol-
specific pop-up window. If you want to edit the default values, refer to
Customizing IP Services for instructions.
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[®] EGP CONFIGURATION

§ Cancel |

Configuration Mode: local

SNYP Agent: LOCAL FILE
Local Autonomous System ID (decimal) |1 |
Remote Peer IP Address l192. 32.7. 238 }
Gateway Mode [ CoRE |

Figure 2-31. EGP Configuration Window

Parameter: Local Autonomous System ID

Default: None
Range: 1 to 65535

Function: Identifies the local autonomous system (the AS to
which this router belongs) by the decimal number
assigned by the Network Information Center
(NIC). There is no default for this parameter. Its
value will be the AS number that you supplied
when you first added EGP to this circuit.

Instructions:  Enter a value from 1 to 65535.

MIB Object ID:  1.3.6.1.4.1.18.3.5.3.2.4.1.7
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Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Remote Peer IP Address
None

Any IP address

Specifies the IP address of the interface that will
form an EGP neighbor relationship with this
router.

Enter the IP address in dotted decimal notation.
1.3.6.1.4.1.18.3.5.3.2.4.3.1.5

Gateway Mode
Core
Core | Non Core

Specifies the gateway mode for this EGP
neighbor. If you choose Core, the default, the local
AS to which this EGP neighbor belongs will act as
a transit AS. That is, it will advertise networks
that reside within the AS as well as external
networks.

If you choose Non Core, the AS to which this EGP
neighbor belongs will act as a stub AS. That is, it
will only advertise networks that reside within
the AS.

Set this parameter to either Core or Non Core,
depending on how you want this EGP neighbor to
function.

1.3.6.1.4.1.18.3.5.3.2.4.3.1.6
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Enabling Border Gateway Protocol Services

If you enabled BGP on the interface, the Configuration Manager
displays the BGP Configuration window (Figure 2-32) when you exit
the IP Configuration window. Refer to the parameter descriptions in
this section to specify the parameters. If you want to edit the default
values or find information about BGP-3 or BGP-4, refer to Customizing
IP Services for instructions.

[®) BGP CONFIGURATION

Configuration Mode: local
SNMP Agent: LOCAL FILE
Help,
Identifier [o2.32.4.6 |
Local 45 [1 |

Figure 2-32. BGP Configuration Window

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Identifier
None

An IP address of one of the IP interfaces on this
router

Identifies the BGP router. There is no default for
this parameter; however, the address of some
valid interface is displayed. You must use the IP
address of one of the router’s IP interfaces.

Either accept the current BGP identifier, or enter
a new IP address. Remember, the BGP identifier
must be one of the router’s IP interfaces.

1.3.6.1.4.1.18.3.5.3.2.5.1.1.4
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Note: If both OSPF and BGP are running on the router, then the
OSPF router ID must be identical to the BGP identifier.

Parameter:
Default:
Range:

Function:

Instructions:
MIB Object ID:

Local AS
None
1 to 65535

Identifies the autonomous system to which this
BGP router belongs.

Enter a value from 1 to 65535.
1.3.6.1.4.1.18.3.5.3.2.5.1.1.5

When you have specified all parameters in the window, click on the OK
button. The BGP Peer window appears (Figure 2-33). Refer to the
parameter descriptions in this section to specify the BGP peer. When
you are finished, click on the OK button to enable default BGP services
and to display the next protocol-specific pop-up window. If you want to
edit the default values, refer to Customizing IP Services for

instructions.
[® BGP PEER

Configuration Mode: local

SNYP Agent: LOCAL FILE
Help. ..

Peer Address |192. 32, 4422 }

Peer 45 [4 |

Local Address [192.82.4.6 |

Figure 2-33. BGP Peer Window
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Parameter:

Default:
Options:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Range:

Function:
Instructions:
MIB Object ID:
Parameter:
Default:

Options:

Function:
Instructions:

MIB Object ID:

Peer Address
None
Any IP address

Specifies the IP address of the interface on the
remote side of this BGP peer connection.

Enter the IP address of the BGP peer in dotted

~ decimal notation. If the peer is in a remote AS, the

address must be on the same subnet as the local
interface.

1.3.6.1.4.1.18.3.5.3.2.5.1.2.1.6

Peer AS
None
1 to 65535

Identifies the autonomous system to which the
BGP router at the remote end of this BGP
connection belongs.

Enter the appropriate autonomous system
number.

1.3.6.1.4.1.18.3.5.3.2.5.1.2.1.10

Local Address
None
Any IP address

Specifies the IP address of the interface on the
local side of this BGP peer connection.

Enter the appropriate IP address in dotted
decimal notation.

1.3.6.1.4.1.18.3.6.3.2.5.1.2.1.4
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Enabling NetBIOS

If you selected the NetBIOS option on the circuit, you need not specify
any NetBIOS-specific configuration information. In cases where you
are configuring IP and NetBIOS for the first time on a circuit, the IP
Configuration window (Figure 2-26) appears where you specify the IP-
specific parameters; IP Address, Subnet Mask, and Transmit Bcast
Addr. If you want to edit NetBIOS parameters, refer to Customizing IP
Services for instructions.

Enabling IGMP and DVRMP

If you enabled IGMP and DVRMP on the interface, the Configuration
Manager displays the Initial IGMP Global Configuration window
(Figure 2-34) and the Initial DVRMP Base Parameters window (Figure
2-35) when you exit the IP Configuration window. Refer to the
parameter descriptions in this section to specify the parameters. If you
want to edit the default values or find information about IGMP and
DVRMP, refer to Customizing IP Services for instructions.

IGMP Global Configuration Parameters

Figure 2-34 illustrates the Initial IGMP Global Configuration window.
A description of the parameters displayed in this window follows.
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[@® Initial IGMP Global Configuration
Configuration Mode: local
SNMP Agent: LOCAL FILE
Enable | ENABLE |
Estimated Groups |20 i

Figure 2-34. Initial IGMP Global Configuration Window

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Enable

Enabled

Enabled | Disabled

Enables or disables this IGMP record.

If you have configured IGMP on this router, use
this parameter to disable it.

1.3.6.1.4.1.18.3.5.3.13.1.2
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

DVMRP Base Parameters

Estimated Groups
20 groups
5 to 65535 groups

Specifies the estimated number of groups that be
used through this router.

Determine the approximate number of groups and
enter the value. This is to allow the router to
utilize memory efficiently; exceeding this size
during an operation will not cause an error but
may cause the router to consume more memory
than is required.

1.3.6.1.4.1.18.3.5.3.13.1.4

Figure 2-35 illustrates the Initial IGMP Global Configuration window.
A description of the parameters displayed in this window follows.
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[® Initial Dvmrp Base Paramters

Configuration Mode: local
SNMP Agent: LOCAL FILE

Enable

Full Update Rate
Triggered Update Rate
Leaf Timeout

Neighbor Timeout

Route Expiration Timeout
Garbage Timeout

Estimated Routes

{ BuBLE |
[60 |
B 5
[ 200 |
[ 140 |
[ 200 |
[340 |
B |

Figure 2-35. Initial DVRMP Base Parameters Window

Parameter: Enable
Default: Enabled
Options:  Enabled | Disabled
Function: Enables and disables DVMRP support on the
router.
Instructions:
the router, specify Disabled.
MIB Object ID: 1.3.6.1.4.1.18.3.5.3.12.1.2

To disable DVMRP once you have configured it on
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Parameter:
Default:
Options:

Function:
Instructions:
MIB Object ID:
Parameter:
Default:

Options:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Full Update Rate
60 seconds
10 to 2048 seconds

Specifies, in seconds, how often routing messages
containing complete routing tables are sent.

Determine the full update rate you require and
specify a value.

1.3.6.1.4.1.18.3.5.3.12.1.4

Triggered Update Rate
5 seconds
2 or more seconds

Specifies, in seconds, the minimum amount of
time between triggered updates.

Triggered updates are sent in the period between
full updates. Issuing a full update starts the
triggered update timer. Therefore, the triggered
update rate you specify must be shorter than the
full update rate you have specified with the Full
Update rate parameter.

1.3.6.1.4.1.18.3.5.3.12.1.5

Leaf Timeout
200 seconds
25 to 4096 seconds

Specifies, in seconds, a value for the virtual hold
down timer.

Determine the virtual hold down timer interval
you require and specify a value.

1.3.6.1.4.1.18.3.5.3.12.1.6
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Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:
Parameter:
Default:

Options:

Function:

Instructions:

MIB Object ID:

Neighbor Timeout
140 seconds
40 to 8192 seconds

Specifies, in seconds, how long a connection with
a router neighbor is considered active without
confirmation (that is, without receiving a probe or
a report from the neighbor).

Determine a neighbor timeout period and specify
a value.

1.3.6.1.4.1.18.3.5.3.12.1.7

Route Expiration Timeout
200 seconds
20 to 4096 seconds

Specifies, in seconds, how long a route is
considered valid without confirmation.

Enter a value that represents the duration of time
this route will be used before confirmation is
required.

1.3.6.1.4.1.18.3.5.3.12.1.8
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Garbage Timeout
340 seconds
40 to 8192 seconds

Specifies, in seconds, the duration of time that
this route will be included in routing tables before
confirmation is required.

Enter a Garbage Timeout value that is greater
than the value you specified for Route Expiration
Timeout.

1.3.6.1.4.1.18.3.5.3.12.1.9

Estimated Routes

25 routes

An integer of 10 or greater

Specifies the estimated number of routes per slot.

Enter a value that the router can use for pre-
allocating routing tables. Note that routes are
kept on a per-source network basis, independent
of multicast groups. This number must include a
route for every local area network that has a CCT
configured for multicasting. This is to allow the
router to utilize memory efficiently; exceeding this
size during operation will not cause an error but
may cause the router to consume more memory
than is required.

1.3.6.1.4.1.18.3.5.3.12.1.10
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Enabling DECnet Phase IV Services

You enable DECnet Phase IV services from the DECnet Phase IV
Configuration window (Figure 2-36). Refer to the parameter
descriptions in this section to specify the parameters. When you have
specified all parameters in the window, you can either click on the OK
button to enable default DECnet Phase IV services and to display the
next protocol-specific pop-up window, or click on the Details button to
edit the default values; refer to Customizing DECnet Services for

instructions.

[®] DECNET IV CONFIGURATION

Configuration Mode: local
SNMP Agent: LOCAL FILE

Area ID
Node ID

Figure 2-36. DECnet Phase IV Configuration Window
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Parameter:
Default:
Range:

Function:

Instructions:
MIB Object ID:

Parameter:
Default:
Range:

Function:

Instructions:
MIB Object ID:

Area ID
None
1 to 63

Specifies a unique DECnet Phase IV Area ID for
this circuit.

The area ID is the first six bits of a DECnet Phase
IV node address. You specify the area ID on a
circuit-by-circuit basis; that is, a single router can
have individual circuits residing in different
areas.

Enter the area ID assigned to this circuit.
1.3.6.1.4.1.18.3.5.2.3.1.1

Node ID
None
1 to 1023

Specifies a unique intra-area DECnet Phase IV
node ID for this circuit.

The node ID is the last 10 bits of a DECnet Phase
IV node address.

Note that if individual circuits on a router reside
in different areas, then each circuit can have a
different node address.

Enter the node ID assigned to the router.
1.3.6.1.4.1.18.3.5.2.3.1.2
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Enabling VINES Services

If you enabled VINES on the circuit, and the line type of that circuit is
anything except synchronous, you need not specify any configuration
information in order to enable default VINES service. Click on the
Cancel button in the pop-up window that prompts Do you want to
edit the VINES interface details?

If, however, you enabled VINES support on a synchronous line, you
must specify the clocking source for the synchronous line (internal or
external).

Refer to Chapter 3, “Customizing Line Services,” for instructions on
setting this parameter.

If you want to edit the default values, click on the OK button and refer
to Customizing VINES Services for instructions.

Enabling AppleTalk Services

If you enable AppleTalk routing services on an interface, the AppleTalk
Interface Configuration window appears (Figure 2-37).
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[@ AppleTalk Interface Configuration SN L

R Done
u
R e T ——
Enable a
Network Start
Network End
Default Zone
Network ID
Node ID M

Figure 2-37. AppleTalk Interface Configuration Window

Specify whether this interface functions as a seed router or a nonseed
router. A seed router supplies the Network Start, Network End,

Default Zone, and Zone List information for all other nonseed routers
on this network. Each network must contain at least one seed router.

A nonseed router acquires its Network Start, Network End, Default
Zone, and Zone List information from the other seed routers on the
network.

o To configure a seed router interface, specify the Network Start,
Network End, and Default Zone and Zone List (if multiple zones
are to be configured on this interface), as described below, then
click on the Apply button, followed by the Done button.

o To configure a nonseed router interface, simply accept all of the
default parameters and click on the Done button.
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For information on customizing AppleTalk routing services, see
Customizing AppleTalk Services.

Parameter: Network Start
Default: 0
Range: 0 to 65279

Function:  Specifies the lower boundary (minimum) of the
range of network numbers available for use by
nodes on the network to which this interface
connects.

This parameter’s setting determines whether this
interface functions as a seed or nonseed router.

Instructions:  To configure this interface as a nonseed router,
accept the default, 0.

To configure this interface as a seed router,
specify this parameter as follows:

— If this is the only seed router on the network,
determine the network range for this
interface, and enter the lower boundary
network number.

— If there are already seed routers on the
network, enter the same Network Start value
that is configured on all other seed routers.

MIB Object ID:  1.3.6.1.4.1.18.3.5.4.3.1.13

Note: If you specify a Network Start other than the default, 0,
then 1) the router automatically becomes a seed router
and 2) you must also specify values for the Network End and
Default Zone parameters.
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Parameter:
Default:
Range:

Function:

Instructions:

MIB Object ID:

Network End
0
0 to 65279

Specifies the upper boundary (maximum) of the
range of network numbers available for use by
nodes on the network to which this interface
connects.

You use this parameter in conjunction with the
Network Start parameter to help define a seed
router. If you have not specified a Network Start
for this interface, this parameter is ignored.

If this interface is configured as a nonseed router,
then accept the default, 0.

If this interface is configured as a seed router,
then specify the Network End as follows:

— If this is the only seed router on the network,
determine the network range for this
interface, and enter the upper boundary
network number.

— If there are already seed routers on the
network, enter the same Network End value
that is configured on all other seed routers.

1.3.6.1.4.1.18.3.5.4.3.1.14
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Default Zone
None
Any valid zone name

Specifies the name of the default zone to which all
new nodes are assigned when they first start up
on this network.

This parameter is used in conjunction with the
Network Start and Network End parameters to
help define a seed router. If you have not specified
a Network Start for this interface, this parameter
is ignored.

If this interface is configured as a nonseed router,
then simply leave this field blank.

If this interface is configured as a seed router,
then specify the Default Zone as follows:

— If this is the only seed router on the network,
enter any valid Default Zone name.

— If there are already seed routers on the
network, enter the same Default Zone name
as is configured on all other seed routers.

A valid zone name can consist of up to a maximum
of 32 characters and can include any character
(except the asterisk [*] character). See the
instructions below for using nonprintable
characters in the Default Zone name.

1.3.6.1.4.1.18.3.5.4.3.1.15
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Configuring the Zone List

To configure a Zone List, you must add zone(s) to the list. Complete the

following steps:

1. Click on the Zone List button in the AppleTalk Interface
Configuration window (Figure 2-37).

The AppleTalk Zone Configuration window appears
(Figure 2-38).

[®] AT Zone Configuration
I [ [ Do ]
i
o— ]
Zone Nane | }

Figure 2-38. AppleTalk Zone Configuration Window

2. Click on the Add button.
The Add AppleTalk Zone window appears (Figure 2-39).
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[@] AppleTalk Zone Configuration
Configuration Mode: local
SNMP Agent: LOCAL FILE
Zone Name |2ndfloorl {

Figure 2-39. Add AppleTalk Zone Window

3. Enter a name for the zone in the Zone Name box and click on the
OK button.

You are returned to the AppleTalk Zone Configuration window.

4. Either repeat Steps 2 and 3 for each zone you want to add, or click
on the Done button to exit the window.

Note: The default zone should not appear in the Zone List.

Using Nonprintable Characters in AppleTalk Zone Names

Using nonprintable characters in AppleTalk zone names requires some
additional steps. Enter nonprintable characters into the Default Zone
parameter or Zone Name parameter as follows:

1. Access the Configuration Manager tool in local or remote mode.

Note: You canrot enter nonprintable characters if you are using
dynamic configuration mode.
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2. Type \xx, where xx represents the two hexadecimal-digit
representation of each nonprintable character as shown in the
character set mapping used in AppleTalk. (Refer to the Character
Set Mapping table in Inside AppleTalk, Second Edition, copyright
1990, Apple Computer, Inc., Cupertino, CA 95014.) The router
counts the \xx as a single character.

Type two backslashes (\\) to indicate a literal backslash. The router
counts \\ as a single character.

Select Apply.
Save the configuration.

5. Transfer the configuration file to the router, using the Router Files
Manager tool if the Configuration Manager is in local configuration
mode.

6. Reboot the router with the new configuration file.

t '

Warning Nonprintable characters in these parameters appear as
different characters when you transfer the file to the router
and re-open it using the Configuration Manager. SNMP

translates the characters when transferring the
configuration to Site Manager.

To edit Default Zone or Zone List parameters where you previously
saved nonprintable characters, overtype the zone name and retype the
nonprintable characters, following the six steps in this section.
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Configuring AURP

Before configuring AURP on a router, you must configure AppleTalk on
at least one of the router’s circuits. Once you have configured at least
one AppleTalk interface, you can use AURP to create a wide area link
between two or more AppleTalk networks.

To configure AURP global parameters, begin at the Wellfleet
Configuration Manager window and proceed as follows:

1. Select the Protocols->AppleTalk-»>AURP->Global option.
The Edit AURP Global Parameters window appears (Figure 2-40).
2. Set the Enable parameter to Enable.

3. Enter the appropriate IP address (using dotted decimal notation) in
the Local IP Address field.

Click on the OK button to exit the window and save your changes when
you are finished.

[® Edit Apple AURP Global Parameters 80 0

Configuration Mode: dynamic
SNMP Agent: 192,32, 14,39

Enable

Local IP Address |205. LL2 {

Figure 2-40. Edit AURP Global Parameters Window
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Options:

Function:
Instructions:

MIB Object ID:

Enable

Enable

Enable | Disable

Enables or disables AURP on the router.
Set to Enable to globally enable AURP.
1.3.6.1.4.1.18.3.5.4.8.2

Local IP Address
None

Any valid 32-bit IP address in dotted decimal
notation

Identifies an IP interface on the router. This is the
IP interface used for AURP.

Enter the IP address of the interface on this
router that AURP should use.

1.3.6.1.4.1.18.3.5.4.8.5

To configure the AURP connection, enter the IP address for the remote
peer from the AppleTalk AURP Interface Configuration window. To
configure this parameter, begin at the Wellfleet Configuration Manager
window and proceed as follows:

1. Select the Protocols->AppleTalk»>AURP->Interfaces option to
display the AT AURP Interface Configuration window

(Figure 2-41).
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EI_AT-AFRP Interface Configuration
T |
n
Enable |ENABLE
Timeout Command 13
Command Retries 13 B
Update Rate [30 ]
Last Heard From Timeout [90 |
Hop Count Reduction |DISABLE ]

Figure 2-41. AT AURP Interface Configuration Window

2. Click on the Add button.
The AppleTalk AURP Configuration window appears (Figure 2-42).

@ AppleTalk AURP Configuration
Configuration Mode: local
SNMP Agent: LOCAL FILE
Remote AURP IP Address [ Il:|

Figure 2-42. AppleTalk AURP Configuration Window

3. Enter the appropriate IP address in the Remote AURP IP Address
field and click on OK.
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The AT AURP Interface Configuration window reappears.

4. Repeat Steps 2 and 3 to add additional remote peers to the AURP
connection.

5. Click on the Done button to exit the window.

For information on customizing AURP service or configuring AURP
zone filter lists, refer to Customizing AppleTalk Services.

Parameter: Remote AURP IP Address
Default: None
Options:  Any valid 32-bit IP address

Function: Identifies the peer’s IP address for the AURP
connection.

Instructions:  Enter an IP address using dotted decimal
notation.

MIB Object ID:  1.3.6.1.4.1.18.3.5.4.9.1.14

Enabling Source Routing Services

If you enabled source routing on the circuit, but did not enable the SR
Spanning Tree or Translate/LB algorithms, you enable source routing
from the Source Routing Global Parameters window (Figure 2-43) and
the Source Routing Interface Parameters window (Figure 2-44).

Refer to the parameter descriptions in this section to specify the source
routing bridge internal LAN ID and the source routing bridge ID on
the Source Routing Global Parameters window.
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Note: Because source routing is global (that is it runs across all the
Bridge circuits), the Configuration Manager only displays the
Source Routing Global Parameters window the first time you
specify source routing for the bridge. If you have previously
specified source routing for this bridge, this window will not
appear.

[®] Source Routing Global Parameters

Configuration Mode: local
SNMP Agent: LOCAL FILE

Enable | ENGBLE {

SR Bridge Internal LAN ID [ 0x22 j

SR Bridge ID [ox1q |

SR Bridge Group LAN ID | oxtEf |

IP Encapsulation |DISABLE } _

Con, IP NTWK Ring number [ 0x0 B

IP MIU Size (bytes) [4862 |

NetBIOS Server Name Cache D1saBLE |

NetBIOS Client Name Cache | DISARLE ;

NetBIOS Datagram RIF Cache |DISABLE % -

Figure 2-43. Source Routing Global Parameters Window
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Parameter:
Default:
Range:
Function:

Instructions:

MIB Object ID:

Note:

SR Bridge Internal LAN ID

0x0

0x1 to OxOfff

Specifies this bridge’s internal LAN ID.

Assign an internal LAN ID that is unique among
all other internal LAN IDs, group LAN IDs, and
ring IDs in the network.

1.3.6.1.4.1.18.3.,5.1.1.2.1.4

You cannot use the value 0x0 that appears initially in the SR

Bridge Internal LAN ID parameter box. You must specify a
value for this parameter that is within the given range.

Parameter:
Default:
Range:

Function:

Instructions:

MIB Object ID:

SR Bridge ID
0x0
0x1 to 0x0f

Specifies this bridge’s bridge ID and identifies the
Wellfleet source routing bridges in the network.

Assign the same bridge ID to all Wellfleet source
routing bridges in the network (unless two bridges
operate in parallel; see note below). The bridge ID
must be unique among any other non-Wellfleet
bridge IDs in the network.

1.3.6.1.4.1.18.3.5.1.1.2.1.5
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Note: You cannot use the value 0x0 that appears initially in the SR
Bridge ID parameter box. You must specify a value for this
parameter that is within the given range.

If two Wellfleet source routing bridges operate in parallel, then
you must assign a different bridge ID to one of the bridges. You
must also specify the bridge ID in the Bridge Entry list for all
other Wellfleet source routing bridges in the network. (See
Customizing Bridging Services for more information.)

[®] Edit SR Interface: 031
Configuration Mode: local
SNMP Agent: LOCAL FILE
Enable [ ENeBLE | n
Max number of RDs [7 |
Source Routing Ring Number [0x5l f
Outbound STEs | aCCEPT |
Inbound STEs [ accepT |
Frames With IP Ring [ ACCEPT |
TP Address [0.0.0.0 |
NetBIOS Server Name Cache | ENABLE |
NetBIOS Client Name Cache | ENGBLE |
NetBI0S Datagran Cache [EaBLE ke

Figure 2-44. Source Routing Interface Parameters Window
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After you specify the required parameters in the Source Routing
Global Parameters window, the Source Routing Interface Parameters
window appears. Refer to the parameter description in this section to
specify the source routing ring number. You also can edit source
routing interface defaults from this window. If you do want to edit
these default values, refer to Customizing Bridging Services for
instructions. Otherwise, click on the OK button.

Parameter: Source Routing Ring Number
Default: 0x0
Range: 0 to OxOfff

Function: Identifies the ring number (ring ID) of this source
routing circuit.

Instructions:  Assign a ring number (ring ID) to this source
routing circuit that is unique among any other
ring IDs, group LAN IDs, or internal LAN IDs in
the network.

MIB Object ID:  1.3.6.1.4.1.18.3.5.1.1.2.2.1.6

Note: You cannot use the value 0x0 that appears initially in the
Source Routing Ring Number parameter box. You must specify
a value for this parameter that is within the given range.

Enabling Source Routing Spanning Tree Service

When you select the Spanning Tree option that is directly under the
Source Routing option, you will automatically enable source routing.
This Spanning Tree protocol cannot run without source routing
enabled.

If you have not yet enabled source routing on any circuit, the first
window to appear is the Source Routing Global Parameters window
(Figure 2-43). If you have enabled source routing on some other circuit,
the first window to appear will be the Source Routing Interface
Parameters window (Figure 2-44).
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Refer to “Enabling Source Routing Services” earlier in this chapter to
configure the necessary source routing parameters.

After you configure the interface parameters and click on OK in the
Source Routing Interface Parameters window, the Source Routing
Spanning Tree Autoconfiguration window (Figure 2-45) appears. Refer
to the parameter descriptions in this section to specify the Bridge
Priority and Bridge MAC Address parameters and then click on the
OK button. At this point, a pop-up window will prompt bo you want
to edit the Source Route Spanning Tree Interface Details?
Either click on the Cancel button to enable default Spanning Tree
service and to display the next protocol-specific pop-up window, or click
on the OK button to edit the default values. (Refer to Customizing
Bridging Services for instructions.)

While these parameters have the same names and functions as for
Spanning Tree service under bridging, they need to be set
independently for Spanning Tree service under source routing.

[ @7 Source Route Spanning Tree Autoconfiguration

Configuration Mode: local 0K
SNMP Agent: LOCAL FILE [ Values... |

Spanning Tree Enable |BNABLE |
Spanning Tree Protocol Version 1EEE8021D
Bridge Priority 0
Bridge MAC Address 0000 |
Max Age 2000 ]
Hello Time ) 200 |
Forward Delay 1500 |

Figure 2-45. Source Routing Spanning Tree Autoconfiguration Window
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Note: Because the Spanning Tree is global (that is, it runs across all
Source Routing circuits), the Configuration Manager only
displays the Spanning Tree Autoconfiguration window the first
time you specify Spanning Tree for source routing. After that,
you never again specify global spanning tree configuration
information. If you have previously specified Spanning Tree for
source routing, this window will not appear.

Parameter:
Default:
Range:
Function:

Instructions:
MIB Object ID:

Bridge Priority
None
0 to 65535

In conjunction with the Bridge MAC Address
parameter, assigns a 64-bit bridge ID to the
router. This parameter supplies the most
significant 16 bits of the bridge ID, while Bridge
MAC Address supplies the remaining (least
significant) 48 bits.

The Spanning Tree uses the bridge ID to select the
root bridge. In selecting the root bridge, the
Spanning Tree chooses the bridge with the lowest-
number bridge ID. Thus, the lower the value of
this parameter, the more likely that the router
will be selected as the root bridge.

Enter a decimal value from 0 to 65535.
1.3.6.1.4.1.18.3.5.1.1.2.1.33
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Parameter: Bridge MAC Address
Default: None
Options:  Any valid 48-bit MAC-level address

Function: In conjunction with the Bridge Priority
parameter, assigns a 64-bit bridge ID to the
router. Bridge Priority supplies the most
significant 16 bits of the bridge ID, while this
parameter supplies the remaining (least
significant) 48 bits.

The Spanning Tree uses the bridge ID to select the
root bridge. In selecting the root bridge, the
Spanning Tree chooses the bridge with the lowest-
number bridge ID. Thus, the lower the value of
Bridge Priority, the more likely that the router
will be selected as the root bridge. In the event of
equal bridge priority values, the Bridge MAC
Address value determines the bridge’s priority.

Instructions:  Enter a 48-bit MAC address expressed as a
12-digit hexadecimal value. You should set this
parameter to the MAC address of one of the
router’s Spanning Tree ports, preferably the one
with the lowest priority.

MIB Object ID:  1.3.6.1.4.1.18.3.5.1.1.2.1.33

Enabling Source Routing Translate/LB Service

When you select the Translate/LB option that is directly under the
Source Routing option, you will automatically enable source routing.
The Translate/Learning Bridge protocol cannot run without source
routing enabled.

If you have not yet enabled source routing on any circuit, the first
window to appear is the Source Routing Global Parameters window
(Figure 2-43). If you have enabled source routing on some other circuit,
the first window to appear will be the Source Routing Interface
Parameters window (Figure 2-44).

2-98



Adding Network Interfaces

Refer to “Enabling Source Routing Services” earlier in this chapter to
configure the necessary source routing parameters.

Enabling Source Routing Translate/LB Spanning Tree Service

When you select the Span Tree option that is directly under the
Translate/LB option, you will automatically enable source routing and
translate/LB. This Spanning Tree protocol cannot run without source
routing and translate/learning bridge enabled.

If you enabled the Source Routing Translate/LB Spanning Tree service
on the circuit, the Spanning Tree Autoconfiguration window

(Figure 2-25) appears. Refer to the section “Enabling Spanning Tree
Service” earlier in this chapter for instructions on setting these
parameters.

Note: Because the Spanning Tree is global (that is, it runs across all
Bridge circuits), the Configuration Manager only displays the
Spanning Tree Autoconfiguration window the first time you
specify Spanning Tree for the bridge. If you have previously
specified Spanning Tree for this bridge, this window will not
appear.

After you have set the bridge parameters, set the source routing
parameters. Refer to “Enabling Source Routing Services” earlier in this
chapter to configure these parameters. Refer to Figures 2-43 and 2-44
for examples of the windows.
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Enabling OSI Services

You enable OSI services from the OSI Configuration window

(Figure 2-46). Refer to the parameter description in this section to
specify the router ID. When you are finished, click on the OK button. A
pop-up window appears, prompting Do you want to edit the OSI
interface details? click on the Cancel button to enable default OSI
services and to display the next protocol-specific pop-up window, or
click on the OK button to edit the default values. Refer to Customizing

OSI Services for instructions.

[®] 05T CONFIGURATION
Configuration Mode: local
SNYP Agent: LOCAL FILE
Router ID (hex) [ 000812345678 |
Area Address (hex) 490040 [N

Figure 2-46. OSI Configuration Window
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Router ID
Variable

Any valid system ID. The router ID must be
exactly 6 bytes.

Identifies the router within its local area.

The system ID is the ID portion of the router’s
NSAP address. (See Customizing OSI Services for
more information.)

You specify a router ID only the first time you
configure an OSI interface. Site Manager uses this
router ID for any additional OSI interfaces you
configure. Enter a system ID in hexadecimal
format. The router ID must be exactly 6 bytes.

Note the following guidelines:

— Every router in a domain must have a unique
system ID. Using a router’s MAC address for
its system ID ensures this.

— If this router is located in an area that also
supports DECnet Phase IV End Systems,
then the system ID must be within the
DECnet Phase IV legal range (that is, Ox1 to
0x3ff hexadecimal).

1.3.6.1.4.1.18.3.5.6.1.6
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Parameter: Area Address
Default: None
Options:  Any valid OSI address in hexadecimal notation

Function: Identifies the OSI area to which this interface
belongs.

Instructions:  Enter the appropriate area ID in hexadecimal
notation.

MIB Object ID:  1.3.6.1.4.1.18.3.5.6.1.16

Creating an NML Port

To create a Native Mode LAN port, use the following procedure:

1

Select the circuit to which you want to add the NML protocol.

Depending on the configuration of the circuit, the WAN Protocols
window may or may not appear (Figure 2-4). If it appears, click on
the OK button.

The Select Protocols window appears (Figure 2-24).

Select the Native Mode LAN protocol. Site Manager automatically
selects the Bridge protocol.

Click on the OK button. The Configuration Manager displays a
pop-up window with the message Do you want to edit the NML
interface details?

Click on the OK button. The Configuration Manager displays the
Edit NML Interface window (Fiigure 2-47).
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[@] Edit NML Interface: E22

Configuration Mode: local
SNMP Agent: LOCAL FILE

Disable [ BuBLED T

Add Security Header |ADD_SECURITY ;

SAID Type { INDIVIDUAL |

SATD Value [o |

CUG Yalue [0 |

Security List Action | FORWARD L

Figure 2-47. Edit NML Interface Window

6. For instructions on editing NML parameters and assigning an
access list to a port, refer to Customizing Bridging Services.

Enabling IPX Services

You enable IPX services from the IPX Configuration window

(Figure 2-48). Refer to the parameter descriptions in this section to
specify the parameters. When you have specified all parameters in the
window, you can either click on the OK button to enable default IPX
services and to display the next protocol-specific pop-up window, or
click on the Details button to edit the default values. Refer to
Customizing IPX Services for instructions.
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[®] TPX CONFIGURATION

Configuration Mode: local
SNMP Agent: LOCAL FILE
Network Address (hex) |OOIDO418I I
Configure RIP [ vES |
Configured Encaps |ETHERNET f

Figure 2-48. IPX Configuration Window

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Network Address (hex)

None

Any valid IPX network address

Assigns an IPX address to the interface.

Enter the IPX address of the interface in
hexadecimal notation.

If you are configuring an IPX interface that will
either implement IPX WAN or run over PPP, then
you must enter a zero for this parameter.

If you are attempting to establish a connection to
a Series 5 Wellfleet router, or a router that does
not implement IPXWAN or PPP, then you must
enter a non-zero network address (for example,
the network address of the link).

1.3.6.1.4.1.18.3.5.5.4.1.6
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Note: You can change the value of the Network Address parameter as
long as the IPX Configuration window remains in the
workstation display. However, once you save the contents of this
window, the Network Address parameter appears only in the
list of IPX interfaces in the IPX option configuration screens.
You cannot edit the Network Address parameter in any option
configuration screen. To change the network address of a
specific IPX interface, you must delete the interface from its
circuit, then add the interface again to the same circuit, this
time specifying the desired (changed) network address.

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Configure RIP
Depends on whether you have RIP configured
Yes | No

Indicates whether you have RIP configured on
that interface.

The Wellfleet Configuration Manager sets the
default value for this parameter based on your
selection in the Select Protocols window. You can,
however, change the value of this parameter as
long as the IPX Configuration window remains in
the workstation display.

99999.6.2
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Configured Encaps
None (media dependent)
Ethernet | LSAP | Novell | SNAP | PPP

Specifies the encapsulation methods available for
each link layer type (for example, Ethernet or
Token Ring).

Select the encapsulation method you need to use.
Ensure that the encapsulation method matches
that of the clients and servers on the same
network.

1.3.6.1.4.1.18.3.5.5.4.1.9

If you are configuring IPX on a circuit using the PPP or the Frame
Relay WAN protocols, the IPX Configuration window displays the
IPXWAN Enable parameter. To edit this parameter, the Network
Address parameter must be set to 0.

Parameter:
Default:
Options:

Function:
Instructions:

MIB Object ID:

IPXWAN Enable
Disable
Enable/Disable

Enables or disables IPXWAN on a PPP or a Frame
Relay IPX circuit.

Set the Network Address parameter to 0, click on
Values and select Enable or Disable.

1.3.6.1.4.1.18.3.5.5.4.1.32
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Enabling XNS Services

You enable XNS services from the XNS Configuration window

(Figure 2-49). Refer to the parameter descriptions in this section to
specify the parameters. When you have specified all parameters in the
window, you click on the OK button to enable default XNS services and
to display the next protocol-specific pop-up window. If you want to edit
the default values, refer to Customizing XNS Services for instructions.

[® X6 CONFIGURATION
Configuration Mode: local
SNYP Agent: LOCAL FILE
Network Address [ 00100419 |
Base Host Number [721908D26C210 |
Configure RIP |YES %
Inplementation | XEROX §

Figure 2-49. XNS Configuration Window

Parameter: Network Address (hex)
Default: None
Options:  Any valid XNS network address
Function:  Assigns an XNS address to the interface.

Instructions:  Enter the XNS address of the interface in
hexadecimal notation.

MIB Object ID:  1.3.6.1.4.1.18.3.5.10.3.1.6
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Parameter:
Default:

Options:

Function:

Instructions:

MIB Object ID:

Base Host Number

The Configuration Manager automatically
generates a unique 6-byte host number from the
Wellfleet router’s serial number if you do not
enter a value. (The automatically generated
number is not displayed.)

Any host number

Sets a host ID and source MAC address for all
slots. By means of this parameter, XNS interfaces

configured on any slot in the node share the same
host ID and source MAC address.

Do not enter a number in this box if you want the
Configuration Manager to generate a host
number automatically or if the interface is on a
Token Ring circuit and you are setting the Token
Ring Mac Address Select parameter to Boxwide.

Enter the MAC address in hexadecimal notation
only if the interface is on a Token Ring circuit and
you are setting the Token Ring MAC Address
Select parameter to Cnfg. Refer to the section
“Configuring a MAC Address on a Token Ring
Interface” in Customizing XNS Services for more
information about this parameter.

1.3.6.1.4.1.18.3.5.10.1.4

Note: Ifyou already have XNS configured on the router, this field does

not appear.
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Note:

Parameter:

Default:
Options:

Function:

Instructions:

MIB Object ID:

Configure RIP
Depends on whether you have RIP configured
Yes|No

Indicates whether you have RIP configured on
that interface.

The Wellfleet Configuration Manager sets the
default value for the Configure RIP parameter
based on your selection in the Select Protocols
window. You can, however, change the value of
this parameter as long as the XNS Configuration
window remains in the workstation display.

99999.7.3

If you already have XNS configured on the router, this field does
not appear.

Implementation
Xerox
Xerox

Specifies the version of XNS you want to add to
this circuit. At this time, your only option is Xerox.

Accept the default value.
1.3.6.1.4.1.18.3.5.10.1.6
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Note: You can change the value of the Network Address, Base Host
Number, and Implementation parameters as long as the XN'S
Configuration window remains in the workstation display.
However, once you save the contents of this window, these
parameters appear only in the list of XN'S interfaces in the XN'S
option configuration screens. You cannot edit the Network
Address parameter in any option configuration screen. To
change the network address of a specific XNS interface, you
must delete the interface from its circuit, then add the interface
again to the same circuit, this time specifying the desired
(changed) network address.

Enabling DLSw Services

You select DLSw on the Select Protocols window (Figure 2-24). (See
“Enabling Bridging/Routing Services” earlier in this chapter.) From
this starting point, the steps you take to enable DLSw services depend
on whether you are enabling it for the first or a subsequent time and
whether you are enabling it on Token Ring/802.5 (or other) or on
Ethernet/802.3 or Frame Relay.

Figure 2-50 illustrates the steps for configuring DLSw for Token Ring
(or other) networks. Figure 2-51 illustrates the steps for configuring
DLSw for Ethernet/802.3 or Frame Relay.
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Begin Configuration

Are you defining the first DLSw interface on the router?

Yes No (subsequent DLSw interface)

Select a circuit:
Token Ring/802.5 or other
(except Ethernet/802.3 or
Frame Relay)

Configure source routing
global parameters

Configure source routing
interface parameters

Configure DLSw
global parameters

Define DLSw slots

Define DLSw peeEI

[ Define DLSw SAP addresses .

Site Manager automatically Site Manager automatically
enables global TCP services enables a DLSw interface
if not already enabled. on the selected circuit.

(End of mandatory configuration steps)

Key:

—_— Configuration path for the first DLSw interface on the router.

i Configuration path for the second and subsequent DLSw interface on the router.
Figure 2-50. DLSw Configuration Sequence for Token Ring/802.5 or Other

(Except Ethernet)
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Begin Configuration
Are you defining the first DLSw interface on the router?
Yes No (subsequent DLSw interface)
Select a circuit:
Ethernet/802.3 or
Frame Relay
Configure DLSw
global parameters
Configure source routing Yes Use source route Yes Configure source routing
global parameters encapsulation? interface parameters
No No
Configure source routing Enter Frame Relay
interface parameters mapping information
Define DLSw slots
Define DLSw peers
Define DLSw SAP addresses
Site Manager automatically Site Manager automatically
enables global TCP services enables a DLSw interface
if not already enabled. on the selected circuit.
(End of mandatory configuration steps)
Key:
—_— Configuration path for the first DLSw interface on the router.
e e

Figure 2-51. DLSw Configuration Sequence for Ethernet/802.3 or Frame Relay

Configuration path for the second and subsequent DLSw interface on the router.
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DLSw and Other Protocols

DLSw works in conjunction with other protocols, including

a

IP

You must configure the IP addresses of the slots and network
access points assigned to DLSw. You can do this either before or
after you follow the DLSw procedure. See “Enabling Internet
Protocol Services” earlier in this chapter for instructions on adding
IP addresses.

TCP

The initial configuration of DLSw automatically enables global
TCP services if they are not already enabled.

Source Routing Bridge

When you add DLSw to a Token Ring circuit, source routing is also
added. You add Source Routing Global Parameters and you edit the
Source Routing Interface window as noted in the following sections.

LLC2
LLC2 is automatically added when you add DLSw to a circuit.
SDLC

If you specified SDLC from the WAN Protocols window (Figure 2-4),
Site Manager prompts you to add a client protocol, either DLSw or
APPN.

DLSw Initial Configuration

In the initial configuration of DLSw, you use Site Manager windows to

a

Set the DLSw global parameters (for Ethernet and Frame Relay
without source routing bridge [SRB] encapsulation).

Add Source Routing global Parameters (Token Ring or other, or if
you choose to use SRB encapsulation on Ethernet or Frame Relay).

Enter Frame Relay mapping information (Ethernet and Frame
Relay without SRB encapsulation).
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o Set slot IP addresses.
o Add peer IP addresses.

o Add service access points (SAPs).

Setting the DLSw Global Parameters

Enter a value for the IP Virtual Ring parameter in the DLSw Global
Parameters window (Figure 2-52).

[® DLSw Global Parameters

Configuration Mode: local
SNMP Agent: LOCAL FILE

Enable BNABLE

TCP Window Size 16000

IP Virtual Ring 0

Max Slot Sessions 200

Virtual Ring MIU 2052

Mac Cache Age |300

NetBios Cache Age l300

Reject Unconfigured Peers ACCEPT

Keepalive Time (sec) 0 % "

Figure 2-52. DLSw Global Parameters Window
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Parameter:
Default:
Range:

Function:

Instructions:

MIB Object ID:

IP Virtual Ring
None
1 to 4095

Use this parameter to specify a virtual ring
number for the TCP/IP network cloud.

Enter any valid ring number. The number should
match the ring number chosen by other DLSw
peers on the same network cloud. Make sure that
the number is unique among any other Ring IDs,
Group LAN IDs, or Internal LAN IDs assigned in
the network.

1.3.6.1.4.1.18.3.,5.1.5.1.5

When finished, click on the OK button to enable the DLSw global

parameters.

- Specifying Source Routing Bridge Encapsulation

The Source Routing Encapsulation dialog box (Figure 2-53) allow you
to specify the type of encapsulation formats to be used on Ethernet/
802.3 and Frame Relay interfaces running DLSw. Select Cancel if your
are configuring standard LLC over Ethernet, or if you are configuring
Frame Relay using the RFC 1490 Routing Standard. Click on OK if
you want to configure Wellfleet proprietary SRB over Ethernet or
Frame Relay using the RFC 1490 Bridging Standard.

[@ Site Manager 7]

Use Source Route Encapsulation?

OK

Cancel

Figure 2-53. Source Route Encapsulation Dialog Box
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Adding Source Routing Parameters

When you add DLSw to a Token Ring circuit, you first set the Source
Routing global parameters. If you have not yet enabled source routing
on any circuit, the first window to appear is the Source Routing Global
Parameters window (Figure 2-43). If you have enabled source routing
on some other circuit, the first window to appear will be the Source
Routing Interface Parameters window (Figure 2-44).

Refer to “Enabling Source Routing Services” earlier in this chapter to
configure the necessary Source Routing parameters.

The Ethernet configuration does not require the source routing steps.

Mapping Frame Relay Addresses

If you are configuring Ethernet or Frame Relay without SRB, the
Frame Relay Mappings window appears (Figure 2-54).

L]

LLCZ Frame Relay Mappings

[ RET

| Delete

Apply
Yalues, ..

Help. ..

Remote MAC I i Eb
Local MAC | >

Figure 2-54. Frame Relay Mappings Window
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Select Add. The LLC2 Frame Relay Mapping Add window appears

(Figure 2-55).

@ LLC2 Frame Relay Mapping Add ET)

DLCI
Remote MAC
Local MaC

Cancel

Configuration Mode: local OK
SMMYP Agent: LOCAL FILE Yalues. ..

Help...

Figure 2-55. LLC2 Frame Relay Mapping Add Window

Specify the DLCI, Remote MAC and Local MAC parameters, as

follows:

Parameter:
Default:
Range:

Function:

Instructions:

MIB Object ID:

DLCI
None

Standard Data Link Connection Identifier
numbers

This parameter provides the number of the
virtual circuit to which the local or remote MAC
address will be mapped.

Enter a decimal DLCI number assigned by your
system administrator or Frame Relay provider.

1.3.6.1.4.1.18.3.5.1.6.9.1.3
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Parameter: Remote MAC
Default: None
Range: Standard MSB Token Ring MAC addresses

Function:  This parameter provides the remote MAC
address, mapping outgoing requests specifying it
to the DLCI value. The Remote MAC address
must be unique, with only DLCI mapping for a
specific MAC address.

Instructions:  If you need to specify the real hardware address of
the host, enter it as an octal string.

MIB Object ID:  1.3.6.1.4.1.18.3.5.1.6.9.1.5

Parameter: Local MAC
Default: None
Range: Standard MSB Token Ring MAC addresses

Function: This parameter provides the local MAC address,
mapping incoming requests on this DLCI to that
address. The Local MAC address must be unique,
with only DLCI mapping for a specific MAC
address.

Instructions:  If the incoming connections are valid, enter the
MAC address of the recipient.

MIB Object ID:  1.3.6.1.4.1.18.3.5.1.6.9.1.4

After specifying the DLCI, Remote MAC, and Local MAC parameters,
click on OK. The Configuration Manager returns to the Frame Relay
Mappings window showing the selected circuit.
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Adding Slot IP Addresses

The DLSw Slot Configuration window (Figure 2-56) displays a list of
the slot IP addresses you have added.

(@ DLSw Slot Configuration
I [ Do |
-]
Cm—
IP Address for TCP Connection | }[B

Figure 2-56. DLSw Slot Configuration Window

Click on the Add button to add a slot IP address. The second DLSw Slot
Configuration window appears (Figure 2-57).

@ DLSw Slot Configuration
Configuration Mode: local
SNMP Agent: LOCAL FILE
Stot [4 | Iﬂ
IP Address 192.32.6. 100 |

Figure 2-57. Add Slot IP Address Window

Enter the appropriate slot value and its IP address. Use the following
parameter descriptions for guidelines.
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Parameter:
Default:
Range:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

Slot
None
1to 14

Specifies the slot number associated with the
Token Ring or Ethernet interface over which
DLSw is running.

Enter a slot number that is valid for running
DLSw, considering the model of router and the
slots that Link Modules can occupy. You should
only enter slots running DLSw.

1.3.6.1.4.1.18.3.5.1.5.3.1.2

IP Address
None

Any IP address specified in dotted decimal
notation

Specifies where the TCP connection for DLSw
terminates. If a circuitless IP address is
configured, use that address for this parameter. If
not, use a unique IP address that exists on the
router for each slot running DLSw. The address
cannot be reused on another slot.

Enter the appropriate IP address.
1.3.6.1.4.1.18.3.5.1.5.3.1.3

Click on the OK button when you are finished.

You are returned to the DLSw Slot Configuration window. Repeat the
instructions in this section for each slot you want to add.

Click on the Done button when you are finished adding slots.
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Adding DLSw Peer IP Addresses

The DLSw Peer Configuration window (Figure 2-58) displays a list of
the peer IP addresses you have added.

[® DLSw Peer Configuration
|
—

Figure 2-58. DLSw Peer Configuration Window

Click on the Add button to add a peer IP address to the DLSw Peer
Configuration window (Figure 2-59).

[@ DLSw Peer Configuration
Configuration Mode: local
SNMP Agent: LOCAL FILE
Peer IP Address [192.32.8.110 Ii:]

Figure 2-59. Add Peer IP Address Window

Enter the appropriate peer IP address. Use the parameter descriptions
as a guide.
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Peer IP Address
None

Any valid, 32-bit IP address of the form:
network.host (using dotted decimal notation)

Specifies the IP address of a remote DLSw peer.
Once added to the DLSw peer table, this address
defines a “configured peer” on the local router.
Configured peers receive all DLSw-related
broadcast frames for a given router or network
processor.

Enter the IP address at which the configured peer
will receive all DLSw-related broadcast frames.

1.3.6.1.4.1.18.3.5.1.5.5.1.3

Click on the OK button to accept the peer IP address and to display the
first DLSw Peer Configuration window. Add additional peers by
clicking on the Add button and repeating the procedure as many times

- as needed.

Click on the Done button in the DLSw Peer Configuration window
when you are finished adding peers.

Adding a Service Access Point (SAP)

The DLSw SAP Configuration window (Figure 2-60) displays SAP
configuration information and lists the SAP addresses that you have

configured.
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[®] DLSw SAP Configuration

Add
Delete
Apply
Values, ..
Help. ..

S8P Window

R | F Done
[~ ———— ]

.

Figure 2-60. DLSw SAP Configuration Window

Click on the Add button to add a Service Access Point. The second
DLSw SAP Configuration window appears (Figure 2-61).

|[® DLSw Sap Configuration

Configuration Mode: local

SAP

SNMP Agent: LOCAL FILE

[0x04

Figure 2-61. Add DLSw Service Access Point Window

Enter the appropriate SAP value, referring to the parameter
description that follows as a guide.
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Parameter: SAP
Default: None

Options:  Any valid SAP address (in hexadecimal, decimal
or octal format)

Function:  Specifies a Service Access Point that you want to
terminate locally, to establish end-to-end
communication between SNA and/or NetBIOS
endstations in your network.

The SAP entries for SNA are 0x04, 0x08, and
0x0c. The SAP entry for NetBIOS is 0xf0.

Instructions:  Enter the valid SAP address you want to
terminate with DLSw.

MIB Object ID:  1.3.6.1.4.1.18.3.5.1.5.4.1.2
Click on the OK button when you are finished.

You are i‘eturned to the DLSw SAP Configuration window. Repeat the
instructions in this section as needed.

Click on the Done button when you are finished adding SAPs.

The main Configuration Manager screen appears. You are now finished
with your initial installation of DLSw. If you have not already
configured the IP addresses of the slots and connection to the IP
network, add them now.

Subsequent DLSw Configuration

You select DLSw on the Protocol Selection window (see “Enabling
Bridging/Routing Services” earlier in this chapter). From this starting
point, enabling DLSw services follows a simpler procedure than the
initial configuration. Figure 2-50 and Figure 2-51 illustrate these
procedures.

Once you select DLSw on an Ethernet circuit, no further steps are
needed.
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When you select DLSw on a Token Ring circuit, the Source Routing
Edit Interface window appears. Refer to “Enabling Source Routing
Services” earlier in this chapter to configure the window (Figure 2-44).
Click on the OK button to accept the SR Edit Interface window.

The main Configuration Manager screen appears. You are now finished
with your initial installation of DLSw. If you have not already
configured the IP addresses of the slots and connection to the IP
network, add them now.

Enabling LNM Servers

If you enabled LNM servers on the circuit, you need not specify any
configuration information. The system software provides default LAN
Manager/LSS service. To change operating parameters of the default
service, refer to Customizing LNM Services.

Enabling LLC2 Services

If you enabled LL.C2 on the circuit, you need not specify any
configuration information. The system software provides default LL.C
(LLC1 and LLC2) services. To change operating parameters of the
default service, refer to Customizing LLC Services.

Enabling LLC2 Services over Native Frame Relay

If you are configuring and enabling Frame Relay on LLC2 media,
Configuration Manager displays a set of screens that allow you to start
LLC2 and related services such as APPN and DLSw. Perform the

following steps.

1. Select Frame Relay from the WAN Protocols menu and click on OK.
The Select Protocols menu appears (Figure 2-62).
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Select Protocols
Protocols
£1 AN
0 RIP(XNS)
{1 appleTalk

{1 Source Routing

1 SR Span Tree
{1 Protocol Priority
08I

M LLC2

I DLSw |
£1 4PPN

POk iCancel|

Figure 2-62. Select Protocols Menu Showing LLC2

2. Select APPN or DLSw or both. Selecting APPN or DLSw
automatically selects LLC2 as well. Click OK. The Source Route
Encapsulation dialog box appears (Figure 2-63).

[@ Site Manager

=]

Use Source Route Encapsulation?

OK

Cancel

Figure 2-63. Source Route Encapsulation Dialog Box

8. Select Cancel. This selects native (routed) Frame Relay for LLC2.
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4. Ifyou selected APPN on the Select Protocols window (Figure 2-62),
Configuration Manager displays the APPN Configuration window.
Specify the APPN local node name and click OK. (Refer to the
section “Enabling APPN over LLC2 Interfaces” for information.)

5. Specify the DLCI and SAP address for this interface. (Refer to the
section “Enabling APPN over LLC2 Interfaces” for information.)

6. When the Adjacent Link Station dialog box appears, click on
Cancel.
7. If you selected DLSw, the DLSw Global Parameters window

appears (Figure 2-52). Specify the IP Virtual Ring parameter and
click on OK. (Refer to “Enabling DLSw Services” for information.)

8. The Source Route Encapsulation dialog box appears (Figure 2-63).
Click on Cancel. The Frame Relay Mappings window appears
(Figure 2-61).

L]

LLC2 Frame Relay Mappings

. R

'

[+
| — ]
Remote MAC - I
Local MAC | 1"

Figure 2-64. Frame Relay Mappings Window
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9. Select Add. The LLC2 Frame Relay Mapping Add window appears

(Figure 2-65).
[@® LLC2 Frame Relay Mapping Add
Configuration Mode: local
SNYP Agent: LOCAL FILE
DLCI | IR
Remote MAC I ! ; j
Local MAC d

Figure 2-65. LLC2 Frame Relay Mapping Add Window

Specify the DLCI, Remote MAC, and Local MAC parameters, as
follows: '

Parameter: DLCI
Default: None

Range: Standard Data Link Connection Identifier
numbers.

Function: This parameter provides the number of the
virtual circuit to which the local or remote MAC
address will be mapped.

Instructions:  Enter a decimal DLCI number assigned by your
system administrator or Frame Relay provider.

MIB Object ID:  1.3.6.1.4.1.18.3.5.1.6.9.1.3
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Parameter:
Default:
Range:

Function:

Instructions:
MIB Object ID:
Parameter:
Default:

Range:

Function:

Instructions:

MIB Object ID:

Remote MAC
None
Standard MSB Token Ring MAC addresses

This parameter provides the remote MAC
address, mapping outgoing requests specifying it
to the DLCI value. The Remote MAC address
must be unique, with only DLCI mapping for a
specific MAC address.

If you need to specify the real hardware address of
the host, enter it as an octal string.

1.3.6.1.4.1.18.3.5.1.6.9.1.5

Local MAC
None
Standard MSB Token Ring MAC addresses

This parameter provides the local MAC address,
mapping incoming requests on this DLCI to that
address. The Local MAC address must be unique,
with only DLCI mapping for a specific MAC
address.

If the incoming connections are valid, enter the
MAC address of the recipient.

1.3.6.1.4.1.18.3.5.1.6.9.1.4

10. After specifying the DLCI, Remote MAC, and Local MAC
parameters, click on OK. Configuration Manager returns to the
Frame Relay Mappings window showing the selected circuit

(Figure 2-66).
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[® LLC2 Frame Relay Mappings
852, DLCT 101 B Do |

Ciwy ]

Remote MAC
Local MAC

Figure 2-66. LLC2 Frame Relay Mappings Window with DLCI Added

11. Select Apply.

12. If you have more mappings to do, repeat Steps 7 through 9.
Otherwise, select Done. You return to the series of layered
windows. '

13. Fill in any subsequent DLSw layered windows. Refer to the section
“Enabling DLSw Services” or “Enabling APPN Services” for
detailed information on these services. For each window, select
Done or OK as necessary.
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Enabling APPN Services

If you selected APPN for either an LLC2 or SDLC interface, you can
enable APPN services on your router in any one of the following ways:

o APPN on LLC2 media, including Ethernet, Token Ring, and Frame
Relay

o APPN on LLC2 using Source Routing Bridge (SRB) encapsulation
formats over Ethernet, FDDI, SMDS, Frame Relay, and Point-to-
Point (PPP)

o APPN on SDLC links in point-to-point and multipoint networks

Enabling APPN over LLC2 Interfaces

When you configure APPN on LLC2 interfaces, such as Ethernet and
Token Ring, the Wellfleet Configuration Manager requests Media
Access Control (MAC) and Service Access Point (SAP) addresses. On
synchronous interfaces where you are configuring APPN over Frame
Relay, Configuration Manager requests a Data Link Connection
Identifier (DLCI) address and a SAP address.

To enable APPN on Ethernet, Token Ring, or Wellfleet synchronous
interfaces using Frame Relay, perform the following steps:

1. Start at the Select Protocols window (Figure 2-67). Scroll down the
Select Protocols window and select the APPN option. Configuration
Manager automatically selects the LLC2 option.
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Select Protocols
Protocols
{1 AppleTalk

{1 Source Routing
1 SR Span Tree
{1  Translate/LB
08I

mLLC2

£ DLSw

W APPN

O Native Mode L&N

Cancel

Figure 2-67. Select Protocols Window

2. Click OK. The “Use Source Route Encapsulation?” dialog box
appears (Figure 2-68).

@ Site

Use Source Route Encapsulation?

% OK for YES
Cancel for NO

Cancel

Figure 2-68. Source Route Encapsulation Dialog Box
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3. Select Cancel if your are configuring standard LLC over Ethernet,
or if you are configuring Frame Relay using the RFC 1490 Routing
Standard. If you want to configure Wellfleet proprietary SRB over
Ethernet, or Frame Relay using the RFC 1490 Bridging Standard,
click on OK and refer to the next section, “Enabling APPN Over
LLC2 Interfaces Using SRB” for information on the additional
screens that appear. In this example, click Cancel. The APPN Local
Node Name Configuration window appears (Figure 2-69).

(@] APPN CONFIGURATION

Cancel

Configuration Mode: local 0K
SNMP Agent: LOCAL FILE Values, ..,
 Help...

Local Node Name (NETID, NAME) |

Figure 2-69. APPN Local Node Name Configuration Window

4. At the APPN Configuration window, specify the Local Node Name
parameter, as follows:
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Local Node Name
None

Any valid name with up to 17 characters in the
format <NETID.CPNAME>, where NETID is the
global network name with up to 8 characters
followed by a period, and CPNAME is the control
point name with up to 8 characters

The Local Node Name parameter identifies the
unique name of the network and the Wellfleet
router node name.

Enter the node name by first specifying up to 8
characters in the network ID name, type a period,
then enter a control point name withupto 8
characters. Names must be specified in uppercase
characters only and must start with a non-
numeric character. Blank spaces (leading,
trailing, and embedded) are not allowed in the
node name. For example,
NETWORKA.SYSTEMA is a valid entry for the
Local Node Name parameter.

1.3.6.14.1.18.3.5.14.1.1.4

5. Click OK to add the Local Node Name. The APPN Configuration
window appears (Figure 2-70).
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[@ APPN CONFIGURATION
Configuration Mode: local
SNMP Agent: LOCAL FILE
MAC Address (hex, msb) |
S8P (hex)

Figure 2-70. APPN Configuration Window
6. Specify the MAC Address and SAP parameters, as follows:

Parameter: MAC Address
Default: None

Options:  Any unique 48-bit 12-digit hexadecimal MAC-
level address

Function:  Specifies a unique MAC-level address for this port
connecting the adjacent link station

Instructions:  Enter a 12-digit hexadecimal MAC-level address
in most significant bit (MSB) non-canonical
format, regardless of the media.

MIB Object ID:  1.3.6.1.4.1.18.3.5.14.1.3.1.38
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Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

SAP (hex)
None

Any unique service access point (SAP) 2-digit
hexadecimal value, typically 04.

Specifies a service access point (SAP) address that
lets multiple applications and protocol entities in
a single computer share a MAC address

Enter a 2-digit hexadecimal value.
1.3.6.1.4.1.18.3.5.14.1.3.1.38

If you are configuring a Wellfleet synchronous interface (a connector
labeled COM# on the Wellfleet Configuration Manager window in
Figure 2-1) with the Frame Relay protocol, the APPN Configuration
Window displays the Data Link Connection Identifier (DLCI)
parameter instead of the MAC Address parameter. The DLCI is the
Frame Relay permanent virtual circuit (PVC) identification number.
The Frame Relay network uses the DLCI to direct basic data flow.
Specify the DLCI parameter as follows:

Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

DLCI

None

Valid range changes based on the Frame Relay
address length as follows:

Address Length Range

2 Byte 16-1007

3 Byte 1024-64511

4 Byte 131072-8257535

This number is the PVC identification number
that the Frame Relay network uses to direct data.

Enter a decimal number within the valid range.
1.3.6.1.4.1.18.3.5.14.1.3.1.38
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7. Click the OK button on the APPN Configuration Manager window.
The Adjacent Link Station dialog box appears (Figure 2-71).

[@ Site Manager

¢

Would you like to configure Adjacent Link Statlons on this port?

OK for YES
Cancel for NO

OK

Cancel

Figure 2-71. Adjacent Link Station Dialog Box

8. Ifyou wish to configure APPN adjacent link station parameters at
this time, refer to Customizing APPN Services. Otherwise, click the
Cancel button and proceed to Chapter 3 for information on
configuring APPN.

Enabling APPN over LL2 Interfaces using SRB

If you are configuring LL.C2 interfaces such as Ethernet, FDDI, SMDS,
Frame Relay, and Point-to-Point (PPP) and you want to use source
routing bridge (SRB) encapsulation formats, select the appropriate
connector and protocols as described in the previous section. For
Ethernet (Wellfleet proprietary SRB over Ethernet) and Frame Relay
(RFC1490 Bridging Standard), start at the Source Route
Encapsulation Dialog Box (Figure 2-72) and proceed as follows:
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[@® Site Manager §

Use Source Route Encapsulation?

OK for YES
Cancel for NO

Cancel

Figure 2-72. Source Route Encapsulation Dialog Box

1. Click the OK button. The Source Routing Global Parameters
window appears (Figure 2-73).

Source Routing Global Parameters

Configuration Mode: local
SNYP Agent: LOCAL FILE

Enable B -

SR Bridge Internal LAN ID w0 |

SR Bridge I [0x0 {

SR Bridge Group LAN ID  [oxeee ;

IP Encapsulation DIsaBLE |

Conn. IP NTWK Ring number | |

IP MIU Size (bytes) [4562 |

NetBIOS Server Neme Cache  DISABLE |

NetBIOS Client Name Cache DISABLE |

NetBIOS Datagram RIF Cache DIsaBLE '™

Figure 2-73. Source Routing Global Parameters Window
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2. Edit the parameters in the Source Routing Global Parameters
window. The SR Bridge Internal LAN ID and the SR Bridge ID are
mandatory parameters that you must specify before you can

proceed.

Parameter:
Default:
Range:
Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Range:

Function:

Instructions:

MIB Object ID:

SR Bridge Internal LAN ID

0x1

0x1 to OxOfff

Specifies this bridge’s internal LAN ID.

Assign an internal LAN ID that is unique among
all other internal LAN IDs and ring IDs in the
network.

1.3.6.1.4.1.18.3.5.1.1.2.1.4

SR Bridge ID
Ox1
0x1 to 0xO0f

Specifies this bridge’s bridge ID and identifies the
Wellfleet source routing bridges in the network.

Assign the same value to all Wellfleet source
routing bridges in the network (unless two bridges
operate in parallel; see the following note). The SR
bridge ID must be unique among any other third-
party bridge IDs in the network.

1.3.6.1.4.1.18.3.5.1.1.2.1.5

For details on how to configure the source routing parameters on this
window, refer to Customizing Bridging Services.

3. When you have specified the parameters on the Source Routing
Global Parameters window, click the OK button. The Edit SR
Interface window appears (Figure 2-74).
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Edit SR Interface: Eb2
Configuration Mode: local
SNP Agent: LOCAL FILE
Enable [@ueBLE ™
Max number of RDs |7 §
Source Routing Ring Number [ ox0 §
Outbound STEs [ accept |
Inbound STEs [ AccepT |
Frames With IP Ring [ accepT |
TP Address [o.0.0.0 |
NetBIOS Server Name Cache [ ENaBLE |
NetBIOS Client Name Cache | ENABLE |
NetBIOS Datagram Cache [ EveBLE |

Figure 2-74. Edit SR Interface Window

4. Edit the parameters in the Edit SR Interface window. The Source
Routing Ring Number is the only parameter that you must specify
before you can proceed.
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Parameter:
Default:
Range:
Function:

Instructions:

MIB Object ID:

For details on how to

Source Routing Ring Number
0x0
0x0 to 0xOfff

Identifies the ring number (ring ID) of this source
routing circuit.

Assign a ring number (ring ID) to this source
routing circuit that is unique among any other
ring IDs, group LAN IDs, or internal LAN IDs in
the network.

1.3.6.1.4.1.18.3.5.1.1.2.2.1.6

configure the source routing parameters on this

window, refer to Customizing Bridging Services.

5. When you have specified the parameters on the Edit SR Interface

window, click the

OK button. The APPN Virtual Ring Number

window appears (Figure 2-75).

[® APPN Virtual Ring Number
Configuration Mode: local
SNMP Agent: LOCAL FILE

Virtual Ring Number (hex)

Help...

0

Figure 2-75. APPN Virtual Ring Number Window

6. Edit the Virtual Ring Number parameter, as follows:
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Parameter: Virtual Ring Number (hex)
Default: None
Range: 1 to 4095

Function:  Specifies the unique SRB ring number to be used
by APPN if the encapsulation technique is SRB. It
must be unique in the SRB network. This means
that Virtual Ring Number must be different than
the ring IDs specified in the SRB configuration, as
well as different from other Wellfleet routers
running APPN on LLC2/SRB media.

Instructions:  Specify the unique LLC ring number in the range
1 to 4095.

MIB Object ID:  1.3.6.1.4.1.18.3.5.1.6.2.25

7. Click the OK button. If this is the first interface for which you are
configuring APPN, the APPN Local Node Name Configuration
window appears (Figure 2-69). If this is not the first interface for
which you are configuring APPN, the Adjacent Link Station Dialog
Box appears (Figure 2-71). Refer to these figures for information on
completing the remaining APPN configuration steps.

Enabling APPN Interfaces over SDLC

If you are configuring APPN on synchronous interfaces (COM1, COM2,
etc.) using the SDLC protocol, Configuration Manager displays the
SDLC Line Parameters window (Figure 2-76).
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[@ SDLC Line Parameters
Configuration Mode: local
SNMP Agent: LOCAL FILE
Clock Source INTERNAL
Internal Clock Speed 19200
Sync Line Coding NRZ
Cable Type R5232

Figure 2-76. SDLC Line Parameters Window

1. Edit the Clock Source, Internal Clock Speed, Sync Line Coding, and
Cable Type parameters. Refer to “Configuring the Circuit” for
information on enabling SDLC services and the parameters on the
SDLC Line Parameters window.
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2. Click the OK button to display the Select Protocols window (Figure
2-77).

@ Select Protocols ]

Protocols

&1 DLSw
W APPN

Figure 2-77. Select Protocols Window

3. Select APPN and click OK. If this is the first interface for which you
are configuring APPN, the APPN Local Node Name Configuration
window appears (Figure 2-78). Otherwise, the APPN Configuration
window appears (Figure 2-79).

@] APPN CONFIGURATION i
Configuration Mode: local
SNMP Agent: LOCAL FILE

. Help...

Local Node Name (NETID, NAME) | : l

Figure 2-78. APPN Local Node Name Configuration Window

2-144



Adding Network Interfaces

4. At the APPN Local Node Name Configuration window, specify the
Local Node Name parameter, as follows:

Parameter: Local Node Name
Default: None

Options:  Any valid name with up to 17 characters in the
format <NETID.CPNAME>, where NETID is the
global network name with up to 8 characters
followed by a period, and CPNAME is the control
point name with up to 8 characters

Function: The Local Node Name parameter identifies the
unique name of the network and the Wellfleet
router node name.

Instructions: = Enter the node name by first specifying up to 8
characters in the network ID name, type a period,
then enter a control point name with up to 8
characters. Names must be specified in uppercase
characters only and must start with a non-
numeric character. Blank spaces (leading,
trailing, and embedded) are not allowed in the
node name. For example,
NETWORKA.SYSTEMA is a valid entry for the
Local Node Name parameter.

MIB Object ID:  1.3.6.1.4.1.18.3.5.14.1.4

5. Click OK to add the Local Node Name. The APPN Configuration
window appears (Figure 2-79).
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(@ APPN CONFIGURATION =]

Configuration Mode: local 0K
SNMP Agent: LOCAL FILE - Values...
Help...

SDLC Address (hex) |

Figure 2-79. APPN Configuration Window
6. Specify the SDLC address for the interface, as follows:

Parameter: SDLC Address (hex)
Default: None

Options:  Any unique 2-digit hexadecimal SDLC-level
address.

Function:  Specifies a unique SDLC address for this circuit.
Instructions:  Enter a 2-digit hexadecimal address.
MIB Object ID:  1.3.6.1.4.1.18.3.5.14.1.3.1.38
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7. Click the OK button on the APPN Configuration Manager window.
The Adjacent Link Station dialog box appears (Figure 2-80).

[® Site Manager ]

2

Would you like to configure &djacent Link Stations on this port?

OK for YES
Cancel for NO

OK

Figure 2-80. Adjacent Link Station Dialog Box

8. If you wish to configure APPN adjacent link station parameters at
this time, refer to Customizing APPN Services.

Enabling Data Compression Services

If you are configuring a Wellfleet router for PPP operations and if you
want to enable the Wellfleet Compression Protocol (WCP), select WCP
option from the WAN Protocols window (Figure 2-4). WCP operates on
ISDN and all standard synchronous interfaces. For detailed
information on customizing data compression services on Wellfleet
routers, refer to Customizing Data Compression Services.

Note: WCP is not supported on MCT1, MCE1, and multiline circuits.
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About the Multiline Feature

Multiline is a feature that increases the throughput of circuits. It
allows you to configure a single circuit consisting of one or more WAN
data paths. A data path is a logical point-to-point channel. It can be a
permanent physical line or a dial-up physical line; you can group up to
31 physical lines. It can also be a virtual circuit connection. Multiline
can also be used with Frame Relay group mode. For more information
on using Multiline with Frame Relay, refer to Customizing Frame
Relay Services.

The advantages of using the Multiline feature over a single path are
o It provides a greater degree of fault tolerance.

With Multiline, there are multiple data paths configured for a
single circuit. Therefore, if one data path becomes disabled, traffic
can be sent over another data path. As a result, there is greater
fault tolerance.

o It provides greater bandwidth between two sites.

Because there are multiple data paths per circuit, there is more
bandwidth assigned to the circuit than if it was a uni-line circuit
with just one data path. Therefore, the Multiline circuit is able to
handle higher volumes of traffic.

As an example of how Multiline is useful, consider the following.
Suppose that your network has two sites connected by Wellfleet
routers, one in New York City and one in Los Angeles (Figure 2-81).
These two sites have a particularly high volume of traffic transmitted
between them, and that the traffic transmitted between these two sites
is imperative to the operation of your business.

It would be advantageous for you to create a Multiline circuit between
these two sites to facilitate the large amount of traffic, and to decrease
the chance of traffic loss due to connection failure. If the network
topology is as it appears in the example in Figure 2-81, you could group
the three synchronous lines into one Multiline circuit.
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Router Router
— NYC LA

slot 1 slot 1 T
] slot2 [ =2 1 slot2
slt3 ————=__ - [ slt3
sotd = | slot4 u
slot 5 N slot 5

Three SYNC lines grouped
to form one Multiline circuit
with three data paths. ]

1 I

Figure 2-81. Multiline Circuit Composed of Three SYNC Lines

Multiline Support

Multiline is supported over the following types of media: Wellfleet
Standard SYNC, T1/E1, MCT1, MCE]1, Frame Relay (if the data paths

are configured with the same Frame Relay addressing), PPP, and
HSSI.

Multiline Circuit Types

There are two types of Multiline circuits:
0 A circuit distributed over several physical lines

0 Acircuit on one physical line with several separately addressable
data paths
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In Figure 2-82, Multiline Circuit A groups three synchronous lines into
one circuit. Multiline Circuit B consists of just one physical
synchronous line, but has three separately addressable data paths
associated with it.

Multiline Circuit Multiline Circuit

- Q00 QOO

!

Figure 2-82. Multiline Circuit Types

A Multiline circuit reacts to these individual data paths coming up and
going down by adding to and subtracting from its pool of active data
paths, and can operate with some of its data paths down.

Grouping Data Paths

The data paths that together make up a Multiline circuit must share
the same bandwidth, MTU, and encapsulation method. T1, E1, MCT1,
MCE]1, HSSI, and Wellfleet Standard SYNC lines share the same
encapsulation method. This means that you can group any of these
lines to form a Multiline circuit as long as they share the same
bandwidth and MTU.

Frame Relay and PPP each have unique encapsulation methods. You
cannot mix these line types with any other line type when you create a
Multiline circuit.
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Multiline Traffic Distribution

There are two ways a Multiline circuit distributes outbound traffic over
its data paths. It can use address-based selection (this is the default),
or it can use random selection.

Address-based selection

This option determines the appropriate data path for outbound traffic
based on the source and destination address in individual packets. For
any given address pair, the same data path will always be chosen.

Multiline automatically determines whether the packet is to be routed
or bridged, and then uses the appropriate address. It uses the routing-
level addresses for traffic to be routed, and the MAC-level addresses
for traffic to be bridged.

This option ensures that all outbound traffic to a certain endstation
travels on the same data path, and therefore ensures sequentiality of
packets. For protocols that are intolerant of receiving packets out of
sequence, this is the best choice. This is also the default.

Note that this option does not always result in even distribution across
all data paths in a Multiline circuit.

Note: Address-based selection cannot be used with Frame Relay in
Group or Hybrid mode. Traffic distribution is automatically
changed to random selection.

Random-selection

This option determines the data path for outbound traffic based on a
randomly assigned number. For each outbound packet, Multiline
generates a random number. This number determines which data path
will be used to send this particular packet.
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Note: This option provides even distribution across all active data
paths in the topology. However, packets traveling on different
paths can arrive at their destination out of sequence. Some
protocols cannot tolerate packets arriving out of sequence, and
as a result, you can experience poor performance or failures.
Use this option only when it is acceptable for packets to arrive
out of sequence.

Configuring Multiline

The way that you configure a Multiline circuit depends on what it is
that you are grouping.

o For information on how to group up to 16 physical synchronous
lines into a Multiline circuit, follow the directions in the
appropriate following section, either “Grouping Physical
Synchronous Lines into a Multiline Circuit,” or “Adding Physical
Synchronous Lines to a Circuit.”

o For information about how to use Multiline with Frame Relay, refer
to the section “Grouping PVCs for Multipath Mode” in Customizing
Frame Relay Services.

Grouping Physical Synchronous Lines into a Multiline Circuit

To group any physical synchronous lines into a Multiline circuit, begin
at the Wellfleet Configuration Manager window, and complete the
following steps.

1. Double-click on the Link Module connector that you want to
connect to the network to display the Add Circuit window
(Figure 2-83).

The Link Module connector that you select must be of type E1, T1,
MCT1, MCE1, HSSI, or Synchronous.
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[® Add Circuit
Configuration Mode: local
SNMP Agent: LOCAL FILE
Circuit Name: Color Key:
. . Available
Select lines from available connectors: Selected
Slot Connectors
5 {1 NONE {1 NONE {1 NONE {1 NONE
4 {1 NONE £1 NONE £1 NONE {1 NONE
3 {1 NONE £1 NONE {1 NONE £ NONE
2 [ Ol . £ Coma
1 {1 CONSOLE
Cancel

Figure 2-83. Add Circuit Window
2. Click on the other connector(s) that you want to group with the first
connector.

These connectors must also be of type E1, T1, MCT1, MCE1, HSSI,
or Synchronous.
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3. Click on the OK button.

The connectors that you have selected are now grouped and saved
under a single circuit name. For example, in Figure 2-83, the lines
connecting to COM1, COM2, and COMS3 now form one circuit called
S21, which distributes traffic based on address pairs. To change the
traffic distribution method, refer to the section “Changing the
Traffic Distribution Method.”

4. Add the necessary protocols to this circuit.

Refer to the section “Enabling Bridging/Routing Services” earlier in
this chapter for instructions.

Adding Physical Synchronous Lines to a Circuit

To add a physical synchronous line to a synchronous line that has
already been configured with protocols (is now a circuit), you must first
be sure that the lines you intend to group share the same
encapsulation method and MTU. If they do, begin at the Wellfleet
Configuration Manager window, and complete the following steps.

1. Double-click on the connector of the circuit to which you want to
add lines.

2. Click on the Edit Circuit button in the Edit Connector window.
The Circuit Definition window appears (Figure 2-84).
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(@] Circudt Definition |

File Group Protocols iLJ'.nes |Window FR Protocol

Help

Configuration Mod Change Lines PF2
onfiguration Mode: T
P Agent: Edlt'L:'Lnes...
Multiline, ..
Protocols: Bridge
Circuit Name:
Slot Lines
5 £1 NONE
4 700 {1 XCVR2
3 £coml {1 CoM2 {1 XCVR2
2 {com £10oM2 {1 XCVR2
1 0 CONSOLE

{J NONE

0 %CVRL
O %CVR1
{1 XCVR1

Figure 2-84. Circuit Definition Window

3. Click on the connectors that you want to add to the circuit.

For example, in Figure 2-84, COM2 has been selected to be added

to circuit S21.
4. Select Lines-»Change Lines.

The lines are now grouped as one circuit. The default traffic

distribution method is address-based. If you want to change the

traffic distribution method, refer to the section “Changing the

Traffic Distribution Method.”

5. Select File=>Exit to exit this window.
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Changing the Traffic Distribution Method

All Multiline circuits, by default, distribute traffic based on address
pairs. If you want to change the traffic distribution method, begin at
the Wellfleet Configuration Manager window, and complete the
following steps.

1. Double-click on one of the connectors belonging to the Multiline
circuit you want to edit.

2. Click on the Edit Circuit button in the Edit Connector window.
3. Select Lines->Multiline from the menu bar.

The Edit Multiline Options window for this circuit appears

(Figure 2-85).
[@] Edit Multiline Options: §21
Configuration Mode: local
SNYP Agent: LOCAL FILE
Help...
Data Path Chooser [epoRess pase fl:

Figure 2-85. Edit Multiline Options Window for Circuit S21

4. Edit the Data Path Chooser parameter to reflect the appropriate
traffic distribution method for this circuit.

5. Click on the OK button when you are finished.
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Parameter: Data Path Chooser
Default: Address Based
Options:  Address Based | Random

Function:  Specifies how this Multiline circuit will distribute
outbound traffic over its data paths. The default
value is Address Based, which means that traffic
between the same source and destination address
pair will always be sent over the same data path.
This method ensures sequentiality.

If you select Random, the data path used to send
outbound traffic is based on a randomly assigned
number. For each outbound packet, Multiline
generates a random number. This number
determines which data path will be used to send
this particular packet. This method ensures even
distribution among the data paths in a Multiline
circuit, but does not ensure sequentiality.

Instructions:  Either accept the current value, or set this
parameter to another value.

MIB Object ID:  1.3.6.1.4.1.18.3.5.1.4.1.1.23

Editing Circuits
The following six sections describe how to edit circuits. The
Configuration Manager allows you to
o Delete a circuit from the router.

Refer to the section “Deleting a Circuit from the Router” for
instructions.

o Rename a circuit.
Refer to the section “Renaming a Circuit” for instructions.
o Add protocols to a circuit.

Refer to the section “Adding Protocols to a Circuit” for instructions.
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Move a circuit.
Refer to the section “Moving a Circuit” for instructions.
Assign additional IP addresses to a circuit.

Refer to the section “Assigning an Additional IP Address to a
Circuit” for instructions.

Delete protocols from a circuit.

Refer to the section “Deleting Protocols from a Circuit” for
instructions.

Deleting a Circuit from the Router

You can delete circuits from the router. When you delete a circuit from
the router, you remove all line and protocol information from the
circuit. You will need to go through the process for adding network
interfaces if you want to redefine this circuit.

To delete a circuit from the router, begin at the Wellfleet Configuration
Manager window and complete the following steps:

1.

Select Circuits»Delete Circuit.

The Circuit List window appears.

Select the circuit you want to delete from list of the circuits.
Click on the Delete button.

The Delete Circuit window appears (Figure 2-86), with the circuit
you selected specified.

[®] Delete Circuit

Delete circuit $21

Cancel

Figure 2-86. Delete Circuit Window
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4. Click on the Delete button.

The circuit is deleted from the router, and no longer appears in the
Circuit List window.

Repeat Steps 1 through 4 for each circuit that you want to delete from
the router.

Renaming a Circuit
To rename a circuit on the router, begin at the Wellfleet Configuration
Manager window and complete the following steps:
1. Select Circuits-»Edit Circuits.
The Circuit List window appears.
2. Select the circuit that you want to rename from the list of circuits.

3. Click on the Edit button; the Circuit Definition window appears
(Figure 2-87).
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[®] Circuit Definition
File Protocols Lines Window Help
Configuration Mode: local
SNMP Agent: LOCAL FILE
Protocols: Source Routing
Circuit Name: » v
Slot Lines
5 £ NONE £ NONE £1 NONE £1 NONE
4 £ oML £1Com2 {1 XCVR2 {1 XCVR1
3 £ oML £ CoM2 £1 XCVR2 {1 XCVR1
2 £3 CoML {com2 {1 XCVR2
1 £1 CONSOLE

Figure 2-87. Circuit Definition Window

4. Enter a new name for this circuit in the Circuit Name box.

5. Select Lines=»Change Lines; the circuit’s new name is saved.
Follow Steps 1 through 5 for each circuit that you want to rename.

6. Select File->Exit to exit this window when you are finished.

Adding Protocols to a Circuit

To add protocols to a circuit, begin at the Wellfleet Configuration
Manager window and complete the following steps:

1. Select the Circuits=>Edit Circuits option.
The Circuit List window appears.

2. Select the circuit to which you want to add protocols.
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3. Click on the Edit button.
The Circuit Definition window appears.

4. Select Protocols-»Add/Delete; the Select Protocols window appears
(Figure 2-24).

5. Select the protocols that you want add to this circuit; then click on
the OK button.

For each protocol you add, the Configuration Manager displays a
configuration window prompting you to define each protocol you
enabled on the circuit.

6. Define each protocol you added to the circuit. To do this, refer to the
corresponding section(s) earlier in this chapter.

Repeat Steps 1 through 6 for each circuit to which you want to add
protocols.

Moving a Circuit

Once you have configured a circuit on a network interface, you can
move the circuit to another network interface. When you move a circuit
to a different type of network interface (for example, when you move an
Ethernet circuit to an FDDI network interface connector), the
Configuration Manager notes the type of connector for the circuit
interface, and automatically provides the appropriate line detail
parameters.

To move a circuit, begin at the Wellfleet Configuration Manager
window and complete these steps.

1. Select Circuits-»Edit Circuit.

The Circuit List window appears.
2. Select the circuit that you want to move from the list of circuits.
3. Click on the Edit button.

The Circuit Definition window appears (Figure 2-88). The name of
the circuit you want to move appears in the Circuit Name box, and
the connector for the circuit interface is highlighted.
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4. Click on the circuit’s connector.

The circuit is removed from the connector, and the connector is no

longer highlighted.
[® Circuit Definition
File Protocols Lines Window Help
Configuration Mode: local
SNMP Agent: LOCAL FILE
Protocols: Bridge
Circuit Name:
Slot Lines
5 {1 NONE £1 NONE £1 NONE £1 NONE
4 £1coM1 £100M2 £1 XCVR2 £1 XCVR1
3 i CoM2 £1 XCVR2 {1 XCVR1
2 Qcom £1com2 {1 XCVR2 {1 XCVRL
1 £1 CONSOLE

Figure 2-88. Moving a Circuit

5. Click on the connector for the circuit interface.

The connector you chose is now highlighted, indicating that the
circuit now connects to it. For example, in Figure 2-88, Circuit S32
was moved to the connector COM1.

At this point, you may want to rename the circuit if you think the
old circuit name may cause some confusion. To do this, enter a new
name in the Circuit Name box.
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6. Select Lines-»Change Lines.

All circuit moves are reflected in the Wellfleet Configuration
Manager window. Follow Steps 1 through 6 for each circuit that you
want to move.

7. Select File-»Exit to exit this window when you are done.

Changing Network Addresses on a Circuit

Site Manager allows you to change network addresses on a circuit by
using the Configuration Change Utility. For information on this utility,
see the section “Configuration Change Utility” in Chapter 5.

Assigning an Additional IP Address to a Circuit

Wellfleet IP routing supports Multinet. Multinet allows you to assign
multiple IP addresses to a single circuit; thus, one circuit can support
multiple IP network interfaces. Each IP address on a Multinet circuit
must belong to a unique network/subnet. You cannot have two
interfaces on the same subnet.

For more information about Multinet,' see the section “Multinet” in
Customizing IP Services.

You can assign as many IP addresses as you desire to a circuit. To
assign additional IP addresses to a circuit, begin at the Wellfleet
Configuration Manager window and complete the following steps:

1. Select Circuits->Edit Circuits.
The Circuit List window appears.

2. Select the circuit to which you want to assign an additional IP
address, then click on the Edit button.

The Circuit Definition window appears (Figure 2-87).
3. Select Protocols-»Edit IP->Interfaces.
The IP Interfaces window appears (Figure 2-89).
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[®] IP Interfaces
]

R - T ——

Enble { EnaBLE il
Subnet Mask [255. 255, 225, '
Broadcast Address [0.0.0.0 i
Interface Cost ll

MIU Discovery [ OFF I
Addr Mask Reply [ OFF |

Figure 2-89. IP Interfaces Window

4. Click on the Add button.
The IP Configuration window appears (Figure 2-90).
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[®] IP CONFIGURATION

Configuration Mode: local
SNYP Agent: LOCAL FILE
TP Address [192.32.4.90 IR
Configure RIP [no | I
Configure OSPF [No B

Figure 2-90. IP Configuration Window

5.

Enter the IP address you want to assign to this circuit in the IP
Address box.

Click on the OK button.

You are returned to the IP Interfaces window. The address you just
assigned to the specified circuit appears in the Interfaces scroll box.

Follow Steps 1 through 6 for each IP address you want to add to a
circuit.

Deleting Protocols from a Circuit

To delete protocols from a circuit, begin at the Wellfleet Configuration
Manager window and complete the following steps:

1.

Select Circuit-»Edit Circuits.
The Circuit List window appears.
Select the circuit from which you want to delete protocols.

Click on the Edit button; the Circuit Definition window appears
(Figure 2-87).

Select Protocols->Add/Delete; the Select Protocols window appears
(Figure 2-24).
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5. Deselect the protocols that you want to delete from this circuit by
clicking on the boxes beside those protocols.

6. Click on the OK button.

You are returned to the Circuit Definition window. The protocols
you just deleted no longer appear in the Protocols scroll box.

Follow Steps 1 through 6 for each circuit from which you want to delete
protocols.

Configuring the Console Port for the Technician Interface

This section describes how to configure the console port to connect the
router to the Wellfleet Technician Interface. Configure the console port
by editing parameters in the Console Lists window (Figure 2-91).
Display this window by clicking on the Console button in the Wellfleet
Configuration Manager window (Figure 2-1).
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@] Console Lists
sonEole Port gL B é Done I
Console Port & 2
Console Port # 3
Console Port # 4

Enable | ENeBLE |
Port Type (11 |
Baud Rate [ 9800 |
Port Data Bits B |
Port Parity |NONE i
Stop Bits (1 |

Figure 2-91. Console Lists Window

The Console Lists window displays the router’s console ports. Console
ports are the physical ports on a router for system input/output. The
number of ports depends on the router model. For example, the
Wellfleet AFN™ router has two console ports, labeled Console and
Modem.

Select a console port from the Console Lists window and then edit its
parameters. After you are finished, click on the Apply button to save
your changes. When you are done with all ports, click on the Done
button to exit the window and save your changes.
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Parameter:
Default:

Options:

Function:

Instructions:
MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

Enable

Enable (first port)
Disable (other ports)

Enable | Disable

Enables or disables the serial ports. The first port
on a router is enabled by default. The other ports
on routers with multiple ports are disabled by
default.

Select the status of the serial port.
1.3.6.1.4.1.18.3.3.2.11.1.1.2

Port Type

TI

TI

Configures the port for the Technician Interface.
Select the port type.

1.3.6.1.4.1.18.3.3.2.11.1.1.7

Baud Rate
9600
9600 | 4800 | 2400 | 1200 | 600 | 300

Specifies the rate of data transfer between the
console and the router.

Set according to your console requirements.
1.3.6.1.4.1.18.3.3.2.11.1.1.8
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Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

Port Data Bits
8
7|8

Specifies the number of bits in each ASCII
character received or transmitted by the router.

Set according to your console requirements.
1.3.6.1.4.1.18.3.3.2.11.1.1.9

Port Parity
None
None | Odd | Even

Enables or disables data error detection for each
character transmitted or received.

Set according to your console requirements. Odd
or Even enables data error detection. None
disables data error detection.

1.3.6.1.4.1.18.3.3.2.11.1.1.10

Stop Bits
1 bit
1|1.5|2 bits

Specifies the number of bits that follow each
ASCII character received or transmitted by the
router.

Set according to your console requirements.
1.3.6.1.4.1.18.3.3.2.11.1.1.11
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Range:
Function:

Instructions:
MIB Object ID:

Modem Enable
Disable
Enable | Disable

Specifies whether the terminal is connected
directly or via a modem to the Technician
Interface.

Select Enable if the terminal is connected via a
modem to the Technician Interface.

Select Disable if the terminal is connected directly
to the Technician Interface.

1.3.6.1.4.1.18.3.3.2.11.1.1.12

Lines Per Screen
24
5 to 100 inclusive

Specifies the maximum number of lines displayed
on the console screen.

Set according to your console requirements.
1.3.6.1.4.1.18.3.3.2.11.1.1.13
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

More Enable
Enable
Enable | Disable

Specifies whether the Technician Interface pauses
after the screen fills with data.

Select Enable to configure the Technician
Interface to pause after the screen fills with data.

Select Disable to configure the Technician
Interface not to pause after the screen fills with
data.

1.3.6.1.4.1.18.3.3.2.11.1.1.14

Prompt

$

Any string of up to 19 keyboard characters except
for control key sequences.

Specifies the text used as a prompt on your
console screen. Place quotes around any spaces
you want to include in the text.

Accept the default or enter a different text string.
1.3.6.1.4.1.18.3.3.2.11.1.1.15
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Parameter:
Default:
Range:

Function:

Instructions:
MIB Object ID:

Parameter:
Default:
Range:

Function:

Instructions:
MIB Object ID:

Parameter:
Default:
Range:

Function:

- Instructions:
MIB Object ID:

Login Timeout
1
1 to 99 (99 indicates infinity)

Specifies the number of minutes allowed in which
to press the Enter key after the Login: prompt
appears. This parameter is valid only when
Modem Enable is set to Enable.

Accept the default or enter a new timeout value.
1.3.6.1.4.1.18.3.3.2.11.1.1.16

Password Timeout
1
1 to 99 (99 indicates infinity)

Specifies the number of minutes allowed in which
to press the Enter key after the Password: prompt
appears. This parameter is valid only when
Modem Enable is set to Enable.

Accept the default or enter a new timeout value.
1.3.6.1.4.1.18.3.3.2.11.1.1.17

Command Timeout
15
1 to 99 (99 indicates infinity)

Specifies the number of minutes allowed in which
to press the Enter key after the prompt. This
parameter is valid only when Modem Enable is set
to Enable.

Accept the default or enter a new timeout value.
1.3.6.1.4.1.18.3.3.2.11.1.1.18
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Parameter:
Default:
Range:
Function:

Instructions:
MIB Object ID:

Parameter:
Default:
Options:

Function:
Instructions:

MIB Object ID:

Login Retries
3
1 to 99 (99 indicates infinity)

Specifies the maximum number of login attempts
when Modem Enable is set to Enable.

Accept the default or enter a new retry value.
1.3.6.1.4.1.18.3.3.2.11.1.1.19

Initial Search Path
None
None

Sets the Path environmental variable that defines
the path to the location of autoscript files.

Enter the path to the directory where the
autoscript files are located.

1.3.6.1.4.1.18.3.3.2.11.1.1.28
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Parameter:
Default:
Options:

Function:
Instructions:

MIB Object ID:

Parameter: -

Default:
Options:

Function:

Instructions:
MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Manager Auto Script
None
None

Defines the manager’s login script file, which is
automatically executed for each login.

Enter the name of the login script file for the
manager.

1.3.6.1.4.1.18.3.3.2.11.1.1.29

User Auto Script
None
None

Defines the user’s login script file, which is
automatically executed for each login.

Enter the name of the login script file for the user.
1.3.6.1.4.1.18.3.3.2.11.1.1.30

Force User Logout Enable
Disable
Enable | Disable

Enabling this option forces the user to log out if he
or she tries to escape from the autoscript.

Select Enable to force the user to log out if an
attempt is made to escape the autoscript.

1.3.6.1.4.1.18.3.3.2.11.1.1.31
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Specifying Administrative Information

This section describes how to use the Configuration Manager to specify
a system name, contact, and location for the router. When you access
the router from the Wellfleet Site Manager window, the application
automatically retrieves this administrative information and displays it
in the Wellfleet Site Manager window.

You specify router administrative information in the Edit System
Description Parameters window (Figure 2-92). To display this window,
select Platform->Edit System Information from the Wellfleet
Configuration Manager window. Enter the required information, then
click on the OK button to exit the window and save the administrative
information.

A description of each parameter follows.

[® Edit System Description Parameters
Configuration Mode: local
SNMP Agent: LOCAL FILE
System Name |I ; .
System Contact [ { l
System Location [ K

Figure 2-92, Edit System Description Parameters Window
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Specifying Administrative Information

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

System Name

None

Any name

Identifies this router.

Enter the appropriate name for this router.
1.3.6.1.4.1.18.3.3.1.5

System Contact
None
Any person

Provides the name of the person to contact
regarding issues with this router.

Enter the name of the contact person, and
possibly a way to contact that person.

1.3.6.1.4.1.18.3.3.1.4

System Location

None

Any place

Identifies the physical location of this router.
Enter a location description for this router.
1.3.6.1.4.1.18.3.3.1.6
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Chapter 3
Customizing Line Services

This chapter provides an overview of the following physical-layer
protocols, and describes how to edit them:

o Ethernet
o Token Ring
o FDDI and SMT

It also describes how to edit T1, E1, HSSI, synchronous, and
asynchronous line service parameters. For information about
Multichannel T1 (MCT1) and Multichannel E1 (MCE1) link modules,
see Chapters 4 and 5.

If you prefer, go directly to the section entitled “Accessing Line
Services,” which explains how to access the circuit for which you want
to edit line services. It also directs you to the appropriate section for
instructions on how to edit the line service parameters.

Ethernet Overview

Ethernet is a 10MB/s local area network that uses the Carrier Sense
Multiple Access with Collision Detection (CSMA/CD) protocol to
control access to the medium. Endstations use CSMA/CD to monitor
the medium and wait until it is idle before transmitting data. If
multiple stations transmit simultaneously, a collision occurs and each
endstation waits a random amount of time before attempting to
transmit again.
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Ethernet Overview

There are actually two MAC-layer frame format specifications used on
Ethernet. The first specification is called Ethernet, and the second,
standardized by the IEEE, is called 802.3. One way that they differ is
in message format (Figure 3-1). Note that the Ethernet message does
not include a Length field in the MAC-layer header. Instead, it
includes a Type field, indicating which higher-layer protocol is used in
the Data field.

Ethernet Message Format

Dest. | Source

Addr. | Addr. | TYPe Data - CRC
802.3 Message Format

Dest. | Source

Addr. | Addr. | Length Data CRC

Figure 3-1. Ethernet and 802.3 Message Formats

An Ethernet LAN can use thick or thin Ethernet (coaxial cable), or
twisted-pair cable. Thick and thin Ethernet LANs are arranged in a
bus topology. Devices are attached directly to the backbone

(Figure 3-2).

] 1
] [ 1 [ 1 [

Figure 3-2. Sample Ethernet LAN, Bus Topology
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An Ethernet LAN using twisted-pair cable is arranged in a star
topology. Devices are connected to a central concentrator (Figure 3-3).

] Q/;

Concentrator Concentrator

]

Data sent over an Ethernet LAN is transmitted in all directions;
therefore, every device connected to the LAN sees the data. Each
device checks each data unit to see if the destination address matches
its own address. If the addresses match, the device accepts and
processes the packet. If they do not match, it disregards the packet.

0

Figure 3-3. Sample Ethernet LAN, Star Topology

Token Ring Overview

Token Ring is a 4- or 16-MB/s, token-passing, baseband LAN that
operates in a ring topology. Token Ring conforms to the IEEE 802.5
standard. A 4-MB/s Token Ring LAN uses shielded or unshielded
twisted-pair cable.

Stations on a Token Ring network attach to the network using a Media
Attachment Unit (MAU). Although the Token Ring is logically a ring, it
is physically a star, with devices radiating from each MAU

(Figure 3-4).
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Token Ring Overview

00000006 <V\>1000000060

Figure 3-4. Sample Token Ring LAN, Ring Topology

MAUs are connected to each other using Ring In (RI) and Ring Out
(RO) ports. The connection between two MAUs must always be
between an RI port and an RO port; you cannot connect an RI to an RI
port, or an RO to an RO port. To complete the ring, all RI and RO ports
must be connected (Figure 3-4).

Devices on a Token Ring network get access to the media through
token passing. The devices pass the token around the ring until one of
them needs to transmit data. That device takes the token and replaces
it with a frame. This frame is passed from one device to the next device
until it reaches its destination. As the frame passes through the
intended recipient, the recipient sets certain bits in the frame to
indicate that the frame was received. The original sender of the frame
strips the frame data off of the ring and issues a new token.
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FDDI and SMT Overview

Fiber Distributed Data Interface (FDDI) is a set of ANSI/ISO
standards that define a 100-MB/s, timed-token-passing LAN. FDDI is
suitable for workgroup, backbone, and back-end network
configurations that require high bandwidth and performance. It uses a
dual counter-rotating ring topology for fault recovery and sophisticated
encoding techniques to ensure data integrity. Up to 500 nodes can be
connected per FDDI LAN. The FDDI standard specifies that the total
length of the fiber-optic cabling used to connect the nodes may not
exceed 200 km, or 100 km per ring.

The FDDI standards consist of the following entities:
o Physical Layer Medium Dependent (PMD)

o Physical Layer Protocol (PHY)

0 Media Access Control (MAC)

o Station Management (SMT)

The PMD standard defines the physical characteristics of the media
interface connectors and the cabling, and the services necessary for
transmitting signals between nodes.

The PHY standard defines the rules for encoding and framing data for
transmission, clocking requirements, and line states.

The MAC standard defines the FDDI timed-token protocol, frame and
token construction and transmission on the FDDI ring, and ring
initialization and fault isolation.

The SMT standard defines the protocols for managing the PMD, the
PHY, and the MAC components of FDDI. The SMT protocols monitor
and control the activity of each node on the ring.

Figure 3-5 shows the rélationship of the four FDDI standards.
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FDDI and SMT Overview

Media Access Layer (MAC)
Station
Physical Protocol (PHY) Management
(SMT)

Physical Layer Medium Dependent (PMD)

Figure 3-5. Relationship of FDDI Standards

FDDI Dual Counter-Rotating Ring Architecture

FDDI LANSs are constructed of two independent, counter-rotating
rings, a primary ring and a secondary ring. Data flows in opposite
directions on the rings. Both rings can carry data; however, in high-
bandwidth applications, Bay Networks specifies that the primary ring
be used for data transmission and the secondary ring as a backup.

The counter-rotating ring architecture provides protection against loss
of data flow in the event of a node failure, a link failure, or the failure
of both the primary and secondary links between any two nodes. If a
node or both the primary and secondary links fail, the ring is restored
by wrapping one ring to the other around the faulty component. When
a wrap occurs, the dual-ring architecture changes to a single-ring
architecture. When the problem is corrected, the architecture reverts
to that of the dual-ring.

Figure 3-6 shows how the primary ring wraps to the secondary ring
when both rings are broken.
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7

s
D |

N\

\'/)

4
\

Figure 3-6. Primary Ring Wrapping to Secondary Ring When Both
Rings Disabled

Figure 3-7 shows how the primary ring wraps to the secondary ring on
the nodes on either side of the disabled node.
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FDDI and SMT Overview

N N

N\ 4y

N B

Figure 3-7. Primary Ring Wrapping to Secondary Ring When Node Disabled

FDDI Ring Operation

An FDDI ring consists of nodes connected in a ring architecture by link
segments. There are two classes of nodes: stations (a node with no
master ports), and concentrators (a node with master ports). The FDDI
standards define two types of stations: Single Attachment Station
(SAS) and Dual Attachment Station (DAS). The SAS connects to only
one ring; it cannot wrap the ring in case of a fault. The DAS connects to
both the primary and the secondary rings. The Wellfleet router is an
example of a DAS.

Before data can be transmitted on the FDDI ring, the nodes attached
to the ring must establish connections with their neighbors. The
Connection Management (CMT) portion of SMT controls this process,
as described in the section “FDDI SMT” later in this chapter.
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After the connections between nodes have been established, nodes
negotiate the target token rotation time (TTRT), using the claim token
process. The TTRT is the value used by the MAC sublayer to time its
operations. The claim token process determines which node initializes
the ring (generates the token). The node with the lowest bid for the
TTRT wins the right to generate the token.

After a node has initialized the ring, the ring begins to operate in
steady state. In steady state, the nodes exchange frames using the
timed-token protocol (TTP). The TTP defines how the TTRT is set, the
length of time a node can hold the token, and how a node initializes the
ring. The ring remains in steady state until a new claim token process
is initiated (for example, when a new node joins the ring).

The nodes pass the token from one node to another on the FDDI ring. A
node on the ring captures the token when it wants to transmit data.
The node then transmits data to its downstream neighbor. Each node
reads and repeats frames as it receives them. If a node detects an error
in a frame, the node sets an error indicator. The sending node releases
the token back onto the ring for use by another node when it has sent
all of its frames, or exhausted its available transmission time. When a
frame initiated from a node returns, the node removes the frame from
the ring.

Station Timers

Each node uses three timers to regulate its operation in the ring:

o Token rotation timer (TRT)

o Token-holding timer (THT)

a Valid transmission timer (TVX)

The TRT times the period between the receipt of tokens. TRT is set to

varying values, depending on the state of the ring. During steady-state
operation, the TRT expires when the TTRT has been exceeded.

The THT controls the length of time that a node can hold the token in
order to transmit frames. The value of THT is the difference between
the arrival of the token and the TTRT.
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The TVX times the period between valid transmissions on the ring.
When the node receives a valid frame or token, the TVX is reset. If the
TVX expires, the node starts a ring initialization sequence to restore
the ring to proper operation.

FDDI Ring Maintenance

FDDI SMT

Each node is responsible for monitoring the integrity of the ring. By
using the TVX, nodes can detect a break in ring activity. If the interval
between token receptions exceeds the value set in the TVX, an error
condition is reported and the claim process is initiated to restore ring
operation.

If a token cannot be generated, the node that detected the problem
initiates beacon frames. Beacon frames indicate to the other nodes that
the ring is broken. If the beacon transmission exceeds the value set in
the stuck-beacon timer (controlled by the Ring Management [RMT]
portion of SMT), RMT attempts to restore the ring to normal operation.
If the ring is not returned to normal operation in a specified period of
time, RMT initiates a ¢race. A trace is a diagnostic function used to
isolate a fault on the ring. For more information about RMT, see the
next section.

The Wellfleet router supports Version 7.2 of the SMT protocol. SMT is
a low-level protocol that manages the FDDI functions provided by the
PMD, the PHY, and the MAC. SMT can be used only on a single FDDI
LAN and can manage only the FDDI components and functions within
a node.

SMT contains three components:

o Connection Management (CMT)

o Ring Management (RMT)

o SMT frame services
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The CMT component of SMT inserts and removes stations at the PHY
level and connects PHYs and MACs with a node. It uses trace
diagnostics to identify and isolate a faulty component. It manages the
physical connection between adjacent PHYSs, including establishing the
connection, testing the quality of the link before the connection is
established, and continuously monitoring link errors once the ring is
operational.

The RMT component of SMT receives status information from the
MAC and CMT, reporting this information to SMT and higher-level
processes (for example, SNMP). It detects stuck beacon conditions and
duplicate addresses, and determines when the MAC is available for
transmitting frames. Duplicate addresses prevent the proper operation
of the ring.

SMT frame services allow for the management and control of the FDDI
network and the nodes on the network. Different SMT frame classes
and types implement these services. Frame class identifies the
function that the frame performs. Frame type specifies whether the
frame is an announcement, a request, or a response to a request. FDDI
SMT frames are limited to a single FDDI ring. The frames cannot
move across wide area networks or across multiple FDDI rings. The
frames do not manage functions outside of FDDI.

Table 3-1 shows the SMT frames supported on the Wellfleet router.
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Table 3-1. SMT Frame Class and Type

Frame Class Frame Type
Neighbor Information Frames (NIF) Request/Response
Status Information Frames (SIF) Response

Echo Frames (ECF) Response

Request Denied Frames (RDF) Response

Status Report Frames (SRF) Announcement
Parameter Management Frames (PMF) | Response

Get PMF only

Neighbor Information Frames identify the upstream and downstream
neighbors of each node. After the nodes learn the addresses of their
upstream neighbors, you can use the addresses to create a logical map
showing the order in which nodes appear in the token path. A Wellfleet
station will issue a response to the sender of a NIF frame and will
generate NIF requests as part of the neighbor notification process.

Status Information Frames exchange information about each node,
including the status of each port in the node. You can use SIFs to create
a physical map showing the position of each station in the FDDI
network. There are two types of SIF's:

a SIF configuration frames, which show the configuration
information of a node.

o SIF operation frames, which show the operational information of a
node. A Wellfleet station will issue a response to the sender of a SIF
request frame.
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Echo Frames verify that nodes on an FDDI network can communicate
with each other. Echo frames are used to test connectivity only. A node
sends an echo request (which is a directed packet) to another FDDI
node. The receiver of the echo request copies the data contained in the
information field of the frame and transmits an echo response frame
back to the originator of the echo request. A Wellfleet station will issue
a response to the sender of an Echo request frame.

Request Denied Frames deny requests from the network. If the SMT
agent receives a frame with an unsupported SMT version or an
unknown frame type, it sends a Request Denied frame. A Wellfleet
station will issue an RDF Response frame.

Status Report Frames allow the Status Report protocol to report node
conditions and events. A condition is when a node enters a specific
state (for example, duplicate address detected). An event is an
immediate occurrence (for example, the generation of a trace). A
Wellfleet station will issue an SRF announcement frame.

Parameter Management Frames allow the Parameter Management
protocol to manage an FDDI node. A management station performs
operations on the MIB attributes of a node by exchanging frames
between the management station and the FDDI node. To get an
attribute, the management station initiates a PMF Get Request frame.
The FDDI node to which the PMF Get Request frame was sent
responds by initiating a PMF Get Response frame. A Wellfleet station
will issue a response to the sender of a PMF Get request frame.
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Accessing Line Services

To customize line services, start at the Wellfleet Configuration
Manager window and complete the following steps:

1. Select Circuits=>Edit Circuits.
The Circuit List window appears.
2. Select the circuit for which you wish to edit line service parameters.

3. Click on the Edit button; the Circuit Definition window appears
(Figure 3-8).

@ Circuit Definition RS
File Protocols iLines- |Window Help
|Change Lines PF2

Conflgurg['\ﬁ]ﬁgngg Edit Lines...

Protocols: Bridge

iz voe:

Slot Lines
5 £1 NONE {1 NONE £1 NONE {1 NONE
4 {1 NONE {1 NONE 1 NONE £1 NONE
3 £1 NONE {1 NONE {1 NONE {1 NONE
2 0 comt £1 NONE {1 XCVRL
1 {1 CONSOLE

Figure 3-8. Circuit Definition Window

4. Select Lines-»Edit Lines; the Edit Lines window appears
(Figure 3-9).

This window lists the existing lines by slot number and connector.
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[® Edit Lines

Lines

Figure 3-9. Edit Lines Window

5. Select the circuit for which you want to edit line service parameters
and click on the Edit button.

In this example, the line connected to COM2 in Slot 2 is selected.
Depending on the type of circuit that you selected in Step 2, the
Configuration Manager displays the appropriate window that
allows you to modify the circuit’s line details.

6. Set each of the parameters as appropriate on the line detail window
that appears.

The following sections describe how to edit line detail parameters.
Refer only to the section that corresponds to the type of circuit you are
editing.

Repeat Steps 1 through 6 for each circuit that needs line detail
modification.
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Editing E1 Line Details

If the line you want to edit is an E1 line, the Configuration Manager
displays the E1 Line Entry window (Figure 3-10). Complete the
following steps:

[® El Line Entry

Configuration Mode: local
SNMP Agent: LOCAL FILE
Circuit Name: E1-31

Enable: Enable

Disable

L 2
<
HDB3S Support.: < Enable
€ Disable
Clock Mode: € Internal
& Slave
<o

Manual

Mini Dacs:  {Idle| iData| {Voice| {Circuit 1} iCircuit 2|

Currently Selected: idle

L) 2] (3] (4] (s8] (8] 71 L8
L9 ] (tof (1 [12] (18] [14] [15 16 |
L17] (18] [19) (2] [a] (22 2 |
(5] (8] [(27] (8] [29] [30]

! OK | ' Sync Details... | | Cancel |

Figure 3-10. E1 Line Entry Window
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1. Enter or select new values for the E1 line service parameters that
you want to edit, referring to the descriptions following this
procedure for guidelines.

2. If you want to edit synchronous line parameters, click on the Sync
Details button. Refer to the section “Editing Synchronous Line
Details” in this chapter for instructions.

3. Click on the OK button.

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Enable

Enable

Enable | Disable

Enables or disables the E1 line.

Set to Disable if you want to disable the E1 line.
1.3.6.1.4.1.18.3.4.11.1.2

HDB3S Support
Disable
Disable | Enable

Enables or disables High-Density Bipolar Coding
(a mechanism to maintain sufficient ones density
within the E1 data stream).

Enable or disable this parameter, depending on
the ability of the associated E1 equipment to
support HDB3S.

1.3.6.1.4.1.18.3.4.11.1.7
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Clock Mode

Internal

Internal | Slave | Manual

Specifies the source of the E1 transmit clock.

Internal specifies that the E1 transmit clock is
internally generated; Slave specifies that the E1
transmit clock is externally generated (that is, the
transmit clock is derived from the incoming data
stream); Manual specifies that the clock source is
hardware configured (that is, the source of the
transmit clock is determined by jumpers on the E1
link module). Refer to Installing and Maintaining
BN Routers or Installing and Maintaining ASN
Routers for information on Link Module hardware
configuration.

Select the clocking mode, making certain that the
associated E1 equipment is configured in a
complementary fashion.

1.3.6.1.4.1.18.3.4.11.1.8
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Parameter: Mini Dacs
Default: Idle
Options:  Idle|Data | Voice | Circuit 1| Circuit 2
Function: Assigns each E1 channel to a specific function.
Instructions:  Assign each of the 31 E1 channels as required.

I
Makes the channel idle
D
Assigns the channel to data passthrough (E1
connector to E1 connector)
\'’4
Assigns the channel to voice passthrough (E1
connector to E1 connector)
Circuit 1
Assigns the channel to the first E1 connector
Circuit 2
Assigns the channel to the second E1
connector

MIB Object ID:  1.3.6.1.4.1.18.3.4.11.1.9

Note: 1) The first E1 channel is reserved for signaling. You must
define the remaining 31 channels.

2) Data and voice passthrough require that identical channels
be assigned to data or voice on both E1 connectors. For
example, if the first E1 connector allocates channels 2 through 8
to voice passthrough and channels 9 through 16 to data
passthrough, the second E1 connector must also allocate
channels 2 through 8 to voice and 9 through 16 to data
passthrough.
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3) E1 channels cannot be allocated to both E1 circuits. For
example, if channels 17 through 25 are allocated to circuit 1 on
the first E1 connector, the second E1 connector must make
these channels idle or allocate them to circuit 2.

Editing Ethernet Line Details

If the line you selected to edit is an Ethernet line, the Configuration
Manager now displays the Ethernet Line Entry window (Figure 3-11).

0

|

Configuration Mode: local

SNMP Agent: LOCAL FILE
Enable [ BuaBLE |
BOFL, Enable | ENABLE ;
BOFL Timeout [5 |
Hardware Filter { DISABLE |

Figure 3-11. Ethernet Line Entry Window

Complete the following steps:

1.

Enter or select new values for the Ethernet line detail parameters
you want to edit, referring to the descriptions following this
procedure for guidelines.

Click on the OK button.
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Enable

Enable

Enable | Disable

Enables and disables this Ethernet line.

Set this parameter to either Enable or Disable for
this line.

1.3.6.1.4.1.18.3.4.1.1.2

BOFL (Breath of Life) Enable
Enable
Enable | Disable

When set to Enable, BOFL specifies the sending of
Breath of Life messages from this system to
everyone on the local network. These messages
signify that the Ethernet line is up and
functioning normally.

Set to Enable or Disable, depending on whether
you want this system to issue Breath of Life
messages over this line.

1.3.6.1.4.1.18.3.4.1.1.7

Note: We recommend that BOFL be enabled.
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Parameter:
Default:
Range:

Function:

Instructions:
Instructions:

MIB Object ID:

BOFL Timeout
5 seconds
1 to 60 seconds

Specifies the time between transmissions of
Breath of Life messages from this Ethernet
interface. Timeout will occur if five periods elapse
without a successful frame transmission. When
timeout occurs, the Ethernet interface will be
disabled and re-enabled automatically. For
example, if you set this parameter to 5 seconds,
then the interface must successfully transmit a
frame within 25 seconds. Timeout occurs in 25
seconds.

This parameter is valid only if BOFL Enable is set
to Enable.

Either accept the default BOFL timeout of 5
seconds, or specify a new value.

1.3.6.1.4.1.18.3.4.1.1.8
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Parameter:
Default:

Options:

Function:

Instructions:

MIB Object ID:

Hardware Filter

Disable (the default is changed to Enable when
you add a circuit and reply OK to the prompt bo
you want to enable Hardware Filters on this
circuit?)

Enable | Disable

When this parameter is set to Enable, the Link
Module filtering hardware, if present, does not
allow local frames to be copied into system
memory. In essence, the filtering hardware drops
local frames at the interface. Bridging software
performance is improved because it no longer
requires resources to receive and reject those
frames.

Local frames contain both destination and source
MAC addresses that have been learned on the
interface. The bridge software teaches the
hardware filter which MAC addresses are local to
an interface. To drop a frame, the hardware filter
must have already learned its destination and
source addresses from the bridge software.
Otherwise, the frame is copied into system
memory and processed by the bridge software.

Set to Enable only if the bridge is enabled and the
Link Module is supplied with hardware filters.

1.3.6.1.4.1.18.3.4.1.1.29

3-23



Editing FDDI Line Details

Editing FDDI Line Details

If the line you selected to edit is an FDDI line, the Configuration
Manager displays the FDDI Line Entry window (Figure 3-12).

Configuration Mode: local
SNMP Agent: LOCAL FILE

Enable

BOFL Enable
BOFL Timeout
Hardware Filter

Figure 3-12. FDDI Line Entry Window

Complete the following steps:

1. Enter or select new values for the FDDI line detail parameters you
want to edit, referring to the descriptions following this procedure
for guidelines.

2. Either click on the OK button, or, if you want to edit FDDI
Advanced Attributes, click on the Expert button.
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Parameter:
Default:
Options:

Function:
Instructions:

MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:

Instructions:
MIB Object ID:

Note:

Enable
Enable
Enable | Disable

Enables or disables the FDDI circuit for the
selected connector.

Set to Disable if you want to disable the FDDI
circuit for the selected connector.

1.3.6.1.4.1.18.3.4.4.1.2

BOFL Enable

Enable

Enable | Disable

Enables or disables Breath of Life polling.

When set to Enable, this parameter disables the
LLC interface if the FDDI becomes non-
operational (the link is unavailable), and if the
LLC Data Enable parameter is set to Enable and
the BOFL timer has expired (see “Editing the
FDDI MAC Attributes”).

When set to Disable, this parameter terminates
the LLC interface immediately after the link
becomes unavailable.

Accept the default, Enable, or set to Disable.
1.3.6.1.4.1.18.3.4.4.1.7

We recommend that you enable BOFL.
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Parameter:
Default:
Range:
Function:

Instructions:

MIB Object ID:

BOFL Timeout
3 seconds
0 to 3600 seconds

Specifies the value (in seconds) of the BOFL timer
if BOFL is enabled and the link becomes
unavailable.

Either accept the default value, 3 seconds, or
specify a new value.

1.3.6.1.4.1.18.3.4.4.1.8

Note: This parameter is valid only if BOFL Enable is set to Enable.
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Parameter:
Default:

Options:

Function:

Instructions:

MIB Object ID:

Hardware Filter

Disable (the default is changed to Enable when
you add a circuit and reply OK to the prompt po
you want to enable Hardware Filters on this
circuit?)

Enable | Disable

When this parameter is set to Enable, the Link
Module filtering hardware, if present, does not
allow local frames to be copied into system
memory. In essence, the filtering hardware drops
local frames at the interface. Bridging software
performance is improved because it no longer
requires resources to receive and reject those
frames.

Local frames contain both destination and source
MAC addresses that have been learned on the
interface. The bridge software teaches the
hardware filter which MAC addresses are local to
an interface. To drop a frame, the hardware filter
must have already learned its destination and
source addresses from the bridge software.
Otherwise, the frame is copied into system
memory and processed by the bridge software.

Set to Enable only if the bridge is enabled and the
Link Module is supplied with hardware filters.

1.3.6.1.4.1.18.3.4.4.1.36
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Editing FDDI Advanced Attributes

To edit the SMT, MAC, Path, or Port Attributes, click on the Expert
button in the FDDI Line Entry window (Figure 3-12). The
Configuration Manager displays the FDDI Advanced Attributes
window (Figure 3-13). Follow the instructions in the subsequent
sections: “Editing the FDDI SMT Attributes,” “Editing the FDDI MAC
Attributes,” “Editing the FDDI Path Attributes,” or “Editing the FDDI
Port Attributes.”

L]

[®] fddiexpt

FDDI Advanced 8ttributes:

ISMT Attributes...| {Path Attributes... |

IMAC Attributes,..| |Port Attributes...|

Figure 3-13. FDDI Advanced Attributes Window

Note: Changing any of the FDDI Advanced Attributes parameters will
affect the operation of your FDDI network. You should
understand how each of these parameters can be used to
improve network performance before you modify any of them.

Editing the FDDI SMT Attributes

To edit the SMT attributes, complete the following steps:

1. Click on the SMT Attributes button in the FDDI Advanced
Attributes window (Fiigure 3-13).

The Configuration Manager displays the FDDI SMT Attributes
window (Figure 3-14).
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[® FDDI SMT Attributes
Cancel
Configuration Mode: local
SNMP Agent: LOCAL FILE
Connection Policy |Ixff65 } ?
T _Notify Timeout (s) |22 ;
Trace Max Expiration (ms) |7000 }
Status Report Protocol |ENABLE f
Duplicate Address Protocol [ ENABLE |
User Data | [

Figure 3-14. FDDI SMT Attributes Window

2. Enter or select new values for the FDDI SMT parameters you want
to edit, referring to the descriptions following this procedure for
guidelines.

3. Click on the OK button.
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Parameter:
Default:
Range:
Function:

Connection Policy
0xff65
0x0 to Oxffff

Provides a hexadecimal equivalent of a 16-bit
status word that specifies the connection policies
requested at the FDDI station.

A station sets the corresponding policy for each of
the connection types that it wants to reject. The
policy descriptor takes the form “rejectX-Y” where
X denotes the physical connection (PC) type of the
local port, and Y denotes the PC type of the
neighbor port.

X and Y can take the following values:

A
Indicates that the port is a dual-attachment
station or concentrator that attaches to the
primary IN and the secondary OUT when
attaching to the dual FDDI ring

Indicates that the port is a dual-attachment
station or concentrator that attaches to the
secondary IN and the primary OUT when
attaching to the dual FDDI ring

Indicates a port in a single-attachment station
or concentrator

Indicates a port in a concentrator that serves
as a master to a connected station or
concentrator
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Instructions:

Instructions:

MIB Object ID:

The value of the status word is a sum that initially
takes the value zero (all bits set to 0); then for
each of the connection policies you want the node
to reject, you add 2 raised to a power to the sum.
This is equivalent to setting a bit to 1 for each
policy that you want the node to reject. Table 3-2
lists the powers and the bits. Figure 3-15 shows
the default connection policy.

Set the status word value to reflect local
connection policies.

1.3.6.1.4.1.18.3.4.4.1.30

Note: The setting of a particular connection does not necessarily
mean that the connection will be rejected. The SMT standard
requires that both sides of the connection must agree to reject,
or else both sides must accept the connection. The SMT
standard requires that Bit 15 (rejectM-M) must be set.

Table 3-2.  SMT Connection Policy Values

Poicy | pivumber | P | it Number
rejectA-A 0 rejectS-A 8
rejectA-B 1 rejectS-B 9
rejectA-S 2 rejectS-S 10
rejectA-M 3 rejectS-M 11
rejectB-A 4 rejectM-A 12
rejectB-B 5 rejectM-B 13
rejectB-S 6 rejectM-S 14
rejectB-M 7 rejectM-M 15
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Bit 15

Bit 0

o/1]/1]/0|0|1]|0]|1|<4— Represents Oxff65

I__> Accept A-B
l____> Accept A-M

Accépt B-A

- Accept B-M

Figure 3-15. Connection Policy Status Word

Parameter:
Default:
Range:
Function:

Instructions:

Instructions:

MIB Object ID:

T_Notify Timeout
22 (seconds)
2 to 30 seconds

Specifies the interval between successful
iterations of the Neighbor Notification Protocol.

The Neighbor Notification protocol 1) determines
the MAC address of the FDDI upstream and
downstream neighbor, 2) detects duplicate MAC
addresses on the ring, and 3) generates periodic
“keep-alive” traffic that verifies the local MAC
transmit and receive paths.

Accept the default value of 22 seconds or specify a
new value.

1.3.6.1.4.1.18.3.4.4.1.31
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Parameter:
Default:
Range:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Trace Max Expiration (ms)
7000 milliseconds (7 seconds)
6001 to 256000 milliseconds

The maximum propagation time for a trace on an
FDDI topology. The value is stored in
milliseconds.

Enter a value between 6001 and 256000. We
recommend using the default value of 7000
milliseconds.

1.3.6.1.4.1.18.3.4.15.1.3.1.15

Status Report Protocol
Enable
Enable | Disable

Specifies whether the node will generate Status
Report Frames (SRF) for its implemented events
(for example, high bit errors, topology changes,
trace status events, MAC frame error condition,
port LER condition, and MAC duplicate address
condition).

Accept the default, Enable, if you want the node to
generate SRF's; specify Disable if you do not want
the node to generate SRFs. We recommend using
the default, Enable, to ensure that your FDDI
network is ANSI compliant.

1.3.6.1.4.1.18.3.4.15.1.3.1.14
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Range:

Function:

Instructions:
MIB Object ID:

Editing the FDDI MAC Attributes

Duplicate Address Protocol
Enable
Enable | Disable

Implements an optional ANSI duplicate address
test involving periodic transmission of NSA NIF
frames addressed to the source.

Accept the default, Enable, if you want the
duplicate address test implemented. Specify
Disabled if you do not want the duplicate address
test implemented.

1.3.6.1.4.1.18.3.4.15.1.3.1.18

User Data
None
1 to 32 alphanumeric characters

Allows you to enter additional information about
the router. This information gets attached to the
SIF frames.

Enter up to 32 alphanumeric characters.
1.3.6.1.4.1.18.3.4.15.1.3.1.8

To edit the MAC attributes, complete the following steps:

1. Click on the MAC Attributes button in the FDDI Advanced
Attributes window (Figure 3-13).

The Configuration Manager displays the FDDI MAC Attributes
window (Figure 3-16).
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[@ FDDI MAC Attributes

LLC Data Enable

Configuration Mode: local
SNYP Agent: LOCAL FILE
Help.

[Buate 118

Figure 3-16. FDDI MAC Attributes Window

2. Enter or select new values for the FDDI MAC parameter, referring
to the description following this procedure for guidelines.

3. Click on the OK button.

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

LLC Data Enable
Enable
Enable | Disable

Specifies whether the MAC is available for the
transmission and reception of Logical Link
Control (LLC) Protocol Data Units (PDUs). If you
accept the default, Enable, the interface to the
MAC entity will be available for the exchange of
PDUs between the MAC and the local LLC entity
when the ring becomes operational. Setting this
attribute has no effect on the transfer and
reception of the MAC or SMT frame types.

Accept the default, Enable, if you want the MAC
available for transmitting and receiving LL.C
PDUs; specify Disable if you do not want the MAC
available for transmitting and receiving LL.C
PDUs.

13.6.1.4.1.18.3.4.15.2.3.1.17
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Editing the FDDI Path Attributes

To edit the path attributes, complete the following steps:

1. Click on the Path Attributes button in the FDDI Advanced
Attributes window (Figure 3-13).

The Configuration Manager displays the FDDI Path Attributes
window (Figure 3-17).

[®] FDDI Path Attributes
Configuration Mode: local
SNMP Agent: LOCAL FILE
Tux Lower Bound (ms) IB.E) E .
T_Max Lower Bound (ms) |165 ] |
Requested TTRT (us) [ 165 -

Figure 3-17. FDDI Path Attributes Window

2. Enter or select new values for the FDDI Path parameters you want
to edit, referring to the descriptions following this procedure for
guidelines.

3. Click on the OK button.
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Parameter: Tvx Lower Bound (ms)
Default: 2.5 milliseconds
Range: Variable. The value must be greater than zero and
less than the value of Requested TTRT (ms) and
less than or equal to 5.2 milliseconds, whichever
value is lower. For example, if the value of
Requested TTRT (ms) is 165 milliseconds, the
value for Tvx Lower Bound (ms) must be less than
or equal to 5.2 milliseconds (Figure 3-18).
Function:  Allows you to specify the minimum time value of
the Valid Transmission Timer (Tvx).
Instructions:  Accept the default value of 2.5 ms or specify a new
value in milliseconds.
MIB Object ID:  1.3.6.1.4.1.18.3.4.15.3.3.1.5
Tvx Lower Requested
Bound TTRT
¢
= -
0ms 5.2 ms 165 ms

Figure 3-18. Example of Range of Values for Tvx Lower Bound
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Parameter: T _Max Lower Bound (ms)
Default: 165 milliseconds
Range: 10 to 1336.9344 milliseconds
Function: Allows you to specify the maximum time value of
TTRT. The value must be greater than or equal to
10 ms, greater than or equal to the value of the
requested TTRT, and less than or equal to
1336.9344 milliseconds (Figure 3-19).
Instructions:  Accept the default value of 165 milliseconds or
specify a new value in milliseconds.
MIB Object ID:  1.3.6.1.4.1.18.3.4.15.3.3.1.6
Requested T_Max Lower
TTRT Bound
| | -
| | |
10ms 165 ms 1336.9344 ms

Figure 3-19. Example of Range of Values for T_Max Lower Bound
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Parameter: Requested TTRT (ms)
Default: 165 milliseconds
Range: Variable. This value must be greater than the
value specified for Tvx Lower Bound (ms) and less
than or equal to the value specified for T Max
Lower Bound (ms) (Figure 3-20).
Function:  Specifies the target token rotation time carried in
claim frames issued by the FDDI station.
Instructions:  Accept the default of 165 milliseconds or enter a
new value in milliseconds.
MIB Object ID:  1.3.6.1.4.1.18.3.4.4.1.32
Tvx Lower Requested T_Max Lower
Bound TTRT Bound
l | < | |
l | | |
Oms 1336.9344 ms

Figure 3-20. Example of Range of Values for Requested TTRT

Editing the FDDI Port Attributes

To edit the port attributes, complete the following steps:

1. Click on the Port Attributes button in the FDDI Advanced
Attributes window (Figure 3-13).

The Configuration Manager displays the FDDI Port Attributes
window (Figure 3-21).
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[®] FDDI Port Attributes
Port &
Help...
1]
o S *>
LER Cutoff 8 | l
LER Alarm B 1k

Figure 3-21. FDDI Port Attributes Window

2. Select the port you want to configure (A or B).

3. Enter or select new values for the FDDI Port parameters you want
to edit, referring to the descriptions following this procedure for
guidelines.

4. Click on the Apply button to save your changes.
Repeat Steps 1 through 4 to configure the other port if you wish.

5. Click on the Done button to return to the FDDI Advanced
Attributes window (Figure 3-13)
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Parameter:
Default:
Range:
Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Range:
Function:

Instructions:

MIB Object ID:

Editing HSSI Line Details

LER Cutoff
7
4to15

Specifies the link error rate estimate at which a
link connection is broken. It ranges from 10 to
10715 and is reported as the absolute value of the
base 10 logarithm.

Accept the default value of 7 or specify a new
value.

1.3.6.1.4.1.18.3.4.15.4.3.1.17

LER Alarm
8
4to 15

Specifies the link error rate estimate at which a
link connection %enerates an alarm. It ranges
from 10" to 10'1° and is reported as the absolute
value of the base 10 logarithm of the estimate.

Accept the default value of 8 or specify a new
value.

1.3.6.1.4.1.18.3.4.15.4.3.1.18

If the line you select to edit is a high-speed serial interface line, the
Configuration Manager displays the HSSI Line Entry window

(Figure 3-22).
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0]
Configuration Mode: local
SNMP Agent: LOCAL FILE
Enable [ BuaBLE il
BOFL | ENRBLE |
BOFL Frequency ll f
MIU 4495 |
WAN Protocol [ STANDARD |
Transmission Interface IDSS i
External Clock Speed [ 46359642 |
CRC Size [32 BT I

Figure 3-22. HSSI Line Entry Window

Complete the following steps:

1.

Enter or select new values for the HSSI line detail parameters you
want to edit.
Refer to the descriptions following this procedure for guidelines.
Click on the OK button.
Parameter: Enable
Default: Enable
Options:  Enable | Disable
Function: Enables or disables this HSSI line.
Instructions:  Set this parameter to either Enable or Disable for
this line.
MIB Object ID:  1.3.6.1.4.1.18.3.4.7.1.2
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

BOFL
Enable
Enable | Disable

Enables the transmission of proprietary
Ethernet-encapsulated Breath of Life messages
over a point-to-point connection between the local
router and a remote peer.

The exchange of BOFL messages provides a level
of confidence in the point-to-point connection.
With BOFL enabled, the router sends periodic
keep-alive messages to the remote peer.

Set to Enable or Disable, depending on whether
you want to transmit BOFL messages over this
HSSI interface. If you enable BOFL locally, the
remote peer must also be configured to enable
BOFL Frequency.

1.3.6.1.4.1.18.3.4.7.1.7

Note: We recommend that you enable BOFL for point-to-point
connections between Wellfleet peers. However, if such a
connection is accomplished through a wide-area transport
service such as Frame Relay or SMDS, BOFL must be disabled.
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Parameter:
Default:
Range:
Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Range:
Function:

Instructions:

MIB Object ID:

BOFL Frequency
1 (second)
1 to 60 seconds

Specifies the interval in seconds between BOFL
transmissions. This parameter is valid only if
BOFL is set to Enable.

After sending a BOFL message, the router starts
a timer that has a value equal to 5 times the
setting of BOFL Frequency. If a BOFL message is
not received from the remote peer before the
expiration of the timer, the router takes the HSSI
circuit down, and then attempts to restart it.

Either accept the default, 1 second, or specify a
new value, making certain that both ends of the
point-to-point connection are configured with the
same value.

1.3.6.1.4.1.18.3.4.7.1.8

MTU (Maximum Transfer Unit)
4608 bytes
3 to 4608 bytes

Specifies the buffer size for the HSSI port and, by
extension, the largest frame that can be
transmitted or received across the HSSI port.

Set this parameter to a value appropriate for your
network.

1.3.6.1.4.1.18.3.4.7.1.9
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Note:

Parameter:
Default:
Options:

Function:
Instructions:

MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

WAN Protocol
None
Standard | PassThru | PPP | SMDS | Frame Relay

Indicates which WAN protocol has been enabled
on this HSSI circuit.

Accept the current value.
1.3.6.1.4.1.18.3.4.7.1.12

Transmission Interface
DS3
DS1 | DS3

When SMDS or Frame Relay is configured on this
HSSI circuit, specifies whether the local
management interface (LMI) employs a DS1 MIB
(specified by RFC 1232) or a DS3 MIB (specified
by RFC 1233).

Select on the basis of the carrier services (DS1 at
1.54 MB/s or DS3 at 44.736 MB/s) provided by the
attached DCE device.

1.3.6.1.4.1.18.3.4.7.1.13

This parameter is meaningful only when SMDS or Frame Relay

is configured across the HSSI interface and when LMI is
enabled. The HSSI driver provides no support for either the
DS1 or DS3 MIB. Rather, the external DCE (for example, a
DL3200 SMDS CSU/DSU from Digital Link) may provide MIB
support. In instances where Frame Relay or SMDS and LMI are
configured across the HSSI interface, this parameter specifies
the appropriate MIB for use by the LMI.
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Parameter:
Default:
Range:
Function:

Instructions:

MIB Object ID:

External Clock Speed
46359642 (44.736 MB/s)
307200 to 52638515

Specifies the bandwidth provided by the HSSI
channel.

Set the parameter to a value that equals or
approximates the data transmission rate across
the HSSI.

1.3.6.1.4.1.18.3.4.7.1.14

Note: The HSSI specification requires that the DCE provide a
transmit clock that times data transfer across the DTE/DCE
interface. The value you set for External Clock Speed does not
actually affect hardware initialization. It is used by some
routing protocol software for route selection.

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

CRC Size

32-bit

16-bit | 32-bit

Specifies an error detection scheme. You may

choose either 16-bit (standard CCITT) or 32-bit
(extended) to detect errors in the packet.

Set this parameter to either 16-bit or 32-bit,
making certain that the remote end of the HSSI
connection is configured for the same value.

1.3.6.1.4.1.18.3.4.7.1.15

Editing Synchronous Line Details

If the line you want to edit is a synchronous line, the Configuration
Manager now displays the Edit SYNC Parameters window

(Figure 3-23).




Customizing Line Services

Edit SYNC Parameters

Configuration Mode: local
SNMP Agent: LOCAL FILE

Enable

BOFL

BOFL Timeout

MIU

Promiscuous

Clock Source
Internal Clock Speed
External Clock Speed
Signal Mode

RIS Enable

| ENABLE |
[ ENaBLE |
E 1
[ 1600 j
[ DISaBLE |
{ BXTERNAL |
L~ |
[64102 1l
| BALANCED |
[ DISaBLE |

Figure 3-23. Edit SYNC Parameters Window

Complete the following steps:

1. Enter or select new values for the line detail parameters you want

to edit.

Refer to the descriptions following this procedure for guidelines.

2. Click on the OK button.

On Wellfleet AN or ASN routers, if you selected a connector and
configured it for the X.25 protocol, you can select the LAPB button to
edit the Link Access Procedure Balanced protocol parameters. The
LAPB button only appears if you selected X.25 from the WAN Protocols
Window (Figure 2-4). For detailed information on the LAPB
parameters, refer to the section “Link Access Procedure Balanced

Protocol.”
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Parameter:

Default:
Options:
Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Note:

Enable

Enable

Enable | Disable

Enables and disables this synchronous line.

Set this parameter to either Enable or Disable for
this line.

1.3.6.1.4.1.18.3.4.5.1.2

BOFL
Enable
Enable | Disable

BOFL enables the transmission of proprietary
Breath of Life messages over a point-to-point
connection between the local router and a remote
peer.

The exchange of BOFL messages provides a level
of confidence in the point-to-point connection.
With BOFL enabled, the router sends periodic
keep-alive messages to the remote peer.

Set to Enable or Disable, depending on whether
you want to transmit BOFL messages over this
synchronous interface. If you enable BOFL
locally, the remote peer must also be configured to
enable BOFL.

1.3.6.1.4.1.18.3.4.5.1.7

We recommend that you enable BOFL for point-to-point

connections between Wellfleet peers. However, if such a
connection is accomplished through a wide-area transport
service such as Frame Relay, X.25 or SMDS, BOFL must be

disabled.
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Parameter:

Default:
Range:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Range:

Function:

Instructions:

MIB Object ID:

BOFL Timeout
5 seconds
1 to 60 seconds

Specifies the time between transmissions of
Breath of Life messages from this synchronous
interface. Timeout will occur if five periods elapse
without both a successful frame transmission and
a successful reception. When timeout occurs, the
synchronous line will be disabled and re-enabled
automatically.

For example, if you set this parameter to 5
seconds, then the interface must successfully
transmit and receive a frame within 25 seconds.
Timeout occurs in 25 seconds.

This parameter is valid only if BOFL is set to
Enable.

Either accept the default, 5 seconds, or specify a
new value.

1.3.6.1.4.1.18.3.4.5.1.8

MTU (Maximum Transfer Unit)
1600 bytes
3 to 4608 bytes

Specifies the largest amount of data that can be
transferred across this network in one frame.

Set this parameter to a value appropriate for your
network. For X.25, MTU should be at least 5 bytes
more than the maximum packet size for the
packet level.

1.3.6.1.4.1.18.3.4.5.1.9
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Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Promiscuous
Disable
Enable | Disable

Specifies whether address filtering based on the
local and remote address is enabled. If you set this
parameter to Enable, all frames are received. If
you set this parameter to Disable, only frames
destined for this local address are received.

Set this parameter to Enable or Disable.
1.3.6.1.4.1.18.34.5.1.11

Clock Source
External
External | Internal

Specifies the origin of the synchronous timing
signals. If you set this parameter to Internal, this
router supplies the required timing signals. If you
set this parameter to External, an external
network device supplies the required timing
signals. In most cases, this parameter should be
set to External.

Set this parameter to either Internal or External,
as appropriate for your network.

1.3.6.1.4.1.18.3.4.5.1.13
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Internal Clock Speed
64 KB

1200 B | 2400 B| 4800 B | 7200 B|9600 B|
19200 B | 32000 B| 38400 B |56 KB |64 KB |
125 KB| 230 KB| 420 KB| 625 KB|833 KB|
1.25 MB|2.5 MB |5 MB

Sets the clock speed of an internally supplied clock
when the Clock Source parameter is set to
Internal.

Click on Values and set the clock speed for the
internal clock to the desired data transmission
rate across the synchronous line. Depending on
the protocols configured on this interface, this
value may control internal decision making
within the router. In some cases, the router uses
this value for route selection. If protocol
prioritization is configured, the router uses this
parameter to calculate line delay (refer to
Configuring Filter Options on Wellfleet Routers for
information about protocol prioritization, latency,
and queue depth).

The Internal Clock Speed parameter is non-
settable when the Clock Source parameter is set
to External.

1.3.6.1.4.1.18.3.4.5.1.14
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Parameter:
Default:
Range:

Function:

Instructions:

MIB Object ID:

IExternal Clock Speed
64102
1200 to 6000000 bits per second

Sets the clock speed of an externally supplied
clock when the Clock Source parameter is set to
External.

Set the clock speed for the external clock to the
data transmission rate that most closely
corresponds to the speed of the external clock.
Depending on the protocols configured on this
interface, this value may control internal decision
making within the router. In some cases, the
router uses this value for route selection. If
protocol prioritization is configured, the router
uses this parameter to calculate line delay (refer
to Configuring Filter Options on Wellfleet Routers
for information about protocol prioritization,
latency, and queue depth).

The External Clock Speed parameter is non-
settable when the Clock Source parameter is set
to Internal.

1.3.6.1.4.1.18.3.4.5.1.93
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Signal Mode
Balanced
Balanced | Unbalanced

Specifies balanced or unbalanced transmission.
Balanced transmission uses two conductors to
carry signals; unbalanced uses one conductor to
carry a signal, with a ground providing the return
path.

Set this parameter to either Balanced or
Unbalanced, based on the signaling mode of the
connected device.

1.3.6.1.4.1.18.3.4.5.1.15

RTS Enable
Disable
Enable | Disable

Enables or disables the detection of RTS signals
on this interface.

Set this parameter to Enable if the connected
device (for example, a modem) uses RTS/CTS flow
control.

1.3.6.1.4.1.18.3.4.5.1.16
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Parameter: Burst Count

Default: Enable
Options:  Enable | Disable

Function:  Specifies single or multiple DMA burst cycles. If
you set this parameter to Enable, the chip
performs eight-word bursts. If you set this
parameter to Disable, single-word cycles are
performed.

Instructions:  Set this parameter to Enable to perform eight-

word bursts. Set this parameter to Disable to
perform single-word bursts.

MIB Object ID:  1.3.6.1.4.1.18.3.4.5.1.17

Note:

Burst Count is a performance-tuning parameter. It should be
enabled except in certain cases with DSDE (5430 - Dual Sync,
Dual Enet) and DSE (5420 - Dual Sync, Single Enet) Link
Modules. It should be disabled if excessive TxUflo or RxOflo
errors occur on the Ethernet ports. If both SYNC ports are
configured, Burst Count should be disabled first on the SYNC
interface that is either running at a lower clock speed or carries
lower priority traffic.

The only configurations for which both SYNC interfaces should
have Burst Count disabled are DSDE configurations with both
Ethernet interfaces configured. In these configurations, both
SYNC interfaces should have Burst Count disabled if disabling
Burst Count on only one interface does not eliminate the
excessive TxUflo or RxOflo errors on the two Ethernet
interfaces.
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Range:

Function:
Instructions:

MIB Object ID:

Service
LLC1
Transparent | LLC1 | LAPB

Specifies the link-level protocol for this circuit. If
you set this parameter to Transparent, then raw
HDLC (high-level datalink control) mode is in
effect. LLC1 specifies connectionless datagram
service; it prefixes the HDLC address and control
fields to the frame.

Set this parameter as appropriate for this circuit.
If X.25 is enabled on this line, you must set this
parameter to LAPB.

1.3.6.1.4.1.18.3.4.5.1.18

Transmit Window Size
1
1to7

Controls the number of I frames that can be
transmitted without acknowledgment.

Either accept the default value, or enter a new
value.

1.3.6.1.4.1.18.3.4.5.1.27
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Parameter:
Default:
Range:

Function:
Instructions:

MIB Object ID:

Point-to-Point Address

Minimum Frame Spacing
1 (flag)
1 to 32 flags

Specifies the number of flags that are transmitted
between adjacent frames.

Set this parameter to the appropriate number of
flags.

1.3.6.1.4.1.18.3.4.5.1.29

According to convention, one end of a point-to-point circuit is
designated DCE and is assigned an address of 01; the other end of the
circuit is designated DTE and is assigned an address of 03.

Conventional addressing, however, is inadequate in the case of
multiple communication channels enabled by a common satellite link
(Figure 3-24). As shown, a common satellite relay-link provides a
virtual point-to-point link between routers A and X, B and Y, and

C and Z.
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A |=-——m A —p | X
Virtual

B |<€— Circuits —» | Y

C |+ —> | Z

Figure 3-24. Satellite Broadcast (Sample Topology)

The worst-case scenario consists of routers A, B, and C being
designated as DCE (address = 01), and routers X, Y, and Z being
designated as DTE (address = 03). If A transmits a frame across the
virtual point-to-point circuit to X, the satellite broadcast is monitored
not only by X (the intended recipient), but also by Y and Z. Because X,
Y, and Z all perceive a properly addressed frame, all three accept
delivery and attempt to process the frame contents, with unpredictable
results.

You can avoid such confusion by assigning unique addresses to each
end of a point-to-point circuit. If you set unique addresses for Local
Address and Remote Address, you must then also specify an address
for each end of the circuit. Make sure to reverse the local and remote
address when you configure the other end of the point-to-point circuit.
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Parameter:
Default:
Range:

Function:

Instructions:

MIB Object ID:

Local Address
7
1 to 255

Specifies the 1-byte HDLC address of this
synchronous interface. When you address data
sent to this interface, use this HDLC address.

Set this parameter to the local HDLC address you
want. Enter 1 for a DCE and 3 for a DTE. All other
addresses are considered explicit addresses. To
select an Explicit value, enter that value.

Site Manager assumes the values you enter are
decimal. If you want to enter a hexadecimal value,
preface the value with a 0x, for example, 0x10. If
you configure X.25 on this synchronous line, the
local HDLC address must be either 1 (DCE) or

3 (DTE).

1.3.6.1.4.1.18.3.4.5.1.30
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Parameter: Remote Address
Default: 7
Range: 1 to 255

Function:  Specifies the 1-byte HDLC address of the remote
synchronous interface. When you address data
sent from this interface to the remote end
interface, use this HDLC address.

Instructions:  Set this parameter to the HDLC address of the
remote synchronous interface. Enter 1 for a DCE
and 3 for a DTE. All other addresses are
considered explicit addresses. To select any
explicit value, enter the value.

Site Manager assumes the values you enter are
decimal. If you want to enter a hexadecimal value,
preface the value with a 0x, for example, 0x10. If
you configure X.25 on this synchronous line, the
local HDLC address must be either 1 (DCE) or

3 (DTE).

MIB Object ID:  1.3.6.1.4.1.18.3.4.5.1.31

Note: Make certain to reverse local and remote address values when
you configure the device at the other end of the point-to-point
circuit.
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Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Note:

WAN Protocol
None

Standard | Pass Thru | PPP | SMDS | Frame
Relay | X.25 | ATM DXI | LAPB

Indicates which WAN protocol has been enabled
on this synchronous circuit.

Accept the current value.
1.3.6.1.4.1.18.3.4.5.1.34

Pass Thru Local Address
None
Any unique MAC address

Assigns a MAC address to the local interface. This
address becomes the source address of packets
that are bridged to the destination MAC address.
You assign the destination address with Pass
Thru Remote Address.

Enter the unique MAC address that you want to
assign to the local interface.

1.3.6.1.4.1.18.3.4.5.1.32

Make certain to reverse the local and remote MAC addresses at

the remote sync passthrough interface.
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Note:

Pass Thru Remote Address
None
Any unique MAC address

Assigns a MAC address to the remote interface.
This address becomes the source address of
packets that are bridged to the destination MAC
address. You assign the destination address with
Pass Thru Local Address.

Enter a unique MAC address to be assigned to the
remote interface.

1.3.6.1.4.1.18.3.4.5.1.33

Make certain to reverse the local and remote MAC addresses at

the remote sync passthrough interface.

Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

CRC Size
16-bit
16-bit | 32-bit

Specifies an error detection scheme. You can
chose either 16-bit (standard) or 32-bit (extended)
frame check sequence (FCS) to detect errors in the
packet.

Set this parameter to either 16 bit or 32 bit.
1.3.6.1.4.1.18.3.4.5.1.35
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Parameter:
Default:
Options:

Function:
Instructions:

MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Sync Media Type
1

1 (default) |2 (T1)|3 (E1)| 4 (Raise DTR)|
5 (V.25bis)

Specifies the media type.

Set this parameter to 2 for T1 lines, 3 for E1 lines,
4 for Raise DTR, or 5 for V.25bis. Otherwise,
accept the default value of 1.

1.3.6.1.4.1.18.3.4.5.1.54

Sync Polling
Disable
Enable | Disable

Indicates whether the Data Set Ready (DSR)
signal will be monitored. If you set this parameter
to Enable, the sync driver will be enabled when
the DSR is detected. When the DSR is no longer
detected, the driver will be disabled. This
parameter should be enabled only if you will be
using dialup services.

Either accept the default, or set this parameter to
Enable.

1.3.6.1.4.1.18.3.4.5.1.76
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Parameter:
Status:

Parameter:
Status:

Parameter:
Status:

Sync Line Coding
NRZ
NRZ |NRZI|NRZI Mark

This parameter specifies the line coding of the
physical synchronous line. You can change the
value of this parameter to match the line coding of
a device at the other end of the line.

This parameter is relevant only for the AN and
the ASN.

NRZ
Indicates Non-Return to Zero coding

NRZI
Indicates Non-Return to Zero Inverted coding

NRZI Mark
Indicates Non-Return to Zero Inverted Mark
coding.

Select the appropriate value for synchronous line
coding.

1.3.6.1.4.1.18.3.4.5.1.88

BOD Role

Reserved for future use

BOD Exam Period

Reserved for future use

BOD Full Threshold

Reserved for future use
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Parameter: BOD Recover Threshold

Status: Reserved for future use

Parameter: BOD Periods to Fail

Status: Reserved for future use

KG84A Support

Router

KG84A is a cryptographic device used to secure data transmitted over
a point-to-point synchronous line.

Wellfleet KG84A support allows the router to use the encryption
services of a KG84A device. In a KG84A configuration, the KG84A
device is usually placed between the router and a modem. The KG84A
device acts as the DCE for the attached router. Another KG84A device
must be located at the other end of the point-to-point connection so
that encrypted data can be decrypted (Figure 3-25).

| C__J
—] KG84A Modem | __~=<——1 Modem KGS84A

Figure 3-25. KG84A Network Configuration

Loss of Synchronization

The Wellfleet router attaches to the KG84A device via a modified V.35
synchronous cable. The encryption/decryption process is usually
transparent to the router. However, occasionally two KG84A devices
can lose cryptographic synchronization. When this occurs, the modified
cable allows the router to initiate a cryptographic resynchronization.
The modified cable also allows the router to detect and monitor the
local KG84A device resynchronization, whether the resynchronization
is initiated locally or by a remote KG84A device.
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The router detects the loss of synchronization between KG84A devices
by monitoring the number of Frame Check Sequence (FCS) errors and
valid frames received. If the router detects FCS errors, and it does not
receive a valid frame within a configurable amount of time, the router
software requests resynchronization. The router also requests
resynchronization if it determines that the previous resynchronization
request did not complete before a configurable timer expires.

The network administrator can also force a resynchronization of the
local KG84A device by pressing its RESYNC button. The router can
detect this type of remote resynchronization also, and can request a
new resynchronization if one does not complete in the configured time
period.

Configure KG84A support on synchronous lines that connect to KG84A
cryptographic devices.

Note: For the following four parameters to have any meaning, the
RTS Enable parameter must be set to KG84A Enable.

Parameter: KG84A Cycle
Default: 100 ms
Options: 5|10|25]50 100|200 |500

Function: Specifies the length, in milliseconds, of the timer
cycle. This cycle value is used by the timers on the
other KG84A devices on the network. This also
becomes the polling cycle for monitoring FCS
errors.

Instructions:  Accept the default value or select one of the valid
options.

MIB Object ID:  1.3.6.1.4.1.18.3.4.5.1.67
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Note:

KG84A Sync Loss Interval

50 cycles

2|5|10|25|50| 100|200 | 500

Specifies how many cycles the router should wait
after detecting an FCS error to receive a valid

frame before declaring that a loss of
synchronization has occurred.

Accept the default value or select one of the valid
options.

1.3.6.1.4.1.18.3.4.5.1.68

KG84A Remote Resync Wait

200 cycles

2|5|10|25|50| 100|200 |500

This parameter specifies the number of cycles that
the router waits for the remote KG84A to
complete a resynchronization operation, once
synchronization is lost and a remotely initiated
resynchronization has been detected, before the
router software determines that the

resynchronization failed and initiates another
resynchronization.

Configure this parameter with different settings
at each end of the point-to-point link to avoid a
possible race condition.

1.3.6.1.4.1.18.3.4.5.1.69

If the network administrator presses the RESYNC button on

the local KG84A device, the router responds as if it were a
remotely initiated resynchronization.
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Parameter:
Default:
Range:

Function:

Instructions:
MIB Object ID:
Parameter:
Default:

Options:
Function:

Instructions:

MIB Object ID:

KG84A Sync Pulse
10 ms
2 to 4096

The router uses the RTS signal of the V.35
interface, which is wired to the KG84A device’s
SYNC signal via a special cable, to initiate KG84A
resynchronization. This parameter specifies the
number of milliseconds that the SYNC signal
retains its high value.

Accept the default value, or enter one of the valid
options.

1.3.6.1.4.1.18.3.4.5.1.70

Network Link Level
NET2
NET2 | GOSIP ] SYNC_TYPE_C03

Indicates the link-level for this synchronous
point-to-point connection. The default is NET2.
Change this parameter to GOSIP when this
synchronous point-to-point connection is part of a
GOSIP-compliant network (such as DOD).
Change this parameter to SYNC_TYPE_C03
when you are running X.25 on a sync board with
the MK 5025 CO03 chip.

Either accept the default, NET2, or select GOSIP
or SYNC_TYPE_CO03.

1.3.6.1.4.1.18.3.4.5.1.81
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Parameter:

Default:
Range:

Function:
Instructions:
MIB Object ID:
Parameter:
Default:

Range:
Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Retry Count
16 attempts
1 to 64 attempts

Indicates the number of retransmission attempts
allowed per frame before a line is declared down.

Either accept the default, or enter a number
between 1 and 64.

1.3.6.1.4.1.18.3.4.5.1.19

Link Idle Timer
9 seconds
1 to 9999 seconds

Indicates the number of seconds before a line is
determined to be idle. An idle line is disabled.

Either accept the default value of 9 seconds, or
enter a new value between 1 and 9999.

1.3.6.1.4.1.18.3.4.5.1.20

Extended Control (S and I frames)
Disable
Enable | Disable

Allows the control fields of all S and I frames to
become two octets in length instead of one.
Numbering of all I frames becomes module 128
instead of module 8.

Either accept the default, Disable, or set to
Enable.

1.3.6.1.4.1.18.3.4.5.1.24
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Parameter:
Default:
Options:

Function:
Instructions:
MIB Object ID:
Parameter:
Default:

Options:

Function:

Instructions:

MIB Object ID:

Idle RR Frames
off
On | Off

Indicates whether or not a Receiver Ready (RR)
signal is sent when the Link Idle Timer expires.

Either accept the default, Off, or set to On if you
want RRs sent.

1.3.6.1.4.1.18.3.4.5.1.61

Cable Type
Null
Null | RS232 | RS422| V35| X21

This parameter is used only for switched-service
lines. If the sync port is connected to a dialup
device for switch services, use this parameter to
specify the cable interface type of the device.

Set to reflect the cable interface type being used to
connect the dial unit if you are using one.

1.3.6.1.4.1.18.3.4.5.1.83
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Parameter:
Default:
Range:
Function:

Instructions:

MIB Object ID:
Parameter:
Default:

Options:
Function:

Instructions:

MIB Object ID:

Retry Timer
3 seconds
1 to 9999 seconds

Indicates the timeout in seconds for a response to
be heard from the link. Link control frames are
sent at the expiration of this timer value. The
frames will be resent up to the value of Retry
Count, at which time the link will be
disconnected.

Either accept the current value, or enter a new
value.

1.3.6.1.4.1.18.3.4.5.1.21

Extended Address
Disable
Enable | Disable

Controls length determination of the address
field. When this parameter is enabled, the first bit
of the address field will be tested to determine the
length of the address field, in octets.

Either accept the current value, or enter a new
value.

1.3.6.1.4.1.18.3.4.5.1.22
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Parameter: Remote Loopback Detection
Default: Disable
Options: Enable | Disable

Function: Enables or disables Remote Loopback Detection.
IfBOFL is enabled, the device driver detects when
it is receiving its own BOFL packets and disables
the interface assuming that the link has been put
into loopback.

Instructions: Click on Values and select Enable or Disable
MIB Object ID: 1.3.6.1.4.1.18.3.4.5.1.91

Link Access Procedure Balanced Protocol

The LAPB protocol is a version of the HDLC protocol. Wellfleet routers
use the services of LAPB to initialize the link between itself and the
local DCE device, and to frame X.25 data packets before transmitting
them to the DCE. The LAPB information field contains the X.25
packets. Once an X.25 packet reaches the destination router, the LAPB
protocol strips away the LAPB frame and delivers the packet to the
network layer for further processing.

For detailed information on LAPB and X.25, refer to Customizing X.25
Services.

From the Edit Sync Parameters window (Figure 3-23) for an X.25 port
on a Wellfleet AN or ASN router, select the LAPB button to display the
LAPB Edit Parameters window (Figure 3-26).
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@ EEit LAPE Paramcters M

Max T2 Acknowledge Timer (seconds) |0
Max T3 Discomnect Timer (seconds) |60
Initiate Link Setup Action | acTIVE

Configuration Mode: local
SNMP Agent: LOCAL FILE
Enable | BusBLE | n
Station Type IFCE———__——}
Control Field [ MoDULO 8 |
Max N1 Frame Size (octets) [ 256 |
Window Size {7 |
Max N2 Retries [10 |
Max T1 Acknowledge Timer (seconds) |3 |
|
|
|

Figure 3-26. Edit LAPB Parameters Window

Parameter: Enable
Default: Enable
Options:  Enable | Disable
Function:  Globally enables or disables LAPB services.
Instructions:  Select disable to disable LAPB services.
MIB Object ID:  1.3.6.1.4.1.18.3.5.1.8.1.2
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

Station Type
DTE
DTE | DCE | DXE

Identifies the station type, that is, whether the
device is a DTE or DCE, for this interface.

If your device is data terminal equipment, select
DTE. If your device is data communications
equipment, select DCE. If you do not want to
assign a specific station type, and instead, want
the network to determine the station type, choose
DXE. This value indicates that the router is in
unassigned mode; it is neither a DTE nor DCE. If
you select DXE, the router will send an exchange
identification (XID), but negotiation has yet to
take place.

1.3.6.1.4.1.18.3.5.1.8.1.7

Control Field
Modulo 8
Modulo 8 | Modulo 128

Specifies the desired window size, or modulo, of
the sequence numbering the router uses to
number frames.

Select the appropriate size for your configuration.
1.3.6.1.4.1.18.3.5.1.8.1.8
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Parameter:
Default:
Range:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Range:

Function:

Instructions:

MIB Object ID:

Max N1 Frame Size (octets)
1600
3 to 4500

Specifies the frame size, in terms of number of
bytes, for a frame that the router or network
transmits. This number excludes flags and 0 bits
inserted for transparency.

Select the frame size that suits your network
configuration.

1.3.6.1.4.1.18.3.5.1.8.1.9

Window Size
7
1 to 127

Specifies the default transmit and receive window
size for the interface. This value is the maximum
number of unacknowledged sequence frames that
may be outstanding from the router or the
network at any one time.

Enter the appropriate window size for your
configuration.

1.3.6.1.4.1.18.3.5.1.8.1.10
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Parameter:
Default:
Range:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Range:
Function:

Instructions:

MIB Object ID:

Max N2 Retries
10
1 to 64

Determines the value of the N2 retry count, which
is the number of retransmission attempts that the
router tries, per frame, before it considers the line
to be down. The retry count is the maximum

attempts following the expiration of the T1 timer.

Specify the number of times you want the router
to try to retransmit.

1.3.6.1.4.1.18.3.5.1.8.1.11

Max T1 Acknowledge Timer (seconds)
3 seconds
1 to 9999 seconds

Specifies the maximum time, in seconds, that the
router waits for an acknowledgment of a frame
that it has sent to the network.

Enter the amount of time you would like the
router to wait for a frame acknowledgment from
the network.

1.3.6.1.4.1.18.3.5.1.8.1.12
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Parameter: Max T2 Acknowledge Delay Timer (seconds)
Default: 1 second
Range: 1 to 9999 seconds

Function: Specifies the time, in seconds, that the router
waits before sending an acknowledgment for a
sequenced frame. A value of one means that the
router does not delay before generating an
acknowledgment.

Instructions:  Enter the amount of time that you want the router
to wait before acknowledging a frame.

MIB Object ID:  1.3.6.1.4.1.18.3.5.1.8.1.13

Parameter: Max T3 Disconnect Timer (seconds)
Default: 60 seconds
Range: 1 to 9999 seconds

Function: This timer specifies the time, in seconds, that the
router waits before determining that the link is
disconnected. A value of one indicates that once
the router completes the frame exchange to bring
down the link, it considers the link disconnected.

Instructions:  Enter the amount of time that you want the router
to wait before the router decides that the link is
down.

MIB Object ID:  1.3.6.1.4.1.18.3.5.1.8.1.14
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Options:

Function:

InstriJ.ctions:

MIB Object ID:

Initiate Link Setup Action
Active
Active | Passive

Identifies whether or not the router initiates link
setup or waits for the network to initiate.

Enter Active, if you want the router to initiate link
setup or Passive, if you want the network to
initiate link setup.

1.3.6.1.4.1.18.3.5.1.8.1.16

Enable Rx/Tx of XID Frames
Enable
Enable | Disable

Enables or disables the transmission and
reception of test exchange identification (XID)
frames by the router.

Select Enable to allow the router to send XID
frames. Select Disable to prevent the router from
sending XID frames.

1.3.6.1.4.1.18.3.5.1.8.1.17
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Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Idle RR Frames
OFF
ON | OFF

Enables or disables the transmission and receipt
of Receiver Ready (RR) frames during periods
when there are no information frame exchanges.
When ON, an RR is transmitted when no traffic is
present on the physical media.

Click on Values and select ON or OFF.
1.3.6.1.4.1.18.3.5.1.8.1.40

Command/Response Address
DTE
DTE | DCE

Specifies the local command or response address,
which is the DTE or DCE value expressed as a
single octet.

Enter DTE, for the DTE address or DCE, for the
DCE address.

1.3.6.1.4.1.18.3.5.1.8.1.18
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Parameter:
Default:
Options:

Function:
Instructions:

MIB Object ID:

WAN Protocol
Standard
Standard | X.25

Specifies the WAN protocol you want to run on
this interface.

Choose which WAN protocol you want the router
to run.

1.3.6.1.4.1.18.3.5.1.8.1.20

Editing Asynchronous Line Details

If you selected the ASYNC protocol from the WAN Protocols window
(Figure 2-4) for a communications port line on a Wellfleet AN or ASN
router, the Configuration Manager displays the Edit ASYNC
Parameters window (Fiigure 3-27).
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Edit ASYNC Parameters
Configuration Mode: local
SNYP Agent: LOCAL FILE
Enable | BuBLE Iy
MTU [1000 |
Start Protocol [ ANSHER |
Remote IP Addr {0.0.0.0 |
Remote Port |7 f
Local Port [ 2100 |
Baud Rate [9800 |
Idle Tiner 20 |
Receive Window ; |4096 ;
L

TCP Keephlive B

Figure 3-27. Edit ASYNC Parameters Window

Complete the following steps:

1. Enter or select new values for the asynchronous line detail
parameters you want to edit.

Refer to the descriptions following this procedure for guidelines.
2. Click on the OK button.
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Range:

Function:

Instructions:
MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Enable

Enable

Enable | Disable

Enables or disables ASYNC on the router.

Set this parameter to either globally enable or
disable ASYNC.

1.3.6.1.4.1.18.3.4.3.1.2

MTU
1000 bytes
3 to 1580 bytes

Specifies the maximum transfer unit (MTU) size
(in bytes) for the transmission control protocol
(TCP) request buffer size.

Specify a value in the range 3 to 1580.
1.3.6.1.4.1.18.3.4.3.1.7

Start Protocol
Answer
Loop | Originate | Answer

Specifies the start mode for the ASYNC TCP
connection.

Click on Values and select Answer, Loop, or
Originate. Answer makes the local TCP wait for a
connection request. Originate makes the local
TCP initialize a connection to the specified remote
IP address. Loop performs ASYNC cable testing.

1.3.6.1.4.1.18.3.4.3.1.9

3-81



Editing Asynchronous Line Details

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Range:
Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Range:

Function:

Instructions:

MIB Object ID:

Remote IP Address
None

Any valid 32-bit IP address in dotted decimal
notation.

Specifies a remote TCP host to which this router
will communicate using ASYNC. The Remote IP
Address is only used when the Start Protocol
parameter is set Originate.

Enter a valid IP address in dotted decimal
notation.

1.3.6.1.4.1.18.3.4.3.1.26

Remote Port

7

1 to 65535

Specifies a remote port for the TCP connection.

Enter a remote port number. The Remote Port
number is only used when the Start Protocol
parameter is set Originate.

1.3.6.1.4.1.18.3.4.3.1.27

Local Port
2100
1 to 65535

Specifies a local port on the router for ASYNC
communications.

Enter alocal port number. The Local Port number
is only used when the Start Protocol parameter is
set to Answer.

1.3.6.1.4.1.18.3.4.3.1.28
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Range:
Function:
Instructions:
MIB Object ID:

Parameter:
Default:
Range:

Function:

Instructions:
MIB Object ID:

Baud Rate

9600

300 | 1200 | 2400 | 4800| 9600 | 19200
Specifies the ASYNC line speed.

Select the appropriate line speed for this
configuration.

1.3.6.1.4.1.18.3.4.3.1.29

Idle Timer

20

1 to 300 seconds

Specifies the ASYNC idle timer in seconds.
Enter an appropriate idle timer value in seconds.
1.3.6.1.4.1.18.3.4.3.1.30

Receive Window
4096
512 to 65535 bytes

Specifies the size of the TCP receive window for
received ASYNC packets.

Enter a positive value in the range 512 to 65535.
1.3.6.1.4.1.18.3.4.3.1.31
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Parameter:
Default:
Range:

Function:

Instructions:

MIB Object ID:

TCP KeepAlive
8
3 to 180 seconds

Specifies the frequency of keep alive message
transmissions (in seconds) that the local TCP uses
when sending the messages to the remote TCP.

Specify a positive value in the range 3 to 180
seconds. The router uses the TCP KeepAlive
parameter with the TCP Inactive Limit
parameter. When the local TCP sends out a TCP
keep alive message, it expects an
acknowledgment (ACK) from the remote TCP.
The ACK then resets the inactive limit timer.

If the local TCP does not receive the ACK from the
remote TCP before the TCP Inactive Limit
parameter expires, the TCP connection is
disabled. To prevent an error or alarm condition,
set the TCP Inactive Limit with a value that
allows enough time for multiple TCP keep alive
messages.

1.3.6.1.4.1.18.3.4.3.1.35

3-84



Customizing Line Services

Parameter:
Default:
Range:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:

Range:

Function:

Instructions:
MIB Object ID:

TCP Inactive Limit
300
-65536 to 65535 seconds

Specifies the maximum inactivity timer in
seconds. When the inactive limit parameter
expires, the TCP connection between the router
and the remote TCP host is lost. The TCP Inactive
Limit parameter is used with the TCP KeepAlive
parameter setting.

Enter a value in the range -65536 to 65536 or
accept the default value (300). To prevent a TCP
connection loss, set the TCP Inactive Limit with a
value that allows enough time for multiple TCP
keep alive messages and ACKs from the remote
TCP host. Refer to the TCP KeepAlive parameter
for information.

If the port is listening (TCP KeepAlive) for an
incoming connection, you can specify a negative
TCP Inactive Limit value to mark the connection
as inactive and defer resetting the connection
until a connection request is received.

1.3.6.1.4.1.18.3.4.3.1.36

Cfg TxQ Length
None
1 to 255 bytes

Specifies the maximum transmit queue length in
bytes. This parameter reduces the size of the
driver transmit queue if the transmit queue is
larger than this configuration.

Enter a value in the range 1 to 255.
1.3.6.1.4.1.18.3.4.3.1.37
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Parameter: Cfg RxQ Length
Default: None
Range: 1 to 255 bytes

Function:  Specifies the maximum receive queue length in
bytes. This parameter reduces the size of the
driver receive queue if the receive queue is larger

than this configuration.

Instructions:  Enter a value in the range 1 to 255.

MIB Object ID:  1.3.6.1.4.1.18.3.4.3.1.38

Editing T1 Line Details

If the line you selected to edit is a T'1 line, the Configuration Manager
displays the T1 Line Entry window (Figure 3-28).

[® T1 Line Entry

Configuration Mode: local
SNMP Agent: LOCAL FILE
Circuit Name: T1-31
Enable: 4 Enable Frame Type: < D4

< Disable & ESF

BSZS Support: < Enable  Line Buildout:
€ Disable

Clock Mode: € Internal
< Slave
< Manual

Mini Dacs: Woice| [Circuit 1] {Circuit 2|
Currently Selected: Idle
51 ]

o] Cog (o] (2] (5] 6] (5] (€]
O7] [E] 0o ] ] (2] 3] [

| OK ] { Sync Details... | { Cancel

Figure 3-28. T1 Line Entry Window
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Complete the following steps:

1. Enter or select new values for the T1 service parameters you want

to edit, referring to the descriptions following this procedure for

guidelines.

If you want to edit synchronous line parameters, click on the Sync
Details button. Refer to the section “Editing Synchronous Line
Details” in this chapter for details.

3. Click on the OK button.

Parameter: Enable
Default: Enable
Options:  Enable | Disable
Function: Enables or disables the T1 line.
Instructions:  Set to Disable if you want to disable the T1 line.
MIB Object ID:  1.3.6.1.4.1.18.3.4.10.1.2
Parameter: Frame Type
Default: ESF
Options: ESF|D4
Function: Selects either ESF (extended super frame) or D4
framing format. D4 transmits super frames
consisting of 12 individual super frames. ESF, in
contrast, transmits super frames consisting of 24
individual D4 frames and provides enhanced
signaling and synchronization.
Instructions: Select ESF or D4, based on the frame format
required by the associated T1 equipment.
MIB Object ID:  1.3.6.1.4.1.18.3.4.10.1.7
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Parameter:
Default:

Options:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Range:
Function:

Instructions:

MIB Object ID:

B8ZS Support
Disable
Disable | Enable

Enables or disables Binary 8 Zeros Suppression (a
mechanism to maintain sufficient ones-density
within the T1 data stream).

Enable or disable, based on the ability of the
associated T1 equipment to support B8ZS.

1.3.6.1.4.1.18.3.4.10.1.9

Line Buildout

1 foot

1 to 655 feet

Conditions router signals to mitigate attenuation.

Because signal attenuation correlates with the
physical length of the T1 line, enter the
approximate length of the cable connecting the
router and the associated T1 equipment.

1.3.6.1.4.1.18.3.4.10.1.8
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Clock Mode

Internal

Internal | Slave | Manual

Specifies the source of the T1 transmit clock.

Internal specifies that the T1 transmit clock is
internally generated; Slave specifies that the T1
transmit clock is externally generated (that is, the
transmit clock is derived from the incoming data
stream); Manual specifies that the clock source is
hardware configured (that is, the source of the
transmit clock is determined by jumpers on the T1
link module).

Select the clocking mode, making certain that the
associated T1 equipment is configured in a
complementary fashion.

Refer to Installing and Maintaining BN Routers
for information on Link Module hardware
configuration.

1.3.6.1.4.1.18.3.4.10.1.10
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MIB Object ID:

Note:

Parameter:
Default:
Options:

Function:

Instructions:

Mini Dacs

Idle

Idle | Data | Voice | Circuit 1 | Circuit 2

Assigns each T1 channel to a specific function.
Assign each of the 24 DS1 channels as required.

I
Makes the channel idle

D
Assigns the channel to data passthrough (T1
connector to T1 connector)

Assigns the channel to voice passthrough (T'1
connector to T1 connector)

Circuit 1
Assigns the channel to the first T1 circuit

Circuit 2
Assigns the channel to the second T1 circuit

1.3.6.1.4.1.18.3.4.10.1.11

1) Data and voice passthrough require that identical channels
be assigned to data or voice on both T'1 connectors. For example,
if the first T1 connector allocates channels 1 through 8 to voice
passthrough and channels 9 through 16 to data passthrough,
the second T1 connector must also allocate channels 1 through
8 to voice and 9 through 16 to data passthrough.

2) T1 channels cannot be allocated to both T1 circuits. If
channels 17 through 24 are allocated to circuit 1 on the first T1
connector, the second T1 connector must make these channels
idle or allocate them to circuit 2.
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Editing Token Ring Line Details

If the line you select to edit is a Token Ring line, the Configuration
Manager displays the Token Ring Line Entry window (Figure 3-29).

(@]
Configuration Mode: local
SNMP Agent: LOCAL FILE

Enable ( ENeBLE

MAC Address Override IA i ’

MAC Address Select

Speed
Early Token Release [ ENGBLE |

Figure 3-29. Token Ring Line Entry Window
Complete the following steps:

1. Enter or select new values for the Token Ring parameters you want
to edit, referring to the descriptions following this procedure for
guidelines.

2. Click on the OK button.
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Parameter:

Default:
Options:
Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Note:

Enable

Enable

Enable | Disable

Enables or disables the Token Ring circuit.

Set to Disable if you want to disable the Token
Ring circuit.

1.3.6.1.4.1.18.3.4.2.1.2

MAC Address Override
None
Any valid 48-bit MAC level address

Enables the assignment of a user-specified MAC
address.

If you want to specify a MAC level address (for
example, to avoid host number conflicts on a
directly connected IPX or XN'S network), enter the
48-bit MAC address in MSB format. For example,
enter 0x followed by twelve hexadecimal digits.

If you want the router to generate a MAC level
address for this Token Ring interface, ignore this
parameter.

1.3.6.1.4.1.18.3.4.2.1.9

If you enter a MAC address at MAC Address Override, you

must set MAC Address Select to CNFG.
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Note:

MAC Address Select

PROM

BOXWIDE | PROM | CNFG

Determines the source of the MAC address.

Enter BOXWIDE if you want the Token Ring
interface to use a MAC address generated
automatically from the router’s serial number.

Enter PROM if you want the Token Ring interface
to use a MAC address read from programmable
read-only memory on the Token Ring link module.

Enter CNFG if you explicitly assigned a MAC
address at the MAC Address Override parameter.

1.3.6.1.4.1.18.3.4.2.1.10

Speed

16 MB/s

16 MB/s |4 MB/s

Specifies the speed of the Token Ring media.
Enter the ring speed.
1.3.6.1.4.1.18.3.4.2.1.11

If you select 16 MB/s, the router enables the Early Token

Release protocol, which is used extensively on 16 MB/s media.
In the unlikely event that you want to disable Early Token
Release over 16MB/s Token media, you can do so through the
Early Token Release parameter.
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Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

Early Token Release
Enable
Enable | Disable

Indicates whether the token can be released back
onto the ring before all data is copied by the
recipient. This parameter is enabled only when
Speed is set to 16 MB/s.

Accept the current value.
1.3.6.1.4.1.18.3.4.2.1.12

Editing ATM FRE2 Line Details

If you select an ATM FREZ2 line to edit, the Configuration Manager
displays the Edit ATM /ALC Parameters window (Figure 3-30).

Note: You must edit ATM DXI line details using synchronous
parameters. Refer to “Editing Synchronous Line Details” earlier
in this chapter.
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[® Edit ATM/ALC Parameters

- Cancel

Configuration Mode: local
SNMP Agent: LOCAL FILE - Values. ..

- Traffic,.

. Physical

~Help...

[a=]

Enable BIABLE
Data Path Notify ENABLE
Data Path Notify Timeout 3

Figure 3-30. Edit ATM/ALC Parameters Window

Complete the following steps:

1. Enter or select new values for the ATM line detail parameters you
want to edit, referring to the descriptions following this procedure
for guidelines.

2. Either click on the OK button, or click on the Traffic or Physical
button to edit those attributes.
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Parameter:

Default:
Options:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Enable
Enable
Enable | Disable

Enables or disables the ATM circuit for the
selected connector.

Accept the default, Enable, if you want the
selected connector to remain enabled. Set to
Disable if you want to disable the ATM circuit for
the selected connector.

1.3.6.1.4.1.18.3.4.23.2.1.1.2

Data Path Notify
Enable
Enable | Disable

Enables or disables the Data Path Notify function
for the selected connector. This function, when
enabled, disables the data path interface when
the physical interface becomes non-operational.

Accept the default, Enable, if you want Site
Manager to disable the data path interface when
the physical interface becomes non-operational.
Set to Disable if you do not want Site Manager to
disable the data path interface when the physical
interface becomes non-operational.

1.3.6.1.4.1.18.3.4.23.2.1.1.14
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Parameter:
Default:
Range:
Function:

Instructions:

MIB Object ID:

Data Path Notify Timeout
3 seconds
0 to 3600 seconds

Specifies the number of seconds to wait before
implementing the Data Path Notify function.
When the Data Path Notify function is enabled,
Site Manager sets a timer to this value when the
state of the physical interface transitions from
operational to non-operational.

Either accept the default value, 3 seconds, or
specify a new value.

1.3.6.1.4.1.18.3.4.23.2.1.1.15

Editing the ATM Traffic Attributes

To edit the ATM Traffic attributes, complete the following steps:

1. Click on the Traffic button in the Edit ATM/ALC Parameters
window (Figure 3-30).

The Configuration Manager displays the ATM /ALC SAR Traffic
Management Attributes window (Figure 3-31).
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[@® ATM/ALC SAR Traffic Management Attributes
Configuration Mode: local
SNMP dgent: LOCAL FILE

Peak Cell Rate (Cells/Sec)
Sustainable Cell Rate (Cells/Sec)
Maximum Burst Size (Cells/Sec) 0

Figure 3-31. ATM/ALC SAR Traffic Management Attributes Window

2. Enter or select new values for the ATM/ALC SAR Traffic
Management parameters you want to edit, referring to the
descriptions following this procedure for guidelines.

3. Click on the OK button.
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Parameter: Peak Cell Rate (Cells/Sec)
Default: 235849

Range: 1 to 235849 (100 Mb/s multimode fiber-optic
cable); 1 to 365566 (SONET/SDH)

Function:  Specifies the upper traffic limit, in cells/second,
that the ATM connection can submit.

Instructions:  How you set the peak cell rate depends on:

— The optical transmission rate of your ATM
device (235894 cells/sec [100 Mbps] maximum
for 100 Mb/s fiber, 365566 cells/sec [155 Mbps]
maximum for SONET/SDH)

— The amount of traffic you expect on a
particular VCL

— What rate you desire for each VCL

After you determine the transmission rate of
your ATM device, you can set peak cell rates
within the ranges mentioned above.

MIB Object ID:  1.3.6.1.4.1.18.3.4.23.2.9.1.5
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Parameter:
Default:
Range:

Function:

Instructions:

MIB Object ID:

Sustainable Cell Rate (Cells/Sec)
235849

1 to 235849 (100 Mb/s multimode fiber-optic
cable); 1 to 365566 (SONET/SDH)

Specifies the upper limit of the ATM connection
conforming average rate. The “average rate”
equals the total number of cells transmitted
divided by the “duration of the connection.”

By using the SCR, you can define the future cell
flow of a VCL in greater detail than by just using
the PCR.

Specifying the SCR controls the rate over time —
not at a specific instant of time — and can help
you more efficiently utilize your network
resources. When setting the SCR, keep the
following in mind:

— The SCR is essentially a future average. By
setting the SCR you are specifying the cell
rate, over time, to which you want the VCL
to conform.

— To be useful, the SCR must not exceed
the PCR.

1.3.6.1.4.1.18.3.4.23.2.9.1.6
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Parameter: Maximum Burst Size (Cells/Sec)
Default: 40
Range: 1 to 65535

Function: @ The MBS is the maximum length of a cell stream
on a given VCL. In other words, the MBS specifies
the maximum number of sequential cells allowed
on a VCL, at the peak cell rate, before the VCL
must relinquish bandwidth to other VCLs.

Instructions: We recommend a conservative value to start.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.2.9.1.7

Editing the ATM Physical Attributes

Note: You only need to edit ATM Physical Attributes when configuring
a SONET OC-3 line.

To edit the ATM Physical attributes, complete the following steps:

1. Click on the Physical button in the Edit ATM/ALC Parameters
window (Figure 3-30).

The Configuration Manager displays the ATM/ALC Physical
Interface Attributes window (Figure 3-32).

3-101



Editing ATM FRE2 Line Details

[® ATM/BLC Physical Interface Attributes
Configuration Mode: local
SNMP Agent: LOCAL FILE
Framing Mode IEJNET f i
Scrambling | ENABLE |
Loop Back [ DISABLE |
Cell Insertion IUNASSIGNED f v

Figure 3-32. ATM/ALC Physical Interface Attributes Window

2. Enter or select a new value for the ATM/ALC Physical Interface
parameter, referring to the description following this procedure for
guidelines.

3. Click on the OK button.

Parameter: Framing Mode
Default: None
Options: SDH | SONET
Function: Specifies either SDH or SONET Framing Mode.
Instructions:  Set to either SDH or SONET.
MIB Object ID:  1.3.6.1.4.1.18.3.4.23.2.11.1.4
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Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

Scrambling
Enable
Enable | Disable

Enabling the scrambler/descrambler randomizes
cell payload sufficiently to guarantee cell
synchronization. If disabled, cell synchronization
problems may result.

Click on Values and select Enable or Disable.
1.3.6.1.4.1.18.3.4.23.2.11.1.5

Loop Back
Disable
Enable | Disable

When enabled, the framer device will be
internally configured so that the transmitter loops
to the receiver. Loop Back is a diagnostic tool to
determine data flow to the transmitter and back
through the receiver.

Click on Values and select Enable or Disable.
1.3.6.1.4.1.18.3.4.23.2.11.1.7

Cell Insertion
Unassigned
Idle | Unassigned

In the absence of user cells, the framer device fills
idle bandwidth with either idle or unassigned
cells.

Click on Values and select Idle or Unassigned.
1.3.6.1.4.1.18.3.4.23.2.11.1.49
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Chapter 4
Configuring MCT1

This chapter documents how to use the Configuration Manager to add
an MCT1 circuit to a Wellfleet router with an installed Multichannel
T1 Link Module.

Adding MCT1 Circuits

The Configuration Manager window (Figure 2-1) displays a slot with
an MCT1 module and its associated connectors. To add circuits,
proceed with the following steps:

Select the connector

Set clock parameters

Set port parameters

Define logical lines

Define a circuit for each logical line
Complete the logical line parameters
Assign timeslots

Accept the configuration

QOO 0O Qo Qo a o

Save your changes

Note: Inlocal mode you need to add an initial hardware configuration.
See the “Specifying Hardware” section of Chapter 2.
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Selecting the Connector

Click on the MCT1 connector in the Configuration Manager window
(Figure 2-1) to begin the process of adding an MCT1 port. See Chapter
2 for more information on the Configuration Manager window and
connectors.

Setting Clock Parameters

The Clock Parameters window (Figure 4-1) appears after you click on
the connector. The clock parameters define the timing sources that
apply globally for all ports and DSO timeslots supported by the MCT1
Link Module in the current slot.

There is one clock chip on the Link Module that applies to all ports. Ifa
port is already configured, the clock parameters set for the first port
apply to all subsequent ports.

[®)Edit Slot 4 DSI/ET Clock Parameters
Configuration Mode: local OK |
SNMP Agent: LOCAL FILE Values... |
[ Help... |
Primary Clock (PORT 1 EXT LOOP llu
Secondary Clock | INTERNAL |

Figure 4-1. MCT1 Clock Parameters Window

Click on OK to accept the default values or modify the clock
parameters according to the descriptions that follow.
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Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

Primary Clock

Port 1 Ext Loop

Internal | Port 1 Ext Loop | Port 2 Ext Loop |
Auxiliary Ext

Identifies the primary source of the transmit
timing used by the single port on the MCT1-1
Link Module and both ports on the MCT1-2 Link
Module.

Internal
Generated by the clock chip on the Link
Module.

Port 1 Ext Loop
Generated by the signal coming in from Port 1.

Port 2 Ext Loop
Generated by the signal coming in from Port 2.

Auxiliary Ext
Generated from an external source using the
DB9 interface.

The internal and external clock source options,
include loop timing from either port or an
auxiliary timing source using the DB9 connector.

Specify the source of the primary transmit clock.
1.3.6.1.4.1.18.3.4.9.1.14
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Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

Setting Port Parameters

Secondary Clock

Internal

Internal | Port 1 Ext Loop | Port 2 Ext
Loop | Auxiliary Ext

Identifies the secondary source of the transmit
timing used by the single port on the MCT'1-1
Link Module and both ports on the MCT1-2 Link
Module only if the primary clock becomes
unavailable.

Internal
Generated by the clock chip on the Link
Module.

Port 1 Ext Loop
Generated by the signal coming in from Port 1.

Port 2 Ext Loop
Generated by the signal coming in from Port 2.

Auxiliary Ext
Generated from an external source using the
DB9 interface.

The internal and external clock source options,
include loop timing from either port or an
auxiliary timing source using the DB9 connector.

Specify the source of the secondary transmit clock.
1.3.6.1.4.1.18.3.4.9.1.1.5

The MCT1 Port Parameters window (Figure 4-2) appears after you
accept the clock parameters.
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[®IEdit Siot 3, MCTI-1 Port Paraneters MR R

Configuration Mode: local
SNYP Agent: LOCAL FILE

Enable/Disable [BNABLE |
MIU Size (bytes) 1600 n
Line Type ESF
Line Coding [BSZS |
Signal Level (dB) [0.0 DB |
Setup Alarm Threshold (seconds) [2 |
Clear Alarm Threshold (seconds) [2 |
FDL Configuration ANSI 403 i h
Remote FDL HDLC Address Mode BY |
Accept Loopback Request {ENABLE |

Figure 4-2. MCT1 Port Parameters Window

The port parameters apply to each of the 24 DS0 channels provided by
an individual MCT1 port (connector). Click on OK to accept the default

values, or modify the port parameters according to the descriptions

that follow.

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Enable/Disable

Enable

Enable | Disable

Enables or disables the MCT1 port.

Set to Disable only if you want to disable the
MCT1 port.

1.3.6.1.4.1.18.3.4.9.3.1.2
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Parameter:
Default:
Range:
Function:

Instructions:
MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Maximum Transfer Unit
1600 (bytes)

3 t0 4608

Specifies the Transmit/Receive buffer size, which
determines the largest frame that can be

transmitted or received across this port on the
MCT1 Link Module. Frames larger than the
maximum transfer unit are discarded.

Enter the maximum transfer unit.
1.3.6.1.4.1.18.3.4.9.3.1.5

Line Type
ESF
Unframed T1| ESF | SF/D4
Selects either ESF or SF/D4 framing format.
Unframed T'1
Use only during BERT mode to match the line
type.
ESF
Transmits super frames consisting of 24

individual SF/D4 frames and provides
enhanced signaling and synchronization.

SF /D4
Transmits super frames consisting of 12
individual frames.

Select ESF or SF/D4, based on the frame format
required by the associated T1 equipment.

1.3.6.1.4.1.18.3.4.94.1.6
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Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

Line Coding

B8ZS

AMI | B8ZS

Selects a line coding method.

AMI line coding is bipolar: a binary 0 is
transmitted as zero volts and a binary 1 is
transmitted as either a positive or negative pulse,
opposite in polarity to the previous pulse. (When
configured for AMI line coding, the MCT1 Link
Module remains synchronized upon receiving up
to 45 consecutive zeros.)

B8ZS line coding replaces a block of 8 consecutive
binary zeros with an 8-bit B8ZS code containing
bipolar violations in the 4th and 7th bit positions
of the substituted code. In the receive direction,
the B8ZS code is detected and replaced with 8
consecutive binary zeros.

Specify the line coding method.
1.3.6.1.4.1.18.3.4.94.1.7

4-7



Adding MCT1 Circuits

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Signal Level
0.0dB

-15dB | -7.5dB | 0.0dB| 0.5dB | 0.8 B | 1.1dB|
1.5dB

Specifies the T1 transmit power level in terms of
decibels.

The DS1 values of -15 and -7.5 decibels (dB) are
long haul and are determined by the carrier if 0.0
dB is not sufficient.

The DSX1 values of 0.0, 0.5, 0.8, 1.1, and 1.5
decibels are short haul and correlate with cable
length as follows:

0.0dB ----> 0to 133 feet

0.5dB ----> 133 to 266 feet
0.8dB ----> 266 to 399 feet
1.1dB ----> 399 to 533 feet
1.5dB ----> 533 to 655 feet

Specify the decimal level according to the length of
the cable or as determined by the carrier.

1.3.6.1.4.1.18.3.4.9.3.1.6
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Parameter:
Default:
Range:
Function:

Instructions:
MIB Object ID:

Parameter:
Default:
Range:
Function:

Instructions:
MIB Object ID:

Setup Alarm Threshold
2 seconds
2 to 10 seconds

Specifies the time interval (in seconds) during
which a performance defect or anomaly will be
tolerated. If the performance defect or anomaly is
still present at the expiration of the time interval
specified by this parameter, MCT1 records a
performance failure and logs an event message.

Set the timer value.
1.3.6.1.4.1.18.3.4.9.3.1.7

Clear Alarm Threshold
2 Seconds
2 to 10 Seconds

Specifies the clear time (in seconds) for
performance failure conditions. If the defect or
anomaly clears in the time interval specified by
this parameter, MCT1 records a performance
cleared condition and logs an event message.

Set the timer value.
1.3.6.1.4.1.18.3.4.9.3.1.8
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Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

FDL Configuration
ANSI 403
ANSI 403 | AT&T 54016 | None

Selects a Facility Data Link (FDL) mode. The
default, ANSI 403 Mode, conforms with the 1989
ANSI T1.403 specification (Carrier-to-Customer
Installation DS1 Metallic Interface); 54016
conforms with the 1989 AT&T specification
(Requirements for Interfacing Digital Terminal
Equipment to Services Employing the Extended
Superframe Format). Facility Data Link is used
only when the T1 line is configured with an ESF
line type.

Specify the operational mode.
1.3.6.14.1.18.34.94.1.14

Remote FDL HDLC Address Mode
BY
AZ | BY

Selects the BY or AZ FDL address mode. This
determines whether the near-end FDL will
respond to HDLC address AZ or BY in the FDL
messages from the far-end.

Specify the address mode.
1.3.6.1.4.1.18.3.4.9.3.1.9
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Parameter: Accept Loopback Request
Default: Enable
Options:  Enable | Disable

Function: Enables and disables loop-up and loop-down code
detection circuitry in the MCT1 Link Module. If
this parameter is enabled, this interface accepts
and complies with requests to go into loopback
mode from a far-end device.

Instructions:  Enable or disable local loopback.
MIB Object ID: 1.3.6.1.4.1.18.3.4.9.3.1.10
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Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

Defining Logical Lines

Loopback Configuration
No Loopback

No Loopback | Payload Loopback | Line
Loopback

Forces the DS1 interface into loopback.

The far-end or intermediate equipment then
performs diagnostics on the network between that
equipment and the DS1 interface. After testing,
set this parameter to No Loopback to return the
interface to a normal operating mode.

No Loopback
. Returns the interface to non-loopback
operation.

Payload Loopback
The received signal at this interface is looped
through the device. Typically the received
signal is looped back for re-transmission after
it has passed through the device’s framing
function.

Line Loopback
The received signal at this interface does not
go through the framing device (minimum
penetration) but is looped back out.

Select the loopback configuration option.
1.3.6.1.4.1.18.3.4.9.4.1.10

A single MCT1 port supports up to 24 logical lines (logical paths for
data communications on a physical connection). Each logical line

supports one circuit.
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The MCT1 Logical Lines window (Figure 4-3) appears after you

complete the Port Parameters window (Figure 4-2). Use the Logical
Lines window to add a logical line. Then add the circuit for the line,
modify the line parameters, and assign timeslots to the logical line.

[@SIot 3, WCI1-1 Logical Lines

i

T1 Details..

Enable/Disable |
Breath Of Life (BOFL) Enable/Disable |
BOFL Timeout (seconds) |

Fractional Loopback
WAN Protocol
Service

|
!
|
|
I
|

Figure 4-3. Logical Lines Window before You Add a Logical Line
Click on the Add button to add the first logical line.

Defining a Circuit for Each Logical Line

When you add a logical line, the Add Circuit window (Figure 4-4)
automatically appears so that you can add a circuit to the line.

Use the circuit windows to
0 Group lines into a Multiline circuit, if desired

1 Name the circuit
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o Select a protocol

o Save the circuit

® &dd Circuit
Configuration Mode: local
SNMP Agent: LOCAL FILE
Circuit Name: [MCT1-31-1 | Color Key:
Available
Select lines from available connectors: Selected
Slot Connectors
5 CINONE [CINONE CINONE [CINONE
4 [INONE INONE INONE [INONE
3 [OIMCT1-2 INONE 1 CLOCK _IMCT1-1-1
2 [CINONE INONE [ CLOCK CIMCT1-1
1 [71 CONSOLE
Cancel

Figure 4-4. Add Circuit Window
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Grouping Lines into a Multiline Circuit

This section shows you how to group multiple MCT1 unused logical
lines into one Multiline circuit. (An unused logical line is similar to an
unused synchronous port, such as COM1, COM2, etc.) All logical lines
in Multiline group have the same circuit name.

If you do not want to group the MCT1 logical lines into a Multiline
circuit, proceed to the next section, “Naming the Circuit.”

If you are adding an MCT1 Multiline circuit, follow these steps:

1. Add the first MCT1 logical line that you want to group into a
Multiline circuit by following the steps in the previous sections
“Selecting the Connector,” “Setting Clock Parameters,” and
“Setting Port Parameters.” When you set these parameters, the
MCT1 Logical Lines window appears (Figure 4-5).

Slot b, MCII-1 Logical Lines

——F [ Do ]

Port Details

Enable/Disable
Breath Of Life (BOFL) Enable/Disable |
BOFL Timeout (seconds)
Fractional Loopback
WAN Protocol

Service

—

B
B | O O | O

Figure 4-5. MCT1 Logical Lines Window
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2. Click on the Add button to display the Add Circuit window (Fiigure
4-6).

(@ Add Circuit

Configuration Mode: local
SNMP Agent: LOCAL FILE

Circuit Neme: |[MCT1-51-1 Color Key:
) . Available
Select lines from available comnectors: Selected
5lot Cormectors
5 £IMCT1-2 £1 NONE £ CLOCK [ HCT1-1-1
4 {1 NONE 1 NONE £ NONE
3 £1 NONE 1 NONE £ NONE £1 NONE
2 £ NONE £1 NONE £ NONE {1 NONE
1 £ CONSOLE
Cancel

Figure 4-6. Add Circuit Window

3. Click on the OK button. The WAN Protocols window appears.
Select Standard or PPP and click on the OK button.

4. The Select Protocols window appears. Select the protocol(s) to run
on this circuit and perform the appropriate configuration for that
protocol using the windows that appear. When you are finished, you
are returned to the MCT1 Logical Lines window showing the first
MCT1 circuit (Figure 4-7).
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@ Slot B, MCT1-1 Logical Lines

Done

. Delete
 Apply

ort Detalls
- Circuit...

5

Timeslots, ..
¥
Values, ..
Help...

i

Figure 4-7. Logical Lines Window with One MCT1 Circuit

5. To create unused logical lines, click on the Add button to display
the Add Circuit window. From this window, click Cancel. You are
returned to the MCT1 Logical Lines window. The unused logical
line will be the next available logical line, represented by a number
between 1 and 24. Repeat this Add and Cancel operation for each
unused logical line that you want to create. Figure 4-8 illustrates
the MCT1 Logical Lines window with multiple unused logical lines.

E-N
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@ Slot B, MCT1-1 Logical Lines

Figure 4-8. Logical Lines Window with Unused Logical Lines

Done

Delete

___&pply
Port Details
Circuit...
Timeslots. ..

Values, ..
Help...

6. From the MCT1 Logical Lines window, highlight the logical line
that has a circuit associated with it that you want to include in

multiline group. Click on Circuit to display the Circuit Definition
window. Click on the connector that has the unused logical line(s).

This displays the Select Logical Line window (Figure 4-9).
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Circuit Definition

LE]

File Protocols Lines Window

Help

Configuration Mode: local

SNMP Agent: LOCAL FILE

Protocols:
Circuit Name:
Slot
5 I MCT1-2
4 {1 NONE
3 {1 NONE
2 £1 NONE
1 {1 CONSOLE

{1 NONE
{1 NONE
{1 NONE
O NONE

Lines
0 CLOC
{1 NONE

{1 NONE
{1 NONE

Select Logical Line

OV = OO oo

=l

{1 NONE

Figure 4-9. Select Logical Line Window for Multiline

7. Click on the logical line that you want to multiline and then click
on OK. From this window, select Lines=>Change Lines from the
menu bar. Then, select Lines-»Change Lines once again to see if
the Multiline option highlighted and available for this circuit, as
illustrated in Figure 4-10. You can repeat this step for each unused
logical line on that connector. These lines are now grouped as one

circuit.
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?] Circuit Definition

File Protocols [Lines |Window

Configuration
SNMP

Protocols: l 1

Change Lines PF2

Fdit Lines. ..

Multiline...

Figure 4-10. Selecting Lines->Change Lines from the Menubar

8. Select File=>Exit to return to the MCT1 Logical Lines window.

Figure 4-11 illustrates a Multiline grouping. Notice that all logical

lines have the same circuit name, MCT1-51-1.

@ Slot 5, MCT1-1 Logical Lines

Port Details
- Circuit...

T

il

Done

Delete
Apply

imeslots, ..

il

Values...
Help...

Figure 4-11. MCT1 Logical Lines Window with a Multiline Circuit
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Please go to the section “Completing the Logical Line Parameters” to
edit the logical line parameters and to assign timeslots to each logical
line.

Naming the Circuit

The Add Circuit window displays a default circuit name. Figure 4-12
shows the circuit name in detail. The default name identifies the
circuit type (MCT1), the physical connector (slot and number), and the
number of the logical line on the MCT1 port associated with the circuit.

Note: The Configuration Manager assigns MCT1 logical line numbers
sequentially from 1 to 24.

Slot where connector Connector position on
Type of circuit resides (Slot 3) link module (Port 1)

Logical line
] [ g
Circuit Name: MCT1_31_1

Figure 4-12. MCT1 Default Circuit Name

You can change the circuit name by clicking on the circuit name box
and typing in a new name. When you are done, click on OK to accept
the Add Circuit window and to display the protocol selection window.

Selecting a Protocol

Depending on your configuration, the system prompts you to enter
WAN and LAN protocols.

The WAN Protocols window (Figure 4-13) appears after you click on
OK on the Add Circuit window. Select a WAN protocol. Refer to
“Configuring the Circuit” in Chapter 2 for more information about
selecting WAN protocols.
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[@® WAN Protocols

€ Standard
<& PPP

< SMDS

& Frame Relay

! 0K | iCancel]

Figure 4-13. WAN Protocols Window for MCT1

The Select Protocols window (Figure 4-14) appears after you click on
OK on the WAN Protocol window. Select the protocol for the circuit and
then configure the protocol. Refer to “Enabling Bridging/Routing
Services” and “Enabling Internet Protocol (IP) Services” in Chapter 2
for instructions.
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[@®] Select Protocols

a
“QO7Ip
a

OoCo

0

Protocols

{1 Bridge

Spanning Tree

RIP
EGP
BGP
OSPF
BOOTP

1 Decnet IV
{1 Vines

Cancel

Figure 4-14. Select Protocols Window for MCT1

Completing the Logical Line Parameters

After you finish adding a circuit to a logical line, the MCT1 Logical
Lines window (Fiigure 4-15) reappears with the circuit name displayed
next to each logical line and default values displayed for the
highlighted logical line parameter.
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[@1 S1ot 3, MCTI-1 Logical Lines

Add
Delete
Apply
1 Details..

Circuit...

imeslots. ..

Values...
Help. ..

1 MTI-31-1 il
]
Enable/Disable {ENABLE
Breath Of Life (BOFL) Enable/Disable [ENABLE
BOFL Timeout (seconds) B
Fractional Loopback [DISABLE
WAN Protocol | STANDARD
Service [LLC

|

Figure 4-15. Logical Lines Window after You Add a Circuit

In order to modify a logical line’s parameter, first select the logical line
from the logical line list. When you complete the modifications to the
parameters, click on the Apply button to implement them.

The parameter descriptions are as follows:

Parameter: Enable/Disable
Default: Enable
Options:  Enable | Disable

Function: This variable turns the logical line on or off.

Instructions:  Set to Disable only if you want to disable the

logical line.

MIB Object ID:  1.3.6.1.4.1.18.3.4.9.6.1.2
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Range:

Function:

Instructions:
MIB Object ID:

Breath of Life (BOFL) Enable/Disable
Enable
Enable | Disable

Selects the BOFL parameter. When you set this
parameter to Enable, a BOFL packet is sent out
on the wire as often as specified by the BOFL
Period parameter.

Set to Disable only if you want to end transmitting
BOFL packets.

1.3.6.1.4.1.18.3.4.9.6.1.8

BOFL Timeout (seconds)
5
1 to 60 seconds

Indicates the time period between Breath of Life
packets.

Set the time between BOFL packets in seconds.
1.3.6.1.4.1.18.3.4.9.6.1.9
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Options:

Function:
Instructions:
MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

Fractional Loopback
Disable
Enable | Disable

Puts the circuit into diagnostic loopback mode,
where any incoming data is “turned around” and
transmitted across the circuit. You can put any
logical line on this MCT1 port into fractional
loopback (where data coming into that logical line
from the wire is mirrored back to the wire).

Select Enable only if you want the port in loop-
back mode.

1.3.6.1.4.1.18.3.4.9.6.1.10

WAN Protocol
Standard

Standard | PassThru | PPP| SMDS | Frame
Relay

Specifies the WAN protocols for this logical line.
Select the WAN protocol.
1.3.6.1.4.1.18.3.4.9.6.1.14

Service
LLC1
Transparent | LLC1

Sets the HDLC service type for this line.
Transparent is basic HDLC mode. LLC1 will
prefix the HDLC address and control fields to the
frame.

Select the logical line HDLC service.
1.3.6.1.4.1.18.3.4.9.6.1.15
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Local HDLC Address
7
1to 255

Specifies the 1-byte HDLC address of this
synchronous interface. When you address data
sent to this interface, use this HDLC address.

Set this parameter to the local HDLC address you
want. Enter 1 for a DCE and 3 for a DTE. All other
addresses are considered explicit addresses. To
select an Explicit value, enter that value.

Site Manager assumes the values you enter are
decimal. If you want to enter a hexadecimal value,
preface the value with a 0x, for example, 0x10. If
you configure X.25 on this synchronous line, the
local HDLC address must be either 1 (DCE) or

3 (DTE).

1.3.6.1.4.1.18.3.4.9.6.1.16
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Parameter:
Default:
Range:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

Remote HDLC Address
7
1 to 255

Specifies the 1-byte HDLC address of the remote
synchronous interface. When you address data
sent from this interface to the remote end
interface, use this HDLC address.

Set this parameter to the HDLC address of the
remote synchronous interface. Enter 1 for a DCE
and 3 for a DTE. All other addresses are
considered explicit addresses. To select any
explicit value, enter the value.

Site Manager assumes the values you enter are
decimal. If you want to enter a hexadecimal value,
preface the value with a 0x, for example, 0x10. If
you configure X.25 on this synchronous line, the
local HDLC address must be either 1 (DCE) or

3 (DTE).

Rate Adaptation
56 KLSB
64 K| 56 KMSB | 56 KLSB

Determines the number of bits and their bit
positions within the timeslot. The 64-K selection
uses all 8 bits in the time slot. The two 56-K
selections use 7 of the 8 bits in the timeslot. 56-K
MSB does not use the most significant bit and
56-K LSB does not use the least significant bit in
the timeslot.

Select the line rate adaptation.
1.3.6.1.4.1.18.3.4.9.6.1.18
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Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

Assigning Timeslots

InterFrame Time Fill Character
Flags
Flags | Idles

Specifies the interframe time-fill pattern to be
transmitted across this circuit. Flags selects an
0x7E pattern (0111111 0);Idles selects an OxFF
pattern(11111111).

Set the line interframe time-fill character.
1.3.6.1.4.1.18.3.4.9.6.1.19

CRC Size
16-bit CRC
32-bit CRC | 16-bit CRC

Specifies the Cyclic Redundancy Check (CRC)
type. With 16-bit CRC selected, the MCT1
appends a 16-bit CRC to the transmitted frames,
and performs a 16-bit CRC on received frames.
With 32-bit CRC selected, the MCT'1 appends a
32-bit CRC to transmitted frames, and performs a
32-bit CRC on received frames.

Set the CRC size.
1.3.6.1.4.1.18.3.4.9.6.1.20

After you set up the logical line, you assign the timeslots (also called
channels or DSO0s) to it.
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Click on the Timeslots button on the Logical Lines window to display
the MCT1 Timeslots window (Figure 4-16). A graphical representation
of the 24 timeslots appears. Click on the box for the Logical Line to
display a list of configured circuits for that timeslot. Select a logical
line to assign to the timeslot. Click on the OK button when you are
finished assigning timeslots to return to the Logical Lines window
(Figure 4-15).

[® Edit Slot 2, MCTI-1 Timeslots
Timeslot Logical Line Timeslot Logical Line
1 1, MCT1-21-1 =1 13 | Unused e |
o L Wi-a-l =] 14 ] Tnused =
3 2, MCT1-21-2 =1 15 | Unused o |
4 | 2, MCT1-21-2 | 16 i 1, MCT1-21-1 =1
5 | Unused e | 17 1 2, MCT1-21-2 e |
6 Unused ca | 18 | Unused =1
7 ] Unused =] 19 | Unused =]
8 | Unused =1 20 Unused =1
g i Unused =1 21 | Unused =1
10 | Unused e | 22 i 2, MCT1-21-2 e |
11 2, MCT1-21-2 =1 23 | 2, MCT1-21-2 =1
12 1 "2 MCTI-21-2 =1 24 i 1, MCT1-21-1 o |
Cancel

Figure 4-16. MCT1 Timeslots Window

Accept the Configuration
Save the changes you have made to the Logical Lines window by
clicking on the Done button.

Save Your Changes

The Configuration Manager window appears after you click on Done on
the Logical Lines window. Select File-»Save before exiting to save the
changes to your configuration file.
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Initiating MCT1 Actions in Dynamic Mode

While in dynamic mode, you can use the Configuration Manager to
trigger MCT1 port actions to test the quality of the line. MCT1 line
tests include

o Transmitting specific codes to the remote end of the MCT1
connection

o Introducing deliberate error patterns into the transmitted BERT
(Bit Error Rate Test) bit stream

All actions are MCT1 port-specific. For example, a send loopback
action is transmitted across a specific port; a BERT reset action resets
the port-specific series of BERT counters.

You can review the results of your actions by using the Statistics
Manager function of the Configuration Manager to review the BERT
statistics. For more information on the Statistics Manager, refer to
Managing Wellfleet Routers.

Warning Initiating line tests affects all logical lines associated with
that port for the duration of the testing.

4-31



Initiating MCT1 Actions in Dynamic Mode

To initiate MCT1 actions, click on the Port Details button on the
Logical Lines window (Figure 4-15) to display the MCT1 Port
Parameters window (Figure 4-17). Then, click on the Line Tests button
(dynamic mode only) to display the MCT1 Port Actions window (Figure

4-18).

[®I Edit SIot 6, MCIL-1 Port Parameters
Configuration Mode: dynamic

SNMP Agent: 192.32.156.71

Enable/Disable [BNABLE
MIU Size (bytes) [1600 B
Line Type [ESF [
Line Coding [B8ZS |
Signal Level (dB) [0.0 DB 1
Setup Alarm Threshold (seconds) 2 |
Clear Alarm Threshold (seconds) 2 |
FDL Configuration [ANST 403 | h
Remote FDL HDLC Address Mode [BY l
Accept Loopback Request [ENABLE |

Figure 4-17. MCT1Port Parameters Window
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[ITCIL Port Actions
BERT Mode Enable: | DISABLE =] Line Coding: B8ZS ea|

BERT Send Alarm: Line Type:
BERT Test Pattern: | ONES _ =|Signal Level: [ 0.0 dB =]

Send Commands:
Reset, BERT Counters | Loop Up | FDL Line Loop Cl
Insert 1 Error | Loop Down | FDL Line Loop 1A

[ Insert 1 Error/IM | [ FDL Payload Loop | [FDL Disable Line Loop
Disable Insert Error| [FDL Disable Payload] FDL Disable ALL

Figure 4-18. MCT1 Port Actions Window

!
i
Insert 1 Error/1K | | FDL Line Loop IB
f
[

Caution:  Select one action at a time and then click on the Apply
button. Wait until the MCT1 Port Actions window has been
refreshed before issuing another action.

When you are finished with the Port Actions window, click on the Done
button. You are returned to the MCT1 Port Configuration window. All
changes applied to the port while in the Port Actions window are
effective only while the window is active. When you exit the window
using the Done button, all port settings revert to the original port
settings.

The parameter descriptions for these port actions follow.
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

BERT Mode Enable
Disable
Enable | Disable

Selecting Enable activates BERT mode. You do
not have to enable BERT mode to perform non-
BERT activities on this window, such as loop
actions.

To enter BERT mode, select Enable and click on
Apply.

1.3.6.1.4.1.18.3.4.8.2.1.6

BERT Send Alarm
Disable
AIS (Blue Alarm) | Yellow Alarm | Disable

Specifies the type of alarm signal to be generated
while in BERT mode. Select Disable to disable the
generation of alarm messages. Select AIS (Blue
Alarm) or Yellow Alarm to transmit the
corresponding alarm.

Select an alarm generation option and click on
Apply.
1.3.6.1.4.1.18.3.4.8.2.1.22
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Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

BERT Test Pattern
All Ones

0s | Ones | QRSS | 2e15 | 2e15 INV| 2e20 |
2023 | 2623 INV

Specifies the bit pattern transmitted during
BERT diagnostics. When a port is in BERT mode,
it is capable of generating patterns such as all 1s,
all Os, or a QRSS (quasi-random signal sequence)
pattern.

Select a test pattern and click on Apply.
1.3.6.1.4.1.18.3.4.8.2.1.21
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Line Type
None

Unframed T1|SF/D4 | ESF

Selects Unframed T1, SF/D4, or ESF framing
format.

Unframed T1
Use only during BERT mode to match the line
type.

SF /D4
Transmits super frames consisting of 12
individual frames.

If this option is chosen, the FDL port actions do
not apply and their buttons are not seen on the
MCT1 Port Actions Window (Figure 4-18).

ESF
Transmits super frames consisting of 24
individual SF/D4 frames and provides
enhanced signaling and synchronization.

Select ESF or SF/D4 based on the frame format
required by the associated T'1 equipment.

1.3.6.1.4.1.18.3.4.8.2.1.9
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Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

Line Coding
None
AMI | B8ZS

Selects a line coding method.

AMI line coding is bipolar, where a binary 0 is
transmitted as zero volts and a binary 1 is
transmitted as either a positive or negative pulse,
opposite in polarity to the previous pulse. (When
configured for AMI line coding, the MCT1 Link
Module remains in synchronization upon
receiving up to 45 consecutive zeros.)

B8ZS (binary eight zeros substitution) line coding
replaces a block of 8 consecutive binary zeros with
an 8-bit B8ZS code containing bipolar violations
in the 4th and 7th bit positions of the substituted
code. In the receive direction, the B8ZS code is
detected and replaced with 8 consecutive binary
zeros. Note: other options do not apply to MCT1.

Specify the line coding method.
1.3.6.1.4.1.18.3.4.8.2.1.10

4-37



Initiating MCT1 Actions in Dynamic Mode

Parameter:
Default:
Options:

Instructions:

Instructions:

MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Signal Level
None

-15dB | -7.5dB | 0.0dB| 0.5dB| 0.8dB |
1.1dB | 1.5dB

Specifies the T1 transmit power level in terms of
decibels (dBs).

The DS1 values of -15 and -7.5 dBs are long haul
and are determined by the carrier if 0.0 dB is not
sufficient.

The DSX1 values of 0.0, 0.5, 0.8, 1.1, and 1.5
decibels are short haul and correlate with cable
length as follows:

0.0dB ----> 0 to 133 feet

0.5dB ----> 133 to 266 feet
0.8dB ----> 266 to 399 feet
1.1dB ----> 399 to 533 feet
1.5dB ----> 533 to 655 feet

Specify the decimal level according to the length of
the cable or as determined by the carrier.

1.3.6.1.4.1.18.3.4.8.2.1.15

Reset BERT Counters
Reset
None

Resets all counters to zero while the router is in
BERT mode.

Select this action to reset the counters and click on
Apply.

1.2.6.14.1.18.3.4.8.3.1.3
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Parameter:
Default:
Options:

Function:
Instructions:

MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:
Parameter:
Default:
Options:
Function:

Instructions:

MIB Object ID:

Insert 1 Error
Insert
None

While the router is in BERT mode, inserts a single
(non-repeating) error into the bit stream.

Select this action to insert a single error and click
on Apply.

1.3.6.1.4.1.18.3.4.8.3.1.6

Insert 1 Erroxr/K
Insert
None

While the router is in BERT mode, inserts an
error into every thousandth position within the
bit stream.

Select this action to start the insertion of errors
and click on Apply.

1.3.6.1.4.1.18.3.4.8.3.1.6

Insert 1 Erroxr/1IM
Insert
None

While the router is in BERT mode, initiates the
introduction of a deliberate error into every
millionth position within the bit stream.

Select this action to start the insertion of errors
and click on Apply.

1.3.6.1.4.1.18.3.4.8.3.1.6
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Parameter:
Default:
Options:

Function:
Instructions:

MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Disable Insert Error
Disable

None

Terminates the introduction of deliberate errors

into the transmitted bit stream.

Select this action and click on Apply to stop a

previous insertion of errors.
1.3.6.1.4.1.18.3.4.8.3.1.6

Loop Up

Transmit

None

Sends a loop-up code to the remote end.
Select this action to send a loop-up code.
1.3.6.1.4.1.18.3.4.8.3.1.7

Loop Down

Transmit

None

Sends a loop-down code to the remote end.
Select this action to send a loop-down code.
1.3.6.1.4.1.18.3.4.8.3.1.7
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Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

FDL Payload Loop
Transmit
None

Transmits a payload loopback activate code to the
remote end.

Select this action.
1.3.6.1.4.1.18.3.4.8.3.1.8

FDL Disable Payload Loop
Transmit
None

Transmits a payload loopback deactivate code to
the remote end.

Select this action.
1.3.6.1.4.1.18.3.4.8.3.1.8

FDL Line Loop CI
Transmit
None

Transmits a line loopback activate code (format
CI) to the remote end.

Select this action to transmit a CI loopback.
1.3.6.1.4.1.18.3.4.8.3.1.8
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Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

FDL Line Loop IA
Transmit
None

Transmits a line loopback activate code (format
IA) to the remote end.

Select this action.
1.3.6.1.4.1.18.3.4.8.3.1.8

FDL Line Loop IB
Transmit
None

Transmits a line loopback activate code (format
IB) to the remote end.

Select this action.
1.3.6.1.4.1.18.3.4.8.3.1.8

FDL Disable Line Loop
Transmit
None

Transmits a line loopback deactivate code to the
remote end.

Select this action.
1.3.6.1.4.1.18.3.4.8.3.1.8
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Parameter:
Default: -
Options:

Function:

Instructions:
MIB Object ID:

FDL Disable All
Transmit
None

Transmits a loopback deactivate code to

deactivate all types of FDL-initiated loopbacks.

Select this action.
1.3.6.1.4.1.18.3.4.8.3.1.8
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Chapter 5
Configuring MCE1

This chapter documents how to use the Configuration Manager to add
an MCEJ1 circuit to a Wellfleet router with an installed Multichannel
E1 Link Module.

Adding MCE1 Circuits

The Configuration Manager window (Figure 2-1) displays a slot with
an MCE1 module and its associated connectors. To add circuits,
proceed with the following steps:

Select the connector

Set clock parameters

Set port parameters

Define logical lines

Define a circuit for each logical line
Complete the logical line parameters
Assign timeslots

Accept the configuration

g o o o o o o o a

Save your changes

Note: Inlocal mode you need to add an initial hardware configuration.
See the “Specifying Hardware” section of Chapter 2.
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Selecting the Connector

Click on the MCE1 connector in the Configuration Manager window
(Figure 2-1) to begin the process of adding an MCE1 port. See Chapter
2 for more information on the Configuration Manager window and
connectors.

Setting Clock Parameters

The Clock Parameters window (Figure 5-1) appears after you click on
the connector. The clock parameters define the timing sources that
apply globally for all ports and DS0 timeslots supported by the MCE1
Link Module in the current slot.

There is one clock chip on the Link Module that applies to all ports. Ifa
port is already configured, the clock parameters set for the first port
apply to all subsequent ports.

[@ Edit Slot 3 DS1/El Clock Parameters ]
Configuration Mode: local
SNMP Agent: LOCAL FILE
Primary Clock MORT 1 EXT LOOP
Secondary Clock INTERNAL

Figure 5-1. MCE1 Clock Parameters Window

Click on OK to accept the default values or modify the clock
parameters according to the descriptions that follow.
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Parameter:

Default:
Options:

Function:

Instructions:
MIB Object ID:

Primary Clock

Port 1 Ext Loop

Internal | Port 1 Ext Loop | Port 2 Ext Loop |
Auxiliary Ext

Identifies the primary source of the transmit
timing used by the single port on the MCE1-1
Link Module and both ports on the MCE1-2 Link
Module.

Internal
Generated by the clock chip on the Link
Module.

Port 1 Ext Loop
Generated by the signal coming in from Port 1.

Port 2 Ext Loop
Generated by the signal coming in from Port 2.

Auxiliary Ext
Generated from an external source using the
BNC connector.

The internal and external clock source options,
include loop timing from either port or an
auxiliary timing source using the BNC connector.

Specify the source of the primary transmit clock.
1.3.6.1.4.1.18.3.4.9.1.14
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Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

Setting Port Parameters

Secondary Clock

Internal

Internal | Port 1 Ext Loop | Port 2 Ext
Loop | Auxiliary Ext

Identifies the secondary source of the transmit
timing used by the single port on the MCE1-1
Link Module and both ports on the MCE1-2 Link
Module only if the primary clock becomes
unavailable.

Internal
Generated by the clock chip on the Link
Module. ‘

Port 1 Ext Loop
Generated by the signal coming in from Port 1.

Port 2 Ext Loop
Generated by the signal coming in from Port 2.

Auxiliary Ext
Generated from an external source using the
BNC connector.

The internal and external clock source options,
include loop timing from either port or an
auxiliary timing source using the BNC connector.

Specify the source of the secondary transmit clock.
1.3.6.1.4.1.18.3.4.9.1.1.5

The MCE1 Port Parameters window (Figure 5-2) appears after you
accept the clock parameters.
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[® Edit Slot 2, MCE1-1 Port Parameters ]

Configuration Mode: local
SNYP Agent: LOCAL FILE

Enable/Disable ENABLE B

Line Type El

Line Coding HDR3

Setup 8larm Threshold (seconds) 2

Clear Alarm Threshold (seconds) 2

International Bit DISARLE ¥

Figure 5-2. MCE1 Port Parameters Window

The port parameters apply to each of the 31 DSO channels provided by
an individual MCE1 port (connector). Click on OK to accept the default
values, or modify the port parameters according to the descriptions
that follow.
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Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:
Parameter:
Default:

Options:

Function:

Instructions:

MIB Object ID:

Enable/Disable

Enable

Enable | Disable

Enables or disables the MCE1 port.

Set to Disable only if you want to disable the
MCE]1 port.

1.3.6.1.4.1.18.3.4.9.3.1.2

Line Type
El
E1|E1CRC|E1MF |E1 CRC MF

Selects E1, E1 CRC, E1 MF, or E1 CRC MF
framing format.

Select E1, E1 CRC, E1 MF, or E1 CRC MF, based
on the frame format required by the associated E1
equipment.

1.3.6.1.4.1.18.3.4.9.4.1.6
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Parameter:

Default:
Options:

Function:

Instructions:
MIB Object ID:

Line Coding

HDB3

AMI |HDB3

Selects a line coding method.

AMI line coding is bipolar: a binary 0 is
transmitted as zero volts and a binary 1 is
transmitted as either a positive or negative pulse,
opposite in polarity to the previous pulse. (When
configured for AMI line coding, the MCE1 Link
Module remains synchronized upon receiving up
to 45 consecutive zeros.)

HDB3 (High-Density Bipolar Coding) line coding
maintains sufficient ones density within the E1
data stream. It replaces a block of 8 consecutive
binary zeros with an 8-bit HDB3 code containing
bipolar violations in the 4th and 7th bit positions
of the substituted code. In the receive direction,
the HDBS3 code is detected and replaced with 8
consecutive binary zeros.

Specify the line coding method.
1.3.6.1.4.1.18.3.4.9.4.1.7
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Parameter:
Default:
Range:
Function:

Instructions:
MIB Object ID:

Parameter:
Default:
Range:
Function:

Instructions:
MIB Object ID:

Setup Alarm Threshold
2 seconds
2 to 10 seconds

Specifies the time interval (in seconds) during
which a performance defect or anomaly will be
tolerated. If the performance defect or anomaly is
still present at the expiration of the time interval
specified by this parameter, MCE1 records a
performance failure and logs an event message.

Set the timer value.
1.3.6.1.4.1.18.3.4.9.3.1.7

Clear Alarm Threshold
2 Seconds
2 to 10 Seconds

Specifies the clear time (in seconds) for
performance failure conditions. If the defect or
anomaly clears in the time interval specified by
this parameter, MCE1 records a performance
cleared condition and logs an event message.

Set the timer value.
1.3.6.1.4.1.18.3.4.9.3.1.8
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Parameter: International Bit
Default: Disable
Options:  Enable/Disable

Function:  Specifies if the international bit should be set in
the E1 frame.

Instructions:  Select Enable to set the international bit, or select
Disable.

MIB Object ID:  1.3.6.1.4.1.18.3.4.9.3.1.16

Defining Logical Lines

A single MCE1 port supports up to 31 logical lines (logical paths for
data communications on a physical connection). Each logical line
supports one circuit.

The MCE1 Logical Lines window (Figure 5-3) appears after you

complete the Port Parameters window (Figure 5-2). Use the Logical
Lines window to add a logical line. Then add the circuit for the line,
modify the line parameters, and assign timeslots to the logical line.
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Slot 3, MCE1-2 Logical Lines

B | Done |

H

< S— ] ] » f Values... I
Help. ..
Enable/Disable | ENABLE |
Breath Of Life (BOFL) Enable/Disable |ENABLE |
BOFL Timeout (seconds) |5 i
Fractional Loopback [ DISABLE |
WAN Protocol [ STANDARD |
Service ILLCl i

Figure 5-3. Logical Lines Window before You Add a Logical Line
Click on the Add button to add the first logical line.

Defining a Circuit for Each Logical Line

When you add a logical line, the Add Circuit window (Figure 5-4)
automatically appears so that you can add a circuit to the line.

Use the circuit windows to
0 Group lines into a Multiline circuit, if desired

o Name the circuit

5-10



Configuring MCE1

o Select a protocol

o Save the circuit

[@ Add Circuit
Configuration Mode: local
SNMP 8gent: LOCAL FILE
Circuit Name: |MCE1-31-2 Color Key:
. . fvailable
Select lines from available connectors: Selected
Slot Connectors
5 {1 XCVR2 £1 NONE £ NONE 1 XCVR1
4 {1 NONE 1 NONE {1 NONE {1 FDDI1
3 CCIMCEL-2 £ NONE 1 CLOCK
2 {1 TOKEN4 £ TOKEN3 1 TOKEN2 {1 TOKEN1
1 {1 CONSOLE
Cancel

Figure 5-4. Add Circuit Window
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Grouping Lines into a Multiline Circuit

This section shows you how to group multiple MCE1 unused logical
lines into one Multiline circuit. (An unused logical line is similar to an
unused synchronous port, such as COM1, COM2, etc.) All logical lines
in Multiline group have the same circuit name.

If you do not want to group the MCE1 logical lines into a Multiline
circuit, proceed to the next section, “Naming the Circuit.”

If you are adding an MCE1 Multiline circuit, follow these steps:

1. Add the first MCE1llogical line that you want to group into a
Multiline circuit by following the steps in the previous sections
“Selecting the Connector,” “Setting Clock Parameters,” and
“Setting Port Parameters.” When you set these parameters, the
MCE1 Logical Lines window appears (Figure 5-5).

Slot 5, MCEl-1 Logical Lines

L Bone
[ — —— ]

Port Details

Enable/Disable I
Breath Of Life (BOFL) Enable/Disable |
BOFL Tineout (seconds) |
Fractional Loopback |
WAN Protocol |

I

Service

Figure 5-5. MCE1 Logical Lines Window
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2. Click on the Add button to display the Add Circuit window (Figure
5-6).
[® Add Circuit

Configuration Mode:

Circuit Name: |MCE1-51-1 | Color Key:

. . Available
Select lines from available connectors: Selected
Slot . Connectors
5 0 MCE1-2 {1 NONE 1 CLOCK [ MCEL-1-1
4 {1 NONE {1 NONE £1 NONE {1 NONE
3 £ NONE {1 NONE &1 NONE 1 NONE
2 £ NONE {1 NONE £1 NONE {1 NONE
1 {1 CONSOLE
Cancel

local
SNMP Agent: LOCAL FILE

Figure 5-6. Add Circuit Window

3.

Click on the OK button. The WAN Protocols window appears.
Select Standard or PPP and click on the OK button.

The Select Protocols window appears. Select the protocol(s) to run
on this circuit and perform the appropriate configuration for that
protocol using the windows that appear. When you are finished, you
are returned to the MCE1 Logical Lines window showing the first
MCE1 circuit (Figure 5-7).

5-13



Adding MCE1 Circuits

[® Slot b, MCEl-1 Logical Lines

Done

Delete

fpply
ort Details
Circuit. ..

—3

O

imeslots. ..
Values, ..
Help...

Figure 5-7. Logical Lines Window with One MCE1 Circuit

5. To create unused logical lines, click on the Add button to display
the Add Circuit window. From this window, click Cancel. You are
returned to the MCE1 Logical Lines window. The unused logical
line will be the next available logical line, represented by a number
between 1 and 31. Repeat this Add and Cancel operation for each
unused logical line that you want to create. Figure 5-8 illustrates
the MCE1 Logical Lines window with multiple unused logical lines.
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[@ Slot 5, MCE1-1 Logical Lines

Done

Delete
Apply
Port Details
Circuit...

il

Timeslots. ..
v
Values...
Help...

il

Figure 5-8. Logical Lines Window with Unused Logical Lines

6. From the MCE1 Logical Lines window, highlight the logical line
that has a circuit associated with it that you want to include in
multiline group. Click on Circuit to display the Circuit Definition
window. Click on the connector that has the unused logical line(s).
This displays the Select Logical Line window (Figure 5-9).
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@ Circuit Definition

File Protocols Lines Window

Help

5

_ o W

Protocols:

Circuit Name:

Configuration Mode: local

SAMP Agent: LOCAL FILE

Slot

O MCE1-2
£ NONE

£ NONE

£ NONE

{1 CONSOLE

MCEL-51-1

{1 NONE
{J NONE
{1 NONE
{1 NONE

Lines
£ CLOCK 7 MCE1-1
O NONT®] Select Logical Line B E1
£ NON
£2 NN 2—) =
4 1]
5

Figure 5-9. Select Logical Line Window for Multiline

7. Click on the logical line that you want to multiline and then click
on OK. From this window, select Lines=»Change Lines from the
menu bar. Then, select Lines=»Change Lines once again to see if
the Multiline option highlighted and available for this circuit, as
illustrated in Figure 5-10. You can repeat this step for each unused
logical line on that connector. These logical lines are now grouped

as one circuit.
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File Protocols ILines |Window Help
IChange Lines PF2
kdit Lines. ..

Multiline...

Protocols: ‘ I

Figure 5-10. Selecting Lines->Change Lines from the Menubar

Configuration
SNMP

8. Select File=>Exit to return to the MCE1 Logical Lines window.
Figure 5-11 illustrates a Multiline grouping. Notice that all logical
lines have the same circuit name, MCE1-51-1.

@ Slot b, MCE1-1 Logical Lines

)
T, MLEL-A1-1 | Done |
2: CE]._E)]."].
5 W51
4, MCE1-51-1
5, MCE1-51-1

Port Details
Circuit...

Timeslots, ..
Values, ..
Help...

il

Figure 5-11. MCE1 Logical Lines Window with a Multiline Circuit
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Please go to the section “Completing the Logical Line Parameters” to
edit the logical line parameters and to assign timeslots to each logical
line.

Naming the Circuit

The Add Circuit window displays a default circuit name. Figure 5-12
shows the circuit name in detail. The default name identifies the
circuit type (MCE1), the physical connector (slot and number), and the
number of the logical line on the MCE1 port associated with the
circuit.

Note: The Configuration Manager assigns MCE1 logical line numbers
sequentially from 1 to 31.

o Slot where connector Connector position on
Type of circuit resides (Slot 3) link module (Port 1)
Logical line
| g

Circuit Name: ‘MCE1_31__1

Figure 5-12. MCE1 Default Circuit Name

You can change the circuit name by clicking on the circuit name box
and typing in a new name. When you are done, click on OK to accept
the Add Circuit window and to display the protocol selection window.

Selecting a Protocol

Depending on your configuration, the system prompts you to enter
WAN and LAN protocols.

The WAN Protocols window (Figure 5-13) appears after you click on
OK on the Add Circuit window. Select a WAN protocol. Refer to
“Configuring the Circuit” in Chapter 2 for more information about
selecting WAN protocols.
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@ WAN Protocols

€ Standard
<& PPP

< SMDS

& Frame Relay

[ 0K | iCancel]

Figure 5-13. WAN Protocols Window for MCE1

The Select Protocols window (Figure 5-14) appears after you click on
OK on the WAN Protocol window. Select the protocol for the circuit and
then configure the protocol. Refer to “Enabling Bridging/Routing
Services” and “Enabling Internet Protocol (IP) Services” in Chapter 2
for instructions.
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[@ Select Protocols

a

a

CCCCCLCE

aIp

Protocols

{1 Bridge
Spanning Tree

RIP

EGP

BGP

OSPF

BOOTP

IGMp
DVMRP

Figure 5-14. Select Protocols Window for MCE1

Completing the Logical Line Parameters

After you finish adding a circuit to a logical line, the MCE1 Logical

Lines window (Figure 5-15) reappears with the circuit name displayed

next to each logical line and default values displayed for the

highlighted logical line parameter.
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@ Slot 5, MCE1-1 Logical Lines

Done

o

Delete
Apply
Port Details
Circuit. ..

neslots, ..
Values, ..
Help...

< |

Figure 5-15. Logical Lines Window after You Add a Circuit

In order to modify a logical line’s parameter, first select the logical line
from the logical line list. When you complete the modifications to the
parameters, click on the Apply button to implement them.

The parameter descriptions are as follows:

Parameter: Enable/Disable
Default: Enable
Options:  Enable | Disable
Function: This variable turns the logical line on or off.

Instructions:  Set to Disable only if you want to disable the
logical line.

MIB Object ID:  1.3.6.1.4.1.18.3.4.9.6.1.2
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Range:

Function:

Instructions:
MIB Object ID:

Breath of Life (BOFL) Enable/Disable
Enable
Enable | Disable

Selects the BOFL parameter. When you set this
parameter to Enable, a BOFL packet is sent out
on the wire as often as specified by the BOFL
Period parameter.

Set to Disable only if you want to end transmitting
BOFL packets.

1.3.6.1.4.1.18.3.4.9.6.1.8

BOFL Timeout (seconds)
5
1 to 60 seconds

Indicates the time period between Breath of Life
packets.

Set the time between BOFL packets in seconds.
1.3.6.1.4.1.18.3.4.9.6.1.9
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

Fractional Loopback
Disable
Enable | Disable

Puts the circuit into diagnostic loopback mode,
where any incoming data is “turned around” and
transmitted across the circuit. You can put any
logical line on this MCE1 port into fractional
loopback; (where data coming into that logical line
from the wire is mirrored back to the wire).

Select Enable only if you want the port in loop-
back mode.

1.3.6.1.4.1.18.3.4.9.6.1.10

WAN Protocol

Standard »

Standard | PPP | SMDS | Frame Relay

Specifies the WAN protocols for this logical line.
Select the WAN protocol.
1.3.6.1.4.1.18.3.4.9.6.1.14

Service
LLC1
Transparent | LLC1

Sets the HDLC service type for this line.
Transparent is basic HDLC mode. LLC1 will
prefix the HDLC address and control fields to the
frame.

Select the logical line HDLC service.
1.3.6.1.4.1.18.3.4.9.6.1.15
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Parameter:
Default:
Range:

Function:

Instructions:

MIB Object ID:

Local HDLC Address
7
1 to 255

Specifies the 1-byte HDLC address of this
synchronous interface. When you address data
sent to this interface, use this HDLC address.

Set this parameter to the local HDLC address you
want. Enter 1 for a DCE and 3 for a DTE. All other
addresses are considered explicit addresses. To
select an Explicit value, enter that value.

Site Manager assumes the values you enter are
decimal. If you want to enter a hexadecimal value,
preface the value with a 0x, for example, 0x10. If
you configure X.25 on this synchronous line, the
local HDLC address must be either 1 (DCE) or

3 (DTE).

1.3.6.1.4.1.18.3.4.9.6.1.16
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

Remote HDLC Address
7
1 to 255

Specifies the 1-byte HDLC address of the remote
synchronous interface. When you address data
sent from this interface to the remote end
interface, use this HDLC address.

Set this parameter to the HDLC address of the
remote synchronous interface. Enter 1 for a DCE
and 3 for a DTE. All other addresses are
considered explicit addresses. To select any
explicit value, enter the value.

Site Manager assumes the values you enter are
decimal. If you want to enter a hexadecimal value,
preface the value with a 0x, for example, 0x10. If
you configure X.25 on this synchronous line, the
local HDLC address must be either 1 (DCE) or

3 (DTE).

1.3.6.1.4.1.18.3.4.9.6.1.17

Rate Adaptation
64 KLSB
64 K|56 K MSB |56 K LSB

Determines the number of bits and their bit
positions within the timeslot. The 64-K selection
uses all 8 bits in the time slot. The two 56-K
selections use 7 of the 8 bits in the timeslot. 56-K
MSB does not use the most significant bit and
56-K LSB does not use the least significant bit in
the timeslot.

Select the line rate adaptation.
1.3.6.1.4.1.18.3.4.9.6.1.18
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Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

InterFrame Time Fill Character
Flags
Flags | Idles

Specifies the interframe time-fill pattern to be
transmitted across this circuit. Flags selects an
Ox7E pattern(01111110); Idlesselects an OxFF
pattern(11111111).

Set the line interframe time-fill character.
1.3.6.1.4.1.18.3.4.9.6.1.19

CRC Size
16-bit CRC
32-bit CRC| 16-bit CRC

Specifies the Cyclic Redundancy Check (CRC)
type. With 16-bit CRC selected, the MCE1
appends a 16-bit CRC to the transmitted frames,
and performs a 16-bit CRC on received frames.
With 32-bit CRC selected, the MCE1 appends a
32-bit CRC to transmitted frames, and performs a
32-bit CRC on received frames.

Set the CRC size.
1.3.6.1.4.1.18.3.4.9.6.1.20
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Parameter: MTU Size (bytes)
Default: 1600
Range: 3 to 4608 bytes

Function:  Specifies the transmit/receive buffer size to
configure the largest frame that can be
transmitted or received across this MCE1 port.
Frames larger than the maximum transfer unit
are discarded.

Instructions:  Enter the maximum transfer unit in the range 3
to 4608 bytes.

MIB Object ID:  1.3.6.1.4.1.18.3.4.9.6.1.55

Assigning Timeslots

After you set up the logical line, you assign the timeslots (also called
channels or DSO0s) to it.

Click on the Timeslots button on the Logical Lines window to display
the MCE1 Timeslots window (Fiigure 5-16). A graphical representation
of the 31 timeslots appears. Click on the box for the Logical Line to
display a list of configured circuits for that timeslot. Select a logical
line to assign to the timeslot. Click on the OK button when you are
finished assigning timeslots to return to the Logical Lines window
(Figure 5-15).

Note: Timeslot 16 is unavailable when the Line Type parameter in
the MCE1 Port Parameters window (Figure 5-17) is either E1
MF or E1 CRCMF.
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[@ Edit Slot 3, MCE1-1 Timeslots :
Timeslot Logical Line Timeslot Logical Line
1 | Unused =1 17 Unused =1
2 i Unused =1 18 | Unused e |
3 i Unused e | 19 | Unused |
4 1 Unused =1 20 | Unused e |
S Unused =1 21 Unused e |
6 i Unused e | 22 i Unused =1
70 lnused =1 23 i Unused £ |
8 | Unused =1 24 i Unused z |
9 | Unused =1 yoR | Unused 1 |
10 | Unused e | 6 i Tnused =1
1 Unused =1 27 Unused £ |
12 Unused =1 8 i Unused =1
13 1 Unused =1 29 Unused e |
14 | lnused =1 30 | Unused =1
15 i Unused =1 31 nused £ |
16 i Unused £ |
Cancel

Figure 5-16. MCE1 Timeslots Window

Accepting the Configuration

Save the changes you have made to the Logical Lines window by
clicking on the Done button.
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Saving Your Changes

The Configuration Manager window appears after you click on Done on
the Logical Lines window. Select File->Save before exiting to save the
changes to your configuration file.

Initiating MCE1 Actions in Dynamic Mode

While in dynamic mode, you can use the Configuration Manager to
trigger MCE1lport actions to test the quality of the line. MCE1 line
tests include

o Transmitting specific codes to the remote end of the MCE1
connection

0 Introducing deliberate error patterns into the transmitted BERT
(Bit Error Rate Test) bit stream

All actions are MCE1 port-specific. For example, a BERT reset action
resets the port-specific series of BERT counters.

You can review the results of your actions by using the Statistics
Manager function of the Configuration Manager to review the BERT
statistics. For more information on the Statistics Manager, refer to
Managing Wellfleet Routers.

w9
Warning Initiating line tests affects all logical lines associated with
that port for the duration of the testing.
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To initiate MCE1 actions, click on the Port Details button on the
Logical Lines window (Figure 5-15) to display the MCE1 Port
Parameters window (Fiigure 5-17). Then, click on the Line Tests button
(dynamic mode only) to display the MCE1 Port Actions window (Figure

5-18).
[@ Edit Slot 3, MCE1-1 Port Parameters

Configuration Mode: dynamic
SNMP Agent: 192,82, 18,108

Enable/Disable BVABLE B

Line Type El |

Line Coding HDE3

Setup 8larm Threshold (seconds) IZ i

Clear Alarm Threshold . (seconds) |2

International Bit DISARLE ¥

Figure 5-17. MCE1 Port Parameters Window
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(@ MCE1 Port Actions

BERT Mode Enable: | DISABLE c3|Line Coding: | HDB3 e |
BERT Send Alarm: | DISABLE ea| Line Type: | El =1

BERT Test Pattern: ONES e

Tnternational Bit: i DISABLE ml

Send Commands:

| Reset BERT Counters |
| Insert 1 Error |
! Insert 1 Error/IK |
{ Insert 1 Error/IM |
iDisable Insert Error|

Figure 5-18. MCE1 Port Actions Window

Caution:  Select one action at a time and then click on the Apply
button. Wait until the MCE1 Port Actions window has been
refreshed before issuing another action.

When you are finished with the Port Actions window, click on the Done
button. You are returned to the MCE1 Port Configuration window. All
changes applied to the port while in the Port Actions window are
effective only while the window is active. When you exit the window
using the Done button, all port settings revert to the original port
settings.

The parameter descriptions for these port actions follow.
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

BERT Mode Enable
Disable
Enable | Disable

Selecting Enable activates BERT mode. You do
not have to enable BERT mode to perform non-
BERT activities on this window, such as loop
actions.

To enter BERT mode, select Enable and click on
Apply.

1.3.6.1.4.1.18.3.4.8.2.1.6

BERT Send Alarm
Disable
AIS (Blue Alarm) | Yellow Alarm | Disable

Specifies the type of alarm signal to be generated
while in BERT mode. Select Disable to disable the
generation of alarm messages. Select AIS (Blue
Alarm) or Yellow Alarm to transmit the
corresponding alarm.

Select an alarm generation option and click on
Apply.
1.3.6.1.4.1.18.3.4.8.2.1.22
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Parameter:
Default:
Options:

Function:

Instructions:
MIB Object ID:

Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

BERT Test Pattern
All Ones

0s |Ones | QRSS | 2e15 | 2e15 INV | 2e20 | 223 |
2e23 INV

Specifies the bit pattern transmitted during
BERT diagnostics. When a port is in BERT mode,
it is capable of generating patterns such as all 1s,
all Os, or a QRSS (quasi-random signal sequence)
pattern.

Select a test pattern and click on Apply.
1.3.6.1.4.1.18.3.4.8.2.1.21

International Bit
Enable
Enable/Disable

Specifies if the international bit should be set in
the E1 frame.

Select Enable to set the international bit, or select
Disable.

1.3.6.1.4.1.18.3.4.9.3.1.16
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Parameter;
Default:

Default:
Options:

Function:

Instructions:
MIB Object ID:

Line Coding

None

HDB3

AMI|HDB3

Selects a line coding method.

AMI line coding is bipolar: a binary 0 is
transmitted as zero volts and a binary 1 is
transmitted as either a positive or negative pulse,
opposite in polarity to the previous pulse. (When
configured for AMI line coding, the MCE1 Link
Module remains synchronized upon receiving up
to 45 consecutive zeros.)

HDB3 (High-Density Bipolar Coding) line coding
maintains sufficient ones density within the E1
data stream. It replaces a block of 8 consecutive
binary zeros with an 8-bit HDB3 code containing
bipolar violations in the 4th and 7th bit positions
of the substituted code. In the receive direction,
the HDBS3 code is detected and replaced with 8
consecutive binary zeros.

Specify the line coding method.
1.3.6.1.4.1.18.3.4.8.2.1.10
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Options:

Function:
Instructions:
MIB Object 1D:
Parameter:
Default:

Options:

Function:
Instructions:

MIB Object ID:

Line Type
None

E1|E1 CRC|E1 MF |E1CRC MF|
UNFRAMED E1

Selects E1, E1 CRC, E1 MF, or E1 CRC MF
framing format.

Select E1, E1 CRC, E1 MF, E1 CRC MF, or
UNFRAMED E1 based on the frame format
required by the associated E1 equipment. MF
framing is not supported using BERT.

1.3.6.1.4.1.18.3.4.8.2.1.9

Reset BERT Counters
Reset
None

Resets all counters to zero while the router is in
BERT mode.

Select this action to reset the counters and click on
Apply.
1.3.6.1.4.1.18.3.4.8.3.1.3

Insert 1 Error
Insert
None

While the router is in BERT mode, inserts a single
(non-repeating) error into the bit stream.

Select this action to insert a single error and click
on Apply.

1.3.6.1.4.1.18.3.4.8.3.1.6
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Parameter:
Default:
Options:

Function:

Instructions:

MIB Object ID:

Parameter:
Default:
Options:

Function:
Instructions:
MIB Object ID:
Parameter:
Default:

Options:

Function:
Instructions:

MIB Object ID:

Insert 1 Error/K
Insert
None

While the router is in BERT mode, inserts an
error into every thousandth position within the
bit stream.

Select this action to start the insertion of errors
and click on Apply.

1.3.6.1.4.1.18.3.4.8.3.1.6

Insert 1 Error/1M
Insert
None

While the router is in BERT mode, initiates the
introduction of a deliberate error into every
millionth position within the bit stream.

Select this action to start the insertion of errors
and click on Apply.

1.3.6.1.4.1.18.3.4.8.3.1.6

Disable Insert Error
Disable
None

Terminates the introduction of deliberate errors
into the transmitted bit stream.

Select this action and click on Apply to stop a
previous insertion of errors.

1.3.6.1.4.1.18.3.4.8.3.1.6
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Chapter 6
Implementing Configuration Changes

This chapter tells you how to use the Configuration Manager and the
Router Files Manager to implement configuration changes.

Configuration Implementation Overview

Alocal or remote configuration file has no effect until you reboot the
router using the configuration file.

You must save changes you make dynamically to a configuration file
and then reboot the router with that file to make these changes
permanent. If you reboot the router without saving the dynamic
changes to a configuration file, the changes are lost.

In general, implementing configuration changes consists of four steps:
1. Saving the configuration file locally

You only save dynamically made changes to a config file when you
want to maintain a permanent record of the changes.

2. Transferring the configuration file to the router using TFTP
Rebooting the router with the configuration file
4. Using the Configuration Manager Change utility
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Saving a Configuration File

Note: When you save a configuration file that was created in local
mode, it is saved to the Site Manager workstation. Therefore,
you must transfer the file to the router in order to reboot the
router with it. When you save a configuration file that was
created in remote mode, the file is transferred directly to the
router. Use the procedures identified in this chapter when
saving files in remote configuration mode or transferring files to
the router to avoid corrupting the config file on the router.

If the router has a non-volatile file system (NVFS), you boot the router
with the router software image for your specific router platform (for
example, bn.exe in the BN, asn.exe in the ASN) and a configuration file
residing on a volume you specify. The volume in this case is the slot
location of one file system on the router. Each router equipped with an
NVFS is shipped with at least one volume. The default volume is
displayed in the Boot and File Management windows. These windows
allow you to change the volume from which to boot.

If the router has a DOS file system, you boot from the volume named A.

Saving a Configuration File

The Configuration Manager does not create the configuration file until
you save the configuration information you specified. The three
sections that follow describe how to save a configuration file locally,
remotely, or dynamically. Refer to the appropriate section, depending
on the configuration option you selected when you started the
Configuration Manager.

Saving a Configuration File in Local Configuration Mode

This section describes how to save a configuration created or modified
in local mode to a file on the Site Manager workstation.
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Note: If Site Manager is in local configuration mode, and you want to
store the configuration you have just created or modified to a
file on the router, follow the instructions in this section to store
the file locally. Then follow the instructions in the section
“Transferring a Configuration File to the Wellfleet Router.”

To save your file, begin at the Wellfleet Configuration Manager window
and complete the following steps. '

1. Save the configuration file to the same directory in which Site
Manager is located, or to another directory:

— Select File=>Save to save to the same directory.

— Otherwise, select File»Save As. The Save Configuration File
window appears. Specify the appropriate directory by clicking
on the Volume button and dragging to the volume of your
choice. Then click on the Save button.

2. Click on the OK button when the File Saved pop-up window
appears.

Select File-»Exit if you want to exit the Wellfleet Configuration
Manager window. You are returned to the Wellfleet Site Manager
window.

Refer to the section, “Transferring a Configuration File to the Wellfleet
Router,” if you want to transfer the configuration file to the router. You
must do this if you want to boot the router with this file.

Saving a Configuration File in Remote Configuration Mode

This section describes how to save a configuration created or modified
in remote configuration mode to a file on the router.
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Saving a Configuration File

¥

Warning Ensure that you have sufficient free space on the router’s
memory card or disk before using the Router Files Manager
TFTP command to transfer a file to it, or when saving a file
in Configuration Manager remote mode. When you use the
File-»Save or File»Save As options in remote configuration
mode, the configuration is automatically transferred to the
router’s file system. The destination system in a file transfer
automatically overwrites any file already on its volume that
has the same filename. If enough space does not exist on the
file system for the new file, and the new file has the same
name as an old file, the old file will be destroyed and the
new file will be corrupt. This is because TFTP copies the
new file over the old and runs out of space before completing
the copy. Be sure to follow the instructions in this section to
avoid corrupting the config file in the router if the
Configuration Manager is in remote mode.

The recommended procedure for saving a corfig file created or modified
in remote configuration mode is

1. If the file system on the router is an NVFS, compact the memory
card to optimize the available space as follows:

a. Select Tools>Router Files Manager in the Wellfleet Site
Manager window.

The Wellfleet File System Manager window appears.
b. Select Commands->Compact.

c. Click on the OK button in the Confirmation window. (If the file
system on the router is DOS, disregard this step.)

2. Select File->Save As from the Wellfleet Configuration Manager
window.
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3. The Save Configuration File window displays an Enter File name
box.

4. Enter a new filename, such as temp, and click on the Save button.
Do rot use the filename config.

5. Click on the OK button when the File Saved pop-up window
appears.

You replace an old configuration file with a new one as follows:

1. Verify the integrity of the new file first by booting with that file
(refer to the section “Rebooting a Wellfleet Router with a
Configuration File” later in this chapter).

2. Verify that there is enough space on the volume for another copy by
selecting Tools>Router Files Manager in the Wellfleet Site
Manager window.

The Wellfleet File System Manager window displays the files, file
sizes, and available free space. The contiguous free space displayed
in this window applies only to memory cards.

3. Ensure that there is enough space on the volume for the file.

DOS Instructions: Ensure that the space occupied by the new file is
not larger than the available free space.

NVEFS Instructions: Ensure that the space occupied by the new file
is not larger than the contiguous free space.

4. If enough space is available, copy the file to the old filename. Refer
to Managing Wellfleet Routers for detailed file management
instructions.

Saving a Configuration File in Dynamic Configuration Mode

If you made changes to the currently active configuration file in the
dynamic configuration mode, you may save these changes to a file on
the router’s file system. This preserves the current configuration file,
yet gives you the option to reboot the router with these changes later.
When you save these changes, the file is saved directly to the router.
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To save your changes, start at the Wellfleet Configuration Manager
window, and complete the following steps:

1.

Select File=>Save As.

The Save Configuration File window displays an Enter File name
box.

Enter a new filename to save the configuration file on the router,
using the following format:

filename.cfg

where filename is the name you are assigning this file, and cfg
specifies the file type.

If the file system on the router is an NVFS, and the volume (slot
location of the memory card on the router) that appears in the
Volume box is not the volume to which you want to save this file,
click on the Volume box and select an alternate volume. Otherwise,
go to the next step.

Click on the Save button.

Click on the OK button when the File Saved pop-up window
appears.

If you want to reboot the router with the file you just created and
saved, refer to the section “Rebooting a Wellfleet Router with a
Configuration File” for instructions.

Transferring a Configuration File to the Wellfleet Router

The Router Files Manager allows you to transfer files between the Site
Manager workstation and any Wellfleet router using TFTP. You must
transfer a configuration file that has been configured and saved in local
mode to the router before you can reboot the router with it.
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vy

Warning The destination system in a file transfer automatically

overwrites any file already on its volume that has the same
filename. If enough space does not exist on the file system
for the new file, and the new file has the same name as an
old file, the old file will be destroyed and the new file will be
corrupted. This is because TFTP copies the new file over the
old and runs out of space before completing the copy. Be sure
to follow the instructions in this section to avoid corrupting
the config file.

Transferring files from the Site Manager workstation to a router
involves the following steps:

1.
2.

4.

Choosing the router to which you want to transfer the file.

Examining the existing filenames on the router destination
volume.

Verifying the existence of adequate free space on the destination
volume.

Transferring the file to the destination volume.

To choose the router to which you want to transfer the file, follow these
steps from the Router Files Manager window:

1

2.

Select Options>Router Connection from the Router Files Manager
window.

The Router Connection Options window appears (Figure 6-1).
Enter the IP address of the router and click on OK.
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L]

[®] Router Comnection Options

Node Name/IP Address 192, 32, 14,80

Identity (Community) public

Timeout (seconds)

—_ —
[o2]

Retries (per request)

Cancel

Figure 6-1. Router Connection Options Window

You should choose a filename that is unique to the router when
transferring the file. The names of the files currently on the router are
displayed in the Router Files Manager window (Figure 6-2).
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@ Fovter Files fammger g

File Options Commands

Help

System Name: 192,32, 14.59

Volume:

o CTRID. CRG 7343

T.CFG 34
CONFIG 2108
AT, BAT 47864
AT, AL 4011
AURP, BAT 19945
ACE. OUT 1206402
I1_STRUD. CFG 2108

T

27,
27,
27,
27,
217,
10,
27,

Jul
Jul
Jul
Jul
fug

Total size: 1474560
Available free space: 169472
Contiguous free space: 169472

Figure 6-2. Router Files Manager Window

You must make sure that the router destination volume has enough
space available for the file you transfer. The Router Files Manager

window shows the available free space and contiguous free space on
the router. For a DOS file system, use the number of bytes displayed
for available free space. For an NVFS file system, use the number of
bytes displayed for contiguous free space.

If the file system on the router is an NVFS, compact the memory card
to optimize the available space as follows:

1. Select Commands->Compact in the Router Files Manager window.
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2. Click on the OK button on the Confirmation window.

To transfer a file from the Site Manager workstation to the router,
select File>TFTP->Put File(s) from the Router Files Manager window.
The TFTP Put File Selection window appears (Figure 6-3).

[® TFTP Put File Selection

Path: [ Bextra/sogr

Files: , Files To Put:

mod_0035, cfg
mod_0036. cfg Add )

mod_0037, cfg
mod_0038, cfg
mod_0039, cfg
mod_0041, cfg
mod_0066, cfg
bep

mod_(055, cfg
BLNX, cfg, bak
bgp. bak

BLNX, cfg

Multiple Routers: EEI:O:I
|

Figure 6-3. TFTP Put File Selection Window

1. In the Path box, enter the pathname of the directory on the Site
Manager workstation that contains the file you want to transfer.
The files in that directory appear in the Files window. You may
transfer more than one file at a time.

2. In the Files window, click on the files that you want to transfer to
the router. Then click on Add. The selected files appear in the Files
To Put window.

6-10



Implementing Configuration Changes

If you inadvertently add files that you do not want to transfer to the
router, select those files in the Files To Put window and click on
Remove.

3. Repeat Steps 1 and 2 to select files from other directories that you
want to transfer to the router.

4. Ifyou want to send files to only one router, click on No in the
Multiple Routers field. The Router Files Manager transfers the
selected files to the router to which you are currently connected.

Refer to Managing Wellfleet Routers for information on transferring
files to multiple routers.

5. Click on OK.

During the file transfer operation, the Router Files Manager
displays a message in the window indicating which file is currently
being transferred, and the address of the router that is receiving
the files. When the transfer is complete, the TFTP Put File
Selection window closes and you return to the Router Files
Manager window.

Now that you have transferred your configuration file to the router, you
can reboot the router with it. The next section provides instructions.
You replace an old configuration file with a new one as follows:

1. Verify the integrity of the new file first by booting with that file.

2. Verify that there is enough space on the volume for another copy by
selecting Tools»Router Files Manager from the Wellfleet Site
Manager window.

The Router Files Manager window displays the files, file sizes, and
available free space. The contiguous free space displayed in this
window applies only to memory cards.

3. Ensure that there is enough space on the volume for the file.

DOS Instructions: Ensure that the space occupied by the new file is
not larger than the available free space.

NVFS Instructions: Ensure that the space occupied by the new file
is not larger than the contiguous free space.
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4. If enough space is available, copy the file to the old filename. Refer
to Managing Wellfleet Routers for detailed file management
instructions.

Rebooting a Wellfleet Router with a Configuration File

After you save a configuration file to the router, you implement the
configuration by rebooting the router with that configuration file. You
begin from the Wellfleet Site Manager window and proceed as follows:

1. Select Administration=>Boot Router.

The Boot Router window appears (Figure 6-4). The default volume
is displayed next to the Boot Image file (bn.exe) and default
configuration file (config). The default volume is the first available
memory access card (indicated by slot number) on a router with an
NVFS or volume A on a router with a DOS file system.

Refer to Step 2 if you want to boot from the default volumes and

configuration file.
Boot Router
Boot Cancel

Boot Image: | 1: m”bn.exe f

Configuration: § =] ”config i

Figure 6-4. Boot Router Window

If the router has multiple volumes, you can select one volume from
which to read the router software image and another from which to
read the configuration file, as follows:

a. Click on the rectangle adjacent to the Boot Image volume
number.
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A pop-up window displays the available volumes containing the
router software image.

Click on the number of the slot from which you want to boot.

The pop-up window closes and the new slot number is displayed
next to Boot Image.

Click on the rectangle adjacent to the Configuration slot
number.

A pop-up window displays the available slots containing the
configuration file.

Click on the number of the slot you want to configure from.

The pop-up window closes and the new slot number is
displayed.

Enter the configuration filename in the Configuration filename box
if you want to configure from an alternative file. When you select
the Boot button, the router boots using the router software image
and configuration files in the volumes displayed.

2. Click on the Boot button.

The router boots using the router software image and the
configuration file you specified.

Note:

The router software image and configuration file revert to their
respective default volumes and filenames (boot.exe or ace.out
and config) after every boot. To change the default boot or
configuration file, back up the old default file, using the copy
option; then overwrite the old default file with the new default
file, using the copy option.

After you successfully reboot the router with a configuration file, and it
is up and running on your network, it is actively routing and bridging

traffic.
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Configuration Change Utility

The Configuration Change utility is a Site Manager feature that
enables you to change an existing configuration file so that it operates
on an identical router model. You can develop a standard configuration
file, apply it to applicable routers, and then customize as needed.

A series of windows prompt you for the information necessary to move
a configuration file to an identical router without having to create the
configuration from scratch. This utility is helpful in configuring
multiple routers.

Protocols that are not configured are skipped in the window sequence.

Basic Operation

In local mode, select File=>Profiler from the Wellfleet Configuration
Manager window (Fiigure 6-5). The Configuration Change utility
displays windows with the parameters to edit for each configured
protocol.

gj Configuration Manager

File Options Platform Circuits Protocols Dialup Window Help

Configuration Mode: 1
SM

Slot

— o W H

MIB Version: x8, 00

ocal
P Agent: LOCAL
File Name: /extra/srr@r/heather/’conflgchgl
Model: Backbone Link Node (BLN)
Color Key: Used Unused

Description Connectors
Enpty Slot |1 NONE |{ NONE |i{ NONE |i NONE |

§

15740 Dual Sync, Single Token|{ COML || COM2 || NONE || TOKEND |
15430 Dual Sync, Dual Ethernet|{ COML || COoM2 |{ XCWR2 | ‘
i
[

5300 Guad Sync | T comt | come ] come ] [ come |

COMSOLE

System Resource Module |

Figure 6-5. Configuration Manager Window
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The following sections summarize the windows that can appear for
each protocol. The parameters to be edited on each window are
documented in the section on the corresponding protocol elsewhere in

this manual.

Source Routing Global Profile

The Source Routing Global Profile window (Figure 6-6) displays the
Source Routing Bridge Internal LAN ID. Edit this parameter, as

needed.

[®] Source Routing Global Profile

Configuration Mode: local
SNMP Agent: LOCAL FILE

SR Bridge Internal LAN ID

[ @6

Figure 6-6. Source Routing Global Profile Window

Source Routing Interface Profile Window

The Source Routing Interface Profile window (Figure 6-7) displays the
Source Routing Ring Number. Edit this parameter, as needed.
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[®] Source Routing Interface Profile

A Done
[~ —

8pply
Values, ..
Help...

il

K

Source Routing Ring Number IOXZ

Figure 6-7. Source Routing Interface Profile Window

IP Interface Profiles Window

The IP Interface Profiles window (Figure 6-8) lists all IP interfaces in
the configuration. Add a new IP address and edit the Subnet Mask and
Broadcast Address parameters, as needed. If you change an IP address
in this window, the system modifies all related objects with the old

address to reflect the new IP address.
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@] IP Interface Profiles
1 Done |
v
| — ]
New IP Address I .
Subnet Mask [ 255, 255, 255, 0 | l
Broadcast Address IO. 0.0, 0 ; ¥

Figure 6-8. IP Interface Profiles Window

SNMP Manager Profiles Window

The SNMP Manager Profiles window (Figure 6-9) lists all SNMP
managers in the current configuration. Edit the Trap Port and Trap
Types fields for the selected SNMP manager, as needed.
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[®] SNMP Manager Profiles
2 Done |
[+
[ m———
Trap Port | 162 l
Trap Types [ GENERTC | ¥

Figure 6-9. SNMP Manager Profiles Window

DECnet Interface Profiles Window

The DECnet Interface Profiles window (Figure 6-10) displays the New
Area ID and the New Node ID. Edit these parameters, as needed.
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[®] DECnet Interface Profiles
i Done |
v
4 o
New Area ID [1 | '
New Node ID [1 I

Figure 6-10. DECnet Interface Profiles Window

Vines Interface Profiles Window

The VINES Interface Profiles window (Figure 6-11) lists the following
parameters:

o SMDS Broadcast
o Frame Relay Broadcast
o Configured MAC Addresses

Edit any of these parameters, as needed.
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[® Vines Interface Profiles
4] 1 Do__ne_______l

SMDS Broadcast I
Frame Relay Broadcast |
Configured MAC Address |

Figure 6-11. VINES Interface Profiles Window

IPX Interface Profiles Window

The IPX Interface Profiles window (Figure 6-12) lists the New Network
Address. Edit this parameter, as needed.
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[® IPX Interface Profiles
0000 Ly Bl Done
Help...
7}
com— ]
New Network Address (hex) | 5!

Figure 6-12. IPX Interface Profiles Window

AppleTalk Interface Profiles Window

The AppleTalk Interface Profiles window (Figure 6-13) lists the
following parameters:

Network Start
Network End
Default Zone
Network ID
Node ID

Q o o o Q

Edit any of these parameters, as needed.
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[@ fppleTalk Interface Profiles
A
!
Network Start |1 i
Network End [1 |
Default Zone [ hey |
Network ID 10 |
Node ID [o |

Figure 6-13. AppleTalk Interface Profiles Window

The OSI Profiles Window

The OSI Profiles window (Figure 6-14) lists the following parameters
to enter in hex format:

o Router ID
0 Area Address

Edit any of these parameters, as needed.
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[@®] 08I Profiles

Configuration Mode: local
SNMP Agent: LOCAL FILE
Router ID (hex) [ Bx123456789098 |

Area Address (hex) | 0x490040

« (-

Figure 6-14. OSI Profiles Window

X.25 Packet Level Profiles Window

The X.25 Packet Level Profiles window (Figure 6-15) displays the

following X.25 packet level parameters:
Network Address Type

PDN X.121 Address

DDN IP Address

Incoming Logical Channel Count
Incoming LCN Start

Bidirectional Logical Channel Count
Bidirectional LCN Start

Outgoing Logical Channel Count
Outgoing LCN Start

Q o o o o o o o o

Edit any of these parameters, as needed.
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[®] X25 Packet Level Profiles 0
A
v

| om— ]

Network Address Type [ PDN_NETWORK |

PDN %, 121 Address 12345 |

DDN TP Address | |

Incoming Logical Channel Count |0 }

Incoming LCN Start |0 f

Bidirectional Logical Channel Count [0 ;

Figure 6-15. X.25 Packet Level Profiles Window

X.25 Service Profile Window

The X.25 Service Profile window (Figure 6-16) displays the following
X.25 service-level parameters:

g Connection ID
g Remote IP Address
g Remote X.121 Address

Edit any of these parameters, as needed.
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(@] %25 Service Profile NI

05 IO, ot e (0, Cotf o fon 1 B
K

o— ]

Connection ID | § 4

Renote IP Address [ 192, 32. 156, 1 | l

Remote X, 121 Address [ 234 e

Figure 6-16. X.25 Service Profile Window
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Appendix A
Site Manager Default Settings

This appendix lists the default settings for Site Manager. Use the
Configuration Manager to edit any of the Site Manager default
settings listed here.

Circuit Parameters

Site Manager supports Ethernet, FDDI, synchronous, asynchronous,
E1, T1, Token Ring, MCT1, MCE1, HSSI, and ISDN circuits. The
following sections describe the Site Manager default parameter
settings for these circuits.

Table A-1. Ethernet Circuit Parameters

Parameter Default

Enable Enable

BOFL Enable Enable

BOFL Timeout 5s

Hardware Filter Disable (this default is changed to Enable
if you add a circuit and reply OK to the
prompt Do you want to enable Hard-
ware Filters on this circuit?)
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Circuit Parameters

Table A-2. FDDI Circuit Parameters

Parameter | Default
Enable Enable
BOFL Enable Enable
BOFL Timeout 3s

Hardware Filter

Disable (this default is changed to Enable
if you add a circuit and reply OK to the
prompt Do you want to enable Hard-
ware Filters on this circuit?)

Table A-3. FDDI SMT Attributes Parameters

Parameter Default
Connection Policy 0xff65
T_Notify Timeout (s) 22 s

Trace Max Expiration (ms) 7000 ms (7 s)
Status Report Protocol Enable
Duplicate Address Protocol Enable

User Data None

Table A-4. FDDI MAC Attributes Parameters

Parameter

Default

LLC Data Enable

Enable
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Site Manager Default Settings

Table A-5. FDDI Path Attributes Parameters

Parameter Default
Tvx Lower Bound (ms) 2.5 ms
T_Max Lower Bound (ms) 165 ms
Requested TTRT (ms) 165 ms

Table A-6. FDDI Port Attributes Parameters

Parameter Default
LER Cutoff 7
LER Alarm 8

Table A-7. Synchronous Circuit Parameters

Parameter Default

Enable Enable

BOFL Enable (Disable if X.25 is enabled)
BOFL Timeout 5s

MTU (Maximum Transfer 1600 B

Unit)

Promiscuous Disable

Clock Source External

Internal Clock Speed 64 KB

continued on the next page




Circuit Parameters

Table A-7.  Synchronous Circuit Parameters (continued)

Parameter Default

External Clock Speed 64102 B

Signal Mode Balanced

RTS Enable Disable

Burst Count Enable

Service LLC1 (LAPB if X.25 is enabled)
Transmit Window Size 1

Minimum Frame Spacing 1 flag

Local Address Explicit (DCE or DTE if X.25 is enabled)
Remote Address Explicit (DCE or DTE if X.25 is enabled)
WAN Protocol None

Pass Thru Local Address None

Pass Thru Remote Address None

CRC Size 16-bit

Sync Media Type 1

Sync Polling Disable

KG84A Cycle 100 ms

KG84A Sync Loss Interval 50 cycles

KG84A Remote Sync Wait 200 cycles

KG84A Sync Pulse 10 ms

Network Link Level NET2

Retry Count 16 attempts

continued on the next page
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Site Manager Default Settings

Table A-7.  Synchronous Circuit Parameters (continued)

Parameter Default

Link Idle Timer 9s

Extended Control (S and I Disable

frames)

Idle Receiver Ready (RR) Off

Frames

Cable Type Null

Retry Timer 3s

Extended Address Disable

Remote Loopback Detection Disable
Table A-8. LAPB Parameters

Parameters Default

Enable Enable

Station Type DTE

Control Field Modulo 8

Max N1 Frame Size (octets) 1600

Max Unacknowledged 7

Sequence Frames

N2 Retries 10

%Vl)ax T1 Acknowledge Timer 3s

s

continued on the next page




Circuit Parameters

Table A-8. LAPB Parameters (continued)

Parameters Default
Max T2 Acknowledge Delay 1 second
Timer (s)

Max T3 Disconnect Timer (s) | 60 s
Initiate Link Setup Action Active
Enable Rx/Tx of XID Frames | Enable
Idle RR Frames OFF
Command/Response Address | DTE
WAN Protocol Standard

Table A-9. Asynchronous Circuit Parameters

Parameter Default
Enable Enable
MTU 1000 B
Start Protocol Answer
Remote IP Address None
Remote Port 7

Local Port 2100
Baud Rate 9600
Idle Timer 20
Receive Window 4096
TCP KeepAlive 8

continued on the next page
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Site Manager Default Settings

Table A-9. Asynchronous Circuit Parameters (continued)

Parameter Default
TCP Inactive Limit 300
Cfg Transmit Queue (TxQ) None
Length
Cfg Receive Queue (RxQ) None
Length

Table A-10. T1 Circuit Parameters
Parameters Default
Enable Enable
Frame Type ESF
B8ZS Support Disable
Line Buildout 1ft
Clock Mode Internal
Mini Dacs Idle

Table A-11. Token Ring Circuit Parameters

Parameter Default
Enable Enable
MAC Address Override None
MAC Address Select Boxwide

continued on the next page




Circuit Parameters

Table A-11. Token Ring Circuit Parameters (continued)

Parameter Default
Speed 16 MB/s
Early Token Release None

Table A-12. MCT1 Set Clock Parameters

Parameters Default

Primary Clock Port 1 Ext Loop

Secondary Clock Internal
Table A-13. MCT1 Port Parameters.

Parameters Default

Enable/Disable Enable

MTU Size 1600 B

Line Type ESF

Line Coding B8ZS

Signal Level 0.0dB

Setup Alarm Threshold 2s

Clear Alarm Threshold 2s

FDL Configuration ANSI T'1.403

Remote FDL HDLC BY

Address Mode

continued on the next page
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Site Manager Default Settings

Table A-13. MCT1 Port Parameters (continued)

Parameters Default
Accept Local Loopback Enable
Loopback Configuration No Loopback

Table A-14. MCT1 Logical Line Parameters

Parameters Default
Enable/Disable Enable
BOFL Enable/Disable Enable
BOFL Timeout s
Fractional Loopback Disable
WAN Protocol Standard
Service LLC1
Local HDLC Address 7

Remote HDLC Address 7

Rate Adaptation 56 KLSB
InterFrame Time Fill Flags
Character

CRC Size 16-bit

continued on the next page
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Circuit Parameters

Table A-15. MCT1 Port Actions Parameters

Parameters Default
Line Type None
Line Coding None
Signal Level None
Reset BERT Counters Reset
Loop Up Transmit
Loop Down Transmit
FDL Payload Loop Transmit
FDL Disable Payload Loop Transmit
FDL Line Loop CI Transmit
FDL Line Loop IA Transmit
FLD Line Loop IB Transmit
FDL Disable Line Loop Transmit
FDL Disable All Transmit

Table A-16. MCE1 Set Clock Parameters

Parameters Default
Primary Clock Port 1 Ext Loop
Secondary Clock Internal
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Site Manager Default Settings

Table A-17. MCE1 Port Parameters

Parameters Default
Enable/Disable Enable
Line Type E1
Line Coding HDB3
Setup Alarm Threshold 2s
Clear Alarm Threshold 2s
International Bit Disable

Table A-18. MCE1 Logical Line Parameters

Character

Parameters Default
Enable/Disable Enable
BOFL Enable/Disable Enable
BOFL Timeout 5s
Fractional Loopback Disable
WAN Protocol Standard
Service LLC1
Local HDLC Address 7

Remote HDLC Address 7

Rate Adaptation 64 KLSB
InterFrame Time Fill Flags
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Circuit Parameters

Table A-18. MCE1 Logical Line Parameters (continued)

Parameters Default
CRC Size 16-bit
MTU Size 1600

Table A-19. MCE1 Port Actions Parameters

Parameters Default
BERT Mode Enable Disable
BERT Send Alarm Disable
BERT Test Pattern Ones
International Bit Enable
Line Coding None
Line Type None
Auto Ebit Enable
Reset BERT Counters Reset
Insert 1 Error Insert
Insert 1 Error/1K Insert
Insert 1 Error/1M Insert
Disable Insert Error Disable
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Site Manager Default Settings

Table A-20. HSSI Circuit Parameters

Parameter Default

Enable Enable

BOFL Enable

BOFL Frequency 1ls

MTU (Maximum Transfer 4495 B

Unit)

WAN Protocol None

Transmission Interface DS3

External Clock Speed 46359642 (44.736 MB/s)
CRC Size 32-bit

Table A-21. ISDN Circuit Parameters

Parameter Default
Switch Type BRIVN3
Local Phone Number None
Local Phone Extension None
Acceptable LAPD MTUs 400 B
BRI Timer Timeout 10s
BRI B Channel Loopback Disable
Configuration Type BRIVN3

continued on the next page
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WAN Protocol Parameters

WAN Protocol Parameters

Table A-21. ISDN Circuit Parameters (continued)

Parameter Default
Incoming Filter Enable
Channel Type Logical Channel

This section describes the Site Manager default parameter settings for
the Frame Relay, SMDS, SDLC, X.25, ATM DXI, ATM FREZ2, and
Point-to-Point (PPP) protocols, including the Wellfleet Compression

Protocol (WCP).

Table A-22. Frame Relay Interface Parameters

Parameter Default
Enable Enable
Mgmnt Type ANSI T1 617D
Address Addr Q922
Address Length 2B
Polling Interval 10s

Full Enquiry Interval 6

Error Threshold 3
Monitored Events 4
Multicast Enable
Congestion Control Disable

continued on the next page
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Site Manager Default Settings

Table A-22. Frame Relay Interface Parameters (continued)

Parameter

Default

Congestion Timer

1s

Congestion Counter

20 notifications

Table A-23. Frame Relay PVC Parameters

Parameter Default
Circuit State Set Active
Multicast Unicast
Mode Group Access
Congestion Control Inherit
Congestion Timer | ls

Table A-24. SMDS Interface Parameters

Parameter Default
Enable Enable
Individual Address None
Group Address None
ARP Address None
Heartbeat Poll Disable
Heartbeat Poll Interval 10s

continued on the next page
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WAN Protocol Parameters

Table A-24. SMDS Interface Parameters (continued)

Parameter Default
Heartbeat Poll Down Count 3 messages
LMI Network Mgmt Disable
Congestion Counter 20 notifications

Table A-25. SDLC Interface Parameters

Parameter Default

Enable Enable

Port Name None

Line Type Leased

Topology PTOP (Point-to-Point)
No Activity Timer 15s

Poll List Traversal Time 20 tenths of a second
Initial Flow Control Credit 7

Idle Line Timer 10000 ms

Idle Retry Limit 64

Non-Productive Timer 1000 ms
Non-productive Retry Limit 6400

Port Write Timer 10000 ms

Port Write Retry Limit 64

Link Connection Timer 10000 ms

continued on the next page
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Site Manager Default Settings

Table A-25. SDLC Interface Parameters (continued)

Parameter Default
Link Connection Retry Limit | 64
Primary Full Duplex True
Secondary Full Duplex True
Enable Reject Frame True
Port Type Leased
Max XID Size 256
Max Frame Retransmit 5

Count

Max Frame Size PDU2057
DLC Name None
Local CP Type Network
Link Station Role Primary
Port Number 1

Link Station Address None
Total Link Station Limit 4
Inbound Link Station Limit 2
Outbound Link Station Limit | 2
Support Negotiable Connect True
Receive Buffer Pool Size 7
Enable Stats Collection False
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WAN Protocol Parameters

Table A-26. SDLC Link Station Parameters

Parameter Default
Link Station Address None
Enable Enable
Group Address 0

Link Station Role Primary
Max PDU Size None
Required Reply Timer 10 tenths of a second
Max Un-Acked In Frames 7

Max Un-Acked Out Frames 7
Window Size 8
Transmit Retry SEQ’s 20
Retry SEQ’s Interval 2s

Max Retry SEQ’s to Frame 4

Max Time in RNR State 3 min
Initial Contact Timer 4000 ms
Initial Contact Retry Limit 4

Slow Poll Contact Timer 4000 ms
Slow Poll Retry Limit 4
Retransmit DISC Timer 4000 ms
Retransmit DISC Retry Limit | 4

Slow Poll List Timer 4000 ms

continued on the next page
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Site Manager Default Settings

Table A-26. SDLC Link Station Parameters (continued)

Parameter Default
Slow Poll List Retry Limit 4

Time on Slow Poll List 4000 ms
Max Times on Slow Poll List | 4000
Retry Count to Failure 400
Busy Link Station Limit 400
Max Wait for RR 1500 ms
Group Address Name None
Pre-Activation Poll Frame XD
Send Poll on I-Frame True
Link Station Name None
Link Station Flow Control False
Adjacent Node Type None
Support SIM/RIM False

Table A-27. X.25 Global Parameters

Parameter

Default

Enable

Enable
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WAN Protocol Parameters

Table A-28. X.25 Packet-Level Parameters

Parameters Default

Enable Enable \
Network Address Type None

PDN X.121 Address None

DDN IP Address None

Sequence Size MODS8

Restart Procedure Type DTE_Restart (for DTE)YDCE_Restart (for
DCE)
Default Tx/Rx Window Size 2
Default Tx/Rx Pkt Length 128
Incoming Logical Count 0
Incoming LCN Start 0
Bidirectional Logical Channel | O
Count
Bidirectional LCN Start 0
Outgoing Logical Channel 0
Count
Outgoing LCN Start 0
T1 Timer 60 s
T2 Timer 180 s
T3 Timer 200 ms
T4 Timer 200 ms
Flow Control Negotiation Off
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Site Manager Default Settings

Table A-28. X.25 Packet-Level Parameters (continued)

Parameters Default
Max Window Size 2

Max Packet Length 128
Tx/Rx Throughput Class 3
Throughput Class Off
Negotiation

Max Throughput Class 19200
Network User Identification Off
Incoming Calls Accept On
Outgoing Calls Accept On
Fast Select Accept Off
Reverse Charge Accept Off
Fast Select Off
Reverse Charging Off
CUG Selection Null
CUG Outgoing Access Null
CUG Bilateral Selection Null
RPOA Selection Off
Charging Information Off
Transit Delay Off
Full Addressing On
Acceptance Format Basic (2)
Release Format Basic (2)

continued on the next page
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WAN Protocol Parameters

Table A-28. X.25 Packet-Level Parameters (continued)

Parameters Default
CCITT Conformance DXE1988
Network Standard None
Statistics Computation Enable

Table A-29. X.25 Network Service Records Parameters

Parameters Default
Enable Enable
Type None
Connection ID 1
Remote IP Address | 0.0.0.0
Remote X.121 Address None
Broadcast Off
Max Connections 2
Precedence Off
Max Idle (Mins) 2

Call Retry 60
Flow Facility Default
Window Size 2
Packet Size 128
Fast Select Request Off

continued on the next page
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Site Manager Default Settings

Table A-29. X.25 Network Service Records Parameters (continued)

Parameters Default
Fast Select Accept Off
Reverse Charge Request Ooff
Reverse Charge Accept Off
DDN BFE Disable
User Facility (hex) None
CUG Facility Format None
CUG Facility Type Normal
CUG Number 0

Table A-30. ATM DXl Interface Parameters

Parameter Default

Enable Enable

Interface Description None

DXI Mode Mode 1A

Max # VCs 512

Multi Protocol Encapsulation | RFC 1483 Style MPE
CS PDU Encapsulation AALS5 Encapsulation
Multicast Disable

LMI Enable Disable
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WAN Protocol Parameters

Table A-31. ATM DXI Virtual Circuit Parameters

Parameter Default
VPI Number None
VCI Number None

Table A-32. ATM DXI PVC List Parameters

Parameter Default

Enable Enable

Mode Group Access

Multi Protocol Encapsulation | RFC 1483 Style MPEm (hybrid or direct)
CS PDU Encapsulation AALS5 Encapsulation (hybrid or direct)
Multicast Unicast (hybrid or direct)

Table A-33. ATM FRE2 Interface Parameters

Parameter Default

Administrative State UP

A-24



Site Manager Default Settings

Table A-34. ATM FRE2 Virtual Channel Link Parameters

Parameter Default
VPI Number None
VCI Number None

Table A-35. ATM FRE2 Virtual Channel Link Settings

Parameter Default

VCL Mode GROUP ACCESS
Administrative State UP

Xmit Peak Cell Rate (Cells/ 4716

Sec)

Xmit Sustainable Cell Rate 4716

(Cells/Sec)

Xmit Burst Size (Cells/Sec) 40

AAL Type AALS5 Encapsulation
Maximum AAL CPCS Trans- | 4500

mit SDU Size

Maximum AAL CPCS 4500

Receive Size

Data Encapsulation Type RFC 1483
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WAN Protocol Parameters

Table A-36. ATM/ALC Parameters

Parameter Default
Enable Enable
Data Path Notify Enable
Data path Notify Timeout 3

Table A-37. ATM/ALC SAR Traffic Management Parameters

Parameter Default
Peak Cell Rate 235849
Sustainable Cell Rate 235849
Maximum Burst Size 40

Table A-38. ATM/ALC Physical Interface Attributes

Parameter Default
Framing Mode Unassigned
Scrambling Enable
Loop Back Disable
Cell Insertion Unassigned




Site Manager Default Settings

Table A-39. Point-to-Point (PPP) Interface Parameters

Parameter

Default

IP Enable

If you enabled IP support on this interface,
then Site Manager automatically sets IP
Enable to Enable. Otherwise, the default
is Disable.

OSI Enable

If you enabled OSI support on this inter-
face, then Site Manager automatically sets
OSI Enable to Enable. Otherwise, the
default is Disable.

XNS Enable

If you enabled XNS Enable on this inter-
face, then Site Manager automatically sets
XNS Enable to Enable. Otherwise, the
default is Disable.

DECnet IV Enable

If you enabled DECnet IV support on this
interface, then Site Manager automati-
cally sets DECnet IV Enable to Enable.
Otherwise, the default is Disable.

AppleTalk Enable

If you enabled AppleTalk support on this
interface, then Site Manager automati-
cally sets AppleTalk Enable to Enable.
Otherwise, the default is Disable.

IPX Enable

If you enabled IPX support on this inter-
face, then Site Manager automatically sets
IPX Enable to Enable. Otherwise, the
default is Disable.

Bridge Enable

If you enabled Bridging on this interface,
then Site Manager automatically sets this
parameter to Enable. Otherwise, the
default is Disable.

continued on the next page
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WAN Protocol Parameters

Table A-39. Point-to-Point (PPP) Interface Parameters (continued)

Parameter Default

WCP Enable If you enabled the Wellfleet Compression
Protocol on this interface, then Site Man-
ager automatically sets this parameter to
Enable. Otherwise the default is Disable.

VINES Enable If you enabled VINES support on this
interface, Site Manager automatically sets
VINES Enable to Enable. Otherwise, the
default is Disable.

Remote IP Address 0.0.0.0

IPX Network Number None

IPX Remote Node Number None

Remote AppleTalk Node None

AppleTalk Routing Protocol RTMP

Bridge Enet Enable

Bridge FDDI Enable

Bridge Token Ring Enable

Table A-40. Point-to-Point (PPP) Line Lists Parameters

Parameter Default
Enable (LCP) Enable
Restart Timer in s 3s

s between Xmit of Echo- 0
Request

continued on the next page
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Site Manager Default Settings

Table A-40. Point-to-Point (PPP) Line Lists Parameters (continued)

Parameter Default
Echo-Reply Acceptable Loss 3

Max Configure-Requests 1000
Max Terminate-Requests 2

Max Configuration Failure 10
Count

Local Authentication Protocol | None
Local PAP Id None
Local PAP Password None
Remote PAP Id None
Remote PAP Password None
Link Quality Protocol "None
Peer Link Quality Report Enable
Timer

LQR Reporting Period 3s
Inbound Link Quality 90 %
Outbound Link Quality 90 %

Table A-41. Wellfleet Compression Protocol Circuit Interface Parameters

Parameter Default
Enable Enable
Compression Mode Inherit from Line
History Size Inherit from Line
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Bridge Parameters

Table A-42. Wellfleet Compression Protocol Line Interfaces Parameters

Parameter

Default

Enable

Enable

Compression Mode

Continuous Packet

History Size 32 KB
Buffer Size Normal
Bridge Parameters

This section describes the Site Manager default parameter settings for
the Transparent Bridge (including Spanning Tree), the Source Routing
Bridge, Source Routing NetBIOS Broadcast Reduction, and the
Transparent-to-Source-Routing Translation Bridge.

Table A-43. Transparent Bridge Global Parameters

Parameter Default
Enable Enable
Bridge Table Size 1024 entries
Enable Forwarding DB Enable
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Site Manager Default Settings

Table A-44. Transparent Bridge Interface Parameters

Parameter

Default

Enable

If you added Bridging either using the
Quick Start procedure or the configuring
circuits procedure, this parameter defaults
to Enable.

If you previously used this parameter to
disable Bridging on this circuit, the
parameter defaults to Disable.

Translation Bridge Enable

Disable

Table A-45. Spanning Tree Global Parameters

Parameter Default

Enable Enable

Spanning Tree Protocol Ver- IEEES802ID

sion

Bridge Priority None

Bridge MAC Address None

Max Age 20 s (expressed in hundredths of a second:
2000)

Hello Time 2 s (expressed in hundredths of a second:
200)

Forward Delay 15 s (expressed in hundredths of a second:

1500)
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Bridge Parameters

Table A-46. Spanning Tree Interface Parameters

Parameter

Default

Spanning Tree Enable

If you added spanning tree either using
the Quick Start procedure or the configur-
ing circuits procedure, this parameter
defaults to Enable.

If you previously used this parameter to
disable spanning tree on this circuit, the
parameter defaults to Disable.

Path Cost

1

Translation Bridge Enable

Disable

Table A-47. Source Routing Global Parameters

Parameter Default
Enable Enable
SR Bridge Internal LAN ID 0x0

SR Bridge ID 0x0

SR Group LAN ID Oxfff
IP Encapsulation Disable
Conn. IP NTWK Ring 0x0
Number

IP Net MTU (bytes) 4562
NetBIOS Server Name Cache | Disable

continued on the next page

A-32




Site Manager Default Settings

Table A-47. Source Routing Global Parameters (continued)

Parameter Default

NetBIOS Client Name Cache | Disable

NetBIOS Datagram RIF Disable
Cache

15-Character Name Cache Disable

Create MIB Instance for Enable
Cached Name

Max Name Cache Entries 100 entries
Name Cache Age (secs) 300 s
Hash Entry Count 253
NetBIOS Query Cache Disable
Create MIB Instance for Enable
Cached Query

Max Number Query Cache 100 entries
Entries

NetBIOS Query Cache Age 15s

(secs)

Table A-48. Source Routing Interface Parameters

Parameter Default
Enable Enable
Max Number of RDs 7

Source Routing Ring Number | 0x0

continued on the next page
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Bridge Parameters

Table A-48. Source Routing Interface Parameters (continued)

Parameter Default
Outbound STEs Accept
Inbound STEs Accept
Frames with IP Ring Accept
IP Address None
WAN Broadcast Address -1
Encapsulation Format Proprietary
NetBIOS Server Name Cache | Enable
NetBIOS Client Name Cache | Enable
NetBIOS Datagram Name Enable
Cache

NetBIOS Query Cache Enable

Table A-49. Translation Bridge Global Parameters

Parameter Default

Enable Enable

Virtual Lan ID 0x0

Max Translation Entries 255 entries
Aging Value 300 s
Broadcast Conversion Enable
Ethernet Type Ethernet
Source Router Explorer Type | Spanning Tree
SAPs 000408F0F4FC




Site Manager Default Settings

Native Mode LAN (NML) Parameters

This section describes the Site Manager default parameter settings for
Native Mode LAN services.

Table A-50. Native Mode LAN Services

Parameter Default
Disable Enabled
Add Security Header Add Security
SAID Type INDIVIDUAL
SAID Value 0
CUG Value 0
Security List Action Forward

IP Parameters

This section describes the Site Manager default parameter settings for
the Internet Protocol (IP), the Routing Information protocol (RIP), the
Trivial File Transfer Protocol (TFTP), the Revised IP Security Option
(RIPSO), the Bootstrap Protocol (BOOTP), the Internet Group
Management Protocol IGMP), the Distance-Vector Multicast Routing
Protocol (DVRMP), and NetBIOS over IP.
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IP Parameters

Table A-51. [P Global Parameters

Parameter Default
Enable Enable
Forwarding Forwarding
ARP Forwarding Forwarding
Non Local ARP Source Drop

Non Local ARP Destination Drop
Default TTL 30 hops
RIP Diameter 15 hops
Route Cache Interval 60 s
Routing MIB Table(s) “Route

Zero Subnet Enable Disable
Estimated Networks 0
Estimated Hosts 0

Enable Default Route for Disable
Subnets

Table A-52. IP Interface Parameters

Parameter Default

Enable Enable

Subnet Mask You specified the subnet mask when you
added IP to the circuit. .

continued on the next page
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Site Manager Default Settings

Table A-52. IP Interface Parameters (continued)

Parameter Default

Broadcast Address You specified the Broadcast Address
parameter when you added IP to the cir-
cuit.

Interface Cost 1

MTU Discovery Off

Addr Mask Reply Ooff

All Subnet Bcast Ooff

Address Resolution ARP

Proxy Off

Host Cache Off

Checksum On

MAC Address None

TR End Station OFF

Redirects Enable

Enet Arp Encaps ARP Ethernet

SMDS Group Address None

SMDS ARP Req Address None

FR Broadcast DLCI 0

FR Multicast DLCI #1 0

FR Multicast DLCI #2 0

Slot Mask Slot-mask bit set to 1 (enabling circuitless

IP interface support) for every router slot

running IP

continued on the next page
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IP Parameters

Table A-52. IP Interface Parameters (continued)

Parameter Default
Max Forwarding Table Size 128 entries
Enable Security Disable

Table A-53. RIP Interface Parameters

Parameter Default
Enable Enable
RIP Supply Enable
RIP Listen Enable
Default Route Supply Disable
Default Route Listen Disable
Poisoned Reverse Poisoned
Table A-54. TFTP Parameters
Parameter Default
Enable Enable
Default Volume 2
Retry Time Out 58
Close Time Out 25s
Retransmit 5 retransmissions
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Site Manager Default Settings

Table A-55. RIPSO Parameters

Parameter Default
Enable Security Disable
Strip Security None
Require Out Security All

Require In Security None
Minimum Level Unclassified
Maximum Level Top Secret
Must InAuthority None

May InAuthority None

Must OutAuthority None

May OutAuthority None
Implicit Label Enable
Implicit Authority None
Implicit Level Unclassified
Default Label Enable
Default Authority None
Default Level Unclassified
Error Label Enable
Error Authority None
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IP Parameters

Table A-56. BOOTP Relay Agent Interface Parameters

Parameter Default
Enable/Disable Enable
Hops 4 hops
Timeout Secs. ls

Table A-57. IGMP Global Configuration Parameters

Parameter Default
Enable Enable
Estimated Groups 20 groups

Table A-58. DVRMP Base Parameters

Parameter Default
Enable Enable
Full Update Rate 60 s
Triggered Update Rate 5s

Leaf Timeout 200 s
Neighbor Timeout 140 s
Route Expiration Timeout 200 s
Garbage Timeout 340 s
Estimated Routes 25 routes
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Site Manager Default Settings

Table A-59. NetBIOS/IP Global Parameters

Parameter Default
Enable/Disable Enable
NetBIOS Name Caching Disable
15-Character NetBIOS Disabled
Name Caching

Create MIB Inst for Cached Enabled
Name

Max Name Cache Entries 100 entries
Name Cache Age 300 s
Hash Entry Count 253
Rebroadcast Packet TTL 5s
Rebroadcast Record Route | Disabled

Table A-60. NetBIOS/IP Interface Table Parameters

Parameter Default
Enable/Disable Disable
NetBIOS Name Caching Enable
Enable NetBIOS Inbound Enable
Broadcasts

Enable NetBIOS Outbound Enable
Broadcasts

Rebroadcast Address Null
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SNMP Parameters

Table A-61. NetBIOS/IP Static Entry Table Parameters

Parameter Default

Enable Enable

NetBIOS Scope ID None

NetBIOS Station Name None

NetBIOS Scope ID None
SNMP Parameters

This section describes the Site Manager default parameter settings for
the Simple Network Management Protocol (SNMP).

Table A-62. SNMP Global Parameters

Parameter Default
Enable Enable
Use Lock Enable
Lock Timeout 2 min

Authentication Failure Traps | Enable

Trap Debug Events Off
Trap Trace Events Off
Trap Info Events On
Trap Warning Events On
Trap Fault events On

A-42



Site Manager Default Settings

Table A-63. SNMP Community Parameters

Parameter Default
Community Name None
Access Read Only

Table A-64. SNMP Manager Parameters

Parameter Default
Trap Port 162
Trap Type Generic

Table A-65. SNMP Threshold Global Parameters

Parameter Default

Polling Interval 60 s

Table A-66. SNMP Threshold Interface Parameters

Parameter Default
Threshold Enable Enable
Threshold Low Value 10

Threshold Low Event level Info

continued on the next page
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OSPF Parameters

Table A-66. SNMP Threshold Interface Parameters (continued)

Parameter Default
Threshold Medium Value 0
Threshold Medium Event Info

Level

Threshold High Value 0
Threshold High Event Level | Info
Threshold Units Per second
Threshold Action Greaterthan
Threshold Max Successive 5

Alarms

Threshold HoldDown 1
Intervals

Table A-67. SNMP Trap Interface Parameters

Parameter Default

Entity Code/Event Code None

Always/Never Trap None
OSPF Parameters

This section describes the Site Manager default parameter settings for
the Open Shortest Path First (OSPF) Protocol.
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Site Manager Default Settings

Table A-68. OSPF Global Parameters

Parameter Default

Enable Enable

Router ID None

AS Boundary Router False (No)

Hold Down Timer 1s

OSPF Slot All slots

Ase Metric Support Disabled

Backup Enable Enabled

Primary Log Mask All options enabled
Backup Log Mask All options disabled

Table A-69. OSPF Area Parameters

Parameter Default
Enable Enable
Authentication Type No Password
Import AS Extern Yes

Stub Metric 1

Import Summaries True
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OSPF Parameters

Table A-70. OSPF Interface Parameters

Parameter Default
Enable Enable
Area ID 0.0.0.0
Type None
Rtr Priority 1
Transit Delay 1s
Retransmit Interval 5s
Hello Interval 10s
Dead Interval 40 s
Poll Interval 120 s
Metric Cost 1
Password None

Table A-71. OSPF Virtual Interface Parameters

Parameter Default
Enable Enable
Transit Delay 1ls
Retransmit Interval 10s
Hello Interval 15s

continued on the next page
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Site Manager Default Settings

Table A-71. OSPF Virtual Interface Parameters (continued)

Parameter Default
Dead Interval 60 s
Password None

BGP and BGP-3 Parameters

This section describes the Site Manager default parameter settings for
the Border Gateway Protocol (BGP).

Table A-72. BGP Global Parameters

Parameter Default
BGP Enable Enable
BGP Identifier None
BGP Local AS None

Table A-73. BGP-3 Global Parameters

Parameter Default
Enable Enable
Intra AS Routing Enable

continued on the next page
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EGP Parameters

Table A-73. BGP-3 Global Parameters (continued)

Parameter Default
Internal Advertisement 5s
Timer
RIP Rules Disable
Table A-74. BGP Peer Parameters
Parameter Default
Enable Enable
Min BGP Version 3
Max BGP Version 3
Remote AS None
External Advertisement 5s
Timer
Connect Retry Timer 120s
Holdtime 90 s
Keepalive Timer 30s
Path Attribute Table Switch | Enable
EGP Parameters

This section describes the Site Manager default parameter settings for

the Exterior Gateway Protocol (EGP).
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Site Manager Default Settings

Table A-75. EGP Global Parameters

Parameter Default
Enable Enable
Local Autonomous System None

Table A-76. EGP Neighbor Parameters

Parameter Default

Enable Enable

Gateway Mode Core

Acquisition Mode Passive

Poll Mode Both

Hello Timer 60 s

Poll Timer 180 hundredths of a second
TCP Parameters

This section describes the Site Manager default parameter settings for
the Transmission Control Protocol (TCP).

A-49




Telnet Parameters

Table A-77. TCP Configuration Parameters

Parameter Default

Enable/Disable Enable

Min. Retransmission Timeout | 250 ms

Max. Retransmission 240000 ms

Timeout

Max. Window 4096 octets
Telnet Parameters

This section describes the Site Manager default parameter settings for

Telnet.

Table A-78. Telnet Configuration Parameters

Parameters Default
Enable/Disable Enable
TI Line per Screen 24 lines
TI More Enable
TI Prompt $

Login Timeout 1 min
Password Timeout 1 min
Command Timeout 15 min

continued on the next page
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Site Manager Default Settings

Table A-78. Telnet Configuration Parameters (continued)

Parameters Default

Login Retries 3 login attempts
Diagnostic Report Disable
Diagnostic Exercise Disable
Diagnostic Network Data Disable
Diagnostic PTY Data Disable
Diagnostic Options Disable

Table A-79. Telnet Client Global Parameters

Parameters Default
Enable/Disable Enable
Verbose Debug Logging Off
Remote Port 23
Prompt telnet>

DECnet Parameters

This section describes the Site Manager default settings for the
DECnet Phase IV and DECnet Phase IV to V Transition parameters.
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DECnet Parameters

Table A-80. DECnet Phase IV Global Parameters

Parameter Default
Route Enable Enable
Broadcast Route Timer 180 s
Route Max Addr 1023
Max Broadcast Non Routers | 64

Max Broadcast Routers 32

Max Circuits 1024 circuits
Max Cost 1022
Max Hops 30 hops
Max Visits 63 visits
Area Max Cost 1022
Area Max Hops 30 hops
Max Area 63 areas

Table A-81. DECnet Phase IV Interface Parameters

Parameter Default
Enable Enable
Area ID None
Node ID None
Cost 10

continued on the next page
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Site Manager Default Settings

Table A-81. DECnet Phase IV Interface Parameters (continued)

Parameter Default
Hello Timer 158
Max Routers 33 routers
Router Priority 64
End Nodes MAC None
End Routers MAC None
Area Routers MAC None
Node Hello Enable
Router Hello Enable
Level 1 Topology Update Enable
Level 2 Topology Update Enable

Table A-82. DECnet IV to V Transition Parameters

Parameter Default
DECnet 4 to 5 Transition None
Enable

Area Address Alias 1 (hex) None

Route Max Addr 1023

Max Broadcast Non Routers | 64

Max Broadcast Routers 32

Max Circuits 1024 circuits
Max Cost 1022

continued on the next page
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VINES Parameters

Table A-82. DECnet IV to V Transition Parameters (continued)

Parameter Default
Max Hops 30 hops
Max Visits 63 visits
Area Max Cost 1022
Area Max Hops 30 hops
Max Area 63 areas
VINES Parameters
This section describes the Site Manager default parameter settings for
the VINES protocol.

Table A-83. VINES Global Parameters

Parameter Default
Enable Enable
Network ID 0
Broadcast Class All
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Site Manager Default Settings

Table A-84. VINES Interface Parameters

Parameter Default

Enable Enable

ARP Enable Disable

End Station Enable Disable

Ethernet Header Ethernet

Remote Client Enable Disable

Split Horizon Enable Disable

Frame Relay Broadcast 0xff_f (not displayed)
Configured MAC Address 0

Configured Interface Cost 0

SMDS Broadcast 0xff _f (not displayed)

A-55



AppleTalk Parameters

AppleTalk Parameters

This section describes the Site Manager default parameter settings for

AppleTalk and AURP.

Table A-85. AppleTalk Global Parameters

Parameter

Default

Enable

Enable

Table A-86. AppleTalk Interface Parameters

Parameter Default
Enable Enable
Network Start 0
Network End 0
Default Zone None
Network ID 0

Node ID 0
Interface Cost 0 hops
Checksum Enable Disable
WAN MAC Address None
WAN Broadcast Address None
Enable Split Horizon Enable

A-56



Site Manager Default Settings

Table A-87. AURP Global Parameters

Parameter Default
Enable Enable
Local IP Address None
Remote AURP IP Address None

Table A-88. AURP Interface Parameters

Parameter Default
Enable Enable
Command Timeout |3s
Command Retries 3
Update Rate 30s
Last Heard from Timeout 90 s
Remote AURP IP Address None
Hop Count Reduction Disable
Interface Cost 0 hops

OSI Parameters

This section describes the Site Manager default parameter settings for

the Open System Interconnection (OSI) protocol.
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0S| Parameters

Table A-89. OSI Global Parameters

Parameter Default
Enable Enable
Router Type Level 1 & Level 2
Router ID None

Load Balancing Disable

Max # Area Addresses 63 areas

Max # End Systems 1023 systems

Max # L1 Intermediate 15 systems
Systems

Max # L2 Intermediate 63 systems
Systems

Max # External Addresses 1 address

IS Checksum Enable

L1 LSP Password None

L2 LSP Password None

Area Address 490040

Area Address Alias 1 None

Area Address Alias 2 None

Max # Learned End Systems | 1024 systems

Max # Learned L1 64 systems

Intermediate Systems

Max # Learned L2 64 systems
Intermediate Systems

CLNP Source Route Support | Enable
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Site Manager Default Settings

Table A-90. OSI Interface Parameters

Parameter Default
Enable Enable
Routing Level Level 1 & Level 2
L1 Default Metric 20

L2 Default Metric 20

L1 Designated Router 64
Priority

L2 Designated Router 64
Priority

ITH Hello Timer 8s
ISH Hello Timer 30s
ESH Configuration Timer 600 s
Circuit Password None
ITH Hold Time Multiplier 3

ISH Hold Time Multiplier 3

IPX Parameters

This section describes the Site Manager default parameter settings for
the Internet Packet Exchange (IPX) protocol and for IPX RIP.
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iPX Parameters

Table A-91. IPX Global Parameters

Parameter Default

Enable Enable

Multiple Host Address Enable

Enable

Host Number (hex) If you disable the Multiple Host Address

Enable parameter and enter a unique host
number, the Configuration Manager
assigns this number to all IPX interfaces
you configure on the router.

If you disable the Multiple Host Address
Enable parameter and do not enter a box-
wide host ID number for this parameter,
the Configuration Manager automatically
generates a unique 6-byte host ID number
for all IPX interfaces. The generated host
ID is based on the serial number of the
router’s backplane.

ance

Router Name None

Primary Net Number None

RIP Method Tick
Maximum Path 1 path

Log Filter Trace

Initial Network Table Size 0 table entries
Novell Certification Conform- | Enabled
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Site Manager Default Settings

Table A-92. IPX Interface Parameters

Parameter Default

Enable Enable

Cost 1 (for hop- or tick-based routing)
Host Number (hex) None

Configured Encaps None (media dependent)
TR End Station Disable

NetBIOS Accept Enable

NetBIOS Deliver Enable

WAN RIP Period 2 (two 30-second intervals)
WAN SAP Period 2 (two 30-second intervals)
FR Broadcast (hex) OxFFFFFF (not displayed)
FR Multicast (hex) OxFFFFFF (not displayed)
Split Horizon Enable

IPXWAN Enable Disable

IPXWAN Common Net (hex) | None

IPXWAN Time Out 60 s

IPXWAN Link Retry 5 retries
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XNS Parameters

Table A-93. IPX RIP Parameters

Parameter Default

Enable Enable

Supply Enable

Listen Enable
XNS Parameters

This section describes the Site Manager default parameter settings for
the Xerox Network Systems (XNS) protocol and for XNS RIP.

Table A-94. XNS Global Parameters

Parameter Default

Enable Enable

Base Host Number (hex) None

Configure RIP Depends on whether RIP is configured
Implementation XNS

Table A-95. XNS Interface Parameters

Parameter Default

Enable Enable

continued on the next page
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Site Manager Default Settings

Table A-95. XNS Interface Parameters (continued)

Parameter Default
Cost 0
Xsum On Enable
MAC Address None
SMDS Group Address None
Ext Server Disable
Ex Server Network Enable
Ex Server Host ID 0
Ex Serv Pkt Type None
Ex Serv SockNM None
Frame Relay Broadcast bidiiig
Frame Relay Multicast biiiiid
Split Horizon Algorithm Enable
Table A-36. XNS RIP Parameters
Parameter Default
Enable None
Supply Enable
Listen Enable
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DLSw Parameters

DLSw Parameters

This section describes the Site Manager default parameter settings for
the Data Link Switching (DLSw) service.

Table A-97. DLSw Global Parameters

Parameter Default

Enable Enable

TCP Window Size 16000

IP Virtual Ring None

Max Slot Sessions 200 sessions per slot
Virtual Ring MTU 2052

MAC Cache Age - 300 s

NetBIOS Cache Age 300 s

Reject Unconf Peers Accept

Keepalive Time (sec) 0

Table A-98. DLSw Interface Parameters

Parameter Default

Enable Enable
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Site Manager Default Settings

Table A-99. DLSw SAP Parameters

Parameter Default

SAP Window 7 frames

Table A-100. DLSw Siot Parameters

Parameter Default
IP Address for TCP None
Connection

LNM Parameters

This section describes the Site Manager default parameter settings for
the LAN Network Manager (LNM) application.

Table A-101.LNM Global Parameters

Parameter Default
LNM Servers Enable
Allow IBM LAN Network Disable
Manager to Set
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LLC2 Parameters

Table A-102.LNM Interface Parameters

Parameter Default
Enable Enable
Remote MAC Address None
LRM Active Enable
REM Active Enable
RPS Active Enable
CRS Active Enable
Control Manager Password All 0s
OB (1, 2, or 3) Manager All 0s
Password
Error Rate Threshold 128
LLC2 Parameters

This section describes the Site Manager default parameter settings for
the Logical Link Control (LLC2) service.

Table A-103.LLC2 Giobal Parameters

Parameter Default

Enable Enable

A-66




Site Manager Default Settings

Table A-104.LLC2 interface Parameters

Parameter Default
Enable Enable
Maximum UI-PDU Size 5128 octets
Max Retry 1
Maximum I-PDU Size 128 octets
K 7 PDUs
N2 10 retransmissions
N3 2 PDUs

Tx Wait Acknowledgment 15s

Timer

LLC2 Interface Reject Timer | 30 s
Remote Busy Timer 60 s

Idle Timer 120 s

Poll Cycle Timer 30s

Max Number of SAPs per 255 SAPs
Service

Maximum Number of End-to-
End Connections per SAP

255 end-to-end connections
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APPN Parameters

APPN Parameters

This section describes the Advanced Peer-to-Peer Networking (APPN)

default parameter settings.

Table A-105.APPN Global and Advanced Global Parameters

Parameter Default
APPN Enable/Disable Enable
Local Node Name None
Local ID Block None
Local ID Number None
Route Addition Resistance 128
Endpoint Session RSCV Enable
Storage

Max Directory Entries 0

Max Cached Directory 100
Entries

Network Local Timeout (in s) | 60
TRS Route Tree Cache Size 8

TRS Route Tree Cache Size 8
Usage Limit

Max NNs in Topology DB 0
(0=Unlimited)

Max TGs in Topology DB 0
(0=Unlimited)

Max Number of ISR Sessions | 1000

continued on the next page
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Site Manager Default Settings

Table A-105. APPN Global and Advanced Global Parameters (continued)

Parameter Default
ISR Congestion Threshold 900
ISR Decongestion Threshold | 800
Max RU Size for ISR Sessions | 1024
ISR Receive Pacing Window 7

ISR Sessionn RSCV Storage Enable

Table A-106. APPN Interfaces and Ports Parameters

Parameter Default
Interface Enable/Disable Enable
Port Enable/Disable Enable
Port Address None
Local Link Station Role Negotiable
Port Name None
Port Number None
Port MAC Address None
Port SAP (hex) None
Max Receive BTU Size 2057
Max Send BTU Size 2057
Max I-Frame Window 7

Total Link Activation Limits | 256

continued on the next page
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APPN Parameters

Table A-106. APPN Interfaces and Ports Parameters (continued)

Parameter Default
Inbound Link Activation 128
Limits

Outbound Link Activation 128
Limits

Implicit CP Sessions Yes
Implicit Limited Resource Yes
Implicit Effective Capacity 133
Implicit Connection Cost 128
Implicit Byte Cost 128
Implicit Security 1
Implicit Delay 0
Implicit User-Defined 1 128
Implicit User-Defined 2 128
Implicit User-Defined 3 128

Table A-107. APPN Adjacent Link Station Parameters

Parameter Default
Enable/Disable Enable
Port Name None
Adjacent Node Name None
Adjacent Node Type Learned

continued on the next page
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Site Manager Default Settings

Table A-107. APPN Adjacent Link Station Parameters (continued)

Parameter Default
Link Address (hex) None
Max Send BTU Size 2057
Target Pacing Count 4
Adjacent Link Station Name | None
Adjacent Node Name Local NETID for NETID portion of name
MAC Address (hex) None
SAP (hex) None
Limited Resource TG No
Down-level Adjacent Node No
Adjacent Node Block Number | None
Adjacent Node ID Number None
CP-CP Session Support Yes
Automatic Activation Disable
Use Default TG No
Characteristics

Effective Capacity 133
Connection Cost 128
Byte Cost 128
Security 1
Delay 0
Implicit User-Defined 1 128

continued on the next page
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APPN Parameters

Table A-107. APPN Adjacent Link Station Parameters (continued)

Parameter Default
Implicit User-Defined 2 128
Implicit User-Defined 3 128

Table A-108. APPN Connection Networks and Ports Parameters

Parameter Default
Enable/Disable Enable
Connection Network Name None
Connection Network Port None
Name

Effective Capacity 133
Connection Cost 128
Byte Cost 128
Security 1
Delay 0
Implicit User-Defined 1 128
Implicit User-Defined 2 128
Implicit User-Defined 3 128
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Site Manager Default Settings

Table A-109. APPN Directory Services Parameters

Parameter Default

Enable/Disable Enable

Resource Type LU

Parent Name None

Parent Type ENCP

Resource Name NETID portion of local node name

Multiline Feature Parameters

This section describes the Site Manager default parameter settings for
the Multiline feature.

Table A-110. Multiline Parameters

Parameter Default

Data Path Chooser Address Based

Switched Access Services Parameters

This section describes the Site Manager default parameter settings for
the Switched Access Services.
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Switched Access Services Parameters

Table A-111. Modem Parameters

Parameter Default
Connection When Available Data
Connection Time None

Call Connection Time None
Inactivity Timeout 5 min

Retry Delay 0 min
Bandwidth None
Maximum Aggregate 0 channels
Channels

Minimum Aggregate 0 channels
Channels

Management Type None

Restrict Type No restriction
Redial Count 3 attempts
Force Dial False

Force Hangup False

Bring Up Hour None

Bring Up Minute None

Take Down Hour None

Take Down Minute None
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Site Manager Default Settings

Protocol Prioritization Parameters

This section describes the Site Manager default parameter settings for

Protocol Prioritization.

Table A-112. Protocol Prioritization Interface Parameters

Parameter Default
Enable Enable
High Queue 20 packets
Normal Queue 20 packets
Low Queue 20 packets
Max High Queue Latency 250 ms
High Water Packets Clear None
Prioritization Algorithm Type | Bandwidth Alloc
High Queue Percent 70 percent
Normal Queue Percent 20 percent
Low Queue Percent 10 percent

Console Parameters

This section describes the Site Manager default parameter settings for
the console that runs the Technician Interface.
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Console Parameters

Table A-113. Console Parameters

Parameter Default
Port Type TI
Baud Rate 9600
Data Bits 8
Parity None
Stop Bits 1
Modem Enable Disable
Lines Per Screen 24
More Enable Enable
Prompt $
Login Timeout 1
Password 1
Command Timeout 15
Login Retries 3
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access privileges, 1-8

accessing
line service parameters, 3-14

adding network interfaces
configuring circuits, 2-2
enabling protocols, 2-2
overview, 2-2

address modes, 4-10

addressing
point-to-point connections
conventions, 3-56
explicit, 3-57
Adjacent Link Station Dialog Box, 2-137,
2-147

alarm signal, 4-34, 5-32
AMI line coding, 4-7, 5-7
ANSI 403, 4-10

AppleTalk

configuring AURP, 2-88
configuring default zone, 2-85
configuring zone list, 2-85

nonprintable characters, 2-86
defaults, A-56
enabling on a circuit, 2-80
nonseed router

configuring, 2-81
parameters

networks, 2-83, 2-84
parameters, networks, 2-82
seed router, configuring, 2-81

Index

APPN
defaults, A-68, A-70
enabling on LLC2 using SRB, 2-137 to
2-142
enabling over LLC2, 2-131 to 2-137
enabling over SDLC, 2-142 to 2-147

APPN Configuration window, 2-146

APPN Local Node Name Configuration
window, 2-133, 2-144

APPN Virtual Ring Number window, 2-141

ARP Address parameter, 2-22

Asynchronous

defaults, A-6

parameters
Baud Rate, 3-83
Cfg RxQ Length, 3-86
Cfg TxQ Length, 3-85
Enable, 3-81
Idle Timer, 3-83
Local Port, 3-82

- MTU, 3-81
Receive Window, 3-83
Remote IP Address, 3-82
Remote Port, 3-82
Start Protocol, 3-81
TCP Inactive Limit, 3-85
TCP KeepAlive, 3-84

Asynchronous Transfer Mode Data
Exchange Interface. See ATM
DXI; ATM FRE2.

AT&T 54016, 4-10
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ATM DXI
adding PVCs, 2-10
defaults, A-23
enabling on a circuit, 2-9
parameters
VCI Number, 2-13
VPI Number, 2-13

ATM FRE2

adding PVCs, 2-14

defaults, A-24

enabling on a circuit, 2-14

parameters
Cell Insertion, 3-103
Data Path Notify, 3-96
Data Path Notify Timeout, 3-97
Enable, 3-96
Framing Mode, 3-102
Loop Back, 3-103
Maximum Burst Size, 3-101
Peak Cell Rate, 3-99
Scrambling, 3-103
Sustainable Cell Rate, 3-100
VCI Number, 2-18
VPI Number, 2-18

ATM WAN protocol, 2-7

AURP
configuring, 2-88
defaults, A-57
parameters
enable, 2-89
local IP address, 2-89
remote IP address, 2-91

AZ, 4-10

B

B8ZS line coding, 4-7

BERT, 4-35, 5-33

BERT mode, 4-31 to 4-40, 5-29 to 5-36

BGP
defaults, A-47
parameters
Identifier, 2-68
Local Address, 2-70
Local AS, 2-69
Peer Address, 2-70
Peer AS, 2-70
peers
configuring, 2-70
BNC connector
and timing, 5-4
BOFL, 4-25, 5-22
booting
with a configuration file, 6-12
BOOTP
defaults, A-40
Border Gateway Protocol. See BGP
Bridge
enabling on a circuit, 2-51
parameters
Bridge MAC Address, 2-53, 2-98
Bridge Priority, 2-52, 2-97
Bridge (Translation)
defaults, A-34
Bridge (Transparent)
defaults, A-30
Bridge ID
assigning a, 2-139
bridging/routing protocols
enabling on a circuit, 2-49
BY, 4-10

Index-2



C

Cable Type parameter, 2-26

Carrier Sense Multiple Access with
Collision Detection. See
CSMA/CD

changing configuration files, 6-14
channels. See timeslots

circuit name
MCE1, 5-18
MCT1, 4-21
circuits

adding, 2-5

adding protocols to, 2-160

and MCE], 5-10

and MCT1, 4-13

assigning additional IP addresses to,
2-163

configuration

enabling bridging/routing protocols,
2-49
selecting protocols, 2-49

deleting from the router, 2-158

deleting protocols from, 2-165

enabling WAN services for, 2-8

moving, 2-161

naming conventions, 2-5, 2-6

renaming, 2-159

type designators, Table, 2-6

claim token process, 3-9
Clock Source parameter, 2-24

Configuration Change Utility, 6-14
AppleTalk Interface Profiles, 6-21
DECnet Interface Profiles, 6-18
IP Interface Profiles, 6-16
IPX Interface Profiles, 6-20
OSI Profiles, 6-22
SNMP Manager Profiles, 6-17
Source Routing Global Profile, 6-15
Source Routing Interface Profile, 6-15

Vines Interface Profiles, 6-19
X.25 Packet Level Profiles, 6-23
X.25 Service Profile, 6-24

configuration file
changing dynamically, 1-13
dynamic mode, 6-5
existing, 1-7
implementation of, 6-1
local mode, 6-2
new, 1-8
opening (local), 1-6
opening (remote), 1-11
overwriting, 6-4, 6-7
rebooting a router with, 6-12
remote mode, 6-3
saving, 1-9
configuration mode, 6-2
selecting router model (local), 1-8
specifying hardware, 2-3
transferring to a router, 6-6
Configuration Manager
router functions, 1-2

Configuration Manager overview, 4-1
Configuration Manager window, 1-9
configuration sequence, 2-111
Configure OSPF parameter, 2-48
Configure RIP parameter, 2-48

console
parameters

Baud Rate, 2-168
Command Timeout, 2-172
Data Bits, 2-169
Enable, 2-168
Enable Modem, 2-170
Force Use Logout Enable, 2-174
Initial Search Path, 2-173
Lines Per Screen, 2-170
Login Retries, 2-173
Login Timeout, 2-172
Manager Auto Script, 2-174
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More Enabled, 2-171

Parity, 2-169

Password Timeout, 2-172

Port Type, 2-168

Prompt, 2-171

Stop Bits, 2-169

User Auto Script, 2-174
CSMA/CD, 3-1

cyclic redundancy check, 4-29, 5-26

D

DAS, 3-8

Data compression
enabling, 2-147

Data link connection identifier, 2-136
purpose of, 2-136
Data Link Switching. See DLSw

DB9 connector
and timing, 4-4
DCE, 3-56
DECnet Phase IV
defaults, A-52
parameters
Area ID, 2-79
Node ID, 2-79

DECnet Phase IV to V Transition
defaults, A-53

default zone
configuring for AppleTalk, 2-85

defaults
AppleTalk parameters, A-56
APPN parameters, A-68, A-69, A-70,
A-72
Asynchronous parameters, A-6
ATM DXI parameters, A-23
ATM FRE2 parameters, A-24
AURP parameters, A-57

BGP parameters, A-47

BOOTP parameters, A-40

console parameters, A-76

DECnet Phase IV parameters, A-52

DECnet Phase IV to V Transition
parameters, A-53

DLSw parameters, A-64

DVRMP parameters, A-40

EGP parameters, A-49

Ethernet circuit parameters, A-1

FDDI circuit parameters, A-2

Frame Relay parameters, A-14

HSSI circuit parameters, A-13

IGMP parameters, A-40

IP, A-36

IP parameters, A-36

IPX parameters, A-60

ISDN circuit parameters, A-13

LAPB parameters, A-5

LLC2 parameters, A-66, A-73

LNM parameters, A-65

MCE1 parameters, A-10, A-11

MCT1 parameters, A-8, A-9

Modem parameters, A-74

Multiline parameters, A-73

Native Mode LAN (NML) parameters,
A-35

NetBIOS over IP parameters, A-41

OSI parameters, A-58

OSPF parameters, A-45

Point-to-Point (PPP) parameters, A-27

Protocol Prioritization parameters, A-75

RIP parameters, A-38

RIPSO parameters, A-39

SDLC parameters, A-16, A-18

SMDS parameters, A-15

SNMP parameters, A-41, A-42

Source Routing parameters, A-32

Spanning Tree parameters, A-31

Synchronous circuit parameters, A-3

T1 circuit parameters, A-7
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TCP parameters, A-50

Telnet parameters, A-50

TFTP parameters, A-38

Token Ring circuit parameters, A-7
Translation Bridge parameters, A-34
Transparent Bridge parameters, A-30
VINES parameters, A-54

Wellfleet Compression Protocol, A-29
X.25 parameters, A-19

XNS parameters, A-62

deleting

circuits from the router, 2-158
diagnostics

MCT1 actions, 4-31 to 4-43
directories, 1-7
directories list, 1-7
directory

delete, 1-7

privileges, 1-8
DLCI choice, 2-117, 2-128
DLCI parameter, 2-136

DLSw
and IP, 2-113
and LLC2, 2-113
and Source Routing, 2-113
and TCP, 2-113
defaults, A-64, A-65
enabling, 2-110
parameters
IP Address, 2-120
IP Virtual Ring, 2-115
Peer IP Address, 2-122
SAP, 2-124
Slot, 2-120
DSO0s. See timeslots
DS1, 4-8
DSX1, 4-8
DTE, 3-56

Dual Attachment Station. See DAS

DVRMP

defaults, A-40

enabling, 2-71

parameters
Enable, 2-74
Estimated Routes, 2-77
Full Update Rate, 2-75
Garbage Timeout, 2-77
Leaf Timeout, 2-75
Neighbor Timeout, 2-76
Route Expiration Timeout, 2-76
Triggered Update Rate, 2-75

dynamic mode
description of, 1-13
performing, 1-13
specifying router, 1-14

E

El
editing line details, 3-16
parameters
Enable, 3-17, 3-18
HDB3S Support, 3-17
Mini Dacs, 3-19
Echo Frames, 3-12
Edit SR Interface window, 2-140
editing
line details
Asynchronous, 3-79
E1l, 3-16
Ethernet, 3-20
FDDI, 3-24
FDDI MAC attributes, 3-34
FDDI Path attributes, 3-36
FDDI Port attributes, 3-39
FDDI SMT attributes, 3-28
Synchronous, 3-46
T1, 3-86
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Token Ring, 3-91

EGP
defaults, A-49
enabling on a circuit, 2-65
parameters
Gateway Mode, 2-67 ‘
Local Autonomous System ID, 2-66
Remote Peer IP Address, 2-67

Enabling
APPN over LLC2 interfaces, 2-131 to
2-137
APPN over LLC2 interfaces using SRB,
2-137 to 2-142
APPN over SDLC interfaces, 2-142 to
2-147
error, 1-23
ESF, 4-6, 4-36
Ethernet
defaults, A-1
editing line details, 3-20
overview of, 3-1
parameters
BOFL (Breath of Life) Enable, 3-21
BOFL Timeout, 3-22
Enable, 3-21
Hardware Filter, 3-23

Exterior Gateway Protocol. See EGP

F

FDDI

claim token process, 3-9

defaults, A-2, A-3

editing line details, 3-24
FDDI MAC attributes, 3-34
FDDI Path attributes, 3-36
FDDI Port attributes, 3-39
FDDI SMT attributes, 3-28

overview of, 3-5

parameters

BOFL Enable, 3-25
Connection Policy, 3-30
Duplicate Address Protocol, 3-34
Enable, 3-25
LER Alarm, 3-41
LER Cutoff, 3-41
LLC Data Enable, 3-35
Requested TTRT (ms), 3-39
Status Report Protocol, 3-33
T_Max Lower Bound (ms), 3-38
T_Notify Timeout, 3-32
Trace Max Expiration (ms), 3-33
Tvx Lower Bound (ms), 3-37
User Data, 3-34
primary ring, 3-6
ring
architecture, 3-6
maintenance, 3-10
node regulation in, 3-9
operation, 3-8
wrapping, 3-6
secondary ring, 3-6
SMT
Connection Policy values, Table, 3-31
Echo Frames, 3-12
frame class and type, Table, 3-12
Neighbor Information Frames, 3-12
overview of, 3-10
Parameter Management Frames, 3-12
Request Denied Frames, 3-12
Status Information Frames, 3-12
Status Report Frames, 3-12
standards
MAC, 3-5
PHY, 3-5
PMD, 3-5
SMT, 3-5, 3-10
station timers
token rotation timer, 3-9
token-holding timer, 3-9
valid transmission timer, 3-9
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FDL
mode, 4-10

file
create privileges, 1-8
File Selection window, 1-7
file system. See volume
files, 1-7
delete, 1-7
open, 1-7
files list, 1-7
fractional loopback, 4-26, 5-23

Frame Relay
and Protocol Prioritization, 2-7
defaults, A-14
enabling on a circuit, 2-8
Frame Relay Mapping Add window, 2-117,
2-128

Frame Relay Mappings window, 2-116,
2-127

Frame Relay WAN protocol, 2-7

free space
and saving configuration files, 6-4

G

Group Address parameter, 2-21

H

hardware filters

enabling on a circuit, 2-6
hardware specification, 1-9, 2-3
HDBS3 line coding, 5-7
HDLC

service type, 4-26, 5-23

HSSI
defaults, A-13

editing line details, 3-41
parameters
BOFL, 3-43
BofL Frequency, 3-44
CRC Size, 3-46
Enable, 3-42
External Clock Speed, 3-46
MTU, 3-44
Transmission Interface, 3-45
WAN Protocol, 3-45

IGMP
defaults, A-40
enabling, 2-71
parameters
Enable, 2-72
Estimated Groups, 2-73
Individual Address parameter, 2-20
interframe time fill pattern, 4-29, 5-26
Internal Clock Speed parameter, 2-25
Internal LAN ID, 2-139
Internet Packet Exchange. See IPX
Internet Protocol. See IP
IP
and DLSw, 2-113
defaults, A-36
enabling on a circuit, 2-53
parameters
IP Address, 2-42, 2-44, 2-47, 2-54
Subnet Mask, 2-42, 2-55
Transmit Bcast Addr, 2-43, 2-56
IP addresses
assigning to a circuit, 2-163
IPX
defaults, A-61
enabling on a circuit, 2-103
parameters
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Cfg Encaps, 2-106
Configure RIP, 2-105
Network Address (hex), 2-104

ISDN
defaults, A-13

K
KG84A, 3-64 to 3-70

L

Lan Network Manager. See LNM

LAPB
defaults, A-5
parameters

Command/Response Address, 3-78

Control Field, 3-73
Enable, 3-72

Enable Rx/Tx of XID Frames, 3-77

Idle RR Frames, 3-78

Initiate Link Setup Action, 3-77

Max N1 Frame Size, 3-74
Max N2 Retries, 3-75

Max T1 Acknowledge Timer, 3-75
Max T2 Acknowledge Delay Timer,

3-76
Max T3 Disconnect Timer, 3-76
Station Type, 3-73
WAN Protocol, 3-79
Window Size, 3-74
line coding
AMI and B8Zs, 4-7, 5-34
AMI and HDBS, 5-7

line services
accessing, 3-14

line tests, 4-31 to 4-43
MCT1, 4-31

Link Access Procedure Balanced (LAPB)
protocol
description, 3-71
LLC1, 4-26, 5-23
LLC2
and DLSw, 2-113
defaults, A-67
enabling APPN over, 2-131 to 2-137
enabling on a circuit, 2-125
LLC2 Frame Relay Mapping Add window,
2-117, 2-128
LLC2 Frame Relay Mappings window,
2-116, 2-127
LLC2/SRB
enabling APPN over, 2-138 to 2-142
LNM
defaults, A-66
enabling on a circuit, 2-125
local mode
description, 1-6
selecting router model, 1-8
Local Node Name parameter, 2-134, 2-145
locked message, 1-23
logical line, 4-12
Logical Link Control. See LLC1; LLC2
loop tests, 4-40 to 4-43
loopback, 4-12
diagnostic, 4-26, 5-23
fractional, 4-26, 5-23
loopback mode, 4-11
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MAC Address parameter, 2-135
maximum transfer unit, 4-6
MCE1

Reset BERT Counters, 5-35
Secondary Clock, 5-4
Service, 5-23

Setup Alarm Threshold, 5-8
WAN Protocol, 5-23

AMI line coding, 5-34
channels, 5-27

defaults, A-10, A-11
defining circuits, 5-10
diagnostics, 5-29 to 5-36
DSO0s, 5-27

dynamic mode, 5-29
HDBS3 line coding, 5-34
line tests, 5-29

logical lines, 5-9
multiline groupings, 5-12

port parameters, 5-5
timeslots, 5-27

MCE]1 diagnostics, 5-29, 5-36
MCT1

adding circuits, 4-1, 5-1
default parameters, A-9
defaults, A-8, A-9
defining circuits, 4-13
line tests, 4-31 to 4-43
multiline groupings, 4-15
parameters

naming circuit, 5-18
parameters
BERT Mode Enable, 5-32
BERT Send Alarm, 5-32
BERT Test Pattern, 5-33
BOFL Period, 5-22
Breath of Life, 5-22
Clear Alarm Threshold, 5-8
CRC Size, 5-26
Disable Insert Error/K, 5-36
Enable, 5-6
Enable/Disable, 5-21
Fractional Loopback, 5-23
Insert 1 Error/K, 5-36
Insert 1 Error/M, 5-36
Inset 1 Error, 5-35
InterFrame Time Fill Character, 5-26
International Bit Mode, 5-9, 5-33
Line Coding, 5-7, 5-34
Line Type, 5-6, 5-35
Local HDLC Address, 5-24
MTU Size, 5-27
Primary Clock, 5-3
Rate Adaptation, 5-25
Remote HDLC Address, 5-25

Accept Local Loopback, 4-11
BERT Mode Enable, 4-34
BERT Send Alarm, 4-34
BERT Test Pattern, 4-35
BOFL Period, 4-25

Breath of Life, 4-25

Clear Alarm Threshold, 4-9
CRC Size, 4-29

Disable Insert Error/K, 4-40
Enable, 4-5

Enable/Disable, 4-24

FDL Configuration, 4-10
FDL Disable All, 4-43

FDL Disable Line Loop, 4-42
FDL Line Loop CI, 4-41
FDL Line Loop IA, 4-42
FDL Line Loop IB, 4-42
FDL Payload Loop, 4-41
Fractional Loopback, 4-26
Insert 1 Error/K, 4-39
Insert 1 Error/M, 4-39

Inset 1 Error, 4-39
InterFrame Time Fill Character, 4-29
Line Coding, 4-7, 4-37

Line Type, 4-6, 4-36
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Local HDLC Address, 4-27
Loop Down, 4-40

Loop Up, 4-40

Loopback Configuration, 4-12
Maximum Transfer Unit, 4-6
Primary Clock, 4-3

Rate Adaptation, 4-28
Remote HDLC Address, 4-28
Remote HDLC Address Mode, 4-10
Reset BERT Counters, 4-38
Secondary Clock, 4-4

Service, 4-26

Setup Alarm Threshold, 4-9
Signal Level, 4-8, 4-38

WAN Protocol, 4-26

MCT1 port actions, 4-31
modem
defaults, A-74
moving
circuits, 2-161
Multiline
circuit types, 2-149
configuring, 2-152, 2-154

MCE1, 5-12
MCT1, 4-15
synchronous lines, 2-152

configuring MCE1, 5-12 to 5-18
defaults, A-73

description of, 2-148

grouping data paths

guideline, 2-150

media support, 2-149
parameters

Data Path Chooser, 2-157

traffic distribution, 2-151

address based selection, 2-151

uses of, 2-148
Multinet, 2-163

N

Native Mode LAN (NML)
defaults, A-35

Neighbor Information Frames, 3-12

NetBIOS over IP
defaults, A-41

NML (Native Mode LAN) port
creating, 2-102

nonseed router
configuring for AppleTalk, 2-81

o)

Open Shortest Path First. See OSPF

Open Systems Interconnection
0OSI, 2-100

operating modes
description of, 1-5
identification of on windows, 1-5
overview, 1-4
specifying, 1-5
OPSF
enabling on a circuit, 2-57
OSI
defaults, A-58
enabling on a circuit, 2-100
parameters
Router ID, 2-101

OSPF

defaults, A-45, A-46

parameters
Area Address, 2-65, 2-102
AS Boundary Router, 2-58
Ase Metric Support, 2-60
Backup Enable, 2-60
Backup Log Mask, 2-63
Hold Down Timer, 2-59
OSPF Slot, 2-59
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Primary Log Mask, 2-61
Router ID, 2-58

P

Parameter Management Frames, 3-12

parameters
AppleTalk
Default Zone, 2-84
Network End, 2-83
Network Start, 2-82
ARP Address, 2-22
Asynchronous
Baud Rate, 3-83
Cfg RxQ Length, 3-86
Cfg TxQ Length, 3-85
Enable, 3-81
Idle Timer, 3-83
Local Port, 3-82
MTU, 3-81
Receive Window, 3-83
Remote IP Address, 3-82
Remote Port, 3-82
Start Protocol, 3-81
TCP Inactive Limit, 3-85
TCP KeepAlive, 3-84
ATM DXI
VCI Number, 2-13
VPI Number, 2-13
ATM FRE2
Cell Insertion, 3-103
Data Path Notify, 3-96
Data Path Notify Timeout, 3-97
Enable, 3-96
Framing Mode, 3-102
Loop Back, 3-103
Maximum Burst Size, 3-101
Peak Cell Rate, 3-99
Scrambling, 3-103
Sustainable Cell Rate, 3-100
VCI Number, 2-18

VPI Number, 2-18
AURP
enable, 2-89
local IP address, 2-89
remote IP address, 2-91
BGP
Identifier, 2-68
Local Address, 2-70
Local AS, 2-69
Peer Address, 2-70
Peer AS, 2-70
Bridge
Bridge MAC Address, 2-53, 2-98
Bridge Priority, 2-52, 2-97
console
Baud Rate, 2-168
Command Timeout, 2-172
Data Bits, 2-169
Enable, 2-168
Enable Modem, 2-170
Force Use Logout Enable, 2-174
Initial Search Path, 2-173
Lines Per Screen, 2-170
Login Retries, 2-173
Login Timeout, 2-172
Manager Auto Script, 2-174
More Enabled, 2-171
Parity, 2-169
Password Timeout, 2-172
Port Type, 2-168
Prompt, 2-171
Stop Bits, 2-169
User Auto Script, 2-174
DECnet Phase IV
Area ID, 2-79
Node ID, 2-79
DLCI, 2-117, 2-128
DLSw
IP Address, 2-120
IP Virtual Ring, 2-115
Peer IP Address, 2-122
SAP, 2-124
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Slot, 2-120
DVRMP
Enable, 2-74
Estimated Routes, 2-77
Full Update Rate, 2-75
Leaf Timeout, 2-75
Neighbor Timeout, 2-76
Route Expiration Timeout, 2-76
Route Garbage Timeout, 2-77
Triggered Update Rate, 2-75
El
Enable, 3-17, 3-18
HDB3S Support, 3-17
Mini Dacs, 3-19
EGP
Gateway Mode, 2-67
Local Autonomous System ID, 2-66
Remote Peer IP Address, 2-67
Ethernet
BOFL (Breath of Life) Enable, 3-21
BOFL Timeout, 3-22
Enable, 3-21
Hardware Filter, 3-23
FDDI
BOFL Enable, 3-25
BOFL Timeout, 3-26
Connection Policy, 3-30
Duplicate Address Protocol, 3-34
Enable, 3-25
Hardware Filter, 3-27
LER Alarm, 3-41
LER Cutoff, 3-41
LLC Data Enable, 3-35
Requested TTRT (ms), 3-39
Status Report Protocol, 3-33
T _Max Lower Bound (ms), 3-38
T_Notify Timeout, 3-32
Trace Max Expiration (ms), 3-33
Tvx Lower Bound (ms), 3-37
User Data, 3-34
Group Address, 2-21
HSSI

BOFL, 3-43
BofL Frequency, 3-44
CRC Size, 3-46
Enable, 3-42
External Clock Speed, 3-46
MTU, 3-44
Transmission Interface, 3-45
WAN Protocol, 3-45
IGMP
Enable, 2-72
Estimated Groups, 2-73
Individual Address, 2-20
IP
IP Address, 2-42, 2-44, 2-47, 2-54
Subnet Mask, 2-42, 2-55
Transmit Bcast Addr, 2-43, 2-56
IPX
Cfg Encaps, 2-106
Configure RIP, 2-105
Network Address (hex), 2-104
LAPB
Command/Response Address, 3-78
Control Field, 3-73
Enable, 3-72
Enable Rx/Tx of XID Frames, 3-77
Idle RR Frames, 3-78
Initiate Link Setup Action, 3-77
Max N1 Frame Size, 3-74
Max N2 Retries, 3-75
Max T1 Acknowledge Timer, 3-75
Max T2 Acknowledge Delay Timer,
3-76
Max T3 Disconnect Timer, 3-76
Station Type, 3-73
WAN Protocol, 3-79
Window Size, 3-74
Line Coding, 4-37, 5-34
Local MAC, 2-118, 2-129
MCE1l
BERT Mode Enable, 5-32
BERT Send Alarm, 5-32
BERT Test Pattern, 5-33
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BOFL Period, 5-22

Breath of Life, 5-22

Clear Alarm Threshold, 5-8
CRC Size, 5-26

Disable Insert Error, 5-36
Enable, 5-6
Enable/Disable, 5-21
Fractional Loopback, 5-23
Insert 1 Error, 5-35

Insert 1 Error/K, 5-36
Insert 1 Error/M, 5-36
InterFrame Time Fill Character, 5-26
International Bit, 5-9, 5-33
Line Coding, 5-7

Line Type, 5-6, 5-35

Local HDLC Address, 5-24
MTU Size, 5-27

Primary Clock, 5-3

Rate Adaptation, 5-25
Remote HDLC Address, 5-25
Reset BERT Counters, 5-35
Secondary Clock, 5-4

FDL Line Loop IB, 4-42

FDL Payload Loop, 4-41
Fractional Loopback, 4-26
Insert 1 Error, 4-39

Insert 1 Error/K, 4-39

Insert 1 Error/M, 4-39
InterFrame Time Fill Character, 4-29
Line Coding, 4-7

Line Type, 4-6, 4-36

Local HDLC Address, 4-27
Loop Down, 4-40

Loop Up, 4-40

Loopback Configuration, 4-12
Maximum Transfer Unit, 4-6
Primary Clock, 4-3

Rate Adaptation, 4-28
Remote HDLC Address, 4-28
Remote HDLC Address Mode, 4-10
Reset BERT Counters, 4-38
Secondary Clock, 4-4

Service, 4-26

Setup Alarm Threshold, 4-9

Service, 5-23 Signal Level, 4-8, 4-38
Setup Alarm Threshold, 5-8 WAN Protocol, 4-26
WAN Protocol, 5-23 Multiline

MCT1 Data Path Chooser, 2-157
Accept Local Loopback, 4-11 OSI
BERT Mode Enable, 4-34 Router ID, 2-101
BERT Send Alarm, 4-34 OSPF

BERT Test Pattern, 4-35
BOFL Period, 4-25

Breath of Life, 4-25

Clear Alarm Threshold, 4-9
CRC Size, 4-29

Disable Insert Error, 4-40
Enable, 4-5
Enable/Disable, 4-24

FDL Configuration, 4-10
FDL Disable All, 4-43

FDL Disable Line Loop, 4-42
FDL Line Loop CI, 4-41
FDL Line Loop 1A, 4-42

Area Address, 2-65, 2-102
AS Boundary Router, 2-58
Ase Metric Support, 2-60
Backup Enable, 2-60
Backup Log Mask, 2-63
Hold Down Timer, 2-59
OSPF Slot, 2-59

Primary Log Mask, 2-61
Router ID, 2-58

Remote MAC, 2-118, 2-129
router connection

Identity (Community), 1-17
Node Name/IP address, 1-16
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Retries (per request), 1-18
Timeout (seconds), 1-17
Source Routing
Source Routing Ring Number, 2-95
SR Bridge ID, 2-93
SR Bridge Internal LAN ID, 2-93
Synchronous
BOFL, 3-48
BOFL Timeout, 3-49
Burst Count, 3-54
Cable Type, 3-69
Clock Source, 3-50
CRC Size, 3-61
Enable, 3-48, 3-49
Extended Address, 3-70
Extended Control (S and I frames),
3-68
External Clock Speed, 3-52
Idle RR Frames, 3-69
Internal Clock Speed, 3-51
KG84A Cycle, 3-65
KG84A Remote Sync Wait, 3-66
KG84A Sync Loss Interval, 3-66
KGB84A Sync Pulse, 3-67
Link Idle Timer, 3-68
Local Address, 3-58
Minimum Frame Spacing, 3-56
Network Link Level, 3-67
Pass Thru Local Address, 3-60
Pass Thru Remote Address, 3-61
Promiscuous, 3-50
Remote Address, 3-59
Remote Loopback Detection, 3-71
Retry Count, 3-68
Retry Timer, 3-70
RTS Enable, 3-53
Service, 3-55
Signal Mode, 3-53
Sync Line Coding, 3-63
Sync Media Type, 3-62
Sync Polling, 3-62
Transmit Window Size, 3-55

WAN Protocol, 3-60
system
System Contact, 2-176
System Location, 2-176
- System Name, 2-176
T1
B8ZS Support, 3-88
Clock Mode, 3-89
Enable, 3-87
Frame Type, 3-87
Line Buildout, 3-88
Mini Dacs, 3-90
Token Ring
Early Token Release, 3-94
Enable, 3-92
MAC Address Override, 3-92
MAC Address Select, 3-93
Speed, 3-93
X.25
Bidirectional LCN Start, 2-34
Bidirectional Logical Channel Count,
2-33
Connection ID, 2-38
DDN IP Address, 2-32
Incoming LLCN Start, 2-33
Incoming Logical Channel Count, 2-32
Link Address Type, 2-30
Network Address Type, 2-31
Outgoing LCN Start, 2-35
Outgoing Logical Channel Count, 2-34
PDN X.121 Address, 2-31
Remote IP Address, 2-37
Remote X121 Address, 2-37
Type, 2-36
XNS
Base Host Number, 2-108
Configure RIP, 2-109
Implementation, 2-109
Network Address (hex), 2-107

PassThru WAN protocol, 2-7

Index-14



Passthru WAN service
enabling on a circuit, 2-8
path list, 1-7
Point-to-Point (PPP)
defaults, A-27
port actions
MCT1, 4-31
port parameters, 4-5
power level
T1 transmit, 4-8
PPP
and Protocol Prioritization, 2-7

and synchronous line parameters, 2-8
enabling on a circuit, 2-8
PPP WAN protocol, 2-7
primary ring, 3-6
Protocol Prioritization
and WAN Protocols, 2-7
defaults, A-75
protocols
adding to a circuit, 2-160
deleting from a circuit, 2-165

rate adaptation
line, 4-28, 5-25
remote mode
description of, 1-10
performing, 1-11
specifying router, 1-14
renaming
circuits, 2-159
Request Denied Frames, 3-12
Ring ID
of source routing circuit, 2-141

RIP
defaults, A-38

RIPSO
defaults, A-39

router connection
parameters
Identity (Community), 1-17
Node Name/IP Address, 1-16
Retries (per request), 1-18
Timeout (seconds), 1-17

router connection messages, 1-23

router model
specifying, 1-8

S

SAP (hex) parameter, 2-136

SAS, 3-8

saving
configuration file (dynamic mode), 6-5
configuration file (local mode), 6-2
configuration file (remote mode), 6-3

SDLC
defaults, A-16, A-18
enabling, 2-23
enabling APPN over, 2-142 to 2-147

SDLC Address (hex) parameter, 2-146
SDLC Line Parameters window, 2-143
secondary ring, 3-6

seed router
configuring for AppleTalk, 2-81

Select (LAN) Protocols window, 2-126
Select Protocols window, 2-132, 2-144
Select Router Model window, 1-9
service type, 4-26, 5-23

set error, 1-23

SF/D4, 4-6, 4-36
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Single Attachment Station. See SAS

SMDS
and Protocol Prioritization, 2-7
defaults, A-15
enabling on a circuit, 2-8, 2-19
SMDS WAN protocol, 2-7
SMNP, 1-23

SNMP
defaults, A-41, A-42, A-43, A-44
Source Route Encapsulation Dialog Box,
2-132, 2-138
Source Routing
and DLSw, 2-113
defaults, A-32, A-33
enabling on a circuit, 2-91
parameters
Source Routing
SR Bridge Internal LAN ID, 2-93
Source Routing Ring Number, 2-95
SR Bridge ID, 2-93
Source routing bridge
enabling APPN over LLC2 using, 2-137
to 2-142
Source Routing Ring Number
parameter, 2-141
SR Bridge ID global parameter, 2-139
SR Bridge Internal LAN ID parameter,
2-139
SR BridgelD parameter, 2-139
Source Routing Global Parameters
window, 2-138
Source Routing Ring Number parameter,
2-141
Source Routing Spanning Tree
enabling on a circuit, 2-95
Source Routing Translate/Learning Bridge
enabling on a circuit, 2-98
Source Routing Translate/Learning Bridge
Spanning Tree

enabling on a circuit, 2-99
Spanning Tree

defaults, A-31

enabling on a circuit, 2-51

SR Bridge ID parameter, 2-139

SR Bridge Internal LAN ID parameter,
2-139

Standard WAN protocol, 2-7
station management (SMT), 3-11
Status Information Frames, 3-12
Status Report Frames, 3-12

Switched Multi-Megabit Data Service. See
SMDS

Sync Line Coding parameter, 2-26

Synchronous
defaults, A-3
parameters
BOFL, 3-48
BOFL Timeout, 3-49
Burst Count, 3-54
Cable Type, 2-26, 3-69
Clock Source, 2-24, 3-50
CRC Size, 3-61
Enable, 3-48
Extended Address, 3-70
Extended Control (S and I frames),
3-68
External Clock Speed, 3-52
Idle RR Frames, 3-69
Internal Clock Speed, 2-25, 3-51
KG84A Cycle, 3-65
KG84A Remote Sync Wait, 3-66
KG84A Sync Loss Interval, 3-66
KG84A Sync Pulse, 3-67
Link Idle Timer, 3-68
Local Address, 3-58
Minimum Frame Spacing, 3-56
MTU (Maximum Transfer Unit), 3-49
Network Link Level, 3-67
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Pass Thru Local Address, 3-60

Pass Thru Remote Address, 3-61

Promiscuous, 3-50
Remote Address, 3-59

Remote Loopback Detection, 3-71

Retry Count, 3-68

Retry Timer, 3-70

RTS Enable, 3-53

Service, 3-55

Signal Mode, 3-53

Sync Line Coding, 2-26, 3-63
Sync Media Type, 3-62

Sync Polling, 3-62

Transmit Window Size, 3-55
WAN Protocol, 3-60

synchronous line parameters
and PPP, 2-8

system
parameters
System Contact, 2-176
System Location, 2-176
System Name, 2-176

system information
specifying, 2-175

T

T1
defaults, A-7
editing line details, 3-86
parameters
B8ZS Support, 3-88
Clock Mode, 3-89
Enable, 3-87
Frame Type, 3-87
Line Buildout, 3-88
Mini Dacs, 3-90
TCP
and DLSw, 2-113
defaults, A-50

Technician Interface, 1-3
configuring console port to, 2-166
Telnet
defaults, A-50
TFTP
defaults, A-38
using to transfer a config file, 6-6

time fill pattern
interframe, 4-29, 5-26
timed-token protocol, 3-9
timeslots, 4-5, 4-29
Token Ring
defaults, A-7
editing line details, 3-91
overview of, 3-3
parameters
Early Token Release, 3-94
Enable, 3-92
MAC Address Override, 3-92
MAC Address Select, 3-93
Speed, 3-93
token rotation timer, 3-9
token-holding timer, 3-9
TTP (timed token protocol), 3-9

vV

valid transmission timer, 3-9

VINES
defaults, A-54
enabling on a circuit, 2-80

Virtual Networking System. See VINES
Virtual Ring Number parameter, 2-142

volume
description of, 6-2




w

WAN Protocols, 2-7

WCP
enabling, 2-147

Wellfleet Compression Protocol
Enabling, 2-147

windows

Choosing frame relay or source routing,
2-126

File Selection, 1-7

LLC2 Frame Relay Mapping Add, 2-117,
2-128

LLC2 Frame Relay Mappings, 2-116,
2-127

Select (LAN) Protocols, 2-126

wrapping, 3-6
write-access privileges, 1-8

X

X.25
adding network service records, 2-35
configuring multiple IP addresses over,
2-39
defaults, A-19
enabling bridging/routing protocols on a
circuit, 2-38
enabling on a circuit, 2-8, 2-28
parameters
Bidirectional LCN Start, 2-34
Bidirectional Logical Channel Count,
2-33
Connection ID, 2-38
DDN IP Address, 2-32
Incoming LCN Start, 2-33
Incoming Logical Channel Count, 2-32
Link Address Type, 2-30
Network Address Type, 2-31
Outgoing LCN Start, 2-35

Outgoing Logical Channel Count, 2-34
PDN X.121 Address, 2-31
Remote IP Address, 2-37
Remote X121 Address, 2-37
Type, 2-36
specifying the packet level, 2-28
X.25 WAN protocol, 2-7
Xerox Network Systems. See XNS
XNS
defaults, A-62
enabling on a circuit, 2-107
parameters
Configure RIP, 2-109

Implementation, 2-109
Network Address (hex), 2-107

y4

zone list
configuring for AppleTalk, 2-85
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